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Preface 

Why craft a book on business technology 
essentials? I (your author) have a lot of years 
of business technology job experience, and I 
have taught at a couple of community colleges. 
Over time  I have experienced changes in the 
emphasis on business technology at college. It 
used to be an integral part of basic business 
courses at the college level; however, in the 
past few years, an assumption seems to have 
been that because people use smartphones, 
they are skilled in workplace computing skills. 
That because people engage on social media 
and visit aggregated news sources, they are 
accessing accurate and unbiased information 
and thinking critically with it. That because 
there are so many lifestyle-related apps, people 
are prepared with academic and workplace self 
and time management skills. And, most 
recently, that because people engage with 
generative AI chatbots and workflow steps, 
they are fully informed and trained in specific 
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skills that require good writing, 
communication, and information integrity. 

Yet I and other instructors encounter waves of 
learners who don’t have basic keyboarding or 
productivity application experience, or an 
ability to discern accurate and unbiased 
information, or work-ready communication 
and time management skills, or the ability to 
present their own ideas and conclusions 
without generating them through an 
generated AI conversation content. There are 
likely a number of reasons for this; one tends 
to be the sheer amount of information being 
thrown at us, and not necessarily enough 
organized and guided pathways to access, sort, 
and manage it in academic / training settings. 

So, therefore this book has come to exist. 
Business Technology Essentials provides a 
survey of computing and digital coverage and 
skills necessary to engage in academic settings 
and in the work market. This includes a survey 
of practical computing skills; coverage about 
digital citizenship; application practice in utility 
and productivity programs; and overviews on 
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various business technology-related issues like 
privacy, security, workplace preparation, etc. 

This book is not an exhaustive reference 
manual, and much of the coverage is about the 
high points and fairly generalized. Technology 
and digital citizenship changes too fast and too 
much for static text and specific examples to 
be useful for very long. This book will not be 
able to list every permutation or version of 
everything, or every insight, or every piece of 
hardware or system tool. A learner or instructor 
will always find something that has been left 
out or become current in the moment. The 
author is not a generative AI bot, and can’t 
aggregate and interpret every piece of 
available information on the whole Internet. 

Instead, this book is designed to prompt 
discussions of main points to help instructors 
and learners have a starting point for debates, 
reviews of current needs and topics, and 
practices of workplace computing skills. It will 
have only a few specific references to 
information sources and tools, as a nod to what 
seems to be currently long-term reliable 
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sourcing and access (like US Government data 
sites). 

However, it is recognized and expected that 
instructors will tailor the overview aspects of 
this textbook with needed actual in-the-
classroom examples they research as part of 
their own curriculum-building. Instructors may 
choose to change the order in which the 
information in this book is currently presented, 
based on the length of their course offering 
and/or the needs of the topic(s) at hand. They 
will make their own videos, and look for 
additional current demo videos, tutorial links, 
and other study aids like LinkedIn Learning and 
free open-learning academies, workshops, and 
student-learning tools. Great examples and 
issues can be discovered in educator 
publications and professional development 
groups. Self-study learners can use their 
preferred search engine and unbiased 
information-finding tools to look for relevant 
examples (especially after covering the chapter 
on Communications Media Accuracy). Worker 
Retraining advisors can suggest avenues for 
learners to pursue in workshops and practices. 
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This book attempts to focus on analyzing and 
solving business-related problems in efficient 
ways; they are not the only ways. Learners can 
approach the objectives with detailed steps in 
the “Try Me Activity”, and try things out in the 
“Quick Task” options. Learners should be 
challenged to use critical thinking to solve real 
world scenarios, because what is all this for if 
not to help enhance one’s education and 
workplace future? 

This book also attempts to have a personal feel 
and occasionally some quirks in humor. Who 
wants to be totally bored and pedantic, 
anyway? 

Suitable Learners 

This book can be used by: 

• Adult Basic Education (ABE) learners. 
• I-Best business and technology programs. 
• Worker retraining programs at colleges 

and employment service centers. 
• Learners at community colleges, training 
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programs, and high schools. 
• Professionals as a quick review of business 

technology information and skills. 
• Self-study learners. 
• Anyone else with an interest in the covered 

topics. 
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Introduction: 
Using this Book 
as a Course 

How to access this book 

This textbook is available in the following 
formats: 

• HTML. An HTML file can be opened in a 
browser. It has very little style so it doesn’t 
look very nice, but some people might find 
it useful. 

• Mobile. If you want to read this textbook 
on your phone or tablet offline, you can 
use the EPUB (eReader) or MOBI (Kindle) 
files. 

• Online webbook. You can read this book 
online on a computer or mobile device in 
one of the following browsers: Chrome, 
Firefox, Opera, Edge, and Safari. 
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• PDF. You can download this book as a PDF 
to read on a computer (Digital PDF) or 
print it out (Print PDF). Note: if you choose 
to have this book printed out in PDF 
format for your own study use, I am fine 
with this, and you should let your printer 
know this approval is part of the Open 
Educational Resource (OER) nature of this 
publication. 

You can access the online webbook and 
download any of the formats for free on 
Pressbooks. To download the book in a 
different format, look for the “Download this 
book” drop-down menu and select the file type 
you want. 

To access a shared CANVAS course module of 
the textbook link with the 
downloadable StudentDataFiles.zip, you will 
need to visit CreativeCommons: look 
for BTEText/Business Technology Essentials 
Welcome. 

How to use different formats: 
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MedAttrib: author-generated. Textbook format 
options and features. 

Tips for Using This Textbook 

Annotate the textbook: If you like to highlight 
or write on your textbooks, you can do that by 
getting a print copy, using the Digital PDF in 
Adobe Reader. 

Navigate the textbook: This textbook has a 
table of contents to help you navigate through 
the book more easily. If using the online 
webbook, you can find the full table of contents 
on the book’s homepage or by selecting 
“Contents” from the top menu when you are in 
a chapter. 

Search the textbook: If using the online 
webbook, you can use the search bar in the top 
right corner to search the entire book for a key 
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word or phrase. To search a specific chapter, 
open that chapter and use your browser’s 
search feature by hitting [CTRL] + [F] (PC) 
or [CMD] + [F] (Mac). 

The [CTRL] + [F] and [CMD] + [F] keys will also 
allow you to search a PDF, HTML, EPUB, and 
MOBI files if you are reading them on a 
computer. 

If using an eBook app to read this textbook, the 
app should have a built-in search tool. 

Key Features 

As an aid to learners, the book provides some 
useful features: 

• Callouts on specific tips and keybind 
shortcuts. 

• Clear and easy-to-understand written 
format and style. 

• Clear step-by-step instructions* for in-
chapter activities. 

*  Instructions are designed for book learners. 
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They are meant to be used independently of 
any classroom instructions. Learners who use 
this book within a course provided by an 
instructor may be asked to save their student 
data files, their working files, and their 
resources in different places than the book 
instructs, and that is okay. They may also be 
asked to rename their working files per their 
instructor’s requirements, which is also okay. It 
is up to the learner to differentiate between 
what the solo-study instructions are and what 
their course instructor – if any – 
requires instead. 

Doing the Work 

This Open Education Resources (OER) book 
can be used as a stand-alone overview, for 
general practice, and/or for a course that 
teaches introductory-to-intermediate business 
technology information and productivity 
applications’ basics. This book includes: 

• Data files (Word .docx, Excel .xlsx, 
PowerPoint.pptx, and image files for 
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students to work with) 
• Examples for learners to try out (Try Me 

activities) 

However, this book does not currently include 
starter or finished assignments, or videos 
resource links, or other personalized/in-the-
moment resources. Instructors will likely create, 
have and/or access full assignment content, 
steps, previews, and example finished product 
documents. A later edition may include a few 
generalized assignments; this first edition will 
not. 

• Alternately, learners can access demos on 
productivity tool exercises, and other 
training demos/tutorials, on the web. 
Sources can include LinkedIn Learning, 
free online learning academies, free 
Microsoft and Apple resources and 
tutorials, etc. 

For following/trying out in-book demos, it is 
recommended that you take the following 
steps to prepare yourself for exploring Business 
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Technology Essentials, and for going through 
the content in this book. 

ACTION: Preparation steps for using 
this content 

If your instructor uses this textbook and has 
their own file naming/saving standards, then 
use that. Otherwise, on your own computer, in 
a location you can easily find, create a file 
directory called BUSTECH ESSENTIALS. 

• In this directory, create 3 (three) folders: 
Examples, Images, DataFiles. 

• Use the Examples folder to save your 
explorations, activities, and assessments in 
this book – unless a specific course 
instructor gives you different directions. 

• Use the Images folder for any images you 
choose to use in your work, any 
screenshots you take as you learn, and 
notes of image attributions. 

• Use the DataFiles folder for any files you 
download to use while working with this 
book. You want to keep only the Original 
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downloaded files here, so that you can 
reuse them when you rename/save a copy 
to your Examples folder. 

• IN the Examples folder, you should also 
create subfolders: MS Word, MS_Excel, and 
MS_PowerPoint. In those folders, you will 
want to save a copy of Word, Excel, and 
PowerPoint data files to work on. 

MedAttrib: author-generated. Recommended 
learner file directory organization. 

• Download the data files Zip file and save it 
into your new DataFiles folder. 

• Extract the data files from the Zip file and 
also save them in the same DataFiles 
folder. 
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TIP: Zip files. You can use the free 7-Zip, 
PEAZip, or file applications, which 
should work for all computer types (PC, 
Mac, Linux). 

Regularly SAVE your practice work and your 
assignments in your Examples folder (unless 
you have an instructor who has other 
instructions). Saving regularly is one of the 
most useful and time/aggravation-saving 
things you can do for yourself. 
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Part 1: Business 
Technology Tools 

In this section, we’ll have an overview of 
business technology: what it is, computing 
essentials, practical utilities use, and managing 
information skills. This will help place us in the 
current state of technology in business – in 
academic settings and in the workforce. 

We won’t be able to cover every single thing; 
there is just too much information. The scope 
is a focus on general preparation for the 
workplace, and the various aspects of 
computing and digital technology that impact 
us in school/training and in jobs. 

Some of the information will be an overview 
of concepts so we can understand computing 
tools and their place in our training and work 
lives. Some will be an exposure to issues we 
face in the business technology-related 
situations. Some will be practical skills-building 
activities. Most are starting points. 
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Chapter 1: 
Overview of 
Business 
Technology 

What We’ll Cover >>> 

• What is Business Technology? 
• Information Technology 
• Business Technology Usage 
• Computer Systems 
• Productivity Tools 
• Advantages of Business Technology 
• Challenges of Business Technology 
• Business Technology in Education 
• Business Technology in the Workplace 
• Business Technology-related Work 
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What is Business Technology? 

Technology is integrated in everything we do: 
television, music, education, work, play, 
communication, etc. It is in hardware, software, 
systems, processes, and output. 

Business technology, specifically, refers to the 
technologies and systems that help employees 
accomplish activities. It is related to use in 
school and the workplace, and includes 
computers and their peripherals, software and 
utility programs, and systems/use of the 
Internet. It is also the output that we use in 
our interactions with businesses, like when we 
shop, have an online visit with our doctor, do 
our banking online, and even the effects of our 
time on social media as it can relate to how 
our workplace/employers can respond to us. 
Business technology is about all the uses that 
make finding and getting a job, getting the 
work done, and providing results for 
stakeholders like customers, vendors, shippers, 
colleagues, and students. 
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Information Technology 

Information Technology is a broader reference 
to technology in general: the use of hardware, 
software, services, and supporting 
infrastructure in any context to communicate, 
transfer data and process information. It refers 
to technology Like software engineering, 
programming, robotics, artificial intelligence 
(AI) and deep learning, applications 
development, hardware production, 
communications systems, the Internet, and 
more. 

Business technology narrows information 
technology down (somewhat) to workplace-
related activities. It is the management and 
utilization of information technology focused 
in reference to accomplishing business-related 
work. 

Business Technology Usage 

Business technology computing and processes 
include: 
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• Communication tools (smartphones, 
digital media, social media, generative AI). 

• Data management (backup, storage, 
delivery, search and pulls). 

• Enterprise systems (company-wide 
equipment and information 
management). 

• Information and hardware security. 
• Information management (databases, 

data dashboards). 
• Marketing and sales processes (emails, 

websites, customer data). 
• Productivity applications (word processing, 

accounting, presentations, design, image 
work, project management, calendaring, 
emails, online meetings). 

• Relationship management (customers, 
employees, students, patients, vendors). 

• Workplace collaboration (conferencing, 
shared documents, online timesheets, 
workplace trainings). 

Businesses use technology in many ways, 
including: 

• Communication: Employees, 
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management, vendors, and related 
colleagues can meet, coordinate activities, 
manage projects, work remotely, and 
report results through phones, emails, 
texting, shared documents, generative AI 
workflows, and tech-assisted online and 
hybrid meetings. 

• Data storage: Data is the backbone of any 
company’s functions, and can include all 
employee-related, customer-related, 
infrastructure and equipment-related, and 
research/work-product-related data. It has 
to be sorted, tracked, evaluated, used, 
revised, shared, and protected at all stages 
of work. 

• Hiring: Businesses can research work-
related laws, look for talent, post job 
listings, and do hiring-related 
communications. 

• Human Resources and Payroll: 
Specialized software and scheduled payroll 
applications can communicate with 
employees about benefits, trainings, and 
annual evaluations. It can manage salaries 
and deductions during pay periods, 
provide annual tax preparation 
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documents, and evaluate staff costs and 
performance. 

• Inventory management: Inventory and 
orders can be organized, stored, fulfilled, 
tracked, and shipped through the use of 
databases, spreadsheets, and dashboards. 
Applications can include reminders for 
ordering, alerts for shortages, and supply-
chain relationships. 

• Networked devices and printers: 
Computers and equipment work within a 
network, connecting to each other and 
through the internet. Networks can be 
within a single office space, across several 
workplace floors, between several 
workplace locations, and regional or 
worldwide for accessing information and 
storage. Networked equipment allows 
employees to share information and 
processes, like emails, conferences, 
research and analysis, records, and work 
products. 

• Relationships: Businesses can manage 
customer relationships through finding 
leads, profiling, tracking, using complex 
contact databases, advertising, & offering 
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discounts and inducements. 
• Security: Various tools and processes can 

help with the protection and monitoring of 
equipment, infrastructure, information, 
and work products in the workplace to 
present disruption, disclosure, and 
destruction. Security measures like 
surveillance and alert systems can prevent 
unauthorized usage, incorrect handling, 
stealing of proprietary work product, 
breach of confidential employee and 
customer records, and reveals of financial 
activities. 

• Training: School and workplaces trainings 
can happen synchronously inside a face-
to-face classroom, asynchronously through 
online learning management tools and 
digital course materials, and in flex-hybrid 
forms using elements of both. 

• Work activities: Work can be assigned, 
monitored, and evaluated. Project 
management can use shared scheduling 
and flow-charting of goals and activities. 
Employees can meet online and by phone, 
can work on documents in real time, can 
share work output in secure repositories 
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for access, and can evaluate customer 
activity. Employers can check for employee 
quality, communication, and integrity 
practices. 

Computer Systems 

Computer systems allow business functions 
through equipment that supports software 
use, data storage, work production, information 
retrieval, activities coordination, and a virtual 
‘desk’ for work activities. Examples include: 

• Communication and collaboration tools for 
employee and vendor coordination. 

• Computing hardware and peripheral 
devices. 

• Computer programs for creating and 
managing work product. 

• Networking equipment for sharing 
information and processes. 

• Software and applications for doing 
business functions in every department, 
like accounting, human resources, 
inventory, research/development, etc. 
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Productivity Tools 

Computing productivity tools support 
employees so they can accomplish work tasks 
that provide products and services to 
customers. Productivity programs let 
employees manage documentation’ schedule 
work activities; store and organize information; 
report and deliver output, connect with 
vendors, customers, and each other; and 
manage work obligations between them and 
the employer. Tools can include software 
applications in: 

• Communications (like phones, emails, 
meeting supports). 

• Databases (for warehousing, organizing, 
querying, and reporting big data). 

• Graphics and layout (like image editors 
and layout programs). 

• Presentations (like slideshows, videos, 
audio recordings, scenario animations). 

• Research interfaces (like Internet browsers 
and reference managers). 

• Spreadsheets (for accounting, calculations, 
charts and graphs). 
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• Storage and retrieval (like preserving and 
organizing work product information and 
intelligence). 

• Word processing (for communications and 
reports). 

Advantages of Technology 

Technology speeds up our ability to manage 
vast amounts of information and processes 
needed for getting work done. While the 
workplace has not gone paperless (despite 
goals before the turn of the 21st century), our 
ability to acquire and use our information is 
much more streamlined and accessible than 
when paper flow and files was the norm. Likely 
today’s generation isn’t even aware of what we 
call ‘analog’ systems of work tools and 
paperwork-based information handling. 

Technology provides many advantages: 

• Ability to immediately evaluate and modify 
activities and processes . 

• Access to multiple forms of media and 
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platforms for accomplishing work. 
• Automated activities that take many 

routine activities out of employee hands, 
like direct deposit of pay. 

• Continuous improvement and less waste 
in manufacturing techniques. 

• Convenience of working with small, light, 
speedy, and powerful computing tools. 

• Coordinated scheduling and work 
handling across offices and regions. 

• Improved and synchronous 
communication methods even at great 
distances. 

• Layers of security that can protect 
employee and customer information, 
research and development, financial 
access, and system faults. 

• Multiple threads of marketing, sales, and 
customer connection activities. 

• Prompt services like financials, order 
fulfillment, customer care, and employee 
needs. 

• Aggregating and searching information 
and trends used for law enforcement and 
military organizations. 

• Quick synchronizing and transferring of 
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information. 
• Real-time access to information for 

research, sales, customer retention, etc. 
• Use of tools that allow for mobile and at-

home workplaces. 

Challenges of Business 
Technology 

Business technology is not without challenges 
and risks. These can include: 

• Constant required systems for updating 
and fixing of technology problems. 

• Costs in keeping up on tools and 
applications. 

• Fractured communications skills related to 
less one-on-one connection. 

• Increased dependency on technology and 
networking access. 

• Loss of boundaries of the ‘workplace’ as 
work activities use constant emails, 
anytime online meetings, and mobile/at-
home work locations. 

• Loss of power or networking which can 
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stop business work. 
• Merging and replacement of job activities 

that risk job availability. 
• Ongoing need for training, upskilling, and 

job searching 
• Ongoing security risks in relation to 

confidentiality, data, fraud, and 
cybercrime. 

• Loss of a sense of privacy when data is 
captured and sold as part of business. 

• Technology-related exhaustion and health 
issues. 

Business Technology in 
Education 

Education is a key area in which business 
technology is prevalent. The entirety of 
managing schools – the students, faculty, staff, 
equipment, learning materials, relationships 
with parents, and legal requirements – is reliant 
on business technology tools and processes. 

For instance, schools use one or more learning 
management and enhancement tools, like 
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course management systems, learning 
providers, library information systems, and all 
the usual workplace processes that manage 
employees, resources and finances. Schools 
have to manage enrollment and retention, 
curriculum and class sizes, employee 
management, assignments evaluations, and 
reporting for student transcripts and transfers. 
This includes the need for: 

• Assignment and grading platforms. 
• Communication tools. 
• Communications (students, instructors, 

parents, education vendors). 
• Computers and technology equipment. 
• Funding and financial management 

applications. 
• Learning information repositories (videos, 

audio, books, cloud-based, resource links, 
demos and tutorials, OER, learning 
modules, coordinated ‘visits’ and field trips 
through digital means). 

• Networking. 
• Teaching and student engagement aids 

(online texts, engagement tools, 
presentation equipment). 
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• Virtual classroom needs. 

Business Technology in the 
Workplace 

Business technology affects most aspects of 
the workplace. Behind-the-scenes and upfront 
needs are in hardware, software-enhanced 
access to information, and tools that allow 
businesses and members of the workforce to 
do work to provide products and services. 

Even low-tech workplaces are affected in 
several ways, including retail stores, food 
service, trades work like automotive or 
construction, and government functions like 
the US National Park Service or Washington 
State Ferry system. Business technology 
impacts looking for jobs, applying for them, 
interview preparation, hiring practices, on-the-
job training, employee management, 
information controls, payroll and accounting, 
legal and regulatory needs, and tracking/
delivering work product. The same goes for 
whether the workplace is in urban or rural 
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settings, in big population centers or smaller 
municipalities. In public, private, nonprofit, or 
small business sectors, various functions are 
performed and/or impacted by business 
technology tools. One way or another, some 
aspect of the workplace is affected by: 

• Business processes 
• Customer interfacing 
• Operational activities 
• Product management 

Business Technology-related 
Work 

Is business technology itself a job? Yes and no. 
One of your best resources (in the United 
States) for looking at current needs, 
expectations, salaries, and prevalence of 
business technology-related work is in the U.S. 
Bureau of Labor Statistics’ Occupational 
Outlook Handbook. 

In many jobs, much of one’s workload is 
impacted by and actually uses business 
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technology tools and means. For instance, in 
automotive work, computing tools are needed 
for diagnostics of current vehicle models and 
parts. In the Department of Motor vehicles, 
data on licenses, vehicles, and driver records 
require business technology tools. Driving 
companies like those that manage trucking, 
limos, taxis, mass transit, and Uber-like services 
need customer-facing contact information and 
tracking of ratings, safety, completed jobs, etc. 
Law enforcement needs business technology 
to manage vehicular-related accidents and 
crime investigation. The insurance industry 
provides recompense for repairing and 
replacing vehicles; vehicle sales have to 
manage pricing, maintenance and ownership 
information, and regulation practices. 
Healthcare has to manage patient-facing care 
needs for vehicle-related accidents and 
malfunctions. 

There are also a lot of business technology-
related jobs, which fall into various areas 
dealing with hardware, software, processes, 
data, and research & development. Many 
require or recommend some kind(s) of 
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certification. Positions can include (not an 
exhaustive list): 

• Business Technology management 
• Data Analysts 
• Digital and Technology Coordinators 
• IT Specialties 
• Networking systems 
• Robotics and AI 
• Software Developers 
• UX and UI design 

Business technology at a more general level – 
office and administrative support – has now a 
number of expected and integrated tasks and 
is not necessarily listed as a business 
technology “job.” However, training and 
experience in business productivity programs 
for document processing, spreadsheets, 
presentations, graphics, web editing, 
communications coordinating, and other 
administrative assistant-level work is also part 
of business technology. 

Business Technology as an 

Chapter 1: Overview of Business Technology  |  19



Education Major 

Various colleges offer training, certificate, and 
degree programs in business technology-
related work. An umbrella one would be called 
a variant of something like Business 
Applications Technology and might range in 
training in basic computing and digital 
systems, productivity and business software, 
data management and analysis, programming, 
and so on. 

More specific business technology-related 
programs can focus on specific aspects of 
computing and digital technology with a 
business aim. There are many. Search engine 
results show these can include certificates and 
degrees titled like: 

• Business Intelligence and Analytics 
• Business and Information Systems 
• Computer Information Systems 
• Computer Networking and Systems 
• Computer Programming 
• Cyber Security 
• Health Information Management 
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• Information Technology and Support 
• IT Management 
• Technical Systems Management 

ACTION: Quick Task 

Assuming you are currently in school, list 5 
(five) business technology computing 
processes that you consider directly affect you 
as a student. If you are instead self-studying 
and have a workplace, answer for that. 

ACTION: Quick Task 

In your own life, what aspect of business 
technology from the list below do you think 
affects you personally the most, and why? 
There is no right or wrong answer. 

• Communications technology 
• Computing hardware 
• Computing software 
• Customer-related data (financial, or health, 

or job-related) 
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• Information access and security 

ACTION: Quick Task 

Think of for very favorite eatery/restaurant. 
What are 5 (five) aspects of business 
technology that you think they must need to 
work with so they can best serve you? 

22  |  Chapter 1: Overview of Business Technology



Chapter 2: 
Computers 

What We’ll Cover >>> 

• Types of Computers 
• Mobile vs. Computer 
• Computing Timeline 
• Computer Hardware 
• Computer Drives 
• Computer Software 
• Operating Systems 
• MS Windows 
• Basic Computer Processing 
• Software Updates and Patches 

In this chapter, we’ll check out a bunch of 
computing-related tools. Like anything in 
technology, this isn’t and can’t be exhaustive, 
and can be replicated/updated by search 
engine queries. Yet, this should give you a 
useful overview you can use in your own further 
research, study, and practical computer-related 
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skills. It will cover some history and mention 
some systems that have become obsolete as 
they were before evolving into current 
technology. Still, it is worth reviewing so you 
can get a sense of ‘place’ in computing tools. 

Types of Computers 

Computers these days keep getting smaller, 
lighter, more powerful, and sometimes ‘hotter’ 
in temperature due to how much is packed 
into them. They were not always small, and 
back in the day (eons ago when your author 
was a kid) they could take up huge rooms. 

Mainframe computers 

Mainframe computer: a high-performance 
computer used for large-scale information 
processing and transaction processing tasks, in 
the thousands of transactions per second. They 
are primarily used in and for: 
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• Academics 
• E-business/E-commerce 
• Enterprise resource planning 
• Financial institutions 
• Government (census, occupations) 
• Health care 
• Insurance agencies 
• Libraries 
• Research 
• Statistics 

Servers 

A server is a primary computer that provides 
information to other computers that are 
networked to it. They can be on personal 
computers or in an organization’s server space. 
They can also be a mid-range computer that 
is intermediate in size, power, speed, storage 
capacity, etc. Examples include: 

• Email processing and managing on the 
Internet. 

• File servers for information and data 
storage in the workplace. 
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• Hosting websites. 
• Managing student and education 

resources at a college. 
• Providing patient data and billing in 

hospitals. 
• Space and tools for computer gaming. 

Supercomputer: A supercomputer used to be 
huge, and could process massive amounts of 
data and do a great amount of computation 
very quickly. They still exist and have changed 
form into chains of computers and networking 
tools. Supercomputers are used for systems, 
computations, and very large database/
information storage related to: 

• Aerospace 
• Climatology 
• Defense 
• Education 
• Engineering 
• Financial sector 
• Government 
• Petroleum/fuels 
• Science and Research 
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Personal computers 

A personal computer (PC) is a small computer 
designed for use by a single user at a time. A 
PC simply refers to a personal computer, even 
if it is considered to be a Windows machine, 
a Mac, a Linux machine. It used to be called 
a microcomputer, and now but it can refer to 
any kind of small computer, like a desktop unit, 
laptop, smartphone, tablet, and wearable. It 
uses a chip (microprocessor) for its central 
processing unit (CPU). 

Types of personal computers 

• Desktop unit: Designed to stay at one 
location and fits on or under a desk. It 
generally uses ‘peripheral’ units for input 
and output of information, like a keyboard, 
screen monitor, and a system unit “tower” 
which houses the computing hardware 
elements. 

• Laptop/notebook: A portable personal 
computer. It can rest on a user’s lap, a café 
table, an airplane’s tray, a school desk, or a 
meeting room conference table. It can be 
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powered when plugged in or by a battery 
during travel. It includes a screen and a 
keyboard with a touchpad, plus wireless 
peripheral capabilities. 

• Smartphone: A mobile phone unit that 
integrates additional computing 
technology for “light” programs (apps 
designed for speed and small size) that 
can appear on a personal computer and 
various small apps that can aid in 
communication, productivity, fun, 
collaborating, etc. 

• Tablet: A wireless touchscreen PC that is 
smaller and weighs less than the average 
laptop. It can be paperback book size up to 
the dimensions of a sheet of paper, and 
can be easily mobile in a backpack or 
briefcase. 

• Wearable: These can include mini 
computers like music players, fitness units, 
health and sleep regulators, enhanced 
watches that track navigation, and virtual 
eyeglasses that show a computer 
interface. 
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Legacy systems 

Technically not a “type” of computer, but an 
ongoing usage challenge. A legacy system is 
outdated computing hardware – mainframe, 
supercomputer, personal computer. Also 
outdated use of computing software, like an 
older operating system, proprietary database 
and information retention applications, and 
processing programs. It sends to still be in use 
because the system still meets the needs for 
which it was originally designed. The challenge 
is that it isn’t scalable or allow for growth or 
more than cosmetic improvements. A legacy 
system replacement is the necessary (and 
usually very costly) solution. 

Mobile vs. Computer 

Currently, you can find information through a 
search engine about how mobile/smartphones 
are a leading technology for people to access 
information, stay connected, check email, fill 
out job applications, organize time and 
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commitments, have quick online meetings, 
and generally fun and entertaining use. You 
can shop for groceries, order tickets, take 
pictures at your own car accident, plan 
alternative routes on a trip, check for open 
hours at an attraction, update friends on social 
media, etc. You can also touch up homework 
and submit files online, get quick information 
before a meeting, look at a quick cooking video, 
confirm instructions, and the list goes on. 

For many people, particularly those with lower 
income and/or low access to home computers, 
the smartphone has become an affordable and 
easier-to-get tool for so many online-related 
and necessary daily functions. Many students – 
particularly in low-Wi-Fi connected rural areas, 
lower income regions, mobile life 
circumstances, and areas with limited library/
community center access – only have reliable 
access to information and services on their 
smartphone. A lot of college learners come 
from high school with limited computer 
experience but a lot of smartphone skills and 
use. 

For the purposes of this book, however, we will 
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not focus on or do direct support of 
smartphones. Why? 

Mobile devices, like smartphones and tablets, 
may use different operating systems than 
computers. Computer and mobile operating 
systems are different because they are 
developed for different uses and attention 
needs. Computer systems will have to store lots 
of complex data, have a different user interface, 
and be prepared for printing, removable disks, 
a mouse, keyboard, and an expectation of 
some quality time and attention for the 
workload. They feature a desktop screen space 
and a Control Panel for users to manage all of 
their information. Computer operating systems 
have been around longer, and therefore are 
more familiar. 

Mobile devices don’t feature a desktop in the 
same way as a full PC computer for school and 
office use. Their user interface is much more 
about simple moves, things you can do with 
your fingers or voice, a small viewing space, 
and limited time/space for attention span 
(think ‘on the move’). While you can make a 
mobile phone do almost anything – for deeper 
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learning of programs, output writing and 
preparation of complex assignments, and 
using multiple integrated tools in finding 
solutions – the question is “should we”? As time 
and technology continue to speed up and as 
apps are created for everything under the sun, 
many would say yes. In workplaces where 
complex work needs human interaction, 
comprehension, and massive amounts of data 
space, the answer is still – more often than not 
– likely to be no. Cell phones may a support, 
not a main work processing tool for many 
workplaces, and they are often still perceived as 
attention-grabbing distractions and potential 
wi-fi security threats. 

In addition, just as an addendum, the use of 
phones keeps us ‘always on’. Since there are 
apps for everything, and since the whole 
experience of the smartphone is about 
stimulation and quick response, we may be 
having more trouble keeping needed attention 
span, attention to detail, and slowing down 
needed for complex and multi-part work 
activities. One only need search the web for 
plenty of references to overworked, 
overstressed, and under detail-oriented 
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employees. Distracted employees. Employees 
who use personal phones for personal use at 
any time of the day, game while on the job, 
who grab information quickly without actually 
attributing or reflecting on it, and so on. The 
mobile phone is a compact workstation, 
camera, gaming console, a camera, e-book 
reader, a notebook, music collection, movie 
viewer, a map and compass, and authenticator. 
It is connection to healthcare, events, kids’ 
daycare, school assignments, rides to locations, 
etc. 

If you’ve got work activities that need complete 
focus and minimal interruptions, then is your 
smartphone really the best way to do it? Is it 
the most professional way for all meetings, 
when the signal is so often intermittent/
interrupted, and your conferencing goes 
down? Is it the healthiest way – for your eyes, 
for your attention span, for your stress levels, for 
your posture while keyboarding and document 
creation and distribution? Can you reliably do 
graphic design campaign work, a Master’s 
thesis project, construction CAD drawing, give 
in-person tours, complete sorts and filters of 
massive amounts of information, and so on? 
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And, will all workplaces allow the use of your 
personal smartphone – or limit it so that you 
can focus on your work and the employment 
environment instead of your personal life? Or, 
will workplaces provide you with smartphones, 
and an expectation that you will somehow be 
available and working in some way 24/7, with 
no real privacy and protections? 

Lots of good questions. Only time will tell, 
especially if future technology visualization and 
input tools for smartphones – and processing 
power/Cloud interface – all mesh up. Wouldn’t 
it be great if we could actually project a touch 
keyboard and stable large viewscreen from a 
wristwatch so we could always be mobile and 
have access to really great viewability and 
processes? Humans are inventive and 
resourceful. However, for the purposes of this 
textbook, we will not focus much more on the 
smartphone – other than as an as-needed 
reference or example. This course will focus on 
primary PC desktop / laptop / and some 
general tablet tools, and the things that 
support them in our education and work 
places. 
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Computing Timeline 

• 1936: first programmable computer, which 
could carry out a finite set of arithmetic or 
logical operations. 

• 1947/48: The transistor is a semiconductor 
device used to amplify and switch 
electronic signals and electrical power on 
and off. 

• 1952: IBM programmed the first self 
learning computer to play checkers. The 
FORTRAN scientific programming 
language was developed in 1957. 

• 1958: The integrated circuit, a set of 
electronic circuits on one “chip” of 
semiconductor material. Sort of like a 
biological Brain Neuron – a cell and the 
transmitting dendrites (say in the brain). 

• 1960s: Central processing unit (CPU), 
which is hardware within a computer that 
carries out the instructions of a computer 
program ;by performing the basic 
arithmetical, logical, and input/output 
operations of the system. Sort of like the 
Human Brain’s Cerebrum. 

• 1964: IBM created the first computer 
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system family for commercial and 
scientific use. 

• 1971: Computer microprocessor, which 
incorporates the functions of a computer 
on a single or several integrated circuits/
chips. 

• 1974/75: First consumer computer (Apple 
1in 1976, TRS-80 in 1977). 

• 1981: The IBM PC – home computer was 
introduced, leading later to the 
Commodore 64 in 1982, Macintosh OS in 
1984, and the Windows 1.0 on the IBM 
compatible computers in 1985). 

• 1989: Creation of the World Wide Web. 
• 1992: First smartphone was created. 
• 2000: First USB Flash Drive. 
• 2016: Sophia The Robot Is Created 
• 2016: First Reprogrammable Quantum 

Computer 

Computer Hardware 

Now we go back to desk/table-related 
computing, whether in the office, at home, in a 
café, or on a plane. 
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Computer hardware includes any physical 
device or equipment used in or with a 
computer system (anything you can see, hear, 
and touch). This includes what is physically 
inside the computer and what it physically links 
to for input of information and output of 
results. 

Internal hardware: Devices or components 
that are located inside the computer. Examples 
include the case, CPU, hard disk drive, ROM, 
RAM, Bios, etc. 

• Battery: A device consisting of one or 
more electrochemical cells that convert 
stored chemical energy into electrical 
energy. 

• Cables: Allow connecting devices to a 
computer. 

• Cards (video, audio): An expansion card 
(printed circuit board) that can be inserted 
into an electrical connector or expansion 
slot on a computer motherboard to add 
functionality to a computer system. 

• Central Processing Unit (CPU): The 
hardware within a computer that carries 
out the instructions of a computer 
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program by performing the basic 
arithmetical, logical, and input/output 
operations of the system. 

• Fan(s): Used for active cooling of computer 
components; draw cooler air into the case 
from the outside, expel warm air from 
inside, move air across a heat sink to cool a 
particular component. etc. 

• Graphic Processing Unit (GPU): 
Motherboard: The main printed circuit 
board (PCB) found in computers and other 
expandable systems; it holds many of the 
electronic components of the system and 
provides connectors for other peripherals. 

• Integrated Circuit: A set of electronic 
circuits on one small plate (“chip”) of 
semiconductor material, normally silicon. 
CPU, RAM, etc. 

• Memory controller circuit: A digital circuit 
which manages the flow of data going to 
and from the main memory – RAM. 

• Modems (internal, radio/Wi-Fi, broadband/
DSL): A device that modulates an analog 
carrier signal to encode digital 
information, and also demodulates such a 
carrier signal to decode the transmitted 
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information. For networking. 
• Motherboard: The main printed circuit 

board (PCB) found in computers and other 
expandable systems; it holds many of the 
electronic components of the system and 
provides connectors for other peripherals. 

• RAM: Allows stored data to be accessed 
directly in any random order; serves as 
temporary storage and working space for 
the operating system and applications. 

• ROM: Hard-wired, non-volatile memory; 
use for data storage and storage of 
computer programs. 

MedAttrib: tutorialsmate.com ©2023. Parts of a 
desktop computer. 
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External hardware: Devices (peripherals that 
are located outside the computer). 

• Input device: a piece of hardware device 
which is used to enter information to a 
computer for processing. Examples: 
keyboard, mouse, trackpad (or touchpad), 
touchscreen, joystick, microphone, light 
pen, and webcam. 

• Output device: a piece of hardware device 
that receives information from a 
computer. Examples: monitor, printer, 
scanner, speaker, display screen (tablet, 
smartphone …), projector, head phone, etc. 

Peripherals include: 

• Keyboard: an input device (the set of 
typewriter-like keys) that allows a user to 
enter characters (letters, numbers, 
symbols, etc.) into a computer. 

• Mouse: a hand-held pointing device that 
can control the position of a cursor 
(pointer) on a display screen. 

• Printer: an output device linked to a 
computer. It transfers the information 
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(text, images, etc.) to paper. 
• Screen monitor: a display screen used to 

display information (text, image, video, 
etc.) processed by a computer. 

• Trackpad (or touchpad): a small flat 
surface on a laptop or other computer that 
does the same things as a mouse (a 
trackpad is a built-in mouse). 

• USB drive: a small portable storage device 
used to store or transfer data for 
computers. It is often used for storage, 
data backup, and transfer of computer 
files. USB stands for Universal Serial Bus. 
Other common names for a USB drive: 
flash drive, USB stick, pen drive, thumb 
drive, etc. 

Memory 

Computers have categories of memory for 
storing data: 

• Non-volatile Memory: This is what a hard 
disk drive, a USB flash drive and ROM 
provide. It is memory that remains when a 
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computer is rebooted, turned off for the 
night, and when a used hard disk is moved 
from one machine into another. 

• Volatile memory: Memory that loses its 
contents when the computer or hardware 
device is switched off. This is what RAM is. 
It exists to assist in processing power, and 
also to hold temporary information for 
user action – like the clipboard that holds 
copied or cut text/images to be pasted 
elsewhere. 

Computer Drives 

As noted above, the computer hard disk drive 
(HDD) is the main data storage device that 
stores and retrieves information, data, files, 
programs, etc., from a disk. There can be more 
than one type of drive on a computer. 

Types of Computer Drives 

Disk drive (location): A computer device that 
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stores and retrieves information, data, files, 
programs, etc., from a disk. The drive is often 
referred to by its letter (your drive letter may 
differ). There can be more than one drive on a 
computer. 

• Hard disk drive (HDD) is the physical hard 
/ fixed disk. It can be interface with the 
computer with different connecting parts 
between the computer and the hard drive 
that use moving parts and magnetism. 
This is where the name SATA, PATAm SCSI, 
or NVMe variants come from. The HDD is 
usually designated as the “C: drive.” 
However, it can be ‘partitioned’: 

• A partition is a logical coded division of a 
hard disk that is treated as a separate unit 
by operating systems (OSes) and file 
systems. Each partition behaves and stores 
information as if it were a separate hard 
drive. Therefore a computer might have a 
“C” drive and a “D” drive although both are 
physically the same HDD unit. 

• Network drive: Allows users to instantly 
grant access to shared files from one 
computer to another. It is usually 
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designated as the “U: or Z: drive.” 
• Optical disk drive (ODD): Allows you to use 

CDs, DVDs, and Blu-ray discs for music, 
movies, and entertainments. If the drive is 
writable too, you can create your own 
music CDs and video DVDs, and create of 
back-up copy of your important data files. 
CD/DVD drive is a is usually designated as 
the “D: or G: drive.” 

• Solid State drive (SSD): they don’t consist 
of moving parts, and they don’t use 
magnetism for storing data. They tend to 
transfer data faster than HDD drives and 
allow faster boot times. 

• Universal Serial Bus (USB) flash drive: A 
removable drive that can be inserted into a 
USB port, and provides a certain amount 
of storage space. It is often designated as 
the “E:, H:, or K: drive.” 

Computer Bit Types 

• Bit systems: The bit system of a computer 
is based on the capacity of external buses, 
as well as a computer’s chipset and 
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motherboard limitations. The bit-size is 
based on the bus size even if they have 
some higher bit internal capabilities. 

• 8-bit computer: CPUs that can access 8 
bits of data in a single machine instruction, 
or the number of bits used to represent 
memory addresses. 

• 16-bit computer: CPUs that can access 16 
bits of data, like those in early x86 
computers in the 80s, and Motorola 68000 
Mac models. 

• 32-bit computer: CPUs that can access 32 
bits of data, like those in later x86, 
Pentium computers and through 
Windows XP, and the Motorola 68020 and 
later Macs. 

• 64-bit computer: CPUs that can access 64 
bits of data, like those in Vista and later 
Windows OS computers, and Mac OS X 
10.5 and later. 

• Higher bit computers are backwards 
compatible in use. Their operating systems 
and various programs may not be. 
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Space 

A computer has space available for processing 
and storing data. Back in the day (Jurassic 
times) the author experienced the wonders of 
kilobytes, and eventually the incredible space 
of 100 MB on a zip disk. Wow! 

Space (the available room to be processed and 
used by actual data) is expressed in bytes (and 
variants). The number of bits of data are 
combined in a binary computer language that 
is then translated into the activity that works 
computing activities. Computer memory and 
disk space are measured in these units. 

Of course, that was ages ago. Space has 
increased. A lot. Mindboggling amounts. 

Memory units 

• Bit – core binary unit 
• Byte – 8 bits, expression of 
• Kilobyte – Approx 1000 bytes 
• Megabyte – Approx 1000 kilobytes 
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• Gigabyte – Approx 1000 megabytes 
• Terabyte – Approx 1000 gigabytes 

And so on with Petabyte, Exabyte, Zettabyte, 
Yottabyte. Really BIG amounts of computing 
storage and usage space. 

Don’t panic. 

Basic computing language 

A computer processor contains decisive 
circuits, each one of which may be either OFF 
or ON. These two states in terms of memory are 
represented in a binary code (either/or) called a 
bit, and represented by a 0 or 1. To count higher 
than 1 (and communicate data in varying ways), 
bits are expressed together. A group of eight 
bits is known as a byte. A byte can have any mix 
of binary code (0s and 1s) that represent larger 
numbers and letters. 

• If everything Humans need to be 
translated into computer terms stayed at 0 
or 1, nothing would get done. 
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• The problem is, there is no “binary” 
number for 2, or 10, or 9999 M&Ms. Argh!!! 

• In Decimal counting (0-9), after 9 we add a 
“1” to the left of the “0” to get 10, and do 
the same thing as the decimal numbers 
move up. 

• This happens in Binary as well! 0=0, 1=1, 
10=2, 11=3, 100=4, 101=5, 110=6, 111=7, etc. 

This is my name – LJ Bothell (including the 
space) – in binary: 

• 01001100 01001010 00100000 01000010 
01101111 01110100 01101000 01100101 01101100 
01101100 

Computer Software 

Computer software: a set of instructions or 
programs that tells a computer what to do or 
how to perform a specific task (computer 
software operates on hardware). 

Main types of software: application software 
and systems software. 

48  |  Chapter 2: Computers



• Application software: A computer 
program that provides users with tools to 
accomplish a specific task. Examples of 
program / application software: word 
processing, spreadsheets, presentation, 
database management, Internet browsers, 
email programs, media players, 
accounting, translation, desktop 
publishing. 

• System Software: Designed to operate a 
computer’s hardware and application 
software, and make the computer system 
available for use. It serves as the interface 
between hardware, application software, 
and the user. It allocates system resources, 
manages storage space, and provides 
security. 

Main types of systems software: Operating 
system, device driver, productivity software, 
utility software. Most other software falls into 
one of these categories. 

Operating system (OS): a software that 
controls and coordinates the computer 
hardware devices and processes other software 
and applications on a computer. It is the main 
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part of system software, and a computer will 
not function without it. 

• Main functions of an operating system: 
booting the computer, managing system 
resources (CPU, memory, storage devices, 
printer, etc.), managing files, handling 
input and output, executing and providing 
services for application software, etc. 
Examples of operating system: Microsoft 
Windows, Apple iOS, Android OS, macOS, 
Linux, etc. 

Device driver: a software program that is 
designed to control a particular hardware 
device that is attached to a computer. It acts 
as a translator between the hardware device 
and operating systems or applications that use 
it and instructs computer on how to 
communicate with the device. Examples 
include: printer driver, display driver, 
USB driver, sound card driver, 
motherboard driver, ROM driver, etc. 

Productivity software: A type of software 
program that helps users produce work 
products like documents, databases, 
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spreadsheets, graphs, visual design projects, 
and presentations. 

Utility software: A type of system software that 
helps set up, analyze, configure, strengthen, 
maintain a computer and performs a very 
specific task (e.g. antivirus software, backup 
software, memory tester, screen saver, etc.). 
Additional utility software can also be external 
to the operating system. 

Operating Systems 

An operating system (OS) is the interface 
software that manages a computer’s processes 
and links the computer user to the machine. 
It manages the computer’s memory and 
processes, as well as all of its software and 
hardware. It also allows the user to 
communicate with the computer without 
knowing how to speak the computer’s 
language. Without an operating system, a 
computer is useless. 

The computer’s OS also manages all of the 
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software and hardware on the computer. Most 
of the time, there are several different 
computer programs operating at the same 
time, and they all need to access your 
computer’s central processing unit (CPU), 
memory, and storage. The OS coordinates all of 
this to make sure each program gets what it 
needs. For instance, a user might be working 
on a book about business technology, have a 
browser open for quick reference searches, 
have a workplace email account open with 
unread emails, and have some mellow music 
playing in the background. The OS manages all 
that and allocates processing speed and RAM 
to keeping the applications active and 
functioning. 

Operating systems usually come pre-loaded on 
a computer. It is also possible to upgrade or 
even change operating systems, such as 
moving to a more recent version, a business 
rather than personal version, or from a 
Windows to a Linux-based OS. 

Most operating systems use a graphical user 
interface, or GUI (pronounced goo-ee). A GUI 
lets you use your mouse to click icons, buttons, 
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and menus. Everything is clearly displayed on 
the screen using a combination of graphics 
and text. Back in 1985, the author saw the first 
version of Microsoft Windows, which was a 
shock and appealing substitute to keying in 
basic computing commands in DOS. 

Standard functions of an OS include: 

• Booting: The process of turning on the 
computer and powering up the system. 

• Data security: Keeping data safe inside the 
computer and computer programs, by 
setting up security features that keep 
unwanted cyberattacks away. 

• Device controlling: Allowing opened or 
blocked access to devices like CD/DVDs, 
data transfer devices, the camera, the 
microphone, a printer, USB drives, the 
keyboard, the mouse, etc. 

• Disk management: Managing all the 
drives installed in a computer like hard 
drives, optical disk drives, and flash drives. 
Disk management can be used to divide 
disks, format drives, and more. 

• Loading and execution: Loading, or 
starting-up, a program and then executing 
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the program so that it opens and works. 
• Memory management: Controlling and 

coordinating the computer applications 
and allocate space for programs to 
function. 

• Print control: Controlling the printers that 
are connected to the computer, and the 
settings that are needed to send and 
accomplish a print job. 

• Process management: Allocating 
resources to different processes on the 
machine, enabling the processes to share 
information, protect operations, and 
synchronize activities. 

• User interface: Allowing a user to enter 
and receive information. This can be done 
with typed commands, code, and clicking 
icons/buttons and menu items. 

Common Operating Systems: 

• Apple MacOS 
• ChromeOS for Chromebooks 
• Google Android OS for tablets 
• Linux open source based on Unix 
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• Microsoft Windows 
• Ubuntu based on Debian 

Microsoft® Windows® 

Since Microsoft® Windows® currently holds 
the majority of the business market share and 
colleges/schools tend to have PCs and 
Windows/Microsoft® Office®, we will primarily 
focus on Microsoft going forward in this 
textbook. Some MacOS shortcuts and 
variations will be covered when possible. The 
overall business technology principles and 
examples should work regardless of OS version, 
although the user interfaces will have 
differences. 

Windows 11 

Microsoft® Windows® (MS Windows / 
Windows) is an operating system developed by 
Microsoft Corporation that works with 
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traditional desktop and laptop PCs, and with 
mobile computing devices. 

The major tasks of Windows are to: 

• Manage the computer’s hardware: the 
printers, scanners, disk drives, monitors, 
and other hardware attached to it. 

• Manage the application software installed 
on the computer—programs like those in 
Microsoft® Office® (MS Office) and other 
programs installed to edit photos and 
videos, play games, play music, design 
graphic art projects, so taxes, and so on. 

• Manage and store the data generated 
from application software. Data refers to 
the documents, worksheets, pictures, 
songs, and so on that one creates and 
stores during the day-to-day computer 
use. 

• Provide utility applications to evaluate and 
manage hardware processing of the 
computer. For instance, the Task Manager 
can show what tasks or applications are 
using the most CPU processing or slowing 
computer performance. Utilities will be 
covered in more detail in a later chapter. 
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The Windows OS is additionally optimized for 
touchscreen tablets and convertible laptop 
computers. Windows handles input devices 
like the mouse, keyboard, touchscreen, and 
pen stylus. 

Basic Computer Processing 

The process that a computer follows for a user 
to work with it is fairly simple, though tons of 
coding, activities, and steps happen in invisible 
ways. 

• Boot-up: The computer, when turned on, 
has to go through a necessary hardware 
‘wake-up’. This includes accessing the 
ROM firmware that pushes the computer 
through the basic steps prior to loading 
the actual operating system, like hardware 
settings such as date and time. 

• Loaded software: Once the OS is fully 
active, the user can access any of the 
installed programs and resources for input, 
output, printing, and all other 
functionalities. 
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• Operating system: The OS interface opens 
so that a user can access menus, icons, 
files, data, computing workspace, and 
from utilities and applications in the 
computer. The OS may require a log-in 
password or PIN depending on the version 
of the OS. 

• Services: Various OS-initiated background 
tasks that process activities such as access 
to web resources and files, event logging, 
and error reporting. They work across the 
computer system, but don’t interact with 
users directly or have a user interface. 

• Start-up activities: As the OS opens, the 
computer will also activate several 
processes and services which guide the 
computer to access the Internet for 
handshakes and permissions to use the 
software. The fewer required startup 
programs that are enabled, the more 
efficient the computer processing can be. 
Important processes – which may or may 
not show desktop taskbar notifications – 
include: 

• Antivirus / security program 
• Audio/sound 
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• Battery power 
• Display settings 
• Wi-Fi connection 

MedAttrib: author-generated. Computer boot-
up process. 

Computer Processing order 

• Input (based on input devices like the on 
button, keyboard) requests information 
from software. 

• CPU/microprocessor responds to the input 
of hard drive space software instructions. 

• CPU starts moving active instructions and 
data to the Main Memory (the computer’s 
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temporary read-write dynamic RAM area) 
to organize and speed processing, using 
the Memory Controller. This is a repeating 
fetch, decode, execute process. 

• CPU gets help from attached static RAM 
cache space, which speeds up access to 
the dynamic RAM. 

• CPU starts processing instructions and 
sending signals, through the buses, to 
appropriate units like the video, audio, and 
peripheral cards, then discards/stores 
finished info/actions as it gets more new 
info to process. 

• Secondary memory (ROM – read only 
memory – hard drive memory chips, 
external disks) is where the body of 
information the computer stores goes for 
later use. 

In Human Terms: 

• Alarm clock goes off (the computer on-
button). 

• Human comes partly awake and aware 
(Bios, startup of Operating System). 
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• Human shuts alarm off (Operating System 
beginning to act and make hardware 
connections). 

• Human smells coffee (new Input). 
• Human recognizes smell of coffee (RAM 

activity) and considers taking action 
(Processing). 

• Human sits up (Output). 
• Human heads to coffee (more Output, also 

partly based on ROM info in brain storage 
as to where coffee is and what it does). 

Computer Interpretation 

Computers do not speak human. They do not 
actually recognize the meaning of data at all. 
Computers just respond to electrical impulses, 
which is their Primer. 

Computers handle 2 decisions: Do Act or Don’ 
Act, Yes or No, On or Off, etc. 

• Are there M&Ms? Yes or No. 

However, computers need instructions to act if 
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we want more than just a simple yes or no. This 
is considered to be an If-Then query. 

• If there are M&Ms, then eat some. If there 
are not M&Ms, then do not eat some. 

But, what if you want more options? Let’s face 
it, if everything was just yes and no, even basic 
processing gets boring and not very helpful. 
Therefore, we have the If-Then-Else query: 

• If there are M&Ms, then eat some. If there 
are not M&Ms (say they have all been 
eaten), then (do something else) are there 
Reese’s Pieces? 

• If there are Reese’s Pieces, then eat some. 
If there are not Reese’s Pieces, then don’t 
eat some. 

There are several additional decision structures 
that computers process by, but this gives you a 
starting point in basic computer logic. 
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Computer Translation 

• Computers do not comprehend or care 
what M&Ms are. M&Ms and every other 
request is just dumb input data for a 
computer and means nothing. The only 
thing that means something is Active or 
Inactive. But how does a computer take 
what we input and translate it so that it 
can process and output a response to our 
requests? 

• Computer applications just manipulate 
the contents of memory stores with the 
no/yes decisions. Note that this does not 
mean that the contents of those memory 
stores have a guarantee of accuracy. 

Software Updates and Patches 

Software update: A software update can be a 
combination of new or enhanced OS or 
software features. These can include additional 
security protocols, adjustments to a software’s 
user interface, or an improvement in a software 
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feature. The OS accepts and delivers the 
updates so that applications can operate 
efficiently. These can be scheduled or accepted 
and processed manually by the user. 

Software patch: Patches are meant to fix 
security vulnerabilities, like code or processes 
in the OS or software could leave a computing 
device open to remote access, theft of 
information, malware, etc. 

ACTION: Quick Task 

With the system properties, examine your own 
computer – whether it is a laptop, desktop, or 
tablet. If needed, also search your computer for 
some of this information. What does it show 
you about your computer’s setup for: 

• Graphics card (GPU) 
• Installed RAM 
• Operating System 
• Processor (CPU) 
• Size of your primary disk drive 
• System Type 
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Take a screenshot or two if this is an 
assignment you need to submit, and feel free 
to white-out any personally confidential 
information that might show. 

ACTION: Quick Task 

What 5 (five) most important tasks do you use 
your cell phone / smart phone for? 

ACTION: Scenario 

If you needed to purchase a computer in the 
next couple of weeks, you would want to 
research what you really need so that you could 
get one that will serve you for 2-5 years, meet 
your needs, have lots of space, and operate the 
highest-level programs that you personally use. 

Actions: Choose a computer spec request 
below, do some research of computer reviews 
and sales. Then, choose a mid-priced computer 
that meets your Processing unit, RAM, Graphic 
Processing Unit, and Disk size needs. If this is 
an assignment, take a screenshot or two of 
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what you find and cite the URL of the source 
information. 

• Option 1: Gaming computer, for Ram and 
Graphics intensive games like ARK Survival 
Evolved, Final Fantasy XV, No Man’s Sky, or 
another of your own favorite high-resource 
consumption online games. 

• Option 2: Mobile workplace computer. 
Should have some emphasis on 
connection and communication tools, 
productivity programs and storage space, 
and security. 

• Option 3: Your dream computer. The world 
is your oyster, and you might consider AI-
related processes, VR visualization, mega 
gaming, heavy use for arts/CAD/design, 
whatever. These will likely need loads of 
RAM, graphics processing, space, and 
resource organization capabilities. 
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Chapter 3: 
Utilities 

What We’ll Cover >>> 

• Computer Utilities 
• System Administration 
• Information Management 
• Disk Drive Management 
• Computer Cleanup 
• Backup & Restore 
• Compression 
• Security 
• GPU/Video Card Management 
• Peripheral Management 
• Driver Maintenance 
• The Registry 
• Program Sources 
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Computer Utilities 

• A utility is system software used to help 
maintain a computer’s infrastructure by 
monitoring, analyzing, and configuring the 
system. computer. A utility is usually 
smaller than a standard program and 
often is included with an operating 
system, while other specialty utilities can 
be installed separately. Utilities can 
include: 

• File management applications like zip file 
compression and file manager. 

• Miscellaneous utilities like HTML 
validators, uninstallers, screenshot 
clipping, registry editors, communication, 
and PC health checks. 

• OS accessories like paint, notepad, photos, 
and accessibility tools. 

• OS/AI application: In September 2023, 
Microsoft did a Windows 11 update to 
introduce Copilot, an AI “companion” that 
has been integrated into the OS for giving 
users ‘natural language’ assistance 
throughout MS applications. MAC and 
Linux are likely to do the same. Cortana 
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was an earlier MS assistant, and who can 
forget the MS “Clippy” paperclip cartoon 
that popped up all the time. . . 

• System administrative tools like the task 
manager, control panel, device manager, 
disk cleanup, and diagnostics. 

System Administration 

The system administration of a computer has 
to do with understanding, reviewing, and 
managing system processing and applications. 
It sounds complicated, yet has a few simple 
interfaces and activities that can tell you about 
what your computer is doing and how it is 
allocating power, memory, storage, and other 
resources. 

In MS Windows, system administrative utility 
interfaces include: 

• Control panel: The control panel in 
Windows is a panel that lists a variety of 
computer functions that Windows allows 
you to adjust settings of. These can include 
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power options, internet options, security 
and maintenance, date and time, and 
many others. You can use the Windows 
search function to locate and open it to 
take a look. MAC: The utility is called 
Control Center. 

• Device manager: The device manager lists 
all the hardware devices in your computer,, 
like network adapters, audio inputs and 
outputs, display, sound/video/game 
controllers, and more. This is a panel which 
presents the hardware properties and 
manually update drivers. 

• Diagnostics: These include 
troubleshooting options, the network and 
sharing center (for Internet/Wi-Fi 
connections), security and maintenance 
options, and administrative tools. These 
can be looked up in the Control Panel’s 
search bar under “diagnostic.” MAC: there 
is instead an Apple Diagnostics utility. 

• Task manager: This panel shows 
information on processing, memory, 
services used that affect software 
operations, startup programs that affect 
the computer’s boot-up, etc. 
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◦ MAC: This utility can be accessed by 
simultaneously pressing down the 
[CMD] + [ALT] + [ESC] keys on the 
keyboard. A window will open, listing 
currently opened programs and 
applications that are running in the 
background. 

• 

MedAttrib: author-generated. MS Office Task 
Manager. 

Basic Windows OS Cleanup/
Tune-Up 

• Computer settings, disk maintenance: 
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Control Panel / System and Security, Power 
Options, Defrag . 

• Disk clean-up by uninstalling programs: 
Control Panel / Programs / Uninstall a 
Program . 

• Get rid of unneeded items: Computer / C 
Drive / Properties, choose Disk Cleanup. 

• Problems: Troubleshooters, File Recovery, 
System Restore. 

• What’s happening: CTRL + Alt + Delete, 
Task manager. See running applications, 
started services, processes, performance. 

• Windows: Defender, firewall, Action 
Center. 

MACs have their own versions, like the Control 
Center, Apple Diagnostics, Task Manager, 
Software Update, About This Mac. Linux 
systems would have variations as well. 

Information Management 

Processing, storing, and retrieving Information 
is what a computer is designed for. Information 
goes through various stages of work in order 
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to process raw input, communications 
information, visuals and audio files, and other 
sources of data into work products like an 
instructor’s curriculum, a brochure about an 
animal preserve, a spreadsheet of contact 
names and addresses, or an industry 
presentation for a conference. Various utilities 
provide ways of managing information: 

• Archivers: Data archiving enables data to 
move from production storage to archive 
storage on a server or in the Cloud. 

• Clipboard: The clipboard of a computer 
allows for the temporary storage of copied 
content in a program. When one copies or 
cuts text and graphic data in an 
application like Microsoft® Word® (MS 
Word, Word), the data is held in the 
clipboard so that it can be inserted into 
another space or document. 

• Data converters: Can convert information 
into computer readable form in order to 
process data efficiently and accurately. 

• Data recovery: Allows the recovery of 
deleted or corrupted data from a storage 
device. 
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• File Manager: File managers provide data 
management at the directory and file 
level. Directories and files can be created, 
copied, moved, renamed, deleted, 
cataloged, browsed, searched for, and have 
file access set. 

Disk Drive Management 

The computer’s disk drive(s) store a lot of 
information pre-, during, and post-processing. 
The disk has to be kept lean and clean so that 
data can be easily accessed and used as 
needed and safely stored for as long as 
necessary. Disk management utilities help 
keep the disk drives organized, uncluttered, 
uncorrupted. 

• Defragging/ debugging: Debugging 
utilities allow for a disk drive to be 
examined and modified so that the 
computer’s memory work with data can 
be made more efficient. For instance, a 
90% full disk drive that hasn’t been 
cleaned by defragmenting means that the 
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computer search for and use of data on 
the drive can get sluggish and unreliable; a 
defragmentation process can move bytes 
of data into segments of space of the drive 
and leave other space empty and ready for 
more data. This type of utility software may 
handle a target program under specific 
conditions and monitor its operations and 
changes. 

• Disk backup: A backup utility will back up 
the contents of a disk to another drive, or 
to a cloud location. The entire contents of 
the disk drive can be backed up, or just the 
system and setting files, or simply the 
work product files like images, documents, 
and projects. The OS will have a disk 
backup utility for backing up the disk into 
another drive or storage device. Cloud 
backup services can back up files into 
dedicated server space so that they can be 
downloaded onto a new computer or the 
existing one if something happens to the 
existing data. 

• Disk checkers: Checker utilities monitor 
and check the disk drive to alert the user 
to problems in storage space and file 
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corruption, and can also remove corrupted 
files. 

• Disk compression: Compressing hard disk 
contents can increase the capacity of disk 
storage by encoding the data to take up 
less physical storage space. This should be 
used very carefully so that information can 
be easily uncompressed and used as 
needed. 

• Disk contents recovery: A recovery utility 
can help find and recover some or all 
deleted or corrupted files. For instance a 
computer’s recycle bin (trash on a Mac) will 
hold deleted files until it is emptied, and 
the OS trash recovery can retrieve those 
files. Other files may have copies or 
fragments embedded on the disk drive 
that can be partially or fully recovered with 
a specialized utility. 

• Disk formatting: The disk formatting utility 
can let you entirely wipe a disk drive of all 
data and settings. This can allow a user to 
refresh a computer with corruption and 
inefficient processing problems by 
reinstalling the operating system on a 
clean and empty disk drive. 
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• Space analyzers: The analyzer utility can 
help determine what is taking up disk 
space so that the user can decide what 
can be archived, compressed, or saved 
elsewhere. 

• Uninstall utilities: An uninstaller can 
remove entire programs and apps from a 
computer in a clean and organized way, 
with the aim to also remove orphaned 
data, settings, and related files. Examples 
of use include removing games and their 
settings and extra files, uninstalling an 
unwanted bloatware app, and deleting a 
program because you found a different 
one that better meets your needs. 
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MedAttrib: author-generated. Computer C: 
Drive properties. 

 

78  |  Chapter 3: Utilities



MedAttrib:freecodecamp.org/. MAC Drive 
properties. 

Computer Cleanup 

A computer goes through a lot of wear and 
tear – digital-wise. When a user creates, moves, 
renames, processes, and copies versions of files, 
the hard drive accumulates unneeded files, 
code fragments, temp files, cached webpages, 
cookies, old log files, and rejected junk items. 
There are third party utilities that are designed 
to scan and sweep a computer as part of the 
process of keeping it lean and clean. It can be 
good personal computer hygiene to have a 
weekly/monthly process for checking your 
computer for things to tidy up. 

Computer cleanup utility: Scans a computer’s 
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hard drive(s) for unneeded files at a deeper 
level than a standard OS disk checker might, 
and can delete them to free up disk space and 
speed up sluggish processing. 

These may also be combined with security 
checks, antivirus tools, registry cleaners, and 
other tasks to identify and repair other 
performance issues to boost startup times, 
update applications, and improve battery life. 

Computer file deletion utility: More than just 
a disk and computer cleaner, some utilities can 
not only remove files, but shred the data to 
prevent recovery, and wipe free disk space to 
clean it. 

Good cleanup practices: You are your own best 
clean-up utility – in how you save, organize, 
backup, and remove files from your own 
computer. Utilities can be very helpful, yet it is 
you who puts on a lot of files. Unintended and 
unwanted files can include: 

• Bloatware: This tends to be unwanted 
software included on a new computer or 
mobile device by the manufacturer, like 
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their own version of maps, games, notes, 
calculator, newspage, etc. It also can be 
things you inadvertently download that is 
piggy-backed onto a free app or an ad you 
clicked – like adware. 

• Cookies: Files created by websites you visit 
that save information about the visit. They 
can help your computer  keep you signed 
into a service like FaceBook, remember 
your site preferences at a retailer, and give 
you local/personalized content based on 
your visit choices. They are considered 
harmless, yet are something that over time 
adds more files to your machine and can 
impact your privacy and security.. 

• File fragments: Sometimes in processing 
a file may be temporarily be broken into 
fragments with the intention of keeping 
them contiguous for streamlined 
processing. Over time, though, your 
computer may end up with pieces of these 
when apps are incompletely uninstalled or 
disorganized hard drive space. 

• Tagged-on utilities: You may download a 
game or a free app that quietly also 
installs something like a ‘free’ browser 
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toolbar or other seemingly cool but 
unnecessary utility. Many of these have 
built-in pingbacks to the creators to gather 
data on you and your computer, and many 
may be cheaply designed and cause 
conflicts with your normal computing 
processes. 

• Temp files: These are created during 
computing processes to hold information 
while a file is being created or modified. 
Unfortunately, they may not always be 
auto-deleted when the processing is done. 

• Viruses/trojans: These are files that can 
launch a virus or other malware attack on 
your computer. They can be 
unintentionally downloaded as part of a 
free game or app, a torrent download, any 
pirated item, and/or clicking ads and links 
in emails. 

Every program and game you download 
creates new file directories with a lot of assets, 
integrate other files into your existing system 
file directories, and over time also temporary/
fragment files. in the local and roaming file 
areas. Every playlist, movie, batch of images, 
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and attachment to texts adds files to your 
computer. Using browsers adds cookies, file 
fragments, and temporary files to your 
machine. Plus, you rarely know what else might 
be downloaded into your hard drive when you 
click any ad, any link in an email, a “free” game 
or app, etc. 

Your own best practice is to be very mindful of 
what you do and do not click, and choose one 
browser and understand its settings for cookies 
and deleting temp files. Consider installing 
only one or two games at a time, and when 
tired of it uninstall it. If you collect pictures, 
movies, music, mod assets for games, etc., 
consider storing most of them on external hard 
drives to leave your OS processing drive as 
clean as possible. Make sure you know exactly 
where you do download your media files and 
app files, as well as your work files – create 
specific directories that are organized so you 
can find and delete what you need to 
whenever you need to. 
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Backup & Restore 

Computers can fail. Even when efficient and 
working properly, sometimes malware can 
corrupt too many data and settings files. An 
electric surge can corrupt contents. A disk drive 
can have partial failure. A user can accidentally 
delete the wrong version of files or an entire 
needed directory. Downloading and installing 
computer patches or updates might cause a 
hardware conflict. The computer may be stolen 
or damaged if dropped. Cups of coffee have 
been known to suddenly spill, and cats have 
been known to flop on a keyboard and delete 
active work in an important project. It is 
important to protect data that can be difficult 
or impossible to replace. 

Backup refers to the process of making a copy 
of data on your computing device in case you 
lose access to the data. Utilities noted in a 
section above can let you save data to external 
hard or USB drives, or to a writable disk. Entire 
disk contents, or just system files, or just data 
files, can be backed up into the cloud or using 
a paid service with proprietary and protected 
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server space. Ideally, a user should develop a 
specific and regular backup plan so that at 
least quarterly, if not monthly, important files 
are backed up in a secondary safe location. 

File Restoring refers to the process of putting 
your backup data back on a computing device. 
This can be data from an old computer being 
restored onto a new unit because you 
upgraded to a new machine. It could be 
making a second computer have a full copy of 
your primary computer’s information. 

The OS should have some kind of backup and 
restore solution built in. In Windows, System 
Restore allows a user to set a restore point so 
that the OS backs up an image of all the 
settings and files at a specific point in time, and 
preserves it on the hard drive to be restored 
if needed. It can return a system to working 
condition without needing to reinstall the 
operating system and repairs the Windows 
environment by reverting back to the settings 
and files that were saved in the restore point. 

TIP: System Restore good practices. Do 
a System Restore before installing new 
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software. Schedule a regular system 
restore if you need to keep sensitive 
data accessible. 

Compression 

File compression is when a file is a compression 
of data that reduces file size to allow easier and 
faster transmission over a drive, network or the 
Internet. It creates a  version of files with the 
same data at a size significantly smaller than 
the original file. 

Computer OS Drive 
Compression 

Different computer operating systems use 
different internal compression tools, such as 
MS Windows NTFS file system, Linux has more 
than one option, and Macs can need third-
party tools to successfully manage the OS 
compression options. 

Compressing the OS drive is a way to save 
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space on a computer’s hard drive. When you 
reduce the size of files, more storage space 
becomes accessible. Since the OS drive often 
contains repetitive assets, config files, and 
code, compressing the drive may free up 
space. And with transparent compression file 
systems available, users can seamlessly use 
their files without manually compressing and 
decompressing them. 

Benefits can include: 

• Increase in storage space: Compressing 
the drive makes file size smaller, which 
allows more data to be stored in drive. the 

• Improved performance: With smaller files 
in the OS drive, computer performance 
may be faster. The system can access 
compressed files faster than 
uncompressed ones. 

• Reduced backup size: Backing up a 
compressed OS drive results in smaller 
backup files, which saves storage space 
and time. a 

• Reduced network traffic: Compressed 
files means less data needs to be 
transmitted over networks. 
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Concerns include: 

• Compatibility problems:  Some other 
computer systems may not support the 
compressed file system or type used in 
your OS drive. 

• Data loss: Compression may glitch and 
corrupt data, especially if files are 
constantly compressed. 

• Troubleshooting issues: Troubleshooting 
to diagnose problems on a compressed OS 
drive can obscure underlying issues. 

• Latency slowdown:  The CPU has to use 
resources to compress/decompress files 
whenever it tries to access them. 

• Potential system instability: Compressed 
OS drives add another layer of processing 
to access and write data which can create 
system instability and crashes, especially if 
the CPU is already running at full capacity. 

Keep in mind the security and integrity of files 
when choosing to compress them. On an 
operating system, your computer’s core 
workability may not work as smoothly, the CPU 
may slow down, and you can risk data 
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corruption. Hard drives with an extremely large 
amount of space don’t likely need drive file 
compression. On the other hand, compressing 
work / project / batches of personal files to send 
through emails, networks, and backups can be 
a very useful way to save time and space. 

External File Compression 

Not only does a computer’s hard drive have a 
compression utility, but there are also utilities 
to allow specific file compression for easier and 
faster file distribution and sharing. 

A zip file utility can compress several files into 
an archive so they can be carried in a mobile 
and shareable file directory. Within the 
directory the files are individually compressed, 
and the entire zipped directory may be smaller 
than any of the uncompressed files. 

Compressing the file in a zip (or related format) 
can make what’s stored inside of it inaccessible 
until the zip file is unzipped to recover the full, 
uncompressed files. 
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An OS may have a built-in file compression 
option, though it may exist for simple 
compression onto the hard drive and not be 
meant for sharing and uncompressing for 
work. A separate non-OS utility can do this, and 
many are free. The trick is to find a free one 
that is easy to interpret and use, and that gives 
more than one compression setting and 
format. 

Common compressed files include: 

• . ZIP (PC, universal) 
• .7Z (proprietary to 7Zip utility) 
• .GZ (proprietary to GNU zip utility) 
• .RAR (Mac) 
• .TAR (proprietary to Unix-based utility) 
• ISO (archive file with identical or image of 

data found on an optical disc; sometimes 
used for installation program files) 

No one is best, though the universal .ZIP file 
usually works on all computer operating 
systems. 
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Security 

Computer security is a constant issue, and will 
be covered more extensively in a later chapter. 

Computers face threats from multiple sources 
that can impact hardware and data security. 
Cyber threats can include: 

• Advanced persistent threats (APT) 
• Distributed denial of service (DDoS) 
• Emotet 
• Hacking 
• Malware 
• Password attacks 
• Person-in-the-middle attack (PitM) 
• Phishing access 
• Ransomware 
• Social engineering attacks 
• Software supply chain attacks 
• Trojans 
• Viruses 

All of these can cause loss of data, resets of 
important settings and computer protections, 
disk wipes, corrupted files, stealing of the 
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computer’s information, a locked-up system, 
and more issues. 

A computer should access security utilities, 
such as: 

• Account protection: use a sign-in security 
protocol and password to lock/unlock a 
computer. 

• Antivirus: Scans, prevents, detects, 
quarantines, and deletes viruses from a 
computer. 

• Browser control: Set warnings in Internet 
browsers for unrecognized apps, files, 
malicious sites, downloads, & web content. 

• Firewall & Network protection: Software 
utility or hardware device that filters data 
and connections entering or leaving a 
network or computer. 

• Malware identifier: Uses tools to identify, 
alert, and block to malware threats. 

GPU/Video Card Management 

The graphics processing unit (GPU) was 
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originally developed to expedite rendering of 
graphics. It evolved to be programmable for 
creating more detailed visual effects, realistic 
scenery, and advanced lighting / shadowing 
techniques. Now it has progressed to also 
handle additional workload in high 
performance computing (HPC), and deep 
learning. The terms GPU, graphics card, and 
video card of a computer tend to be used 
interchangeably. 

The GPU produces a lot of heat when it has 
more processing to do, such as with rendering 
detailed graphics and managing application 
and gaming performance. It usually comes 
with a management utility that allows power, 
heat, and performance settings, and driver 
updating. 

• The GPU can be integrated (hardwired) 
into the motherboard/CPU and come with 
an integrated management utility. 

• If the GPU is a separate hardware unit, like 
something from AMD or GeForce with 
additional RAM, it will come with a 
specialized management utility. 
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Peripherals Management 

Peripheral equipment, like the screen monitor, 
keyboard, house/trackpad, USB flash and 
external hard drives, microphone and 
earphones, printer, and other external devices, 
also tend to have OS-provided or 
manufacturer-provided utilities. These utilities 
allow for identifying the unit, tracking device 
usage, and for adjusting activity and power 
settings. An example might be a specific utility 
for a gaming item attached to the USB of your 
computer, or a mouse/controller- specific 
utility, your computer’s Device Manager, etc. 

Driver Maintenance 

A computer driver is a set of files that assist 
your computer’s operating system interface 
with pieces of hardware like the graphics card, 
the keyboard, the music player, etc. They allow 
the OS to recognize and use hardware 
correctly. Each hardware item requires its own 
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driver files, and these are developed and 
updated by the hardware’s manufacturer. 

Driver updates are routine and can be pushed 
by the manufacturer, depending on the piece 
of hardware’s default utility settings. They may 
also be available at the manufacturer’s website 
for download. Finally, a computer cleaning 
utility may have a section dedicated to 
checking the computer for needed driver 
updates, then download and install the drivers 
upon approval. 

Driver updates fix security and compatibility 
problems, errors, broken code, and can add 
features to the hardware. When drivers are 
outdated, the computer can experience 
slowdowns and performance issues that 
impact workflow. 

Driver types can include: 

• BIOS: The basic input output system is 
located in a read-only memory (ROM) chip, 
and is in charge of booting a computer 
and giving a set of instructions during 
boots. It also does power-on self-tests 
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(POST) that are required during startup, 
and provides drivers for the basic hardware 
to ensure that they interface properly with 
the operating system. 

• Hardware (block, character, motherboard): 
Input/output device data transfer drivers. 

• Kernel device: Part of the operating 
system functionality. 

• Original equipment manufacturer (OEM): 
For managing equipment/add-ons like 
nVidia video cards. 

• User-mode: Drivers that may trigger 
during a user’s session working with an 
external device (USB connected, etc.) 

The Registry 

A computer registry is a hard drive location 
where system and application settings are 
categorized and stored. It is an internal 
database containing machine-specific 
information regarding almost everything in 
your computer. It is very detail-oriented and 
not for casual tweaking or adjustment. That 
being noted, the registry can develop errors of 
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deleted software registries or orphaned 
registry items from ordinary processing 
activities like uninstalling programs, deleting 
files, updating applications, and system 
shutdowns. Malware and viruses can also affect 
the registry, and is a serious computer security 
issue. 

MS Windows has a built-in registry. The MAC 
equivalent would be a series of .plist files in 
several preferences folders. 

A registry cleaner is a tool that scans the 
registry for registry keys that have no use, 
potentially leftover remnants of applications 
that have been deleted or updated. Often 
computer cleaning utilities will build in a 
registry cleaner. Use with care and access to a 
friend/computer tech support. 
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TIP: Cleaning the Registry. If you choose 
to use a Registry Cleaner as part of 
standard computer maintenance, 
always be certain to save a backup of 
the registry file first. A good utility will 
give this option and perform the backup 
and then the registry cleaning for you. 

MedAttrib: author-generated. MS Office 
Registry Editor. 

Program Sources 

Computer programs, like utilities and 
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productivity applications (see Part 2), come 
from different sources. We’ve looked at utilities 
built into operating systems, and noted that 
other utilities can be provided by 
manufacturers of hardware and tools. 

In addition, utilities and other programs can 
come from additional sources: 

• Freeware 
• Open source 
• Payware 
• Shareware 

Freeware: Copyrighted computer software 
which is available for use for free for an 
unlimited time. Limited time use tends to be 
a free sampling, which is not the same thing. 
Freeware developers choose to ‘give to the 
computing community’ while also keeping 
control of future development and direction of 
the application. Freeware software is provided 
to its users free of cost. 

Open source: Software that is distributed with 
its source code so that others can use, modify, 
and distribute variants with its original rights. 
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The developer releases it under a license with 
the rights to use, study, change, and distribute 
the software and its source code to anyone and 
for any purpose, kind of like this OER textbook. 
It can also be developed in a collaborative, 
public manner. 

Payware: The default marketing and 
distribution of commercial software which 
requires a payment/subscription and usually 
no modification or free sharing. 

Shareware: Commercial software that is 
copyrighted, which may be used without cost 
to try it out and for a limited period of time. 
Keeping the software eventually requires a 
payment to keep using, or a more robust full 
version is available than the freebie light 
version. 

ACTION: Quick Task 

Open your computer’s Task Manager. If you are 
doing this for an assignment, you can take 
screenshots to record your information. 
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• Look at the Processes tab. What seems to 
be the process that is using the most 
Memory? What seems to be the process 
that is using the most CPU power? 

• Look at the Performance tab. 
• Observe the CPU graph; what is the base 

speed? 
• Observe the Memory tab; what is the 

Speed? 
• Observe the Wi-Fi tab; what level does the 

signal strength seem to be? 
• Observe the GPU tab; what is the driver 

version and driver date? 
• Look at the Startup tab; how many 

Startup processes are enabled? 

Chapter 3: Utilities  |  101



Chapter 4: 
Information 
Management 

What We’ll Cover >>> 

• Information Management 
• Types of Information Systems 
• OS file Management 
• Email Management 
• Backups 
• Cloud Storage Management 

Information Management 

Information includes both electronic and 
physical material. Computing allows for the 
storage of data and the security measures that 
help protect archived information of 
stakeholders like corporate and government 
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clients. Information systems are associated 
with how technology is used to manage the 
needs of individuals, groups and organizations 
in a systematized way. 

An organization’s (like a community college 
system) structure needs to manage 
information like the enrollment and payroll 
databases, financial aid data, faculty learning 
management system content and backups, IT 
department resources, and more. The 
information lifecycle – data, paper files, 
electronic documents, audio and video, 
computing resources – consists of a series of 
systems that need accounting and security, 
etc. 

According to Wikipedia, Information 
Management (IM) is the collection and 
management of information from one or more 
sources and the distribution of that 
information to one or more audiences. It is not 
enough to create work product (a history term 
paper, a roster of students). The term paper has 
layers of research data, references, and 
supporting examples; a roster of students is 
associated with addresses, transcripts, and 
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program degree outcomes. How this is 
managed – so that the community college 
system can serve students, support advisors 
and faculty, manage tuition and state 
government funding, expand and contract 
courseloads, and report data for accreditation 
standards – is an example of information 
management. 

Types of Information Systems 

Components of information systems 

• Control: The filtering, sorting, and clear 
organization of the stored information. 

• Feedback: The storage and updating of 
information for output and future use. 

• Input: Information resources needed to 
plug into an organization’s plan of action – 
data, tools, info about supplies and costs, 
customer needs, etc. 

• Output: An information product resulting 
from the processing of the information 
resources – a report, database, analysis 
result, etc. 
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• Processing: The organization and 
management of the resources in a useful 
way with the intent to produce a result 
beneficial to the organization – plan for a 
product or service, research results, etc. 

Information in the workplace includes much 
more than just documents and computing 
files. It represents entire systems of workload 
and content from the beginning of a work 
cycle until the final distribution, and then the 
follow-up assessment and process of review, 
improvement, and expansion of the next 
phases of the work cycle. Systems can include: 

• Decision support structures 
• Financial transactions processing 
• Healthcare records 
• Office automation 
• Organization technology 
• Work product research and development 

For the general user (student, employee, home 
owner), the personal information system is 
much smaller but equally important: personal 
finances, music and movie collections, car and 
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health insurance, home rental or ownership 
accounts, work history and references, Internet 
searches, and so on. Dealing with your lifetime 
of information – especially related to your 
computer and devices – is also part of 
information management. 

Let’s cover aspects of personal information 
management related to one’s digital life. 

OS File Management 

People put aspects of their entire life on their 
computing devices at home and in the 
workplace. From music playlists to travel 
planning for a vacation, one’s computer is full 
of documents, images, browser saved data, 
financial records, system settings, directories of 
assignments and work files, etc. That computer 
might be the smartphone, the laptop, the 
desktop, a tablet, etc. 

The computer operating system (OS) usually 
provides a utility for file management; in 
Windows it is called the File Explorer, and acts 
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as a web-interface program that shows 
computer directories, files, and shortcut links. 
Mastering this one tool for organizing 
information on the computer can make your 
digital life a lot easier. 

File: A storage unit on a computer that stores 
information, data, etc. (such as a document, an 
image, etc.). 

File directories: A directory is a virtual 
hierarchical system that allows organizing data 
on different levels, and usually shows contains 
all information about the attributes of 
referenced files. Is not exactly the same as a 
file folder, but the terms directory and folder 
tend to be interchangeable in general 
reference. 

File extensions: The extension of a file reveals 
and aligns with the format of a file’s contents 
and program used to create/modify the 
content. For instance, word processing files 
may use a .docx (document) or .txt (text) 
extension, while a spreadsheet file may 
use.xlsx. Some common extensions (not an 
exhaustive list): 
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• Database-oriented: .db, .accdb, .sql, 
• Executable/program launch-oriented: 

.exe, .apk, .bin, .msi 
• Graphics-oriented: .jpg, .ai, .gif, .png, .esd, 
• Link-oriented: .lnk, -Shortcut, 
• Media-oriented: .mp3, .mp4, .wpl, .wav, .avi, 

.mov 
• Numeric-oriented: .xls, .xlsx 
• Packaged/compressed: .zip, .rar, .pdf, .iso, 
• System files: .dll, .bak, .dmp, .ico, .sys 
• Text-related: .doc, .docx, .rtf, .txt, .odt, pptx, 

ppsx 
• Web and programming-oriented: .html, 

.css, .oft, .msg, .vb 

File folders: A virtual storage space used to 
store and organize computer files. A folder can 
also contain additional folders (known as 
subfolders). The folders usually contain files 
(documents, images, media like music, 
databases, setting files, and more). A folder has 
a name and is visually represented by an icon. 

File manager: a utility that organizes, indexes, 
and allows for the opening, renaming, moving, 
copying/pasting, and deletion of files of data. 
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Filename: a unique name given to a file to 
identify it; can contain letters, symbols, 
numbers, spaces, etc. 

File naming protocol: A practice designed (in 
the workplace, by users, etc.) for naming files 
so they can be easily recognized and found. For 
instance: 

• A computer course file: 
chapterlastnamedate.docx (example 
Ch1bothell033123.docx). 

• A personal spreadsheet: billsyear.xlsx 
(example bills2023.xlsx). 

Shortcuts: A file is located in a specific location, 
while a shortcut (alias on a Mac) to the file 
can be stored elsewhere on a computer (like 
the desktop) and can be used to open the file 
without searching for the file’s physical location 
on the computer. 

Basic File Management Skills 

Basic file management refers to a way to name, 
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save, backup, organize files/folders, and keep 
track of files on a computer. Personal file 
management tips: 

• Create routinely named folders/subfolders 
to organize your files. 

• Save your work frequently into folders/
subfolders (organize by category), not in 
the default computer documents folder. 

• Save your personal data files and 
directories on a backup disk regularly 
(back up your files). 

• Give files and folders short, but 
meaningful names that have consistent 
purposes. 

• When creating or opening a file you plan 
to modify, save it immediately for the first 
time to an organized location where you 
can easily find it again. 

• Create a specific location directory on 
your computer (e.g., USB drive or hard disk 
drive) to save your files. 
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TRY ME Activity 

In this activity, we will use MS Windows 
(Windows 11/10/9, and Macs/Linux systems) 
work pretty much the same) to create a folder 
structure to store your files for class. It is 
important to keep your files organized so that 
you can find them when you need them. 
Saving, accessing, and uploading files is critical 
to your success in this course. This assignment 
will assist you in keeping your files organized 
throughout this course. It was also referenced 
in the Introduction in preparing for this course. 

Using Windows, create the file structure on one 
of the following: One Drive, computer, or 
laptop. Your top folder should be BUSTECH105. 

There are a few different ways to create a new 
folder in Windows. 

• In File Explorer, click the new folder icon in 
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the upper left hand corner. 
• Use the shortcut key CTRL+Shift+N 
• Right click the white area of the File 

Explorer Window, and select New, Folder. 

TIP: File Explorer/Manager actions 

• After you type the name of the folder, 
press enter. 

• Use the Windows File Explorer Navigation 
Pane to expand each file folder (the Mac 
and Linux system should have a similar 
capability). If the arrow, or carrot is 
pointing down, the file is expanded. This 
will allow you to access the folder contents. 

• To rename a folder, right click on the 
folder. In the shortcut menu, choose 
Rename. Start typing the new name, and 
then hit Enter on your keyboard. 

• To delete a folder, right click on the folder. 
In the shortcut menu, choose Delete. 
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Email Management 

Email is an important area of personal and 
professional records that one needs to keep 
organized, clean, and easily searchable. How 
often do you need to refer to an important 
message with instructions, or find an email 
with meeting contact and location 
information? We will cover email management 
in the Email Management chapter, but here 
are a few quick tips: 

• Create secondary email address for 
‘disposable’ and marketing-related emails 
so they don’t get in the way of your main 
email account’s email priorities. 

• Create several email sorting folders/labels 
for handling priorities, like Hot, Reference, 
ReadMe, Meetings, Pending, etc. Email 
folders/labels can also have sublabels, like 
Products > Orders, Books, Computer 

• Create/use a main email account for only 
important business like your bills and 
personal job-related emails. 

• Handle incoming emails a couple of times 
a day and act on them / get them out of 
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your inbox so you know what is new and 
needs a response. 

• Once a quarter, clean folders to get rid of 
or archive past-current emails. Get emails 
out of your face. 

Backups 

File backups have been covered more in 
Chapter 3, yet it is useful to add a reminder 
or two here. Personal files on your home 
computer, and important files on your work 
devices, have a lot to do with how you live day-
to-day and access the information / reference 
content you need to function digitally. As a 
result, make and follow a regular file/data 
backup plan so that you never lose important 
things like music and playlists, financial 
records, images and memories, etc. You can: 

• Consider using a Cloud backup service for 
full-computer backups that are 
maintained continuously, daily, and/or as 
you schedule them. 

• Keep a secondary, external hard drive to 
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back up full personal directories and 
important computer settings. 

• Make a copy of your files onto an external 
drive like a USB flash drive. 

• The computer OS will have a built-in 
system back-up and restore option that 
you can use monthly or quarterly, and 
when you plan to make significant 
changes on your computer like adding a 
new GPU-leavy game or computing 
program. 

Cloud Storage Management 

Information management and storage can and 
should use multiple layers of action so that 
one’s data is backed up in more than one way. 
One common way has become Cloud storage. 

The “Cloud” is a reference to the Internet and 
Web – the system of interconnected 
computers between organizations, people, and 
places. It is called the cloud in part because 
data is available “out there” in the Internet 
through files and websites, rather than stored 
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on a single machine or in a specific office 
environment for use only in that office by 
specific employees. 

MedAttrib: learntek.org public domain. Cloud 
computing concept. 

Cloud Computing refers to using the Internet 
for something other just browsing and finding 
information and resources. It also means using 
the Internet, or “cloud,” for doing work like 
filling out online job applications, submitting 
assignments into a course’s learning 
management application, downloading article 
PDFs and reference manager information 
while working on a term paper, paying bills, 
enrolling in classes, participating in online 
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meetings, making and distributing videos or 
livestreams, and so on. 

The author recalls the ancient days of the 
Paleolithic age when the concept of the “cloud” 
seemed improbable and kind of scary. How 
could one actually do real work in it? How could 
data be safe? How long would it take for 
enough people to discover and use it? What is 
it disappeared in a big stormy puff? 

Cloud computing is not only a reality, but also 
the norm for work and personal computing 
needs. There is a whole section of this textbook 
dedicated to Internet Fundamentals. Much 
more of our computing/digital life is in the 
‘cloud’ than on our own computers, in terms 
of the apps we use, where we store data, how 
we find and use information, and where we 
connect with our finances, health, and 
communication needs. When you are using 
the cloud, it’s likely that both data and useful 
applications reside in the cloud environment 
(like Google Docs, Microsoft 365). 

Advantages of working / 
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storing in the cloud 

• Automatic backup. Cloud storage 
provides use AI and processes to automate 
their own backups. If their own hardware 
fails, they can recover and restore your 
data automatically. 

• Efficiency: Using cloud resources generally 
speeds organizational and personal 
productivity since computer applications 
and/or data are always easily accessible 
regardless of the physical machine in use. 

• Externally managed: Cloud services are 
usually handled by organizations with 
expertise in computing, which employ 
servers to accommodate operations and 
storage. They handle their own backups, 
data restoration, data organization, and 
finances. 

• Fast Recovery: When a computer is lost or 
compromised, data and applications in the 
cloud allow fast recovery of work 
information, files, and processes. This is a 
primary reason while multiple avenues of 
backing up your work is important. 

• Minimal computer setup: When data and 
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applications are entirely cloud-based, any 
computer can do the work with access to a 
browser. Also, computer and cloud data 
can be synchronized. 

• Multiple Device Access. When files are 
stored in a central location, they can be 
accessed by many different types of 
devices and synchronized so versioning is 
the same across the devices, like the 
personal computer and smartphone. 

• Software recency: Cloud-based 
applications are often Software as a 
Service (SaaS) that means one uses the 
latest version of the application when it is 
downloaded from or updated by 
application provider (Microsoft, Apple, 
Steam, etc. Many people use a mix; a 
downloaded full version of software on a 
local computer, augmented by current 
updates, patches, and drivers to keep the 
software current, and a light and/or 
synchronized version in the Cloud. 

• Theft protection. Cloud storage providers 
may offer ways to remotely wipe data off 
any lost device. 
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Challenges of working / storing 
in the cloud 

• Internet Connection. Most cloud services 
typically require a stable and continuous 
Internet connection. Many regions around 
the world, and in the United States, have 
limits in broadband and Wi-Fi due to 
service costs, old or missing internet 
infrastructure, and lack of community 
resources like close-by libraries / 
community centers / school-related 
computing labs. Internet connection 
access and slow speeds affects the 
efficiency and reliability of work. 

• Privacy: When data is available anywhere 
other than inside a closed system (un-
networked home or work computer), it can 
be accessed by others who are not 
supposed to be part of the personal life or 
work system. Data on a system other than 
your own can be hacked, corrupted, stolen, 
and misused. Laws in other countries 
where servers in the cloud exist and 
operate may not protect you. If an Internet 
server provider goes out of business and/or 
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changes policies, pricing, and access, you 
can be limited in accessing your own data. 

• Generative AI: Depending on how you 
store information, it could be accessible to 
AI survey in which generative AI tools 
access information as it aggregates 
everything it can access on the Internet 
from online repositories, public datasets, 
web scraping, APIs, surveys, ‘publicly’ 
accessible info from social media 
accounts, etc. Security products like 
Carbonite should be safe, but the power 
and legality of AI search and aggregation 
of all info it can locate is evolving. 

Cloud-based Storage 

There are many companies that offer cloud-
based storage under different conditions. 
Some may be free, others very low in cost, and 
others as part of a package of services. 

• Backup: Internet/Cloud backup is offered 
my companies that specialize in having 
many massive servers full of storage space. 
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Usually requires a subscription or annual 
payment. Think Carbonite or other backup 
specialists. 

• Free: Various email and personal web 
server space providers piggyback free 
storage space onto their services. Think 
Google, Amazon Web Services. 

• Limited: Providers may offer a limited 
amount of free space, sometimes for a 
limited time period. 

• Sample: Providers may specialize in server 
use, services, and storage, and offer a free 
version as a sample to induce customers 
to upgrade to a paying plan. 

• Subscription: Providers may offer only a 
subscription / pay-as-you-use solution, for 
a monthly or per space amount fee. Think 
Dropbox. 

• Workplace: Organization workplaces 
usually have a lot of storage and work 
processing space for employees and 
related stakeholders in the workflow. This 
is not for personal use, but is a viable 
resource for work-related files and data. 
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Backup Best Practice 

Consider options to ensure good backup and 
restore procedures: 

• Label backups clearly. Label backup 
external drives and backup memory sticks 
and store where they can be easily found. 
Include the date the backup was made, 
and which computing device it is for (if you 
have more than one device). Use this same 
policy for digital backups, like in DropBox, 
Google, and when using a provider for full-
service backups. 

• Schedule computer backups. Schedule a 
regular backup process, such as weekly or 
monthly and when making a significant 
change to a computer’s applications or 
installations. 

• Use multiple methods. Data backup 
redundancy is a good thing, since two or 
more backups can keep data from being 
forever lost. 
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Part 2: 
Productivity 
Tools 

In this section, we’ll have an overview of 
productivity in the workplace. The information 
and applications we’ll discuss can also be, and 
are, used outside the workplace. They were 
designed to make school, work, and 
communications easier, standardized, and 
accessible. 

There are a lot of industries that do not use 
all or most of these programs, and many more 
applications that serve diverse work functions 
and employment needs. This textbook is 
focused on fairly basic support-related tools, 
rather than specialty and/or proprietary ones. 
For instance, there exist work tools for analysis, 
financial management firms, medical 
management, law and regulations, visual 
communications, application development, 
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automotive diagnostics, inventory 
management, sales contacts, marketing 
management, and. . . and . . . Some of these 
may be mentioned to help set the stage for 
productivity applications. 

The thing with the applications we’ll cover in 
more detail is how useful they can be in 
support (and even main) aspects of education 
and a number of industries. 

• Databases are a backbone of data 
management for many purposes and 
industries: collecting, organizing, 
analyzing, synthesizing, and reporting out. 

• Email is a predominant form of business 
communications that can be 
supplemented by text messaging, phone/
audio calls, videoconferencing, and in-
person connections. Emails allow for the 
transfer of information with files and 
images, and also allow for a digital paper 
trail. 

• Presentations are done in meetings, 
conferences, shows, and marketing/
advertising in many industries. 

• Spreadsheets allow for collection, analysis, 
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calculations, and visual graphs/charts of 
data used in a lot of workplaces. 

• Word processing handles document 
creation, formatting, modification, and 
distribution. Businesses around the world 
generate documentation, reports, 
correspondence, and much more. 
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Chapter 5: 
Productivity 
Basics 

What We’ll Cover >>> 

• Productivity Software 
• Application Programs 
• Utilities 
• Office Suites 
• Organization Programs 
• Graphics Work Programs 
• Communications Tools 
• Specialty Work Programs 
• Education Programs 
• Programming Applications 
• Accessibility Programs 

This chapter will mostly identify categories of 
programs / applications used for productivity 
needs. It is not exhaustive, and won’t really 
cover all categories – mainly ones used related 
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to productivity in education and the workplace, 
with a few supports. It also will focus on general 
categories and descriptions of the application 
types and purposes, but mostly not list specific 
applications to use since apps come and go 
and/or change name, pricing structures, 
availability, and integration-with-major 
programs’ capabilities. The exception to this 
will be where we discuss specific big program 
suites and options that are part of operating 
systems and/or of the well-established 
education/workplace market share. 

Productivity Software 

Productivity refers to how efficiently work 
converts input like labor into an output of 
goods and services. Productivity software refers 
to programs that enable someone to create 
and produce information output like in 
documents, databases, information media, and 
other data-related work products. Of course a 
lot of work products are more tangible, like 
equipment and customer-facing goods for 
purchase, but for this book’s context, this 
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chapter will provide an overview of workplace 
productivity applications that have routine 
work uses. 

The market for productivity software is huge, 
and includes program suites with multiple 
tools, stand-alone applications to use for 
specific work products, and many apps for 
mobile use. 

Application Programs 

An application program is a computer program 
that provides users with tools to accomplish a 
specific task. In productivity environments, like 
a college advising office, accounting company, 
factory, synchronous online meetings, movie 
post-production work, US Diplomatic Corps, 
mechanic shop – and so many more – 
computer programs are used in most aspects 
of operating and organizing the business, the 
handling of goods and services, research and 
development, and so on. 

Application software can be any of the pieces 
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of software on a cloud server, company 
mainframe, employee desktop, mobile talent’s 
laptop or tablet, and any smartphone used in 
part for self-organization and work-related 
support. Web browsers, productivity office 
suites, product websites for purchasing 
products (which use databases), online tax 
preparation programs, and scheduling apps 
are examples. 

There are so many – thousands – in many 
categories. Any search engine query for 
something like ‘word processing applications,’ 
‘scheduling software,’ ‘communication apps,’ 
and ‘conferencing tools’ will pull up many ads, 
web shops, and articles with aggregated lists of 
the “Top 10” or something similar. 

Utilities 

Utility programs were covered extensively in an 
earlier chapter; they are often supports for 
school, work, and general lifestyle needs. They 
don’t tend to be all-encompassing for multiple 
needs in workplaces, but they may be quick-
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use apps with questionable lifespans and 
security. However, some do also cross over into 
also functioning as common productivity 
applications, particularly ones with full 
scheduling and work management 
components, and messaging / meeting 
coordination tools. Some useful productivity 
utilities (too many for PC, Mac, Linux, and web-
based use to list all here) include: 

• Coding/programming: Notepad, HTML 
editors, browsers with editing. 

• Communication: ZOOM, Teams, email and 
direct messaging apps. 

• Documents: Wordpad, PDF makers. 
• Finance: calculator, online banking apps. 
• Graphics/media: online image editors, 

online web editors, stock photo acquisition 
and organization. 

• Organization: calendar apps, task-list and 
noting tools, project management utilities, 
time trackers. 

• Products/services–oriented: Online job 
application tools, reference/articles 
databases, grocery-shopping/product 
delivery apps. 
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Office Suites 

There are many combination suites of tools, 
applications, and productivity extenders. So 
many that one should set one’s goals and 
needs, then use a web search engine to 
carefully search and weed out suites and 
packages that don’t meet needs or offer 
reliability and security. 

For this textbook, to support basic Business 
Technology applications in a school setting and 
for workplace preparation, we’ll focus on 
programs that accommodate that. This 
textbook will leave industry-specific software 
solutions (like healthcare, automotive, 
financial/banking, marketing/merchandizing, 
human resources, engineering-related, 
vocational fields, etc.) to specific industry 
training certificates and degrees. 

And, for this textbook, we’ll narrow down basic 
training and skills-building to the Microsoft® 
Office® suite. Skills learned for this are 
generally transferrable to other office suites, 
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even if their user interfaces have some 
differences. 

For office and multiple-industries workplace 
productivity, an office suite is an example of 
standard productivity software. Several office-
work/information production programs are 
bundled together and can integrate in terms 
of styles, key shortcuts, templates, and 
transferrable skilling/tasks for getting work 
done. Suites can be installed on a computer, 
and/or accessed through a web platform from 
the cloud (manufacturer’s servers), and/or 
synchronized between both. Some can also 
have plug-ins from other applications that can 
extend the productivity suite’s capabilities (like 
Acrobat for PDFs, reference manager programs 
for foot- and end-noting citations, Power BI for 
adding data modeling to MS Excel, etc.) 

TIP: Plug-ins/Extensions. A plug-in is a 
piece of software that adds features / 
extends functionality to existing 
program. 

An office suite might include word processing, 
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accounting spreadsheets, visual presentations, 
email/scheduling integration, print publishing, 
flow-charting, and database production. Some 
add additional tools and extensions, too many 
to list. 

Word Processing: A catch-all phrase for 
producing many kinds of informational 
documents in various formats like textbook 
content (such as this book). A word processing 
program allows users to create, copy, save, edit, 
format, rename, print, and retrieve text-primary 
documents. Examples of word processing 
programs include Microsoft Word, Google 
Docs, Apple Pages, and LibreOffice Writer. They 
can be used for: 

• Articles 
• Assignments 
• Correspondence and memos 
• Newsletters 
• Notes 
• Novels and stories 
• Project management documents 
• Reports 
• Resumes 
• Term papers 
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• Worksheets 

Spreadsheets: Another catch-all phrase for 
financial/accounting and calculations-oriented 
workbooks. A spreadsheet program is an 
application that organizes text and numeric 
data into a tabular format. Data can then be 
arranged, sorted, calculated (using formulas 
and functions), analyzed, exported, and 
illustrated using graphical representations. 
Examples of spreadsheet programs include 
Microsoft Excel, Google Sheets, Apple 
Numbers, and LibreOffice Calc. A spreadsheet 
program can be used for: 

• Accounting sheets 
• Analyzing business performance data 
• Calculating revenues 
• Determining assignments’ weight and 

grades 
• Figuring budget information 
• Forecasting loan payments 
• Preparing payroll information 
• Producing charts and graphs 

Presentations: These tend to present images, 
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sounds, videos, text, graphics/charts, and other 
audio-visual clips and media to enhance 
general content for meetings, conferences, and 
customer-facing material. Presentation 
programs are designed to present information 
in transitioning slideshows and other 
multimedia formats. Examples of presentation 
programs include Microsoft PowerPoint, 
Google Slides, and Apple Keynote. They are 
commonly used to: 

• Create animated videos (with voice and 
animation) 

• Design website concepts with hyperlinks 
and interactivity 

• Enhance lectures and tutorials 
• Make illustration slideshows 
• Prepare slideshow presentations 

Databases: An electronic warehouse of 
organized and structured text and numeric 
data that can be sorted, filtered, queried for 
specific information, and data report 
generation. Database programs (database 
management system) are applications 
designed for creating, editing, updating, 

136  |  Chapter 5: Productivity Basics



maintaining databases, and managing 
organized information stored in them. 
Examples of database programs include 
Microsoft Access, Oracle Database, and 
TablePlus. Databases and their programs are 
used in the following industries (well, actually 
in almost everything): 

• Banking 
• E-commerce 
• Education 
• Government data 
• Healthcare records 
• Human resource management 
• Library management 
• Sports data 
• Travel reservations 
• Weather/climatology 

TIP: Database vs Spreadsheet. A 
database is designed to hold potentially 
thousands to millions of tabulated 
records of data, for accessing, sorting, 
querying specific data issues, etc. A 
spreadsheet – while it can be big and 
also uses a tabular format, is designed 
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for specific ranges of data for 
calculations and detailed analysis with 
filters, conditional formatting, summary 
tables, charts and graphs, etc. 

Organization Programs 

Organization programs and apps are designed 
to manage time, information, and other 
lifestyle & productivity schedule-oriented 
needs. Smartphone users have hundreds to 
choose from. Frequently there are “best 
organizing tools” articles with application lists, 
summaries, and links. Some of categories 
include: 

• Calendars/scheduling 
• Collaboration/meetings 
• Note-taking/study aids 
• Reading/viewing content priorities 
• Reference/citation managers 
• Tasks/Lists 
• Time-tracking / accountability for payroll 
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Graphics Programs 

Graphics-related applications can support 
office suite work, web page enhancement, and 
marketing/communications work products. 
They fall into several categories, with payware, 
SaaS options, freeware, and lightweight apps 
for computers and smartphones. Categories 
include: 

• Design: Layout and formatting of 
publications, advertising, and visual-based 
communications. 

• Graphics/images: Creation, modification, 
and organizing of images for other 
documents. Images can include photos, 
collages, painting, cartooning, clip/icon art, 
and image editing/clean-up. 

• Animation: Seamless movement of 
imagery for presentations, online training 
modules, websites, and entertainment/
education-related work products (and so 
much more). 

• Modeling: Developing working models of 
content, like 3D characters and items for 
gaming, Computer Aided Design (CAD) for 
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complex schematics and architectural 
designs, and adding texture and depth to 
3D modules. 

• Video/film: More than just animation, 
video/film-related productivity has to do 
with capturing, editing, modifying, and 
distributing video-related work like 
commercials, website ads, films, and film 
processing. 

Communication Programs 

Communications productivity programs are 
designed to make it easier for people (teams, 
employer/employees, students, conferences) to 
work together. Apps can centralize information 
and enable users to seek additional 
information, get technical help, and conduct 
synchronous online meetings. Some may 
include other useful features, such as client 
communication or project management. There 
are typically two major types of 
communications software that can be broken 
up into more specific areas and groups of 
programs. 
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• Asynchronous: Related to 
communications that can happen at any 
time, any place, at any distance, with an 
emphasis of one user to another user(s). 
This can include email, file transfers, blog 
and comments, forums, recorded lectures 
on a conferencing tool, streams of past 
events and existing entertainment, etc. 

• Synchronous: Real-time communication is 
near-instantaneous for immediate 
consumption and action. Online live 
meetings using a conference tool is one 
example, and can be used for course 
lectures, collaborative meetings, seminars 
and workshops, and team-building 
exercises. Direct messaging/texting in the 
moment is another. Streaming videos of 
gaming or other activities is another, in 
which you can observe a live stream of 
something like the daily lives of foster 
kittens or witness someone preparing a 
recipe in an online ‘cooking party.’ 

Communication application categories can 
include: 
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• Chatbots/agents: Product and service 
websites often include a chat function. 
This may be handled solely by a chatbot, or 
opened with a chatbot before a user gets 
routed to live technical or customer 
support. 

• Conferencing: As more jobs have moved 
to at-home workspaces and mobile 
locations, online conferencing tools for in-
person meetings and collaboration have 
become a staple of work productivity. 

• Editable/signable documents: Automated 
formstacks, and editable PDFs or other 
activated documents can let a user read, 
amend, and sign documents before 
emailing or returning them for processing. 
Students needing an early withdrawal can 
use an online withdrawal form at many 
colleges. 

• Email: Email speaks for itself; messages 
with embedded or attached images and 
files can be sent back and forth. While 
email can have complexities of 
organization and retention, it also provides 
a message trail to help one remain in the 
loop about a situation or work interaction. 
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• Messaging: Direct or text messaging is 
much more in-the-moment than email. It 
can allow attached and embedded files as 
well. Messaging tends to behave like a 
multi-sided conversation, but by text 
rather than an audio phone call. 

• Streaming: Streams can be of past events 
and are also often livestreams of a current 
event. Gamers may stream gameplay. 
People generating an online presence 
may livestream events of their day. A 
lecture of an online meeting can be 
livestreamed for those who are not 
participants but who want to observe the 
current activity. it also allows a streamer to 
create, present, solicit feedback, etc. 

• Online technical support: Technical 
support for computer and technical 
systems can be provided online and in-
the-moment. An example would be a user 
working with tech support of their laptop 
computer to solve a microphone problem, 
or a college tech support helping a 
student install an application like 
SplashTop so the student can use the 
college computers as a virtual machine on 

Chapter 5: Productivity Basics  |  143



their own Chromebook. 

Specialty Work Programs 

There are too many specialty work applications 
to list, but they exist in the thousands, for all 
industries (consider visiting the US Bureau of 
Labor and Statistics). They tend to support: 

• Industry-specific databases: (finance, 
human resources, real estate, insurance, 
informatics, medical information, products 
for shopping). 

• Live Information: (financial, stock market, 
lenders, entertainment life feeds). 

• Repositories: (book and article writing, 
journalism, research theses and academic 
papers). 

• Research and development: (compilers, 
government database exporters). 

• Work product creation and editing: (film, 
3D printing, equipment parts creation). 
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Education Programs 

Education is itself big business, because it 
employs and serves so many people and offers 
so many kinds of output (academic, financial, 
demographic data, career-training stats, 
training interfaces with specific industries). 
Programs can include: 

• Financial: Student financial aid 
applications (FAFSA), education loans, 
college tuition and enrollment 
management, textbook and materials 
acquisition (bookstores). 

• Learning management: Platforms for 
managing students, grades, curriculum, 
assignments, and teaching aids (like 
CANVAS). 

• Media: Access to films, videos, clips, 
recordings, synchronous and 
asynchronous collaboration, etc. YouTube 
and other how-to examples. 

• Reference/info managers: Information, 
articles, and other documents/data that 
can be referenced, cited, and used for 
academic and journalism papers, books, 
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workplace development, and employment 
predictions. 

• Statistical: Data for demographics, college 
success, college accreditation, program 
goals and outcomes, relationship of 
training to industries. 

• Student work-facing: research tools, 
academic honesty checkers, work 
preparation (like Grammarly), training/
demos (LinkedIn Learning, Khan 
Academy). 

Programming Applications 

All the emphasis on online and live-time 
workplace services and applications requires 
technical support for programming, coding, 
developing and modifying programs and tools, 
and more. These can include: 

• Build tools: These are used to automate 
the process of building, compiling, and 
packaging code so it can be executed 
later. 

• Code repositories: Platforms for 
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developers to collaborate on code and 
share in programming libraries. 

• Debuggers/testing frameworks: Find and 
correct code errors as part of streamlining 
and testing programming solutions and 
problems. 

• Emulators/virtual machines: Used to 
create and operate isolated environments 
for software testing in different computing 
conditions. They can also stand in for 
computer productivity work if your 
computer can’t accommodate a needed 
program – you can log into a virtual 
machine and work with its programs as if 
it were one’s own machine. 

• Integrated development environments 
(IDEs): Software applications with 
multiple-functions environment for 
coding, testing, and debugging 
programming for software, apps, and 
websites. 

• Programming Editors: Simple editing 
applications that programmers use for 
coding websites, working in multiple code 
languages, developing mobile apps’ code, 
etc. 
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• Version control: Track changes to code 
over time for collaborating with other 
developers. 

Accessibility Programs 

According to the Disability Status: 2019 – 
Census 2019 Brief (Wikipedia), approximately 
20% of Americans have one or more diagnosed 
psychological or physical disability. This doesn’t 
include undiagnosed persons. However, 
enough people face one or more kinds of 
barrier to doing routine work, study, and travel 
(commuting) that education and the general 
workplace has need of accessibility-related 
hardware and software. 

Accessibility situations tend to rely on assistive 
technologies, which themselves are not 
inappropriate or unhelpful. However, there is a 
long way to go for enough Universal Design 
of in-person and technology-related hardware / 
software to eliminate barriers altogether. These 
things are worth considering when surveying 
tools and applications for team and workplace 
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use, since one or more persons will likely be 
affected by an often silent difference in 
accessibility needs. 

These can include: 

• Audio: Persons with hearing divergence 
may need tools to help access audio 
information in lectures, videos, and 
meetings. These can include closed-
captioning, noise cancelling mono audio 
systems earphones, sign-language 
interpretation, and prioritizing email and 
direct messaging over audio connections. 

• Behavioral divergence: Can include 
persons through attention and stress-
related issues, insecurity in food/shelter/
safety that spills over into the classroom 
and workplace, and situations of 
substance addictions that can affect 
attention and information retention. 

• Cognitive challenges: Persons on the 
Autism spectrum may absorb and 
feedback information differently. Persons 
recovering from brain injuries who are 
being retrained may experience info 
access problems. Mental illness 
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expressions may leave persons needing 
need more time and extended deadlines 
to produce needed work product. etc. 
Dyslexia can make managing text content 
difficult, while other cognitive divergences 
may make watching videos with rapid 
image and lighting changes problematic. 
Each individual situation will be different. 
However, access may be improved by 
actual classroom and workplace 
interaction enhancements, like memory 
aids, task-stepping, reminder systems, 
programmed automation of some tasks, 
regular daily guidelines/scheduling, 
minimized distraction, colleague 
mentoring, clear procedure manuals, etc. 

• Language: Persons for whom the 
dominant language in a region or country 
(like ESL learners) can experience issues 
interpreting text, audio, film, textbooks, 
and computing applications. Access can 
be increased by using learning and work 
applications with full translation capacity 
in any language, an interpreter, and 
computing keyboards that are aligned to 
different alpha-numeric keys. 
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• Mobility: Persons with mobility divergence 
may not be able to get to locations, use 
standard workplace tools the same way, 
and may need more room and time to 
accomplish some work product outcomes. 
Some persons may lack specific limbs or 
capacity to use standard computing tools. 
Transportation options, distance 
movement, exhaustion, and bulkiness of 
some mobility tools can limit access to the 
classroom and workplace as well. While it 
is tempting to recommend distance 
learning / home-based workplaces, the 
actual barriers to connecting 
technologically and in person need to be 
mitigated and removed so people can 
interact socially and professionally at any 
location. For instance, computer 
manipulation tools like sip-and-puff, 
joysticks, head wands, eye tracking, 
electronic pointing devices, and touch 
screens may accommodate specific needs. 

• Visual: Persons with some or significant 
visual divergence may need tools to help 
clarify text (screen readers, magnifiers), 
and explain the content of images (alt 

Chapter 5: Productivity Basics  |  151



text). Optical character recognition (OCR) 
software can scan printed materials into a 
computer for audio and other output 
formats. An accessibility menu may assist. 
Braille keyboards and voice recognition 
can help accomplish workplace tasks. 
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Chapter 6: Email 
Management 

What We’ll Cover >>> 

• Email Concepts 
• Email Account/Interface 
• Organizing Emails 
• Cleaning Accumulated Email 
• Limiting Outgoing Emails 
• Limiting Incoming Emails 
• Email Crafting 

If you have a lot of your emails in your inbox, 
and looming over your head, then this chapter 
is for you. While this textbook covers technical 
aspects of email in other chapters, this chapter 
can help organize your email life with some 
basic tips and tricks. 
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Email Concepts 

Email is electronic mail, the mode of 
communication that uses electronic devices 
and data transmission to deliver messages 
between different computers. 

When you send an email to contacts, there is 
a series of processes that happens in the 
background from when you send the email 
until the email is delivered to the recipient’s 
Inbox: 

• Create then send the email. 
• The email client (such as Gmail) connects 

to an outgoing email Simple Mail Transfer 
Protocol (SMTP) server. 

• The email is handed over in a MIME 
(internet-standard encoded file) format, 
and the outgoing server validates sender 
details before processing the message. 

• The mail goes into the SMTP server’s 
Outgoing queue. 

• The SMTP server looks up then connects 
with the Recipient email server mail 
transfer agent (MTA) and sends the email. 
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• The Recipient server initiates various 
security checks then accepts the email if it 
passes. 

• The Recipient server validates the recipient 
account and delivers the email to the 
user’s mail account, based on the 
incoming email policies set for the 
account. 

This can happen almost instantaneously, or 
over several minutes, or over a couple of hours 
– depending on Internet connection, the rules 
and processes of the responsible servers, etc. 
Think how fast a website/service asking you to 
check your email to authenticate your login 
can be! 

Email account/interface 

Email interfaces, like Outlook and Gmail, have 
fairly standard default aspects to preparing, 
sending, organizing, and saving emails. These 
include: 

• Contact list: An email account contact list 
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lets you add past and current recipients, 
and new names/email addresses, so that 
you can use it to find and send emails to 
specific people as needed. 

• Filters/rules: You can set filters and email 
response rules to help automate your 
email processing. For instance, if you net a 
weekly email newsletter you like but read 
only once every few weeks, you can set a 
filter rule to automatically remove it from 
your inbox, store it in another folder, and 
leave it in unread status. 

• Folders/labels: Organizing emails category 
tool for sorting emails by removing them 
from the active inbox and storing them in 
folders where you can find them later. 

• Forwarding: You can forward a message 
you created or received to another person. 

• Message: Email text area workspace for 
drafting email text. 

• Inbox: Active emails needing a response / 
action come here first. 

• Priorities/sensitivity: You can assign a level 
or important/priority to an outgoing email 
to alert the receiver to handle it quickly. 
Same with sensitivity, but regarding how 
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to handle with confidentiality. 
• Reply: You can send your response to an 

email after choosing to “reply.” Reply All 
refers to replying to everyone who received 
the email you received, and should be 
used extremely rarely or not at all. Why? 
Reply all emails can become long and 
confusing responses by multiple people, 
clog up inboxes with unneeded 
information, and impact the 
confidentiality that one or more recipients 
may expect. 

• Styling: You can style the font size, family, 
and color, as well as text background 
colors and email footer formats, using a 
basic text style toolbar. 

• Subject line: Tells the receiver what the 
message is about. 

• To field: Where the email recipient 
name(s) will go for addressing the email. 
Emails can be sent to one or more people 
in the main To field. A related CC field can 
also accept one or more email contacts, 
and carbon copy (CC) is meant to indicate 
“informational” as a priority. The BCC field 
is a second related field referring to “blind 
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carbon copy), which hides the names/
recipients of an email from the other 
recipients who receive the email. 

MedAttrib: author-generated. Example Email 
user interface. 

There are usually additional email options 
available, depending on the service. These can 
include email views, spell-checking, creating 
default email footers, multi-step email filters, 
showing ‘read email’ status, automatic email 
tasks, etc. You will want to examine your own 
email account for options and how you 
personally want to prioritize using them. 
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Organizing Emails 

These are some general tips and techniques for 
organizing and managing your email process 
and content. An instructor who is focusing on 
an email assignment will likely give you specific 
steps to accomplish in a more formal 
assignment, but this section can help the 
routine email user. 

Your goal should be to keep your email ‘lean 
and clean’ – in reference to having a quickly 
emptied Inbox, easily organized email message 
storage files, and the ability to find and handle 
emails as needed. Inbox Zero is a ‘thing’ – a 
practice to look at and get all emails out of 
your active inbox so that you keep up with 
communications and can focus on incoming 
emails without clutter. People can get tens to 
hundreds of emails a day, and an ignored or 
messy inbox may look dramatic and like lots of 
work is happening, but it can also cause a lot of 
important stuff to be overlooked and ignored. 
In school and in the workplace, part of your job 
is to be accessible and responsive, and to do 
your part to communicate and complete work 
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product on time with minimal confusion with 
and for others. 

Email account tips 

• For your own use, create/use a main email 
account for important personal business 
like your bills, online shopping, school-
related items, and job-related emails that 
are not part of your actual workplace 
emails. 

• Create a secondary email address for 
‘disposable’ and marketing-related emails 
so they don’t get in the way of your main 
email account’s email messaging. You may 
sign up for a newsletter, or discounts, or at 
a gaming company’s website; keep all that 
separate from your primary email address. 

• Choose a basic and professional-sounding 
email address, especially for anything 
routinely serious. Using something like 
KissTheStudent1234@gmail.com does not 
inspire confidence, especially when 
looking for jobs or handling serious 
personal business. 
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• Develop an email password protocol that 
you will remember, that uses strong 
passwords, and that you can update 
regularly. 

• Don’t download or open attachments, 
website addresses, or ads in your email 
unless you really really want viruses and 
ad/malware. 

Email handling 

• Handle incoming emails a couple of times 
a day and act on them / get them out of 
your inbox right away so you know what is 
new and needs a response. 

• Create several email sorting folders/labels 
for handling priorities, like Hot, Reference, 
ReadMe, Meetings, Pending, etc. Email 
folders/labels can also have sublabels, like 
Products >Orders, Books, Computer. 

• Once a quarter, clean folders to get rid of 
or archive past-current emails from, say, at 
least a year earlier. Get emails out of your 
face. 
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◦ That being noted, keep any email 
receipts and notices about ordering / 
product problems for longer, in case 
you need to solve a problem. Same for 
school-related emails and emails 
about any conflicts, with any needed 
login information, etc. Just organize 
them out of your inbox and active 
folders. 

• Use your own outgoing email signature 
footer to give information. For instance, a 
signature usually gives your name, contact 
information, and maybe company name 
and job title. You can also add a useful line 
of text as needed. In my own case as an 
instructor, I always add something like the 
following to my outgoing email signatures: 
“Students: Our next due date is Friday, 
March 24, before 11:59pm. Please review 
the current Section’s Overview/Resources 
pages, the FAQs, and announcements if 
needed.” 
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Clean Accumulated Email 

• Do a fast sort of your emails from top to 
bottom which can make sure the most 
recent are at the top. 

• Review emails you received from NOT 
People: These might include newsletters, 
ads, spam, mail listservs, etc. Consider 
deleting all you can since you likely don’t 
need these, then sort the rest into other 
folders. 

• Review emails to NOT you: These can 
include forwarded emails for your info, 
CC’d emails so you have a copy, listserv 
emails to a group, and emails to a mailing 
list with other people besides you. 
Consider deleting all you can since you 
likely don’t need these, then sort the rest 
that has resource/reference information 
into folders. 

• Review the remaining unread email: Look 
for anything that really seems urgent, like 
emails with an action-needed Subject line, 
priority, sensitivity, and read-receipt 
attached to it to get your attention. Sort/
delete the rest as needed, and take care of 
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the rest of the business.0 
• Act upon emails to YOU from a real 

person: These are the priority emails you 
should want to get to and handle quickly. 
They could include specific-to-you 
homework issues, work benefits deadlines, 
work product/process follow-up, a 
calendar request for a task or online 
meeting, etc. 

Limit Outgoing Emails 

• DO send one email at a time when there 
is a specific need: Different subjects may 
actually need different decisions, and in 
this case, don’t lump 3 or 4 separate topics 
for discussion and decisions in a single 
email. The recipient may also be sorting 
emails for reference and later needs. 

• Don’t send many low-priority emails
when one will do: Use your drafts or a 
notes app to keep track of things that you 
want to send people that are not urgent or 
don’t belong to a specific project. Once 
you hit three things (like a couple of 
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newsletter links and a quick question), 
then send the email with three things 
instead of sending three separate emails. 

• Don’t choose Reply-All: Don’t start an 
email chain where everyone has to 
respond to the whole group and people 
end up being spammed when they don’t 
need/want to be. The fewer people on an 
email, the fewer responses you’ll get back. 
Consider using reply-all only if more than 
one person needs to know the email was 
responded to, if your response will 
influence others, and/or if the email 
impacts maybe 4 out of 5 people on the 
chain, AND let the recipients know if it is 
an info-only email or who needs to take 
action. 

• Give yourself time to back out: If an email 
may be a little challenging, or you might 
not have quite enough information, you 
might hold the email in your outbox for a 
couple of minutes, or even overnight, to 
think about it. Better to be kind, gracious, 
accurate, and professional than to be fast 
and inarticulate. 

• Send fewer emails: If you send out fewer 
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emails, you will receive fewer. Always ask 
yourself if an email needs to be sent out or 
if it can wait until later. Is it specific to a 
school or work product, or a confidential 
matter between you and one other person 
(like in Human Resources), or a necessary 
communication about something you 
need to get handled and have a “paper 
trail” on? Or, is it something the other 
person has to weed out? 

• Use Blind Carbon Copy (BCC) more: BCC 
is a way to keep people in the loop even 
when they are not the primary person an 
email is intended for. BCC on emails 
prevents other people from using to hit 
“reply-all” to spam the whole group. The 
Bcc’d recipient will know the email is sent 
without being subjected to all the chatter 
that happens afterward. It is also good if 
you want to include someone who may be 
affected by the email planning but hasn’t 
been included, like a supervisor, or another 
colleague who may be interested but not 
yet involved. 

• Use email positively: Avoid email as a way 
of breaking bad news to someone, if you 
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are upset, or if you are resolving a conflict. 
These things need face-to-face / a phone 
call / online conferencing so a discussion 
can happen, body language and voice 
inflections can be added, etc. 

Limit Incoming Emails 

• Mark It as Junk: If you can’t unsubscribe 
from something, consider marking it as 
junk. It will go to your junk mail folder so if 
you really need it in the next 30 days, it will 
be there, but it will also not be in your 
inbox and it will automatically disappear. 

• Move it to something else: Do you have a 
blog you follow that you get emails about? 
Instead of getting an email for it, sign up 
for an RSS service or just set a time on your 
calendar to go read the blog. If you are 
getting notifications from a service, just 
schedule a time to check that service 
instead of getting notifications. This goes 
for Twitter, Facebook, Slack, etc. 

• Turn off notifications: People often use 
emails as a notification system. The 
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purpose of a notification is to get your 
attention. If your inbox is full, then any 
notification there will not get your 
attention, so it doesn’t help. 

• Unsubscribe: Unsubscribe from anything 
you can manage. Before you make a rule 
or a workflow in how to handle something, 
decide if you really need it or not. An easy 
way to determine if you need something is 
by looking at how many of the emails from 
that subscription are unread. 

• Use rules: If you can create in-box rules, do 
so. You can sort emails by subject, by 
sender, by colorized category, and by 
keyword into other email folders so that 
you you have them but don’t need to read 
them immediately. You can even use rules 
to leave emails unread (important stuff to 
YOU) or mark them as read (listservs, 
newsletters, training offers). 

Email Crafting 

BE the organized person that you want to get 

168  |  Chapter 6: Email Management



emails from. Help others get your message and 
act on it fast so you don’t have to wait around. 

• Always identify the purpose and action 
needed in your email Subject. Examples: 

◦ ACTION: BUS108 Assignment question 
for Ch6Activity2 

◦ RESOURCE: URLs to Twitch Streamers 
you requested 

◦ QUESTION: Absent tomorrow, need 
timesheet now? 

◦ NOTE: Not available for this week’s 
Fiscal Subcommittee meeting. 

◦ REFERENCE: Steps for new “ghost 
students” drop process. 

• Don’t use a bunch of abbreviations, 
acronyms, misspellings, slang, or treat the 
email like a dashed-off text message to 
your best friend. Your instructor, 
supervisor, or service provider (tech help, 
shopping vendor, billing agent) don’t want 
– or have time – to interpret inarticulate 
info. 

• Use a simple and consistent email content 
structure that immediately tells your 
reader who, what, where, why, how and 
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when. Assume your email receiver will not 
know everything you know and give them 
the info the first time. (Example below). No 
one has time for little bits of information 
dribbled over 4-5 emails – especially your 
instructors. 

• Provide specific information, and a visual 
(or audio if appropriate) example, like a 
screenshot of the error message, or of the 
item giving you trouble. 

• End your email with a call to action and a 
timeline. 

• A “thank you for your time” or other 
kindness in closing makes a social and 
kind difference. 

• Check your spelling. 
• Add priority, or sensitivity, or a read receipt 

only if really needed. If every email from 
you is a rush, none of them will actually be 
treated as a rush. 

EXAMPLE EMAIL 

Subject line: ACTION: BUS108 Assignment 
question for Ch6Activity2 
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Hello. I have a question on Ch6Activity2 for the 
MS Word section, which is due in two days. I 
have already read through the chapter, 
followed the instructions, and also looked at 
the demo video link you posted in the 
assignment summary. 

However, I can’t get the color scheme to look 
like the assignment requires. I don’t get the 
blues and blue-greens in the MS Word color 
palette that the chapter refers to. I am working 
on a Mac, and the palette choices look different 
than in the video demo. 

Here is a screenshot of what my assignment 
looks like now (embedded or attached). Can 
you help me understand why I don’t have the 
color choice and what I can do? 

Thank you. 

Result: 

This covers who (the student), what 
(Assignment problem and what the student 
already tried and an example screenshot), 
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where (Ch6Activity2), why (color palette isn’t 
giving correct options), how (question of how 
to fix) and when (due in 2 days). As the 
instructor, I would likely recognize that the 
student might not be using the specific color 
palette mentioned at the beginning of the 
chapter, which means they are accessing a 
default MS Office color scheme and not the 
BlueGreen palette the assignment actually 
asked for. Or, I might ask the student for a 
screenshot of the available Mac palettes so we 
can pick a close similarity. An easy fix, well 
before deadline! 
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Chapter 7: 
Microsoft® 
Word® 

What We’ll Cover >>> 

• Word Processing Software 
• Microsoft Word 
• Documents 
• Text / Paragraph Formatting 
• Document Formatting 
• Inserting Items 
• References/Citations 
• Review and Distribution 

A word processor is software or a device that 
allows users to create, edit, and print 
documents. Software enables you to write text, 
store it electronically, display it on a screen, 
modify it by entering commands and 
characters from the keyboard, and print it. Of 
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all computer applications, word processing is 
the most common. 

Word processing has evolved into much more 
than words typed on a piece of paper. It is a 
means to communicate with others through 
letters, flyers, essays, articles, research papers, 
books, and reports. It lets a user create content 
for websites, graphic design materials, blogs, 
and publications. Modern word processing 
software and applications are integrated into 
the cloud. If you save your documents to your 
cloud-based storage, you can retrieve them 
from any device and continue to work with and 
share your documents. 

Word Processing Software 

Word processing software can be part of an 
integrated suite of tools, or be stand-alone. It 
can be installed on a computer for full and 
robust features and integration with other 
resources; it can be accessed on the web in a 
light format, and it can be a basic utility tool, 
like text editing applications. Some programs/
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suites are payware, such as those used in many 
workplaces; others are shareware or freeware. 
Information in this chapter should offer you 
transferrable skills for use in any word 
processing application. 

Common word processing software: 

• Apple Pages: Included with most Apple 
devices. Real time collaboration for 
creating, modifying, sharing, and 
distributing word processing documents. 

• Google Docs: Integrates with other Google 
Apps, Q&A feature, has advanced word 
processing features. 

• MS Word: Available across many platforms 
including mobile devices for ease of use. 
Integrates well with MS Office. 

• Smartphone apps that allow for quick use 
and editing on-the-go. 

• Word processing apps in free/open source 
office suites. 

Since Microsoft® Word® (MS Word, Word) is 
widely used in industry, and we are using 
Microsoft® Windows®, we will focus on Word 
going forward. There are many similarities 
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across word processing software, so the skills 
we are learning can be translated to other 
software and apps. The following Try Me 
activities are designed to be completed using 
the downloaded version of Microsoft Word in 
Office 365 on a PC with Windows 10 or higher. 
While MS Office Online is a great free app, it 
won’t provide all the support and built-in 
options the full version does. 

Microsoft Word 

Microsoft Word is a productivity word 
processing program. It is primarily used for 
text-related tasks, like correspondence, lists, 
reports, publications, etc. It can have added 
visual communication items like tables, clipart, 
images, and SmartArt hierarchy graphics. It has 
support for use in a MS Office workflow with 
Excel, Access, PowerPoint, and Outlook. 

DEMO EXAMPLE follow-through 

• In your Computer desktop area, look for 
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and use the relevant start menu to 
navigate to your activities files. 

• Per the Using this book as a course 
section, you can create, then save 
activities files in your BUSTECH directory, 
Activities folder, MS_Word subfolder. If you 
plan to use a provided file, make a copy 
for your working subfolder so that the 
original file will remain untouched. 

Accessing Word 

• In your Computer, use the relevant start 
menu to open MS Word (look for little blue 
icon). On a PC this is a start button on the 
keyboard, and/or menu on the lower left of 
the screen. On a Mac, this should be in the 
top-screen Menu option. 

• Word will open with options to create a 
blank file, open an existing file, and use 
templates. 
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The User Interface (UI) menus 

MedAttrib: author-generated. MS Word user 
interface with context dropdown menu. 

In Word, the user interface contains several 
menu tabs (tab, menu), with ‘Ribbons’ (ribbon) 
that display icons (like buttons) with text 
descriptions of various activities related to a 
task. On a ribbon, you will often see groups 
(group) of icons for tasks that relate to one 
another, like the Home ribbon’s Font group, 
Paragraph group, etc. Some of these icon 
buttons will do a simple task in one step, while 
others may open a panel (panel) which is a 
detailed, multi step or tab window of options. 
Sometimes you may instead see a context 
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dropdown (dropdown) menus of options, or a 
dialog box (dialog) with a couple of fields to 
complete.. Shown (in the program’s order) are: 

• File: Accesses the program backstage area 
for various options. Set your preferences 
for workflow and productivity. 

• Home: Basic text functions like formatting, 
positioning, styles. 

• Insert: tables, images, shapes, charts, page 
sections. 

• Design: themes and related items 
• Page Layout: Layout of the pages, 

including margins, positioning, indents, 
etc. 

• References: Used for research papers 
needing footnotes, endnotes, tables of 
contents, etc. 

• Mailings: Allows mail merge from 
spreadsheet or database table data (like 
names and addresses). 

• Review: Spelling, language, document 
change tracking, etc. 

• View: screen views, rulers, gridlines, 
windows. 

• Additional add-in/specialty tab menus: 
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These are dependent on having MS Word-
related add-ins like Acrobat, a reference 
manager, etc. 

• Contextual tab menus: These are 
contingent on a specific item in the 
program’s workspace being activated. For 
instance, clinking on an image, table, or 
header / footer will activate a context 
menu/ribbon on the right side of the UI 
that shows a menu dedicated to actions 
that can be done specifically for the active 
item (picture editing). 

We’ll cover more detail on specific Menu 
toolbar ribbons in the following demo sections. 

Documents 

Documents are made up of pages with 
content. This whole book is a document. Their 
common MS Word file extension is .docx. They 
can contain: 

• Text paragraphs and lists 
• Images, tables, SmartArt, shapes, and clip 
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art 
• Headings, subheadings, captions, and 

paragraph text 
• Page and section breaks, columns, and 

header / footer information 

Views – View Tab 

• You can see different views as part of the 
main interface – lower right-hand side of 
the user interface, and also from the View 
tab’s ribbon. 

• You can set rulers on or off. 
• You can also set guides for aligning text 

and images. 
• You can choose the window view you like 

to work in, such as draft, outline, and print 
layouts. 

Preferences – File tab 

You can set your Word program preferences 
for documents and program workflow, for 
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smoother productivity, in the ‘backstage’ area 
of the program. 

• Same layout as PowerPoint, Excel, and 
Access 

• Allows personalizing, print, save, and 
publish settings 

• Preferences: Word Options: 
• Customize editing, saving, and other 

program options 
• Personalize a mini-toolbar so you can 

minimize the ribbon 

Text / Paragraph Formatting 

Paragraphs 

In word processing “paragraphs” refer to 
batches of text, with headings, paragraphs, 
lists, etc. Paragraph formatting includes 
indenting, spacing, and alignment. For 
instance, the alignment of text can be left, 
right, centered, or justified alignment; this 
paragraph is in Left alignment. 
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Creating new text 

If you don’t yet have text to work on yet when 
creating a document and setting paragraph 
formatting to use later as a saved style, 
consider using Lorem Ipsum, or one of its 
variants. Fun text fillers can include KittyIpsum, 
BaconIpsum, or ZombieIpsum. You can find 
Ipsum generators free online and copy/paste 
gibberish paragraphs into your document so 
you can play with some chunks of text. Let’s try 
some KittyIpsum now! 

[Nap all day cat dog hate mouse eat string 
barf pillow no baths hate everything but kitty 
poochy. Sleep on keyboard toy mouse squeak 
roll over. Mesmerizing birds. Poop on grasses 
licks paws destroy couch intently sniff hand. 
The dog smells bad gnaw the corn cob.] 

Home tab – Clipboard Group 

At the very left of the Ribbon is the clipboard 
group, which is a small set of tools you can 
use in relation to when text, images, and styles 
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have been saved to the clipboard as you work. 
Clipboard-related activities include: 

• Copy 
• Cut 
• Paste 
• Redo 
• Undo 
• Paintbrush 
• Moving info by dragging 

Format Painter – Home tab 
clipboard group 

• Allows you to “capture” an existing style 
and apply it to any object you click on 

• Single-click applies once 
• Double-click locks so you can reuse it 

Understanding the clipboard 

See the Clipboard Pane by clicking Home tab/
Clipboard section expander icon 
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• Can “store” numerous pieces of text and 
images 

• Items are stored temporarily (in RAM) until 
the program is closed 

• You can also delete items off the clipboard 
• You can store them and then choose 

which one to paste 

Home tab – Font Group 

“Fonts” refer to the letters (characters) used in 
text. Font formatting includes resizing, 
changing the font family, adding bold or 
emphasis, adjusting spacing between letters, 
and more. You can right-click on a word or 
cluster of words for the contextual menu, or 
use the Home Tab’s font group options. These 
include: 

• Style (font family) 
• Size 
• Color 
• Bold, italics, underlining, strike-through 
• Changing text case 
• Effects like highlighting 
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• Advanced formatting, like spacing 

MedAttrib: author-generated. MS Word Font 
panel. 
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Home tab – Paragraph Group 

You can modify your paragraphs in several 
ways. You can right-click on a piece of text, and 
choose “Paragraph” from the contextual menu. 
You can instead select some text, and use the 
Home ribbon’s one-touch paragraph group 
icons. You can also select some text, and 
choose the Home Tab’s paragraph group panel 
opener. With any of these, you can do: 

• Alignment: Determine how text will 
appear in a document: left, right, centered, 
justified 

• Spacing: Single, double, and other-width 
spacing between lines in a paragraph 

• Indenting / Tabbing: Set tabbed indents, 
or pre-set first-line or full paragraph 
indents 

• Call-out: Use bullets or numbers in lists 
• Shading: Paints background coloring 

behind a paragraphs of text 
• Borders: Applies lines above, below, and/or 

around paragraphs of text 
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Paragraph panel 

The paragraph panel, which you can open 
from the lower right corner of the Home 
ribbon’s paragraph group, reveals a panel with 
several tabs of options. 
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MedAttrib: author-generated. MS Word 
Paragraph panel. 

• Spacing before and after 
• Specific indentations 
• Line spacing 
• Tab stops 
• Line and page breaks 

ACTION: MS Word Try Me Activity #1 

Let’s do a few basic text formatting tasks. If you 
have Word open, let’s use the 
Word_textbasics.docx file that should be in 
your DataFiles folder. 

• If Word isn’t open yet, open MS Word. 

On the start screen, or from the File tab, choose 
to open a file. You will likely need to navigate 
through your computer to find the file. You can 
do this from the File tab’s Open screen by 
selecting Other Locations/Browse, then 
browsing to wherever you stored your 
BUSTECH directory, then to the DataFiles 
folder. 
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• Look there for the Word_textbasics.docx 
file, then open it. 

• Next, and this is important: Use the File 
tab again, but choose SAVE AS. In the 
navigation window, back out of your 
DataFiles folder, then enter the Examples 
folder then into your MS_Word folder. 

• Then, save your file as 
Word_textbasicsWork.docx. 

This gives you a saved copy of the file to work 
on, while still leaving the original copy of the 
file in the DataFiles folder. 

With your Word_textbasicsWork.docx file 
open, you should see plain text that starts with 
Get involved! We’ll use this for basic text 
formatting practice. Our goal is to simply use 
several Home tab Font group and Paragraph 
group options to make the document look 
more readable. Just follow along! 

• Select the text Get involved! This is at the 
top, and is the title. 

• Use the Home tab’s Font group to find the 
font size, and change the Get involved! 
Text to 24, This represents 24 points (a 
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point, in text, is just the character size). 
• Then, use the Bold icon to make the text 

bold. 
• Next, use the Font color icon to choose a 

dark color you like, such as dark blue, dark 
orange, etc. 

The title should now be larger, bold, and a 
different color. 

• Click away from the title, then select all of 
the rest of the text, so that we can change 
the font type (font family, font face). 

• With the text selected, use the Home tab’s 
Font group Font selector, and look at the 
existing font. Depending on your 
computer, it is likely Times New Roman (or 
a variant of Times). 

• Choose Arial from the Font dropdown list 
(click the arrow to activate that). 

Next, let’s adjust the spacing of the lines from 
each other. In the Home tab’s Paragraph group, 
choose the Line and Paragraph Spacing icon, 
then choose 1.15. This gives a little more space 
between text lines. 
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• Choose the Line and Paragraph Spacing 
icon again, and click the Add Space After 
Paragraph option. That doesn’t affect all 
lines within a paragraph (clump) of text, 
but between the paragraphs. 

However, this doesn’t look much easier to read, 
because there are a lot of one-line paragraphs. 
Several are actually a list of things for the 
sentence How can you get involved? Let’s 
make those bulleted list items. 

• Select only the 8 lines, then in the 
Paragraph group, click the Bullets icon. 
The 8 lines will close up together and show 
a little round bullet in from of them. 

TIP: List Items. Bullets in a list tend to be 
for listing things in no order of 
importance. A numbered list is for if you 
have steps in order, or a list with items 
already in order of priority. 

Now, let’s add just a bit more emphasis to the 
document’s text. 
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• Select the line How can you get involved? 
– which should not be in the bulleted list. 

• Use the Italics icon in the Font group to 
italicize the line. 

• Select the line What would YOU like to do? 
– which should not be in the bulleted list. 

• Use the Bold icon to bold the line. 
• Select only the word YOU in the line, and 

use the Underline icon in the Font group 
to underline it. 

Now, let’s establish an important habit. 

• SAVE your work as you go: the Use the 
File tab’s Save command, or the Quick 
Access Toolbar disk icon. The keybind 
shortcut is CTRL S / MAC Users: CMD S. 

• Keep this file open for the next steps. 
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MedAttrib: author-generated. MS Word user 
font formatting. 

Let’s practice with the Home tab’s Clipboard 
group. 

In your currently open 
Word_textbasicsWork.docx file, select the last 
line of text. 

• Copy it by using the Home tab’s Clipboard 
group Copy icon. 

• Press Enter twice to add space to the 
bottom of the page. 
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• Paste the line of text by using the Home 
tab’s Clipboard group Paste icon. 

• Press Enter once to add a paragraph 
space. 

• Paste the line of text again by using the 
Home tab’s Clipboard group Paste icon. 

• Using the bold icon, make the first of the 
two lines Bold. 

• Then, select the newly bold line, and then 
click on the paintbrush icon in the Home 
tab’s Clipboard group. The icon will change 
color a bit, which shows you have ‘loaded’ 
the format painter paintbrush with the 
bold style of the line of text. 

• Then, with the paintbrush loaded, select 
the 2nd line of text. This should turn bold as 
well. 

• To undo the last step, you can use the 
CTRL Z shortcut/ CMD Z for MAC. 
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Keyboard Shortcut > UNdo. The 
Quickbar usually has the Undo icon on 
it (looks like a backwards curved arrow, 
but if it doesn’t, learn this keybind: CTRL 
Z shortcut (CMD Z for MAC users.) 

Keyboard Shortcut > REdo. The 
Quickbar usually has the Redo icon on 
it too (looks like a forwards curved 
arrow, but if it doesn’t, learn this 
keybind: CTRL Y shortcut (CMD Y for 
MAC users.) 

• You’ll be using these skills all through 
learning Word, so we’ll pause here. 

• SAVE your work: CTRL S / MAC CMD S. 
Close the file. MS WORD ACTIVITY #1 
FINISHED. 

Document Formatting 

Text and paragraph formatting are parts of 
what happens in a document. This section is 
about the overall document itself – how it will 
present when printed out and consumed by 

196  |  Chapter 7: Microsoft® Word®



users. Document formatting is characterized 
by actions that can affect the whole document, 
and in so doing, add efficiency and steps-
saving to general text and paragraph 
formatting. These include document layout, 
themes and styles, headers and footers, and 
some use of sectioning. 

Setting up documents – Page 
Layout tab 

The Page Layout tab allows you to set the 
physical format of your page, which is a good 
starting step in word processing work. This 
determines how large the paper used will be, 
the margins, the orientation of the document, 
etc. In the Layout tab’s ribbon, you can use the 
page setup group icon dropdowns, or the 
group’s panel activation arrow, to accomplish 
(in order of page setup group): 

• Page margins: the white space around the 
edges of a page that won’t be printed on , 
and also which adds white space around a 
document’s content for viewability. Normal 
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gives a printed document lots of white 
space at the top, bottom, and sides of the 
sheet of paper, and is often used for 
papers and business documents. Narrow 
gives less, and isn’t very effective for 
business documents. Moderate is 
somewhere in between and is useful for 
casual use. 

• Page orientation: the height and width 
direction of a page. Default and common 
use is Portrait, in which a document is 
taller than wide. Horizontal can be useful 
in reports and presentation style formats 
like brochures, flyers, and documents 
which might import wide tables and 
graphs. 

• Page size: the paper size of a document, 
even if it never is intended to be printed on 
paper. Users may choose to print the 
document, print a PDF, and or take a 
screenshot image for later printing/
pasting into another document. The 
default is 8.5 x 11 inches, with other 
common page sizes being legal (8.5 x 14 
inches), and ledger (11 x 14inches). Other 
listed sizes may be legacy for office 
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documents. 
• Columns: A page’s content defaults to 

being one-column – page wide from the 
left to the right margin. It can be changed 
to two or three or multiple column 
numbers. If it is, it will reflect through the 
entire document unless special column 
breaks, or special unlinked document 
sections are created, and the different 
column number used in only a section. 

• Breaks: You can create a new page break, 
a break to begin and end a different 
column style, or wrap text around an 
inserted image, and add new section 
breaks. 

Designing documents – Design 
tab 

Themes apply decorative styles to your Word 
document, such as fonts, colors, effect options, 
paragraph spacing, etc. They can give a set of 
documents a consistent and attractive 
appearance and make your word processing 
efforts look more professional. In business, they 
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are best used as part of a “package” of 
documents, such as a letterhead and envelope 
set or as part of a report style. They can 
enhance what you want to communicate by 
adding company branding colors and fonts. 
You can also: 

• Make your document more readable than 
just black-and-white text 

• Tie consistent inserts, like shapes and 
borders, together with the rest of the 
document’s “look” 

• Use different colors and font styles to 
punctuate headings from text 

• Help your reader respond and/or act in the 
way you need, and 

• Easily update the whole look of your 
document just by changing the color or 
font variants 

Design: Theming / Design Tips 

Using themes can be a double-edged sword. 
While they can add attractiveness to your 
documents, they can also, if misused, make 
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your work look confusing, be hard to read, and 
muddy your communication message. Certain 
types of work should not use themes, like cover 
letters and resumes, which are routinely 
expected to be plain and standardized and 
which the receiver will likely scan into a 
program for database acquisition. 

• Choose theme colors that make sense for 
the product, service, or idea(s) you are 
trying to communicate. 

• Choose theme backgrounds that have 
good contrast and allow text to be very 
easy to read. 

• Choose fonts for readability, based on need 
for headlines, lots of paragraph texts, easy 
bulleting, etc. 

• Remember that less is more – more colors 
and font variations in one document can 
look unprofessional and take away from 
your message. 

• Use themes only when you have full 
control over your own document – if you 
have an instructor or employer who does 
not want them used, then instead focus on 
using a template of the required styling. 
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Design: Theme Variants 

Theme variants let you change aspects of a 
theme you select to apply a different core font 
family to it, or to change the color palette it will 
work with. 

• Fonts: Font families in themes are 
designed and sized to be readable and 
hopefully scannable by screen readers for 
accessibility use. The style will offer a font 
for titles/subtitles, and another for general 
text. Available font families come installed 
with the computer’s operating system, 
and may also be accessed from the word 
processing software’s installation or cloud-
based accessories. 

• Color Palettes: Like fonts, color palettes are 
included in a style, and can also be 
changed independently to modify and 
create a new style. For instance, the overall 
design style of a theme may work for you, 
but the color palette assigned to it may 
not have enough contrast for your 
audience, or your company may focus on a 
different rage of core colors. 
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• Effects: These are subtle styles that can be 
attached to some inserted items, like 
image borders, shapes, SmartArt, etc. 

Theme Additions 

• Paragraph Spacing: This allows you to 
modify a theme’s look of document line 
formatting between paragraphs. 

• Page Color: This allows assigning a color to 
a full page of a document, and acts as if 
the paper itself would be that color. 

• Page Borders: This allows assigning a 
border to a full page of a document. 
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MedAttrib: author-generated. MS Word 
Design/Themes. 

ACTION: MS Word Try Me Activity 
#2 

Let’s do a few document formatting tasks. Let’s 
use the Word_resumestarter.docx file that 
should be in your DataFiles folder. 

Before you start, you should use your file 
manager utility to make a copy of the 
Word_resumestarter.docx file that is in your 
DataFiles folder, then paste the copy into your 
Examples / MS_Word folder. 

• If Word isn’t open yet, open MS Word. 
• In the File tab Backstage area, choose to 

open a file. Use the browser dialog panel 
to locate the Word_resumestarter.docx 
file that should be in your Examples / 
MS_Word folder, then open it. 

You should see a couple of pages of plain text 
that starts with information about cover letters. 
We’ll use this for document formatting 
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practice. Our goal is to simply use several Word 
options to modify this document: 

• Home tab Font and Paragraph group 
options 

• Design tab Document Formatting group 
options 

• Layout tab Page Setup group options 

In creating/inheriting a plain document, it is 
efficient to go from the big changes down to 
the small ones. The big changes tend to be 
those that affect the whole document, like its 
margins, page size, and theme, while smaller 
changes affect parts of the document, like a 
paragraph, a word, an image, etc. We’ll take 
this approach, rather than using the Word tab 
ribbons in order that they appear in the user 
interface. 

Let’s learn about document layout in practice. 
A word processing document is going to be 
distributed in some way so that it can inform 
others – as a cover letter, a brochure, a report, 
a research paper, etc. For others to get at the 
information – whether printed or by email 
attachment – it needs to be readable, 
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accessible, and not visually confusing. Layout 
options help structure the content of a 
document into a useful format. 

• Click anywhere in the 
Word_resumestarter.docx file. Layout 
settings are not depended on choosing 
specific text. Use the Layout tab Page 
Setup group for the following tasks. 

• Select the Margins tab, and consider the 
options. Moderate is somewhere in 
between, and we will use it. Using the 
Margins icon, choose Moderate. 

• Select the Orientation icon; the document 
is set to landscape, which is too wide for 
cover letters and resumes. Choose Portrait, 
which we will use for a standard taller-
than-wider document appearance. 

• Select the Size icon, which is set to default 
to Legal size. This is also too large, so 
choose the Letter (8.5×11 inches) option for 
standard paper size. 

There is one more layout change we should 
make, but this one does require you to place 
your cursor specifically. We need to formally 
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separate the cover letter page from the resume 
page, and we can use a Section break to do this. 

• Click just before the first word of the line 
that begins A resume is one required… 
With your cursor just before the word A, 
use the Layout tab Page Setup group 
Breaks icon and choose the Page break 
option. 

• SAVE your work as you go: The keybind 
shortcut is CTRL S. MAC Users: CMD S. 

Now, Use the Design tab Document 
Formatting group for the following tasks. 
Again, you can be anywhere in the 
Word_resumestarter.docx file, since Design 
isn’t dependent on selecting specific text. 

• Click the Themes icon, which opens a 
panel that has icon examples of a bunch of 
themes. The document is using the 
default Office theme, which you can 
identify because it seems to have a gray 
selection shadow around the theme icon. 

• Let’s choose the Basis style ( Macs may not 
have this; if not, choose something else 
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that looks easy to read.) 
• The color palette for the Basis style might 

not appeal to you. For cover letters and 
resumes, colors are not good. Click the 
Colors icon to see a dropdown list of color 
batches (palettes) to choose from, and 
select Grayscale. 

• The fonts palette for the Basis style also 
might not be something you like. For a 
cover letter or resume, fonts should be 
easy to read. 

• Click the Fonts icon to see a dropdown list 
of Font combinations (palettes) to choose 
from, and select one you like better. 

• Cover letters and resumes don’t usually 
use effects, but you could click the Effect 
icon to see what options are available for 
adding a little pizzazz to items you can 
insert into a document, like shapes, 
images and their borders, etc. Pick one if 
you’d like. 

• SAVE your work: CTRL S / MAC CMD S. 

Let’s deal with paragraph formatting using the 
Paragraph panel. You do not need to select text 
for this, just click anywhere in the document. 
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You can access this from the Home tab’s 
Paragraph group, which has a small arrow in 
the lower right corner of the group that opens 
the Paragraph panel. There are two tabs; we 
will focus on the first – Indents and spacing. 
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MedAttrib: author-generated. MS Word 
Paragraph panel indents tab. 

Cover letters and resumes don’t usually use 
indents to the paragraphs; instead, the 
paragraphs have extra space between them. 

• In the Word_resumestarter.docx file, the 
space after paragraphs is set to 10 pt; 
change it to 6 pt. 

• The Line spacing is set to Multiple 1.15; 
change it to Single. 

That should do it for this document’s 
paragraph settings. 

Now the document layout and theme design/
colors has been set up. You can work on the 
more paragraph and text-specific activities. 

We’ll do a little refresher practice, but not too 
much font-formatting since we will use this 
document later for the Styles panel activities. 

• Scroll to the top of page one. There are 3 
lines of text which are all separate 
paragraphs, which have space between 
them. We should close these up. 
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• Make the 3 lines all text on one line 
instead, by bringing the second line up to 
the end of the first line, and the third line 
up to the end of the second line. You can 
use your backspace key for that, to get: 
Whatever school Street address City state 
zip. 

• Place your cursor just before the word 
Street, then hold your shift key down and 
press Enter. 

• Place your cursor just before the word City, 
then hold your shift key down and press 
Enter. 

• On the first page, select the first half of the 
text of the first big paragraph. Your 
selection should end before the word 
Hello. With this text selected, use the 
Home tab’s Italics icon to italicize the text. 

• Take the same step for the text in 
Paragraph 2 that ends before I am a 
multidisciplinary. 

• Take the same step for the text in 
Paragraph 2 that ends before My portfolio 
is at. 

• SAVE your work: CTRL S / MAC CMD S. 
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On page 2, we’ll do more of this. 

• Italicize the first paragraph. 
• In the third paragraph, italicize I often start 

with a short intro statement, like: . 
• Now, just to practice Font formatting a 

little more, let’s change the font face, size, 
and color for the subheaders on the 2nd 

page (resume) text. 
• For Objective or History: Use the Home 

tab’s Font group to change this to 14 pt, 
Bold, Dark gray (choose a dark gray by 
sight.) 

• Use the Home tab’s Clipboard group’s 
Format Painter to pick up the style and 
apply it to the other subheaders (see 
below). Select the formatted phrase 
Objective or History, and double-click the 
Format Painter icon, which will attach the 
style to it and be reusable for more than 
one application. Then apply the Format 
Painter styling to: 

• Skills, Projects/Accomplishments, 
Experience, Education, Key Words 

• When finished, click Once on the Format 
Painter icon to turn it off. 
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We’ll use a variation of this document for Styles 
a little later. 

• SAVE your work: CTRL S / MAC CMD S. 
Close the file. MS WORD ACTIVITY #2 
FINISHED. 

MedAttrib: author-generated. MS Word 
example resume starter file. 

More advanced formatting 

Styles – Home tab: MS Word allows you to 
create specific, non-theme-related styles for 
how your text, titles, subtitles, and references 
look. Styles WILL appear in a theme’s use and 
affect the fonts used, spacing and layout of 
paragraphs, and even colors / emphasis of text. 
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However, they are not reliant on using different 
themes, especially if you have a goal of creating 
a new default set of styles for a document or 
future templates. 

• There are basic Word pre-created styles. 
These can be used as is, or modified. This 
book modified several Word styles to 
create simplicity and accessibility-facing 
styles for screen readers and visual readers 
alike. 

• You can change the Normal style – font 
used, paragraph and line spacing, etc. 

• You can create new styles and apply them 
to other documents. 

• You can also export styles to another 
program, like Adobe InDesign, for 
publication projects. 

Using Styles 

Using styles can make your work much more 
efficient and easier to update than just using 
one-touch editing. The time investment for 
using/creating styles for a one or two page 
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document might seem wasteful, but if you 
have more than four or five pages (think 
twenty-five or one hundred) styles make the 
most sense. They are also useful if you want 
to clear an entire style set and start from a 
theme’s built-in styles. 

Styles also make great sense if you want to 
replicate the look and feel of document text 
over and over again. You can save styles you 
create or modify. You can also adjust them with 
themes and palettes. 

Styles affect every part of your text, from titles, 
headers, paragraphs, lists, and captions. 

Applying styles 

Basically, you want to apply styles, and save 
changes you make to your style types, early on 
in a document. That way you can have the style 
apply itself automatically as you develop your 
document – this method is best for documents 
that will be longer than just a few pages. 
However, you can choose to apply styles to an 
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existing document instead. Hust use the Home 
Tab’s Styles options: 

• Choose a style from the gallery, which will 
reflect colors and fonts that belong to the 
document’s theme. 

• Choose the Styles Options to open the 
Styles Panel so you can make specific style 
changes, add new styles, and save style 
modifications you make. 

• Styles may apply to primarily paragraph 
text, or to fonts, or to both. 

Style Outline/hierarchy 

• Word reserves names for basic types of 
text used in reports, like headings, 
captions, body text, etc. Headings also 
refer to the core headings use in web 
pages and how headings translate to 
screen readers. For instance, this textbook 
uses the Title style once – for the book title. 
The section titles use Heading 2, the 
chapter titles use Heading 3, and the 
chapter segments use Heading 4. Other 
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styles you see here, like sub sections, use 
variations on the normal style – like bold 
subtitles, normal text, the bulleted lists, 
etc. 

• When you use Word styles, each type of 
text is considered and styled. 

• When you change a style, it will affect all 
the headings and body text. If you want 
this to not happen, consider creating a 
new style based on (no style). 

• Keeping this outline/hierarchy in mind 
helps you keep your styling streamlined 
and easy to change later. 

ACTION: MS Word Try Me Activity 
#3 

Let’s do a few document formatting tasks. Let’s 
use the Word_stylesstarter.docx file that 
should be in your DataFiles folder. 

Before you start, you should use your file 
manager utility to make a copy of the 
Word_stylesstarter.docx file that is in your 
DataFiles folder, then paste the copy into your 
Examples / MS_Word folder. 
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• If Word isn’t open yet, open MS Word. 
• Open a file, and use the browser dialog 

panel to find the Word_stylesstarter.docx 
file that should be in your Examples / 
MS_Word folder, then open it. 

This document is a variation of the theme and 
layout document we worked with, but 
unnecessary text has been removed. The text 
that is there is a placeholder that you can 
replace with your own information so that you 
can really use this document for yourself. 

Like when we worked on the document before, 
we want to take care of big changes that affect 
the whole document before we focus on 
specific parts like subheaders and lists. This 
document was previously set for the Basis 
theme and the Grayscale color palette, which 
will affect the Style changes we make. 

• Select all the text in the document. 
• Look at the current font currently being 

used: Times New Roman. We want to use 
the Basis theme’s font styles and this text 
may not be that. Let’s find out. 

• In the Home tab Styles group, look for the 
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Styles group, and click on the Styles icon. 

This opens a dropdown panel of available quick 
styles for simply clicking and using. 

MedAttrib: author-generated. MS Word quick 
Styles panel. 

With all the document’s text selected, click on 
the Normal style. Even if the style seems to 
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already be selected, it might not apply to the 
whole document until you click it. 

The text changes font face. Look at the Home 
tab’s Font field, which now shows Corbel. 

• Next, deselect the text. 
• Scroll to the second page, and select the 

text Objective or History. 
• Use the Home tab’s quick Styles to 

change this to Header 2. 
• Use the Home tab’s Clipboard group’s 

Format Painter to pick up the style and 
apply it to the other subheaders (see 
below). Select the formatted phrase 
Objective or History, and double-click the 
Format Painter icon, which will attach the 
style to it and be reusable for more than 
one application. Then apply the Format 
Painter styling to the subheadings: 

• Skills, Projects/Accomplishments, 
Experience, Education, Key Words 

• When finished, click Once on the Format 
Painter icon to turn it off. 

• On the second page, select the 8 single 
lines below the paragraph that fall under 
Skills. 

220  |  Chapter 7: Microsoft® Word®



• Use the Home tab’s quick Styles to change 
this to List Paragraph. 

• SAVE your work: CTRL S / MAC CMD S. 

Now, we’ve restyled the document with styles! 
But. . . it doesn’t really look that accessible to 
read – the text is small, and the list of skills looks 
odd, and the headings of the resume seem. . . 
light and hard to read. 

Now, we could change themes, or change fonts 
of the theme’s design. However, that is not a 
useful process, since you may be using 
someone else’s theme requirements. Also, 
Styles lets you easily modify styles even in a 
theme. And, if you like the modifications, you 
can save them into a new theme that you can 
reuse. 

In your document, click into one of the 
paragraphs on the first page – just be sure to 
be in the Normal text we set. 

• In the Home tab Styles group, open the 
Styles modification panel by clicking the 
small arrow on the lower right side of the 
group. 
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MedAttrib: author-generated. MS Word Styles 
panel. 

• If you hover over the Normal style listed in 
the panel, you will see a pop-up that 
shows what the style is made up of. A style 
can include a font, paragraph styling, and 
more. 

We want to change the Normal style so that it 
is easier to read. Right now, the document is 
mostly 11pt in font size. Let’s change the normal 
style to 12pt size for a little more readability. 
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At the right side of each style name, you can 
see a little symbol. A backwards P-like symbol 
indicates the style has paragraph styling. That 
symbol paired with a small a symbol indicates 
the paragraph and font are both styles and also 
that the style is based on another style. Only 
a small a symbol indicates style has only font 
styling. Any of them can be changed. When 
you want to change a style, if you hover over 
the style, you will see a dropdown arrow to the 
right. 

• To the right of the Normal style, click on 
the dropdown arrow, and choose Modify. 
This will open the Modify Style panel so 
you can modify a style’s font, paragraph, 
tab, and other parameters. 
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MedAttrib: author-generated. MS Word Modify 
Styles panel. 

• In the panel, let’s just change the font size 
to 12, then click OK, which will change the 
Normal style font size. 

• Leave the Styles panel open. 
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In the document, you can see that the Normal 
text is now 12pt in size. 

Next, click on one of the Resume headings, 
which we already changed to the style Header 
2. When you plan to modify a style, you can be 
anywhere in a document, but to be sure you 
only influence a specifically-styled selection of 
text, insert your cursor in that text. 

• In the Style panel, hover over Header 2 
then click on the dropdown arrow and 
select Modify. 

• In the Font area, observe that the style is 13 
points and a medium gray in color. 
Change the font size to 14, and click the 
color to get a dropdown of the Grayscale 
color palette. 

• In the palette, look for a darker gray, like 
Black Text 1 Lighter 35%. You can observe 
the color options when you hover over a 
selection. 

• Click OK, which will return you to the 
Modify Style panel. Stay in here, so we can 
also change the Paragraph style to add 
more space before each of the resume 
headers. 
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• In the Modify Style panel, look to the lower 
left for the Format button, and click it. 

• In the dropdown, choose Paragraph, 
which will open the Paragraph panel. 

• In the Paragraph panel, change the Before 
space from 2 pt to 6 pt, then click OK, and 
then OK again to exit the Modify Style 
panel. 

Click in the resume’s list of skills so that we can 
modify this style too. 

• In the Style panel, hover over List 
Paragraph, then click on the dropdown 
arrow and select Modify. 

• In the Modify Style panel, look to the lower 
left for the Format button, and click it. 

• In the dropdown, choose Numbering, 
which will open the Numbering and 
Bullets panel. 

• In the Numbering and Bullets panel, 
choose the Bullet tab. In that tab, choose 
the round bullet, then click OK. Stay in the 
Modify Style panel because we are not 
finished with this style. 

• The bulleted list is indented further than 
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looks elegant, so let’s also change that 
indent. In the Modify Style panel, click the 
Format button again, and select 
Paragraph. 

• In the Paragraph panel, look for the 
Indentation Left, which shows .75. Change 
that to .5, then click OK, then OK again to 
exit the Modify Style panel. 

• Close the Styles panel since we are done 
using Styles. 

• SAVE your work: CTRL S / MAC CMD S. 
• Leave this file open since we are not quite 

finished. 
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Numbers and Bullets panel. 
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Headers and Footers – Insert 
tab 

Space on Word documents that can and 
should show repetitive information are called 
Headers and footers. This space appears in the 
margin space at the top and bottom of a page, 
and part of the Margins setup (Layout tab/
Margins) accounts for that. 

• Header: Space between the top of your 
body text and the top margin of the page 

• Footer: Space between the bottom of your 
body text and the bottom margin of the 
page 

In Page Layout view, double-click the top or 
bottom space on the page to “open” them, or 
use the Insert tab, Header/Footer section. Once 
you access a header or footer space in your 
document view, a context Header & Footer 
menu/ribbon appears at the top left of your 
Ribbon space, which allows you to add various 
items: 

• Date 
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• Page number 
• Other document information, like location, 

file name, etc. 

In our Word_stylesstarter.docx file, there is 
something important missing – primarily from 
the resume. What is it? The name of the 
person! The cover letter example refers to me 
(L.J. Bothell), but the resume does not. 

We will use a Header to change that, and what 
we learn for headers can also be applied to 
footers. 

• In the file, scroll to the top. Then, look in 
the Insert ribbon for the Header & Footer 
group. In that group, click Header. 

• In the dropdown selection, simply choose 
the first selection, which will open the 
space between the top of your document 
text and the edge of the sheet. 
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TIP: Header & Footer. Headers and 
Footers can be managed the same way, 
with the Header & Footer contextual 
ribbon that is available when you are in 
a header or footer part of a document. 

Us the Header & Footer contextual ribbon to 
look at the Position group. The Header is set 
to be .5 inches from the top, which is fine for 
this document. If text in a header needs more 
space, it will push down the text of the 
document. In our case, we are simply going to 
add one line of text. 

• In the open Header space, type your name, 
a space, a dash, another space, then your 
email address. Example: L.J. Bothell – 
ljbtrainings@studiobast.com. 

• If your email address automatically 
becomes an active hyperlink, don’t worry 
about it just yet. 

• Select the line of text you just typed, and 
use the Home ribbon quick Styles to select 
the style Heading 3. 

• Then use the Home ribbon to change the 
line’s alignment to Align-Right. 
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To close the Header and Footer, you can either 
choose the Close Header and Footer icon in 
its ribbon, or you can hover over the main text 
in your document and double-click that to re-
enter document editing mode. 

• In the Header & Footer ribbon, click the 
Close Header and Footer icon. 

• SAVE your work, and close the file. MS 
WORD ACTIVITY #3 FINISHED. 

MedAttrib: author-generated. MS Word 
finished styling example file. 
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Inserting Items 

Inserts are basically anything you can insert 
into a word document that supplements your 
text content. Microsoft keeps changing the 
names of some of the inserts, and so will other 
word processing programs, so these are a bit 
generalized. You use the Insert Ribbon to 
choose what you want to add into a document. 

• Images/pictures: image saved size, inserts 
as own entity (not affecting text), resize as 
needed 

• Clip art/online art/icons: Provides access 
to local and online libraries 

• Shapes and Smart-Art: For drawing 
objects, workflows, etc. 

• Text-related: text box, header/footer, word 
art, drop caps, symbols, hyperlinks, etc. 

• Breaks: You can insert page breaks, 
section breaks, and blank pages 

• Tables: You can create tidy tables to list 
information, and set borders, color, and 
table row/column sizes 

• Charts: opens an instance of MS Excel with 
table outline for details to create a live 

Chapter 7: Microsoft® Word®  |  233



chart 

Options for inserts – Insert tab 

The great thing about inserts is that you can 
modify them in many ways: size, color, theme, 
position, and more. However, there are so many 
things you can do that having all these choices 
in the standard Insert ribbon would be 
overwhelming, so Microsoft created Contextual 
menu ribbons. These Tab menu options only 
appear when you select an inserted item you 
want to modify.: 

Object Editing – Context Tab 

Available when you click on an object like a 
table or picture. 

• Size 
• Color 
• Shape 
• Position 
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• Borders 
• Text wrap 
• Alt Text 

Tables – Context Tab 

Tables are use for tabular data like lists and 
limited layout structure. They are good for 
organizing, sorting, filtering, and exporting 
information to other programs. Word isn’t used 
for calculations or other spreadsheet-type 
tables, but tables do have more functionality in 
Word than standard inserts. This includes: 

• Table Design: table styles, shading, 
borders, items related to columns and 
rows, and header row information. 

• Table Layout: Related to inserting, 
deleting, and table content (text) 
alignment formatting in cells. 

Process: You can use the Insert tab to create 
a table from an interactive grid, or to open a 
panel to more specifically set column and row 
information. You can also choose to change a 
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table from the table format by converting it 
back to text. Table properties include: 

• Cells: The specific field in a table that you 
can input data, like a person’s first name, a 
number in currency format, etc. 

• Rows: A horizontal range of data cells, that 
make up a “record”, like a customer’s 
name and address information. A row that 
is longer than the physical page size 
setting will seem to run off the edge of the 
page and not print out the information. A 
row’s height can also be adjusted, either 
by the content of text in a cell or manually 
by setting a row height. 

• Columns: A vertical range of data cells, 
that make up a “type of data”, like a list of 
all customers names. A column’s height 
can also be adjusted, either by the content 
of text in a cell or manually by setting a 
row height. 

• Headers: Every table’s first row should use 
a specific type of data identification name, 
because these are the headers of the data 
in the rest of the columns, and this header 
row tells a user what to expect to see. 
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Example: 

First name Last Name Fave Beverage 

L.J. Bothell Starbucks mocha 

James Holden coffee 

CrisJen Avasarala Tea 

MedAttrib: author-generated. MS Word table 
insert. 

ACTION: MS Word Try Me Activity 
#4 

Let’s do a few document inserting tasks. In this 
case, we are just going to play, and I’ll show 
you an example of what it can look like when 
finished. For yourself, choose colors, shapes, 
and images you like. 

• With MS Word open, choose the File tab, 
New, Blank document. 
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Keyboard Shortcut > New Document. 
Use CTRL + N, ( Mac users: CMD +N). 

Before you do any work, save this file by giving 
it a name and save location. That way you have 
the file ready to save your changes while you 
work. 

• Use the File Tab, Save As, and save the file 
as Word_Inserts into your Examples / 
MS_Word folder. Word will automatically 
add the file extension of .docx for you. 

• In the blank document, press Enter several 
times, then click on the first empty line. 

• Go to the Insert ribbon, Tables group, and 
click the Table icon. 

• Hover your mouse over the interactive grid 
to select 4 squares across and 4 squares 
down, then click. A table should appear in 
your document. Also, a new contextual 
Table Design ribbon should appear, and a 
Layout tab to its right. 

• Click in the table, then look at the Design 
ribbon. The Table Style options group has 
checkmarks by the Header Row, First 
Column, and Banded Rows. Uncheck the 
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Banded Rows and the First Column. 
• In the Design ribbon, use the Table Styles 

to choose a Grid design in a color you like. 
• While in the table, use the Table Style 

options group to add a check in the 
Banded Rows to see the difference. 

The top row – the colored one – is the Header 
row. The Header Row in a table is important 
because it identifies the kind of data that the 
column represents. 

• Click in the top left cell of the Header Row, 
and type FirstName, then press your 
keyboard Tab key. 

• Type LastName, then press your keyboard 
Tab key. 

• Type FaveDrink, then press your keyboard 
Tab key. 

• We don’t need the 4th column, so click 
inside the table’s 4th column so that you 
see the table’s Layout tab (to the right of 
the Design tab). 

• In the table’s Layout ribbon, Rows & 
Columns group, choose Delete, then 
Delete Columns. The 4th column 
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disappears. 

TIP: Insert/Delete table items. You can 
use a table’s Layout ribbon – to the right 
of the Table Design tab – to insert 
columns and rows, and to delete them. 
You can also right-click on a row or a 
column and use the context dropdown 
to Insert or Delete cells and columns 
and rows. 

The table doesn’t take up the width of the 
page. You can manually change the width of 
columns by selecting a column and dragging 
its right edge further to the right. You may have 
to make several adjustments if you don this to 
a column in the middle of the table. 

• Select the third column, and hover your 
cursor over the top right line of the column 
until you view a vertical double line with 
arrows on each side. This means you can 
drag the column line. 

• Drag the third column’s line about an inch 
to the right. The FaveDrink column is now 
wider. 
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• In the 2nd row’s first cell, type your first 
name, then press Tab. Type your last name 
in the next cell, then press Tab, then type 
your favorite drink in the 3rd cell. 

• Just for practice, populate the 3rd and 4th 

rows of the table the same way, with a 
couple of your best friends. 

Next, let’s insert some other fun items to see 
what Word can do. 

• Click into the document working space 
below the table. 

• Use the Insert ribbon’s Illustrations to add 
a picture; click the Picture icon, and 
choose the Online Images from the 
dropdown. 

• Type the kind of your favorite beverage in 
the field, which will use Bing search. 

• From the beverage selection, pick an 
image you like, then click OK. The image 
will appear under your table. 

The image may be too big, or wide, like mine, 
so let’s edit it and add a border. 

• Click on your image, which should open a 
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Picture Format ribbon. 
• In the Picture Format ribbon, choose the 

Picture Styles group, and click on the 
dropdown for the display of different 
frames so you can see the selection. 

• Choose a frame type that you like. 
• You can also use the Picture Styles group, 

Picture Border to change the frame color. 
• In the Picture Format ribbon, choose the 

Size group, and type 3” in the vertical size 
icon’s field. By default, Word will resize an 
image with the height and width 
proportions locked so that the image 
resizes properly. 
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TIP: Images with attributions. Some 
online images will come from Creative 
Commons and a citation attributing the 
source – a good thing. However, in 
Word, the image may import in with 
both and image and separate citation 
object, and a bounding line to link them 
together. You may have to play with a 
Shape Format ribbon as well as the 
Picture format ribbon, and the imports 
bounding group may not resize the 
same as just the image. 

• Let’s add a shape below the image in our 
document; use the Insert ribbon, 
Illustrations group, Shapes icon, and 
choose a shape your like. 

• The shape will “fill” your cursor, which 
means you will need to press your cursor 
and drag to “draw” the image in it. Draw to 
a size you like, then release the cursor. 

• Click on the image , which will open a 
context Shape Format ribbon. 

• In the Shape Format ribbon, choose the 
Picture Styles group, and click on the 
dropdown for the display of different styles 
so you can see the selection. 
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• Or, you can choose the Shape Border, 
Shape Fill, and Shape Effects dropdown 
selectors to personalize. 

There are so many things to insert, but let’s do 
just one more. Below your shape, insert a piece 
of SmartArt. 

• Use the Insert ribbon, Illustrations group, 
and click the SmartArt icon. 

• In the available selection panel, choose the 
Third row, second item called Horizontal 
Bullet List. 

MedAttrib: author-generated. MS Word 
SmartArt choice panel. 
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When you choose a SmartArt, it will import 
using the default color scheme of your 
document’s theme, and the colors can be 
changed. 

• Click on your imported SmartArt, which 
will open a SmartArt Design ribbon and a 
related Format ribbon to the right of that 
one. 

• Look at the clicked SmartArt item, and see 
the little arrow that appears on one side of 
the other. 

• Click that arrow, which gives a fly-out 
interface of the hierarchy of text that will 
be bulleted. You can either type in this list, 
or in the SmartArt item graphic spaces 
themselves. 

• In the flyout, at the first bullet, type Food, 
and see how it populates the SmartArt’s 
first Header. 

• In the second bullet, type your favorite 
food, and see how it populates the first 
bullet in the SmartArt below the header. 
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MedAttrib: author-generated. MS Word 
SmartArt item and hierarchy list. 

• Continue adding text. The bullets in the 
flyout hierarchy show indented bullets that 
correspond to the SmartArt content below 
the headers. 
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TIP: SmartArt Shapes and Hierarchy. 
SmartArt comes with many shapes and 
formats, and each one uses some kind 
of hierarchy of text input to arrange the 
text into the SmartArt shapes. You can 
use the SmartArt ribbon, Create Graphic 
group, to Demote text (indent the 
bullet) or promote the text (Unindent 
the bullet). 

• After you have added the text you want, 
you can click the arrow that opened the 
Hierarchy text box to close it. 

Let’s change the color/style of the SmartArt 
piece. It will be tied to the document’s theme 
palette of colors, but several built-in styles are 
available, 

• Click on your imported SmartArt, and use 
the SmartArt Design ribbon Styles group 
to Change Colors, and select a set you like. 

TIP: SmartArt Format ribbon. The 
Format ribbon to the right of the 
SmartArt Design tab lets you change 
individual SmartArt pieces, like the 
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header portion, or body portion, or text 
styles. 

• SAVE your work, and close the file. MS 
WORD ACTIVITY #4 FINISHED. 

MedAttrib: author-generated. MS Word Inserts 
file example. 
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References/Citations 

A big part of word processing use is for writing 
– articles, essays, research papers, thesis 
materials, journalism pieces, op-eds, etc. Using 
references for citing and/or attributing source 
materials to their intellectual property owners 
is a critical function in providing accurate, 
unbiased, and professional-standards work in 
school and in the job. 

References – Reference Tab 

Word allows you to create reference notes, 
footnotes, and tables of contents for longer 
documents. 

• You can create a table of contents for your 
documents, and make it updatable with 
page changes and linkable page numbers. 

• You can insert footnotes and endnotes – as 
you go or at the end of the document. 

• You can also insert citations into your 
documents, especially if you use a MS 

Chapter 7: Microsoft® Word®  |  249



Word compatible reference program like 
EndNote. 

• You can set one of the common citation 
and footnote styles, like APA or Chicago 
styles. 

• You can compile a bibliography from your 
references. 

• You can create indexes and tables of 
figures. 

• If you have access to a reference manager 
program, you may also be able to have it 
as a Word add-in. 

Table of Contents – Reference 
Tab 

• You can have Word add and update a 
Table of contents for you, based on 
successful use of Outline/hierarchy of 
styles (see Tuesday). 

• Use Reference tab, Table of Contents, to 
create based on heading types. 

• Update the Table of Contents if you make 
additions or deletions in your document 
that affects the number of pages. 
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We’ll do a quick practice of what the 
References ribbon options can do for you. 

ACTION: MS Word Try Me Activity 
#5 

Let’s do a few document References-related 
tasks. Let’s use the Word_paperstarter.docx 
file that should be in your DataFiles folder. 

Before you start, you should use your file 
manager utility to make a copy of the 
Word_paperstarter.docx file that is in your 
DataFiles folder, then paste the copy into your 
Examples / MS_Word folder. 

• If Word isn’t open yet, open MS Word. 
• Open a file, and use the browser dialog 

panel for the Word_paperstarter.docx file 
that should be in your Examples / 
MS_Word folder, then open it. 

You should see a couple of pages of text that 
lays out the core steps of a research paper 
format. There is already a header and footer 
that you can look at, a modified theme with 
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the grayscale color palette, and the styles have 
already been modified. We need to add a small 
table of contents (ToC), and a few citations to 
practice references. 

Let’s start with a table of contents. You can 
certainly type this manually, but a real research 
paper can have dozens of pages and several 
sections, sub-sections, captioned images and 
charts, a references section, a glossary, and 
more. The Word table of contents option uses 
the document’s styles to layout the ToC and 
make it clickable so that a reader can be moved 
right to the section that was clicked. 

• In the document, select the text “Pending 
table of contents insert” and delete it. 
Keep your cursor there. 

• Find the References tab, Table of Contents 
(ToC) group, and click the Table of 
Contents icon. 

• Choose the first of the built-in ToC’s. 

Now, what comes in is basic, based on the 
hierarchy that Word defaults to, which includes 
Heading 1, Heading 2, and Normal. 
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• Using the References tab, Table of 
Contents group, and click the Table of 
Contents icon, and choose Remove Table 
of Contents. 

• Next, use the Table of Contents icon, and 
select “Custom Table of Contents”, which 
will open a ToC Panel with several tabs in 
it. 

MedAttrib: author-generated. MS Word Table 
of Contents panel, ToC tab. 

Stay in the Table of Contents tab and look over 
it. It shows previews of what you can expect to 
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see, especially if you have a lot more content 
than our starter document. 

• The default Show Levels is 3, but here 
change it to 2. Keep the Use Hyperlinks 
instead of page numbers, so that a user 
can click on the page number and be 
transported to the section. 

• Click OK. You should see a simple table of 
contents. 

• Next, delete your manually typed Table of 
Contents subheading and keep this 
inserted module. 

• In the inserted module, you can choose to 
select the word Contents and apply the 
Header 2 style to it, 

• SAVE your work: CTRL S / MAC CMD S. 
• In your document, on Page 2, add the 

following text below the paragraph in 
Section 3: 

◦ Section 4, and on the line below it, 
(without the quote marks) “This will be 
another big paragraph of facts, data, 
and conclusion. (CITE – in text)” 

• Use the Home tab Format Painter to 
apply the style for Section 3 to the text 
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Section 4, and to apply the format of 
Section 3’s paragraph to Section 4’s 
paragraph. 

• Now, scroll up to the first page’s Table of 
Contents and click on it. 

• When activated, the Table of Contents 
module should reveal an Update Table of 
Contents button at the top left. Click it, 
and choose Update Entire Table. 

Your ToC should now show Section 4. 

Let’s add citations in the document. We will 
do 1 footnote, and 2 endnotes, and 1 in-text 
citation, so that you can see the difference. 

• First, go to page 2, the first section’s 
paragraph, and look for the (CITE – 
Footnote) phrase. Delete that phrase, and 
keep your cursor in that spot. 

• Use the References tab, Footnotes group, 
and click the Insert Footnotes icon. This 
will add a small number 1 where your 
cursor was, and scroll you to the bottom of 
the page to a Footnotes field for you to 
add a footnote reference. 
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TIP: Footnoting formats. Footnotes and 
endnotes follow specific conventions; 
two common ones are APA, Chicago 
style and MLA. Your instructor, or 
newspaper editor, or publisher will tell 
you which is expected, and you can use 
a search engine to look these up. Word 
supports these, and other referencing 
styles as well. 

Word defaults to the APA style, so we will use 
that. 

• In your document’s footnote, type: Print 
Publication: AuthorLastName, 
AuthorFirstName (PubYear/Date). Title in 
sentence format. Italicized Publication 
Title in Title Format, VolumeNumber, 
Page#-Page#. 

• SAVE your work: CTRL S / MAC CMD S. 
• On page 2, the second section’s 

paragraph, look for the (CITE – Footnote) 
phrase. Delete that phrase, and keep your 
cursor in that spot. 

• Use the References tab, Footnotes group, 
and click the Insert ENDnotes icon. This 
will add a small letter i where your cursor 
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was, and scroll you to the bottom of the 
document to an Endnotes field for you to 
add an endnote reference. 

• In your document’s endnote, type: 
Website: AuthorLastName, 
AuthorFirstName (PubYear). Title in 
sentence format. Website Name. full URL 
of the reference item. 

• On page 2, the third section’s paragraph, 
look for the (CITE – Footnote) phrase. 
Delete that phrase, and keep your cursor 
in that spot. 

• Use the References tab, Footnotes group, 
and click the Insert ENDnotes icon. This 
will add a small letter ii where your cursor 
was, and scroll you to the bottom of the 
document to an Endnotes field for you to 
add an endnote reference. 

• In your document’s endnote, again type: 
Website: AuthorLastName, 
AuthorFirstName (PubYear). Title in 
sentence format. Website Name. full URL 
of the reference item. 

• SAVE your work. 

Now, let’s try out an in-text citation, which you 
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use when you refer to or paraphrase / quote 
from another source, and it will require a 
corresponding entry in your reference list. 

• On page 2, the fourth section’s paragraph, 
look for the (CITE – in-text) phrase. Delete 
that phrase, and keep your cursor in that 
spot. 

• Use the References tab, Citations and 
Bibliography group, and click the Insert 
Citation icon. 

• Choose Add New Source, which will open a 
Create Source dialog box. 

MedAttrib: author-generated. MS Word Create/
Edit Source panel. 

The image shows what you can type into your 
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own Cite source fields. This is very casual, and 
of course not representative of serious work. 

Before we leave this section, let’s check out a 
couple more items on the References ribbon. 

On Page 3 of your Word_paperstarter.docx file, 
you would list various references. We see 
Endnotes, because we were experimenting, 
but in an actual research paper, your supervisor 
would require either footnotes or end notes – 
usually footnotes because the References 
section is for formal references only. 

• Click your cursor below the line of Normal 
text in the References section. 

• Use the References tab, Citations and 
Bibliography group, and click the Manage 
Sources icon. 

You can see and manage sources with this 
panel, including editing errors you have made. 
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MedAttrib: author-generated. MS Word 
Sources Manager panel. 

• Close the panel. 
• Use the References tab, Citations and 

Bibliography group, and click the 
Bibliography icon and choose References. 
This will insert a References section 
module like the Table of Contents module, 
but this will format them properly to APA 
References format, and pull from your 
Source manager. 

• Delete the manual text about References 
and its following line, and keep the 
inserted References module. 

• In the inserted module, you can choose to 
select the word References and apply the 
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Header 2 style to it, 
• SAVE your work, and close the file. MS 

WORD ACTIVITY #6 FINISHED. 

MedAttrib: author-generated. MS Word 
finished References example document. 

Review and Distribution 

Review and distribution of your work is about 
preparing it for who will be consuming it. Will 
it stay in a Word document format, be saved 
as a PDF, printed onto paper, added as website 
content, populate an add or newspaper article, 
or be part of a book? It needs to be: 

• Spell checked. 
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• Grammar- and language- reviewed. 
• Accessibility enabled (alt text, proper use 

of heading styles, accessibility for screen 
readers). 

• Consider versioning. 
• Have hyperlinks tested. 
• Cited and attributed properly for 

intellectual honesty. 
• Passed for plagiarism and other content 

integrity needs. 
• Presented for readable print viewing. 
• Secured for limited/no editing. 
• If meant for team collaboration, prepared 

for making shared/trackable changes, 
comments, and notes. 

MS Word provides a good deal of this, which is 
why the application is so frequently used – over 
the long term, in business and education. 

Output/distribute work 

• You can test and adjust your documents 
and review your content before it goes live 
by looking at the File/Print sections Print 
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Preview and settings. 
• You can make sure you have added 

metadate for web/online reference by 
updating information in the File/Info page. 

• You can save files in different formats for 
distribution in the File backstage areas, 
like Save As (for current and older versions, 
RTF, text, and HTML), save as PDF, export, 
etc. 

ACTION: MS Word Try Me Activity 
#6 

Let’s check out a few document Distribution-
related tasks. Let’s use the 
Word_diststarter.docx file that should be in 
your DataFiles folder. 

Before you start, you should use your file 
manager utility to make a copy of the 
Word_diststarter.docx file that is in your 
DataFiles folder, then paste the copy into your 
Examples / MS_Word folder. 

• If Word isn’t open yet, open MS Word. 
• Open a file, and use the browser dialog 
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panel for the Word_diststarter.docx file 
that should be in your Examples / 
MS_Word folder, then open it. 

This is a slightly modified copy of our finished 
product from a couple of sections ago. We’ll 
use it for an editor check, accessibility check 
and to view printing/distribution options. 

First, let’s do a check for spelling, which is 
important for quality. However, you really have 
to pay attention to the context in which you 
use words, because the spell check looks for 
misspellings, not misused versions of the word. 
If you run the whole editor tool, you will also 
have access to a grammar check. 

• Place your cursor anywhere in the open 
document. Then, use the Review ribbon 
options. 

• Click in the Review tab, Editor icon. This 
opens a panel that gives an editor score 
based on spelling, grammar, and other 
criteria that you should explore on your 
own. 

• The Editor has found 5 misspellings. In the 
Editor panel’s Corrections segment, click 
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Spelling to initiate the spell checking tool. 

MedAttrib: author-generated. MS Word Editor 
panel and Editor spelling check. 

Each misspelled word (or word that confuses 
the editor) gives you an option to choose an 
offered word, and to change all of the same 
misspellings and add to Autocorrect. You can 
also ignore the word or add it to the dictionary 
for the document. 

• Process the 5 misspelled words and accept 
Word’s suggested replacement. 

• Save your work. 
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Next, let’s run the Accessibility checker, which 
looks for issues that would make the document 
difficult for a screen reader to process for 
vision-impaired learners who need screen 
readers. 

• Click in the Review tab, Accessibility group, 
Check Accessibility icon. This opens a 
panel that may take a few minutes to 
check the document to see if there are 
problems. 

In our case, the document surprisingly has no 
accessibility issues. I state surprisingly, because 
there is a small graphic in the Header, and the 
list of skills was put into an unbordered table 
with no header row (which is usually a no-no 
for accessibility). However, Word seems to add 
more protections for users, including 
automatically adding some Alt text to graphics 
– although that alt text might not be that great. 

We’ll leave this alone and move on. We can 
protect a document’s content from being 
edited. 

• Using the Review tab, Accessibility group, 
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click the Protect icon and choose Restrict 
Editing. 

This opens a panel that allows you to choose to 
allow some or all restriction, start the restriction 
by setting a password, and to view what your 
document restrictions are. 

• Choose to Start enforcement of the default 
restrictions, and give the password open. 

• Close the Restrictions panel and SAVE 
your work. 
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MedAttrib: author-generated. MS Word 
document restrictions. 

Next, let’s look at the document information, 
which shows who worked on it, and some 
metadata fields you can add for layering into 
the document’s save structure. 

• While still in the document, go to the File 
tab, and in the Backstage area, choose 
Info. 

MedAttrib: author-generated. MS Word Info 
page. 

The Info page lets you add metadata, like 
shown here on the right-hand side under 
Properties. You can also protect the document 
more rigorously from here, inspect the 
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document for accessibility and compatibility 
with earlier versions of Word, and see a version 
history. The Info page has additional info about 
who the user is, and more properties (you need 
to scroll down). 

Next, let’s check out the Print section of the 
document. You may not actually print 
documents, but the print information shows 
how a document would look in a PDF or other 
formats that you may upload on a website or 
send by email – and that someone else might 
print. 

• While still in the document, go to the File 
tab, and in the Backstage area, choose 
Print. 

The left side will give print options for sending 
to a printer, including how the pages should 
come out of the printer (collated, one or two-
sided, etc.) 

TIP: Printer Options. Many people don’t 
have printers at home anymore, but you 
can set your documents up to Microsoft 
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Print to PDF through the Printer 
Settings so that you can take advantage 
of seeing how others will receive your 
distributed document. Microsoft Print to 
PDF doesn’t require a physical printer to 
map settings. 

MedAttrib: author-generated. MS Word Print 
info page. 

Finally, the File tab’s Backstage area lets you 
save your file – and export it – into different 
formats. This is useful because you may not 
choose to keep working in Word, but may 
instead prefer Google Docs or an open source 
office suite. 
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MedAttrib: author-generated. MS Word Save 
As page. 

In the Save As page, you can use the Browse 
option to open the Save As browser window, 
and look for the location you wish to save your 
file – it works the same way as when you open 
a file and browse for it. 

• SAVE your work, and close the file. MS 
WORD ACTIVITY #6 FINISHED. 

This should give you a good overview of MS 
Word skills that you can use in school and as a 
starter for basic workplace support tasks. 
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Chapter 8: 
Microsoft® 
Excel® 

What We’ll Cover >>> 

• Spreadsheet/Financial Software 
• Microsoft Excel 
• Worksheet Formatting and Inserts 
• Workbook Design 
• Datasets 
• Tables 
• Calculations 
• Charts and Graphs 
• Review and Distribution 

Spreadsheet software allows users to create, 
edit, and print financial information and data 
organization. The software enables you to add 
data, store it electronically, display it on a 
screen, modify it by entering commands and 
characters from the keyboard, and print it. 
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Financial software and spreadsheets has 
evolved into much more than just sheets of 
data. One can have thousands of records to be 
analyzed, calculated, summarized, and 
expressed for reporting in graphs, charts, and 
data dashboards. It also allows to import of big 
data, and export of content for other databases, 
like sales contacts, marketing management 
applications, etc. Modern spreadsheet software 
is integrated into the cloud so that data can be 
accessed from cloud-based storage. 

Spreadsheet/Financial 
Software 

A spreadsheet is a file 
with cells in rows and columns that allow you 
to arrange, calculate and sort data. Data in a 
spreadsheet consists of numeric values, text, 
formulas, references and functions. 
Spreadsheets are used to visualize data in a 
meaningful way that can be used to make 
complex decisions. Spreadsheets can take raw 
data, and tell a story with it. 
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Spreadsheet software can be part of an 
integrated suite of tools, or be stand-alone. It 
can be installed on a computer for full and 
robust features and integration with other 
resources; it can be accessed on the web in a 
light format, and it can be a basic utility tool, 
like text editing applications. Some programs/
suites are payware, such as those used in many 
workplaces; others are shareware or freeware. 
Information in this chapter should offer you 
transferrable skills for use in any word 
processing application. 

Common Spreadsheet Software 

• Apple Numbers Online: Part of the iWork 
productivity suite and operates on the 
MacOS, iPadOS, and iOS operating 
systems. Users feel that it is an easy-to-use 
application that allows them to quickly 
create spreadsheets on their Apple 
devices. 

• Google Sheets: Online: Included as part of 
a free, web-based software office suite 
offered by Google within its Google Drive 
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service. Allows users to create, view, and 
edit files online while collaborating with 
other users in real-time. Available as a web 
application supported on Google Chrome, 
Mozilla Firefox, Internet Explorer, Microsoft 
Edge, and Apple Safari web browsers. 
Compatible with Google Drive. 

• Microsoft Excel: Commercial: Operates on 
Windows and Mac. Part of Office 365 
Recent features include robust formulas 
and functions, charts, graphs, and 
sparklines. 

• Smartphone apps that allow for quick use 
and editing on-the-go. 

• Spreadsheet apps in free/open source 
office suites. 

Microsoft Excel 

Since Microsoft Excel is widely used in business 
settings, and since we are using Microsoft 
Windows, we will focus on Excel going forward. 
There are many similarities in tools and 
functions across spreadsheet software, so the 
skills we are learning can be translated to other 
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software and apps. The following Try Me 
activities are designed to be completed using 
Microsoft Excel in Office 365 on a PC with 
Windows 10 or higher. 

We will use Excel to perform complex 
calculations, analyze data so that we can make 
intelligent decisions, and create visually 
interesting charts and graphs that help us 
understand the data. Since Excel is used for 
Data Analysis, it is best to use a keyboard and 
mouse or touchpad rather than the 
touchscreen. 

Accessing Excel 

• In your Computer, use the relevant start 
menu to open MS Excel (look for little 
green icon). On a PC this is a start button 
on the keyboard, and/or menu on the 
lower left of the screen. On a Mac, this 
should be in the top-screen Menu option. 

• Excel will open with options to create a 
blank workbook, open an existing file, and 
use templates. 
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DEMO EXAMPLE follow-through 

• Locate Excel on your computer. This can 
be done with your computer’s search tool 
so that you can locate the application icon. 

• Click Microsoft Excel icon/execution file to 
launch the Excel application where you are 
presented with workbook options to help 
get you started. 

• Options will include a Blank workbook, 
tours of program information, templates 
installed with your application, and the 
choice of opening an existing Excel file. 

• New Excel workbooks start with a blank 
file of worksheet(s) tabbed pages for you 
to start new work. 

• Existing files can be opened from your 
computer, an external drive, and an online 
source like OneDrive (if you have/use that). 

• Choose Blank Workbook, which will open 
a new, blank workbook with a default of 3 
Sheet tabs. 
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The User Interface (UI) menus 

MedAttrib: author-generated. MS Excel user 
interface. 

• Place your mouse pointer over cell A1 and 
click. 

• Check to make sure column letter A and 
row number 1 are highlighted. 

• Look at the application’s upper left field 
(below the ribbon) where you should see 
A1 in the Name Field. 

• Move the mouse pointer to cell D6. 
• Click and hold the left mouse button and 

drag the mouse pointer back to cell A1. 
• Release the left mouse button. You should 
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see several cells highlighted. 

This is referred to as a cell range and is 
documented as follows: A1:D6. Any two cell 
locations separated by a colon are known as a 
cell range. The first cell is the top left corner of 
the range, and the second cell is the lower right 
corner of the range. This is important because 
cell ranges will be an important part of 
formulas later on. 

Keyboard Shortcuts > Worksheet 
Navigation. 

• Use the arrow keys on your keyboard to 
activate cells on the worksheet. 

• Hold the SHIFT key and press the arrow 
keys on your keyboard to highlight a range 
of cells in a worksheet. 

• Hold the CTRL key while pressing the 
PAGE DOWN or PAGE UP keys to open 
other worksheets in a workbook. 

• MAC Users: Hold down the FN and CMD 
keys and press the left or right arrow keys 

In Excel, the user interface contains several 
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menu tabs (tab, menu), with ‘Ribbons’ (ribbon) 
that display icons (like buttons) with text 
descriptions of various activities related to a 
task. On a ribbon, you will often see groups 
(group) of icons for tasks that relate to one 
another, like the Home ribbon’s Font group, 
Paragraph group, etc. Some of these icon 
buttons will do a simple task in one step, while 
others may open a panel (panel) which is a 
detailed, multi step or tab window of options. 
Sometimes you may instead see a context 
dropdown (dropdown) menus of options, or a 
dialog box (dialog) with a couple of fields to 
complete.. Shown (in the program’s order) are: 

Explore Menu/Ribbon tabs: 

• File: Accesses the program backstage area 
for various options. Set your preferences 
for workflow and productivity. 

• Home: Basic text functions –  formatting, 
positioning, styles 

• Insert: tables, images, shapes, charts, page 
sections 

• Page Layout: Layout of the slides – 
margins, positioning, indents, etc. 

• Formulas: For performing mathematical 
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calculations on rows and columns of 
numerical data. 

• Data: For sorting and organizing data. 
• Review: Spelling, language, tracking, etc. 
• View: screen views, rulers, gridlines, 

windows. 
• Add–ins: Based on additional programs a 

workplace might have that work with MS 
Excel. Can include types of macros and 
specific formulas. 

• Additional add-in/specialty tab menus: 
These are dependent on having MS Word-
related add-ins like Acrobat, Power Pivot, 
etc. 

• Contextual tab menus: These are 
contingent on a specific item in the 
program’s workspace being activated. For 
instance, clinking on an image, table, or 
header / footer will activate a context 
menu/ribbon on the right side of the UI 
that shows a menu dedicated to actions 
that can be done specifically for the active 
item (picture editing). 

We’ll cover more detail on specific Menu 
toolbar ribbons in the following demo sections. 
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In addition to the ribbon and Quick Access 
Toolbar, you can also access many commands 
by right clicking anywhere on the worksheet, 
which will enable a dropdown menu of choices 
that are relevant to what you need to 
accomplish. 

MAC Users: There is no “Right-click” 
option for Excel for Mac. Instead, hold 
down the control key and click the 
mouse button. 
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MedAttrib: Beginning to Intermediate Excel. 
MS Excel’s Right-Click dropdown menu. 

Worksheets 

Worksheets are the Excel equivalent of the 
Word document. A worksheet is made up of 
are made up of a tabular view of cells, rows, 
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and columns. Their common MS Excel file 
extension is .xlsx. They can contain: 

• Text data. 
• Calculations. 
• Inserted items like images, graphs, and 

tables, 
• Page breaks, print area settings 

Views – View Tab 

• You can see different views as part of the 
main interface – lower right-hand side of 
the user interface, and also from the View 
tab’s ribbon. 

• You can set rulers on or off. 
• You can also set guides for aligning text 

and images. 
• You can choose the window view you like 

to work in, such as normal, page break, 
page layout, and print layouts. 
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Preferences – File tab 

You can set your Excel program preferences for 
documents and program workflow, for 
smoother productivity, in the ‘backstage’ area 
of the program. 

• Same layout as PowerPoint, Word, and 
Access. 

• Allows personalizing, print, save, and 
publish settings. 

• Preferences: Excel Options: 
• Customize editing, saving, and other 

program options. 
• Personalize a mini-toolbar so you can 

minimize the ribbon. 

The Work stage 

• Excel opens with a default number of 
blank workbook pages, which you can 
change, name, and delete. You can also 
change the default number in the 
program options. 
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• Cells are all named by column (letter) and 
row (number). 

• Data entry goes into individual cells, and is 
accepted (enter) or rejected (red check). 

• The Formula bar at top shows data that is 
inside a specific cell, as well as details of 
any calculation formula when used. 

• Calculations are based on selecting various 
cells and their to be calculated in some 
way. 

• Cells can be formatted like in Word: font 
family, font color, font size, cell contents 
alignment, etc. 

• The worksheet ‘page’ can be formatted 
with borders, color, and alignment of 
objects. 

In Excel, all input data for sorting, filtering, 
calculation, and analysis is stored in a cell. Cell 
content is anything that is stored in the cell and 
can be either a constant value or a formula. The 
most commonly used values are text 
values (string of text like a customer’s name or 
phone number) and number values (like a 
count, etc.) We’ll cover more on this in the 
Datasets section of this chapter. 
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• A text value is also referred to as a label. It 
is not something to calculate, which is why 
a phone number or social security number 
is considered ‘text’. 

• A numeric value can actual numeric data, 
like a date, item of currency, a percentage, 
etc. These can have specific numeric 
formats added to them, like short date, a 
percentage format, a dollar sign, decimal 
points, etc. This is not the same as 
changing a number to ‘look’ like a phone 
number. Numeric values can be 
calculated. 

• Calculations in a cell are when content 
from one or more calculatable cells are 
used in a formula to get an answer. An 
example would be the sum of the numeric 
values in a couple of cells to give a total 
amount. 
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MedAttrib: author-generated. MS Excel cells, 
rows, and columns. 

ACTION: MS Excel Try Me Activity #1 

• Follow along and try things. There is no 
“wrong”, this is just play and exploration! 
This is what we will create: 
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MedAttrib: author-generated. MS Excel cells, 
rows, and columns. 

Plain Data 

• BEFORE you do this activity, make sure 
you have taken the Preparation Steps in 
the Part 1 Introduction (creating file 
directories and folders for all your work in 
this book). This allows you to have a safe 
place to save your files of work while you 
explore this content. 

• Create a new, blank workbook in Excel. 
• Immediately give it a name and save it to 

your Examples on your computer. File 
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naming recommendation: 
Excel_dataentry.xlsx. 

• Click cell A2. 
• Type your first name and press the ENTER 

key. After you press the ENTER key, cell A3 
will be activated. Using the ENTER key is 
an efficient way to enter data vertically 
down a column. 

• Enter the following first names, pressing 
ENTER after each: Alfre, Jonna, Patrick, 
Julio, Ajay 

• Click cell B2. 
• Type your last name and press the ENTER 

key. After you press the ENTER key, cell B3 
will be activated. 

• Type names into cells B3 and press the 
ENTER key. Do this through Cell B7. 
Names: DuShayne, Mills, McNeill, Mendez, 
Bashira 

• Click cell C2. 
• Type the number 50 and press the ENTER 

key. 
• Enter the following numbers in cells C3 

through C7: 75, 22, 180, 65, 48, 125 
• SAVE your work: CTRL S. MAC Users: CMD 

S. 
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Column Headings 

In Excel, data rarely means anything to a viewer 
if there is no context attached to it. Commonly 
this is done through column headings, which 
identify what the content in the column is 
supposed to be. This can also be done as row 
headers instead, but in this course we’ll mostly 
use the standard column headings. 

In the image above, you can see a row of bold 
text in cells A1-C1. These are column headers, 
and you can type them: 

• In cell A1, type Fname, then press TAB. Tab 
lets you move to the right of an active cell 
and activate the next one for data entry. 

• In cell B1, type Lname and press TAB. 
• In cell C1, type Coffee budget, and press 

TAB. 

These are the column headings that tell you 
the first column is full of first names, the 
second column is full of last names, and the 
third column has amounts for a coffee budget. 
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Editing Data 

Data that has been entered in a cell can be 
changed by double clicking the cell location or 
using the Formula Bar. You may have noticed 
that as you were typing data into a cell 
location, the data you typed appeared in the 
Formula Bar. The Formula Bar can be used for 
entering data into cells as well as for editing 
data that already exists in a cell. The following 
steps provide an example of entering and then 
editing data that has been entered into a cell 
location: 

• Click cell D2 in the Sheet1 worksheet. 
• Type Moc and press the ENTER key. 
• Click cell D2. 
• Move the mouse pointer up to the 

Formula Bar. You will see the pointer turn 
into a cursor. Move the cursor to the end of 
the abbreviation Moc and left click. 

• Type the letters ha to complete the word 
Mocha. 

• Click the check mark to the left of the 
Formula Bar. This will enter the change 
into the cell. 
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• Use this method – clicking a cell but typing 
into it through the Formula Bar – to add 
coffee beverages into cells D3-D7. 

• Use this method to also add the data 
FaveDrink into cell D1 (the header for this 
column). 

• SAVE your work: CTRL S / MAC CMD S. 

Keyboard Shortcut: Editing Data in a 
Cell. Activate the cell that is to be edited 
and press the F2 key on your keyboard. 

Autofill 

The Auto Fill feature is a valuable tool when 
manually entering data into a worksheet. This 
feature has many uses, but it is most beneficial 
when you are entering data in a defined 
sequence, such as the numbers 2, 4, 6, 8, and 
so on, or nonnumeric data such as the days of 
the week or months of the year. The following 
steps demonstrate how Auto Fill can be used 
to enter the months of the year in Column E: 

• Click cell E2 in the Sheet1 worksheet. 
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• Type the word January and press the 
ENTER key. 

• Click cell E3 and type February, then Press 
Enter. 

• Click cell E4 and type March, then Press 
Enter. 

• Move the mouse pointer to the lower right 
corner of cell E4. You will see a small 
square in this corner of the cell; this is 
called the Fill Handle. When the mouse 
pointer gets close to the Fill Handle, the 
white block plus sign will turn into a black 
plus (+) sign. 

• Left click and drag the Fill Handle through 
cell E13. Notice that the Auto Fill tip box 
indicates what month will be placed into 
each cell. Release the mouse button when 
the tip box reads “December.” 

Once you release the left mouse button, 12 
months of the year should appear in the cell 
range E2:E13. You will also see the Auto Fill 
Options button. By clicking this button, you 
have several options for inserting data into a 
group of cells. 
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• SAVE your work. 

Deleting Data 

There are several methods for removing data 
from a worksheet, and with each method, you 
use the Undo command if you change your 
mind. This is a helpful command in the event 
you mistakenly remove data from your 
worksheet. 

You can delete data by selecting a cell and 
using your Delete keyboard button. You can 
right-click on a cell and choose Delete. You can 
select a cell and use the Home tab Editing 
group and choose the Clear icon, then Clear all. 

• Select cells E8 through E13. 
• Press the DELETE key on your keyboard. 

This removes the contents of the cells. 
• MAC Users: Hold down the Fn key and 

press the Delete key 
• Click the Undo button – which is by default 

available in the Quick Access Toolbar. This 
should replace the data in the cells E8-E13. 
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• Select cells E8 through E13. 
• Use the Home tab Editing group and 

choose the Clear icon, then Clear all. 
• SAVE your work: CTRL S / MAC CMD S. 

Keyboard Shortcut: Undo Command: 
CTRL Z / CMD Z 

Adjusting columns / rows 

TIP: Column and Row Addresses. Every 
row has an address – the gray “cell” 
number to the left of the editable part 
of your worksheet. Evey Column has one 
too, the gray “cell” letter just above the 
editable part of your worksheet. You 
click on these to select a whole row or 
column. 

There may be a few entries in a worksheet that 
appear cut off. This is because the column is 
too narrow for this word. The columns and 
rows on an Excel worksheet can be adjusted to 
accommodate the data that is being entered 
into a cell using three different methods. The 
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following steps explain how to adjust the 
column widths and row heights in a 
worksheet: 

• Bring the mouse pointer between the 
column number addresses of Column A 
and Column B in the Sheet1 worksheet 
(column address is the gray ‘cell’ just above 
Cells A1 and B1). You will see the white 
block plus sign turn into double arrows. 

• Press your cursor down (press and hold 
your left mouse button when you click) so 
your can drag the column to the right until 
the entire column looks like it is about 2 
inches wide. As you drag the column, you 
will see the column width tip box. This box 
displays the number of characters that will 
fit into the column using the Calibri 
11-point font which is the default setting 
for font/size. 

• Release the left mouse button. 

You may find that using the click-and-drag 
method is inefficient if you need to set a 
specific character width for one or more 
columns. This is a second method for adjusting 
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column widths when using a specific number 
of characters: 

• Click any cell location in Column A. You 
can highlight cell locations in multiple 
columns if you are setting the same 
character width for more than one 
column. 

• In the Home tab of the ribbon, left click 
the Format button in the Cells group. 

• Click the Column Width option from the 
drop-down menu. This will open the 
Column Width dialog box. 

• Type the number 29 and click the OK 
button on the Column Width dialog box. 
This will set Column A to this character 
width. 

A third method is the double-click one: 

• Once again bring the mouse pointer 
between Column A and Column B so that 
the double arrow pointer displays and 
then double-click to activate AutoFit. This 
features adjusts the column width based 
on the longest entry in the column. 
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Keyboard Shortcut: Column Width. 
Press ALT key on keyboard, then press 
letters H, O, and W one at a time. MAC 
Users: not available. 

Row Height adjustment works similarly. Steps 
1 through 4 demonstrate how to adjust row 
height, which is similar to adjusting column 
width: 

• Click cell A1. 
• In the Home tab of the ribbon, left click 

the Format button in the Cells group. 
• Click the Row Height option from the 

drop-down menu. This will open the Row 
Height dialog box. 

• Type the number 24 and click the OK 
button on the Row Height dialog box. This 
will set Row 1 to a height of 24 points. A 
point is equivalent to approximately 1/72 of 
an inch. This adjustment in row height was 
made to create space between the totals 
for this worksheet and the rest of the data. 

Now, to adjust the row with the autofit option: 

• Bring the mouse pointer between Row 1 
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and Row 2 at the row address (the 1 and 2 
just to the left of Cells A1 and A2), so that 
the double arrow pointer displays, and 
then double-click to activate AutoFit. This 
features adjusts the row width based on 
the largest entry in the row. 

• SAVE your work. 

Keyboard Shortcut: Row Height. Press 
ALT key on your keyboard, then press 
letters H, O, and H one at a time. MAC 
Users: not available. 

Hiding and unhiding columns / 
rows 

In addition to adjusting the columns and rows 
on a worksheet, you can also hide them. This 
is a useful technique for enhancing the visual 
appearance of a worksheet that contains data 
that is not necessary to display but which is 
otherwise needed for computations and/or 
storage. 
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• Click cell C1. 
• Click the Format button in the Home tab 

of the ribbon. 
• Place the mouse pointer over the Hide & 

Unhide option in the drop-down menu. 
This will open a submenu of options. 

• Click the Hide Columns option in the 
submenu of options. This will hide Column 
C. 

Keyboard Shortcut: Hiding Columns. 
Hold down CTRL key while pressing 
number 0 on your keyboard. 

To unhide a column, follow these steps: 

• Select the Columns B and D. 
• Click the Format button in the Home tab 

of the ribbon. 
• Place the mouse pointer over the Hide & 

Unhide option in the drop-down menu. 
• Click the Unhide Columns option in the 

submenu of options. Column C will now be 
visible on the worksheet. 
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Keyboard Shortcut: Unhiding Columns. 
Highlight cells on either side of the 
hidden column(s), then hold down CTRL 
key and SHIFT key while pressing the 
close parenthesis key ()) on your 
keyboard. MAC Users: Hold down CTRL 
and Shift keys and press the number 0. 

The following steps demonstrate how to hide 
rows, which is similar to hiding columns: 

• Click Row 3. 
• Click the Format button in the Home tab 

of the ribbon. 
• Place the mouse pointer over the Hide & 

Unhide option in the drop-down menu. 
This will open a submenu of options. 

• Click the Hide Rows option in the 
submenu of options. This will hide Row 3. 

Keyboard Shortcut: Hiding Rows. Hold 
down the CTRL key while pressing the 
number 9 key on your keyboard. 

To unhide a row, follow these steps: 

302  |  Chapter 8: Microsoft® Excel®



• Select the range A2:A4. 
• Click the Format button in the Home tab 

of the ribbon. 
• Place the mouse pointer over the Hide & 

Unhide option in the drop-down menu. 
• Click the Unhide Rows option in the 

submenu of options. Row 3 will now be 
visible on the worksheet. 
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Keyboard Shortcut: Unhiding Rows. 
Highlight cells above and below the 
hidden row(s), then hold down the CTRL 
key and the SHIFT key while pressing 
the open parenthesis key (() on your 
keyboard. MAC Users: Hold down CTRL 
and Shift keys and press the number 9 

TIP: Hidden Rows and Columns. In most 
careers, it is common for professionals 
to use Excel workbooks that have been 
designed by a coworker. Before you use 
a workbook developed by someone 
else, always check for hidden rows and 
columns. You can quickly see whether a 
row or column is hidden if a row 
number or column letter is missing. 

Inserting and deleting 
columns/rows 

Using Excel workbooks that have been created 
by others is a very efficient way to work 
because it eliminates the need to create data 
worksheets from scratch. However, you may 
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find that to accomplish your goals, you need to 
add additional columns or rows of data. In this 
case, you can insert blank columns or rows into 
a worksheet. The following steps demonstrate 
how to do this: 

 

 

 

 

 

 

 

 

 

MedAttrib: Beginning to Intermediate Excel. 
MS Excel Insert Button (Down Arrow). 

•  Click cell C1. 
• Click the down arrow on the Insert button 
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in the Home tab of the ribbon. 
• Click the Insert Sheet Columns option 

from the drop-down menu. A blank 
column will be inserted to the left of 
Column C. The contents that were 
previously in Column C now appear in 
Column D. Note that columns are always 
inserted to the left of the activated cell. 

MedAttrib: Beginning to Intermediate Excel. 
MS Excel Insert Drop-Down Menu. 

• SAVE your work, and close the file. EXCEL 
ACTIVITY #1 FINISHED. 
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Worksheet Formatting and 
Inserts 

Worksheets have a lot that can be done to 
them alone. They are part of a bigger workbook 
(and sometimes one worksheet makes up the 
whole of a workbook. In this segment we’ll 
cover the manual formatting and steps you can 
do on a worksheet. 

• First, let’s consider the worksheet item. 
Near the bottom of a worksheet, a small 
tab will have a name on it; by default this 
would be Sheet1, Sheet 2, etc. Double 
clicking on the name activates the name 
field so you can change the sheet name. 
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TIP. Sheet names. You should always 
assign a clear and simple name to a 
worksheet that designates what it is for. 
Later, when looking at formulas for data 
management, simple named sheets are 
much easier to keep track of when 
building formulas. 

Managing sheets 

Next to the worksheet tab Excel offers a Plus 
sign, which allows the quick addition of new 
worksheets under their default name 
convention. 

• Right-clicking on the sheet name shows a 
context menu that allows you to add or 
delete sheets, copy and move sheets, 
protect sheets, add a tab color, and select 
multiple sheets to group. 

Sheet data formatting 

Worksheets, like documents in MS Word, offer 
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many text formatting options. Other than 
differences in text strings and numeric 
calculation data in cells, all the content in a 
worksheet can be formatted to look different: 

Home tab – Clipboard Group 

At the very left of the Ribbon is the clipboard 
group, which is a small set of tools you can 
use in relation to when text, images, and styles 
have been saved to the clipboard as you work. 
Clipboard-related activities include: 

• Copy 
• Cut 
• Paste 
• Redo 
• Undo 
• Paintbrush 
• Moving info by dragging 
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Format Painter – Home tab 
clipboard group 

• Allows you to “capture” an existing style 
and apply it to any object you click on. 

• Single-click applies once 
• Double-click locks so you can reuse it 

Understanding the clipboard 

• See the Clipboard Pane by clicking Home 
tab/Clipboard section expander icon 

• Can “store” numerous pieces of text and 
images 

• Items are stored temporarily (in RAM) until 
the program is closed. 

• You can also delete items off the clipboard. 
• You can store them and then choose 

which one to paste 
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Home tab – Font group 

MedAttrib: Beginning to Intermediate Excel. 
MS Excel Home tab Fonts group. 

“Fonts” refer to the letters (characters) used in 
text. Font formatting includes resizing, 
changing the font family, adding bold or 
emphasis, adjusting spacing between letters, 
and more. You can right-click on a word or 
cluster of words for the contextual menu, or 
use the Home Tab’s font group options. These 
include: 

• Style (font family) 
• Size 
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• Color 
• Bold, italics, underlining, strike-through 
• Changing text size 
• In Excel, the font color and cell 

background color (paint bucket) are also in 
the Font group. 

Home tab – Alignment group 

In Excel, alignment means the placement of 
text inside a cell. The data you input into cells, 
unless formatted into some numeric form, 
defaults to a Bottom Alignment and to an Align 
Left. Any workbooks you inherit may change 
these defaults, and you may develop a 
preference. 
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MedAttrib: Beginning to Intermediate Excel. 
MS Excel Home tab Alignment group. 

Home tab – Number group 

Text is easy to work with in Excel – the program 
just recognizes it as static data that is 
informational, not computational. However, 
numbers (unless used in something like an 
address or phone number) are recognized as 
data to calculate. 
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MedAttrib: Beginning to Intermediate Excel. 
MS Excel Home tab Number group. 

There are several types of numeric data that 
Excel recognizes, including: 

• Comma, which adds a comma and a 
decimal point with a default 2 decimals 
after the decimal point. 

• Dates, which offers both long and short US 
date formats 

• Time 
• Percentage 
• Currency (explained below) 
• Accounting money (explained below) 
• Fraction 
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Text Formatting 

The following steps demonstrate several 
fundamental formatting skills that will be 
applied to the workbook that we are 
developing for this chapter. The basic 
worksheet formatting tasks can all be found on 
Excel’s Home Menu Ribbon in the Font group. 

ACTION: MS Excel Try Me Activity #2 

This activity is a modification from MS Excel 
BootCamp. 

Let’s do a few basic Excel text formatting tasks. 
Let’s use the Excel_formatting.xlsx file that 
should be in your DataFiles folder. 

Before you start, you should use your file 
manager utility to make a copy of the 
Excel_formatting.docx file that is in your 
DataFiles folder, then paste the copy into your 
Examples / MS_Excel folder. 

Here is an example of what we are aiming for 
from the starter file you are working with: 
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MedAttrib: author-generated. MS Excel 
example formatting file. 

• If Excel isn’t open yet, open MS Excel. 
• Open a file, and use the browser dialog 

panel for the Excel_formatting.docx file 
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that should be in your Examples / 
MS_Excel folder, then open it. 

The Home ribbon has 9 groups. In this series 
of tasks, we’ll work with the Clipboard, Font, 
Alignment, and Styles groups. 

MedAttrib: Beginning to Intermediate Excel. 
MS Excel Font Group of Commands. 

Text Size and Styles 

First, we’ll work on Row 1, which is a document 
identifier title. 
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• Select cell A1. You can see it is selected in 
the formula bar and is active. 

• With the cell active, choose the Text size in 
the Font group and select 18. This makes 
the text a larger 18pt size. 

• Then, from the Font group, click the 
buttons for Bold, then Italic, then 
Underline. 

Keyboard Shortcut: Text Formats. Hold 
down the CTRL key while pressing the 
letter B (Bold), or I (Italic) or U 
(Underline) on your keyboard. MAC 
Users: CMD key. 

Cell and Text Colors 

You can emphasize a region of a spreadsheet 
by adding color to the cells and/or text. 

• Select the cells A1-F1. You may see the 
contents of only A1 in the formula bar, but 
also a selection outline around the 6 cells 
you chose. 

• Find the paintbucket Fill Color button on 
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the ribbon’s Font group, and click the 
down arrow on its right side. This will show 
you a color palette to choose a cell color 
from. 

• If you hover over the colors, a tooltip will 
appear with the color’s information. Click 
on Blue, Accent 5 Darker 25%, which is 
the second to the last column of colors, 
and second from the bottom of that 
column. 

• Click only cell A1 again. Then using the 
Font Color button on the ribbon’s Font 
group, click the down arrow on its right 
side. This will show you a color palette to 
choose a text color from. Select White. 
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MedAttrib: Beginning to Intermediate Excel. 
MS Excel Fill Color Palette. 

Merge Cells 

Data is entered solely into one cell at a time, 
like the exercise example’s rows and columns. 
However, for stylistic purposes, data can also be 
merged into more than one cell. For instance, 
the Merge & Center command is used to center 
the title of a worksheet directly above the 
columns of data. 

• Select cells A1-F1 again. 
• Click the arrow on the Merge & Center 

button in the Font section of the Home 
ribbon to select the Merge and Center 
setting. 
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MedAttrib: Beginning to Intermediate Excel. 
MS Excel Merge Cell Drop-Down Menu. 

• SAVE your work. 

Header rows 

Any range of data in Excel that you may want 
to sort, filter, and/or calculate should have a 
Header Row, which is a row that you use to 
identify the expected contents of the columns 
of data. Sometimes you may see instead a 
header column, but for this course the norm 
will be the header row above columns. 

The header row should stand out from the rest 
of the range of data for ease of identification. 
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• Select Cells A3-F3 
• Using the technique above, make them 

Bold. 
• With the A3-F3 cells still active, click the 

ribbon’s Font group Border button’s arrow 
on the ribbon and select Bottom Border. 

Borders 

In Excel, adding custom lines to a worksheet is 
known as adding borders. Borders are different 
from the grid lines that appear on a worksheet 
and that define the perimeter of the cell 
locations. The Borders command lets you add 
a variety of line styles to a worksheet that can 
make reading the worksheet much easier. The 
following steps illustrate methods for adding 
preset borders and custom borders to a 
worksheet: 

• Click the down arrow to the right of the 
Borders button in the Font group of 
commands in the Home page of the 
ribbon to view border options. (see Figure 
1.40). 
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• SAVE your work. 

MedAttrib: Beginning to Intermediate Excel. 
MS Excel Borders Dropdown Menu. 
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Autowidth Expansion 

You may find that the column E for the salary 
data is showing pound signs (####) in the data 
cells. This indicates that a numeric column is 
too narrow to accommodate the data in it. 
Whie a text column will show some of the data 
in a too-narrow column (like the Address 
column noted above did), Excel can’t do this 
with numbers, and Excel can’t do wrap text for 
numeric data either, because numeric formats 
are for calculations, not static information. 

You can fix this issue by widening the column. 
We’ll cover more column-related sizing later, 
but for now, the Autowidth action will suffice. 

• Select the whole column E – by clicking on 
the E column’s address E at its top. Your 
cursor tip should then show a down arrow. 

• Slowly move your cursor to the right until 
the tip shows a Crosshair graphic. This 
means you have hovered over the border 
between columns E and F. 

• Double-click while you see this crosshair, 
and column E should snap to a width that 
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shows all the numbers within. 

Alignment of Cell Content 

The data you input into cells, unless formatted 
into some numeric form, defaults to a Bottom 
Alignment and to an Align Left. Any workbooks 
you inherit may change these defaults, and you 
may develop a preference. For this worksheet, 
we’ll go for Top Alignment and Align Left. The 
file we are working with currently shows the 
first two columns are align center. 

• Select cell A3, and click the Top Align 
button on the ribbon’s Alignment section. 

• With A3 still selected, then click the Align 
Left button. 
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MedAttrib: Beginning to Intermediate Excel. 
MS Excel Alignment Group in Home Tab. 

You can change the alignments of several cells 
at one time: 

• Select cells A4-A21. 
• Click the Top Align and Align Left buttons 

again. The rest of the column should now 
look like Cell A3. 

• Now, select cells B4-F21, and click the Top 
Align and Align Left buttons again. The 
rest of the table will also be top aligned 
and aligned left. 
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There is just one cell may remain unaligned 
properly: cell B3. Let’s use the Excel Format 
Painter button to fix that. The Format Painter 
button will pick up the formatting of a cell, and 
hold it until you click on another cell to ‘copy’ 
the format onto it. 

• Select cell A3. 
• Click once on the Format Painter 

‘paintbrush’ button in the Home ribbon’s 
Clipboard group. 

• Then, click on cell B3. This should copy cell 
A3’s alignment format onto cell B3. 

• SAVE your work. 

Wrap Text 

Often, a column may have not be wide enough 
for the information in it, and the data will seem 
to be cut off. One way to fix this is to wrap 
text so that the cell will increase in size to 
accommodate the data. 

• Select cell C4. 
• Click on the Wrap Text button in the 
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Home ribbon’s Font group. See how the 
row expands in height to show all the data. 

• Now, while cell C4 is still active, click on 
the Format Painter button from the 
Clipboard group. 

• Then, while the Format Painter is active, 
hover and click over cells C5-C21 to apply 
the wrap text to the rest of the column. 

Keyboard Shortcut: Wrap Text. Press the 
ALT key and then the letters H and W 
one at a time. MAC Users: n/a. 

Number Formatting 

Text is easy to work with in Excel – the program 
just recognizes it as static data that is 
informational, not computational. However, 
numbers (unless used in something like an 
address or phone number) are recognized as 
data to calculate. There are several types of 
numeric data that Excel recognizes, including: 

• Comma, which adds a comma and a 
decimal point with a default 2 decimals 
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after the decimal point. 
• Dates, which offers both long and short US 

date formats 
• Time 
• Percentage 
• Currency 
• Accounting money 
• Fraction 

For this example, let’s first format the Salary 
columns contents with a comma so that the 
numbers look like common ‘thousand’ units. 

• Select cell E4. 
• Look for the Home ribbon’s group called 

Number, and the dialog box arrow, which 
will show a dropdown selection of number 
formats. Click that button. 

• Scroll down that list until you find 
Currency, and click on that. The cell’s 
contents will now appear as $44,200.00. 

• Let’s take out the “cents” part of that 
number. With cell E4 still active, click twice 
on the Number group’s Decrease Decimal. 
This should remove the .00 from the 
number. 
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• You can repeat the Currency format and 
Decrease Decimal steps after you select 
cells E5-E21. 

◦ Alternative method: use the Format 
Painter paintbrush to paint Cell E4’s 
format over cells E5-E21. Click once on 
the Format Painter ‘paintbrush’ 
button in the Home ribbon’s Clipboard 
group while cell E4 is active, then paint 
over cells E5-E21. 

• SAVE your work. 

MedAttrib: Beginning to Intermediate Excel. 
MS Excel Number Group of Commands. 
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The Format Cells Panel 

• When you become proficient with Excel 
and the content you plan to produce, you 
can also use a more comprehensive 
Format Cells panel, which has several tabs 
you can choose from while formatting a 
cell or row or column. 

MedAttrib: Beginning to Intermediate Excel. 
MS Excel Borders Tab of Format Cells Dialog. 

Here, we will add a line to the bottom of the 
data range we have been working on, so that 
you can input some data yourself, then format 
it. 
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• Click on cell A22, and type YOUR own first 
name in it. 

• Add more information for yourself in cells 
B22-F22. Other than your own real last 
name, please feel comfortable ‘making up’ 
data for the other cells so that you 
preserve your confidentiality. 

• Once you have your new data entered, 
click on cell A22. 

• Then, in the Font group on the Home 
ribbon, look for a tiny Font settings arrow 
icon in the group’s lower right corner, and 
click on it. This should open the panel for 
Cell Formatting, which has 6 tabs in it: 
Number, Font, Alignment, Border, Fill, 
Protection. 

• Since Cell A22 is a static text data, you can 
use the Font and Alignment tabs to look 
at your choices and to change the cell’s 
format. 

• Using the Alignment tab, make the 
contents of cell A22 top aligned, left 
aligned if it is not already, then click Okay. 

• RIGHT-Click on cell B22, then scroll down 
the contextual menu until you see the 
Format Cells option (you may have to 
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scroll down the menu list since it is near 
the bottom). Then, click on the Format 
Cells option. The same Cell Formatting 
panel you have already used will open. 

• Using the Alignment tab, make the 
contents of cell B22 top aligned, left 
aligned if it is not already, then click Okay. 

• Now, you can use either of these options to 
open the Cell Formatting panel as you 
adjust the formats of cells C22-F22. 

• OR, you can just select cells C21-F21 and 
click the Format Painter paintbrush button 
on the ribbon, and then run the style over 
cells C22-F22. 

• SAVE your work. 

Special Formatting 

Much of your data formatting will be basic 
tasks, like changing the color of the text or cell 
backgrounds, cell/column/row alignments and 
wrap, and selecting basic numeric formats like 
dates, accounting, percentages, etc. However, 
there are a number of basic additional formats 
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that Excel lets you customize for more 
complicated needs, like: 

• Phone numbers 
• Social Security numbers 
• Zip codes 
• Showing negative numbers in stand-out 

formatting 
• Additional date and time formats 
• Additional fraction formats 
• Customized number formats 
• Validation techniques 

These options are shown in the Format Cells 
panel, in the Number tab. 
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MedAttrib: autogenerated. MS Excel Format 
Cells panel. 

Examples: 

• Phone number: 2065551234 = (206) 
555-1234 

• Social Security Number: 2221111234 = 
222-111-1234 

• Zip Code + 4: 981012345 = 98101-2345 
• Negative Number (one of the formats): 

-2700 = (2,700) 
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AutoSum feature 

Applying mathematical computations to a 
range of cells is accomplished through 
functions in Excel. However, the following steps 
will demonstrate how you can quickly sum the 
values in a column of data using the AutoSum 
command in the Home menu ribbon: 

• Click cell F23 in the worksheet. 
• In the Home tab’s ribbon, look for the 

Editing group (more to the right of the 
ribbon). 

• Look for the button that looks like an and 
reads Sum when you hover over it. Click it 
while cell F23 is active. 

What you’ll ‘see’: Cell F23 will turn into a 
formula – =SUM(E4:E22) – and a dotted border 
and light blue fill will affect the column of 
numbers above it. 

• When you press the ENTER key on your 
keyboard, the sum will calculate 
automatically, and add up the numbers in 
the column above cell F23. 
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Now you will see the number of people in the 
data range we have been working with, 
including the row you input about YOU! 

• SAVE your work. 

Inserts 

In Excel, graphics like images, icons, and 
shapes We won’t cover all the insert options, 
but they work much the same way as the 
Picture one. 

Excel lets you add illustrations, like photos, 
clipart, WordArt, SmartArt, icons, and shapes. 
Inserts are ‘unanchored’ to cells, which means 
that they float above cells and can be easily 
moved without affecting the data typed and 
calculated inside your cells. Like in Word, in 
Excel an inserted item like a picture – when 
made active by clicking on it – will reveal a 
contextual Menu ribbon for doing editing work 
on the inserted item. 

• With the Excel_formatting.docx file still 
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open, let’s insert a picture. 
• Place your cursor around Cell A25. 
• In the Inserts menu ribbon, click the 

Illustrations group button for Pictures. 
• Click Pictures, which shows you image 

locations to choose from: This Device, or 
Stock Images, or Online Pictures. 

• In this case, assuming you are online, 
choose the Online Pictures option, which 
will pull open an Online Pictures window 
only. 

• Then, type in the name of your favorite 
place – if you have one – and look at the 
results you get. Then, choose one and click 
it, which will insert it into your worksheet. 

Your image could be in any size, so we’ll set 
a size for whatever image we use to practice 
resizing. 

• Click your inserted picture. This ‘activates’ 
the picture so that a new, contextual 
menu/ribbon appears at the right-hand 
side of your Menu bar, called Picture 
Format. We will use this ribbon for the 
next several steps. 
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• In the Picture Format ribbon, on the far 
right, choose the text field for the 
horizontal size, and type in 3”. This will 
resize your picture to 3 inches wide, and to 
whatever the proportional height is. 

• Next, click the Accessibility button on the 
Accessibility group. In the text field, type 
“image of my favorite place (and the 
place’s name)”, and place a checkmark in 
the Mark as decorative checkbox. This 
allows Excel to consider this image as 
accessible in the program. 

• Then, in the Picture Styles group, choose 
Picture Border, and in the dropdown, 
choose the color black. This adds a very 
narrow border to your picture. 

• in the Picture Styles group, choose Picture 
Border again, and in the dropdown, 
choose Weight, and on the flyout menu, 
choose 3pt. This will make a more 
prominent border for your picture. 

• SAVE your work, and close the file. EXCEL 
ACTIVITY #2 FINISHED. 
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Workbook Design 

Workbooks are made up of one or more 
worksheets, and are like a book holding file 
folders. Each worksheet can contain different 
data, but be part of the same project. You will 
likely – in the workplace – inherit existing 
workbooks, or create your own with multiple 
worksheets (pages). Managing them in the 
workbook, and designing the workbook itself, 
is a useful skill. 

ACTION: MS Excel Try Me Activity #3 

This activity is a modification from MS Excel 
BootCamp. 

For this chapter, we will use the data file 
Excel_design.xlsx in order to demonstrate the 
various steps. Please find and open 
Excel_design.xlsx, and save a copy to your 
Examples folder. Most of our work will use the 
Page Layout menu ribbon for themes, colors, 
fonts, and effects. 
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Adding and Deleting 
Worksheets 

Now, let’s add, then delete, new worksheets in 
this same file (workbook). 

• The Excel_design.xlsx file currently has 
one worksheet, named Sheet1. Click 
anywhere in the worksheet. 

• In the worksheet’s name tab section, 
double-click name tab that reads Sheet1. 
You can overwrite that name; rename the 
sheet Desserts. 

• In the worksheet’s name tab section, click 
the + to add another worksheet tab, which 
will default name itself Sheet2. It will 
appear just to the right of Desserts. 

• Click the + to add a third worksheet tab, 
which will default name itself Sheet3 and 
appear to the right of Sheet 2. 

• Click the + to add a fourth worksheet tab, 
which will default name itself Sheet4 and 
appear to the right of Sheet 3. 

We actually do not need all of these sheets. 
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• Choose Sheet2, so that you are in that 
blank sheet, then look in Home menu 
ribbon for the Cell group. 

• Click the down arrow on the Delete button 
and choose the Delete Sheet option from 
the drop-down list. This removes the 
Sheet2 worksheet. 

• Click the Delete button on the Delete 
warning box (if a warning box appears). 

◦ Alternate method: RIGHT-click on the 
tab of Sheet3, which will offer a 
contextual menu. On the menu, click 
Delete. 

• SAVE your work. 

Keyboard Shortcut: Inserting New 
Worksheets. Press the SHIFT key and 
then the F11 key on your keyboard. 

Renaming worksheets 

The default names for new worksheet tabs at 
the bottom of any workbook are Sheet1, Sheet2, 
and so on. However, you can change the 
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worksheet tab names to identify the data you 
are using in a workbook. Additionally, using you 
can change the order in which the worksheet 
tabs appear in the workbook, and using that 
same process add a worksheet, delete one, 
protect one, etc. 

The following steps explain how to rename and 
manage the worksheets in a workbook: 

• Double-click the Sheet4 worksheet tab at 
the bottom of the workbook. Type the 
name Beverages. 

• Press the ENTER key on your keyboard. 
Now we have a nice, empty sheet. 

• Moving worksheets 

There are a couple of ways you can move a 
worksheet. We’ll try both for practice. 

• Right-click on the Beverages worksheet’s 
tab name. In the dropdown menu, select 
Move or Copy from the dropdown menu. 

• In the Move or Copy panel, do NOT put a 
checkmark in the Create a copy checkbox. 
This is so that the Beverages sheet will 
only be moved. 
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The To book field will show the name of the 
current file, since we are moving inside the 
same file. 

• Then, in the Before sheet, click Desserts (to 
move before that sheet) and click the OK 
button. The Beverages sheet should now 
be the first available worksheet tab at the 
left. 

TIP: Copying/moving worksheets. You 
can use this same technique to copy a 
worksheet to add somewhere in the 
same workbook, or to start another 
workbook altogether. You would make 
sure to put a checkmark in the Create a 
copy checkbox. To open the copy to a 
new workbook, you would also choose 
to move to (new book). 

Nope, we don’t like it there. Let’s move it back. 

• Press your mouse cursor down on the 
Beverages worksheet’s name tab, until 
you see a small icon of a sheet of paper 
floating near your cursor. That is the 
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indicator that you can, while still pressing 
down on the mouse cursor, drag the 
worksheet tab. 

• Drag the Beverages worksheet tab to the 
right of the Desserts worksheet tab, then 
release the mouse/cursor. The Beverages 
sheet should now be at the end of the row 
of worksheet name tabs. 

• SAVE your work. 

MedAttrib: author-generated. MS Excel 
worksheet design final result. 
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Page Layouts – Page Layout 
Tab 

In MS Word, documents allow both a design 
and layout Menu ribbon. Because Excel is 
mostly about analysis and calculation, the 
essential design and layout options have been 
combined into the Excel Page Layout menu/
ribbon. The Page Layout tab allows you to set 
the physical format of your worksheet. What 
you do here will stick with your document and 
once in the Print preview before printing/
distributing your work, the prepared output 
should be assured. 

Setting up documents – Page 
Layout tab 

The Page Layout tab allows you to set the 
physical format of your page, which is a good 
starting step in word processing work. This 
determines how large the paper used will be, 
the margins, the orientation of the document, 
etc. In the Layout tab’s ribbon, you can use the 
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page setup group icon dropdowns, or the 
group’s panel activation arrow, to accomplish 
(in order of page setup group). 

TIP: Multiple Worksheet set-up: You can 
select all the worksheets in your 
workbook and set the Page Layout 
options all at once, if you know what 
your project parameters will be. 

• Page margins: the white space around the 
edges of a page that won’t be printed on , 
and also which adds white space around a 
document’s content for viewability. 

• Page orientation: the height and width 
direction of a page. Default and common 
use is Portrait, in which a document is 
taller than wide. Horizontal is commonly 
more useful in Excel since ranges of data/
tables can be wide, with many columns. 

• Page size: the paper size of a document, 
even if it never is intended to be printed on 
paper. Users may choose to print the 
document, print a PDF, and or take a 
screenshot image for later printing/
pasting into another document. The 
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default is 8.5 x 11 inches, with other 
common page sizes being legal (8.5 x 14 
inches), and ledger (11 x 14inches). Other 
listed sizes may be legacy for office 
documents. In Excel, a common selectin is 
8.5 x 14, since tables with many columns of 
data tend to be wide. 

• Breaks: You can create a new page break, 
a break to begin and end a different 
column style, or wrap text around an 
inserted image, and add new section 
breaks. 

• Print area: This allows you to designate a 
specific range of columns and rows to be 
printed, even if it is smaller than the whole 
of your worksheet’s contents. 

For this workbook, Excel_design.xlsx, let’s 
adjust the layout of the margins, page 
orientation, and page size. 

• Click anywhere in the Desserts worksheet. 
• Go to the Page Layout ribbon’s Page 

Setup group, and click Margins. 
• With Margins open, choose Narrow. Then, 

click Margins again, and choose Custom 
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Margins (at the bottom). 

Custom Margins will open the Page Setup 
panel, and the Margins tab in it. Make the 
changes to the margins that you see in the 
image below: 

• Top margin=1, Bottom margin=.70, 
Header=.25, Footer=.25, Center on 
page=Horizontally 

MedAttrib: author-generated. MS Excel Page 
setup. 
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• Click OK to exit the Page Setup panel. 
• Next, choose Orientation from the Page 

Layout ribbon’s Page Setup group. 
• Choose Landscape. The default is Portrait, 

which makes the worksheet print-out 
taller than it is wide. Landscape will make 
it wider than tall, and help accommodate 
more columns of information on the same 
page. 

• Now, choose Size from the Page Layout 
ribbon’s Page Setup group. 

• In the Size dropdown, choose Legal. Legal 
is often used for spreadsheets due to their 
many columns that need to appear on a 
single page. 

• SAVE your work. 

Designing documents – Design 
tab 

Themes apply decorative styles to your Excel 
worksheet, such as fonts, colors, effect options, 
paragraph spacing, etc. They can give a set of 
documents a consistent and attractive 
appearance and make your word processing 
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efforts look more professional. In business, they 
are best used as part of a “package” of 
documents, such as a letterhead and envelope 
set or as part of a report style. They can 
enhance what you want to communicate by 
adding company branding colors and fonts. 
You can also: 

• Make your document more readable than 
just black-and-white text. 

• Tie consistent inserts, like shapes and 
borders, together with the rest of the 
document’s “look”. 

• Use different colors and font styles to 
punctuate header rows from the data 
cells. 

• Easily update the whole look of your 
document just by changing the color or 
font variants 

• Design: Theming / Design Tips 

Using themes can be a double-edged sword. 
While they can add attractiveness to your 
documents, they can also, if misused, make 
your work look confusing, be hard to read, and 
muddy your communication message. 
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• Choose theme colors that make sense for 
the product, service, or idea(s) you are 
trying to communicate 

• Choose theme backgrounds that have 
good contrast and allow text to be very 
easy to read 

• Choose fonts for readability, based on need 
for headlines, lots of paragraph texts, easy 
bulleting, etc. 

• Remember that less is more – more colors 
and font variations in one document can 
look unprofessional and take away from 
your message. 

Design: Theme Variants 

Theme variants let you change aspects of a 
theme you select to apply a different core font 
family to it, or to change the color palette it will 
work with. 

• Fonts: Font families in themes are 
designed and sized to be readable and 
hopefully scannable by screen readers for 
accessibility use. The style will offer a font 
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for titles/subtitles, and another for general 
text. Available font families come installed 
with the computer’s operating system, 
and may also be accessed from the word 
processing software’s installation or cloud-
based accessories. 

• Color Palettes: Like fonts, color palettes are 
included in a style, and can also be 
changed independently to modify and 
create a new style. For instance, the overall 
design style of a theme may work for you, 
but the color palette assigned to it may 
not have enough contrast for your 
audience, or your company may focus on a 
different rage of core colors. 

• Effects: These are subtle styles that can be 
attached to some inserted items, like 
image borders, shapes, SmartArt, etc. 

• Scale to fit group: Scale to fit in Excel is a 
way to preset your worksheet for print 
views. 

• Sheet options group: This group lets you 
designate if you want to see gridlines on 
your sheet while you work. Grid lines are 
not the same as borders, and will not 
appear on printed pages. 
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Using Themes 

We’ll start with the Page Layout ribbon. This is 
because when putting together a spreadsheet, 
it is efficient to work from the macro level to 
the granular level; the theme, colors, and other 
things that affect all the styling of the 
worksheet should be considered when 
creating the project, so that any inserts, tables, 
and charts/graphs flow from the color and font 
selections. 

In Excel_design.xlsx, we’ll change the theme 
first, then determine if it meets our needs and 
how to adjust it by choosing other colors and/
or fonts. Normally, Excel defaults to the current 
Office theme, which gives a palette of colors 
and shades from across the color spectrum. 
However, on spreadsheets, you may instead 
prefer a different color set, or inherit a 
workbook at work that uses another color 
scheme, or be tasked with an assignment with 
certain theme specifications. While Excel is 
designed for themes to be changed almost 
effortlessly and without technical glitching. It 
is always good to plan your work and do steps 
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efficiently to avoid rework or conflicts to very 
large spreadsheets later. 

Colors to prioritize for this small company: royal 
blue, muted brick red, white, French blue, 
yellow ochre, pale lavender. We’ll find out what 
applies in the color themes, if any. Blues and 
related muted colors are preferred. 

• Click on cell A1, then choose the Page 
Layout menu ribbon. 

• In the Themes group of the ribbon, choose 
the Themes dropdown box arrow. 

• For fun, just click on a few – on your screen 
outside the Themes dropdown, you can 
see the fonts, header row color, and the 
Taste du Monde “croissant” image effects 
seem to Preview a change. 

We’ll settle on the Berlin theme, because the 
font selection seems easy enough to read with 
a little added text boldness, but not too stylistic 
to make a workbook hard to understand. 

• SAVE your work. 
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MedAttrib: author-generated. MS Excel 
themes/colors/fonts dropdowns. 

Modifying Themes 

Now, the Berlin theme has great fonts, but the 
color palette may not work. Let’s check it out. 
The Taste du Monde header row is currently 
kind of an orange-brown color. Not good for 
the company’s planned color scheme. 

• Right-click on the cell A5, the first cell in 
the header row, which will pull up a menu 
list. 

• Choose the Format Cells (you may have to 
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scroll down the menu list since it is near 
the bottom), which opens the Format Cells 
panel. In this panel, choose the Fill tab. 

• In the Fill tab, look at the upper left that 
shows a palette of 10 columns of colors 
and their shades. This is the color palette 
for this particular theme, and includes 
maybe a couple of the muted French 
county colors we could use, but no blues. 
No thank you! 

• Exit the Format Cells panel by clicking 
Cancel. 

Colors Palette 

Now, let’s consider other color options for this 
theme. While keeping the Berlin theme, we 
will use the Colors panel to look at options 
and change the color palette. 

• You can click anywhere on the work area 
of your worksheet; then In the Themes 
group of the ribbon, choose the Colors 
dropdown box arrow. 

• We are looking for something that has a 
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dark blue, medium blue, darkish brick red, 
and a couple of neutral colors in the 
palette that could be purposed for Taste 
du Monde. Scroll down the Colors 
dropdown, and notice how our header 
row’s color changes. The closest we may 
find is the Aspect color palette. 

◦ Note: this course is focusing on Excel 
for Windows (PC) and the assumption 
that your full installation has all the 
built-in items, like themes, color 
palettes, etc. However. If you don’t 
have some of these themes or named 
palettes / font collections, choose what 
you can to gain the skills-building 
anyway. 

• In the Colors palette, choose Aspect (near 
or at the bottom of the list). This looks 
mostly like reds and so we’ll repeat looking 
at cell A5 in the Cell Format panel’s Fill Tab 
to check out the color palette’s spread of 
colors. 

• In the Cell Format panel’s Fill Tab, look at 
the color palette. In it, there is a blue 
column with a dark blue and a French 
blue, dark brick reddish color, a lavender 
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color, a kind of light tan, and white. This 
should do. We can use a later use a color 
search for a pale yellow, if needed. 

• Click on the 7th column’s dark blue 
(second from the bottom), which will fill 
the A5 cell, then click OK. 

• Use the Home menu’s Format Painter 
paintbrush to paint the style of cell A5 over 
B5-D5. 

Fonts Palette 

Because the Taste du Monde’s header row had 
already had a dark color, the text was already 
white, so we do not need to change the text 
color for readability / contrast. However. We can 
look at the Fonts palette to determine if we 
want a different font set. 

• You can click anywhere on the work area 
of your worksheet; then In the Themes 
group of the ribbon, choose the Fonts 
dropdown box arrow. 

• In the dropdown list, there are a number of 
font sets. Unfortunately, the dropdown list 
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does not show which specific font set we 
are using. You need to click on one of the 
cells in your workspace to see, in the Home 
ribbon’s Font Field which font this 
document is using: Trebuchet. 

• Scroll down and see how the fonts on your 
worksheet seem affected in the preview. 
You can choose to experiment by clicking 
on one or two, but for Taste du Monde, 
we’ll stay with the Berlin theme’s chosen 
fonts. 

• SAVE your work. 

Effects Panel 

The Effects panel lets you preview some effects 
that can be used on graphics like shapes, 
SmartArt, WordArt, and image borders in Excel 
workbooks. In this Taste du Monde worksheet, 
there is already a croissant image that we can 
use to observe what happens with effect 
changes. 

• In the Themes group of the ribbon, choose 
the Effects dropdown box arrow. 
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• For fun, just click on a few – on your screen 
outside the Effects dropdown, you can 
observe the croissant image effects in a 
Preview. Some of the effect options seem 
to make a big change; others seem barely 
noticeable. 

• Click on the Frosted Glass effect to choose 
it. 

• SAVE your work, and close the file. EXCEL 
ACTIVITY #3 FINISHED. 

Now you should have a good handle on basic 
workbooks design. 

Datasets 

Excel is all about data. The data is for viewing, 
organizing, sorting/filtering, analyzing, and 
calculating so that business problems can be 
considered and solved. The more organized the 
data is, the better you will be able to use it, 
analyze it, and get the needed calculations, 
graphs, and pivot tables to answer your 
questions. 
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A dataset is simply a range of data – a range of 
cells in tabular format. It may be formatted or 
unformatted, have an assigned name or be in a 
table object. 

 

ACTION: Quick Task 

Let’s look at an image of some Excel work. In it 
the cells A1 through D7 have data that seems 
related to each other. Cells E1-E6 is a column of 
data, as is the column of G1-G5. This is all part 
of a dataset, although only cells A1 through D7 
seem to meet the dataset definition of being 
contiguous. 

MedAttrib: author-generated. MS Excel 
dataset. 
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Understanding Cells 

• Cell contents: As discussed above, all data 
in Excel (other than inserted objects like 
pictures) is input into cells. Each cell is 
something that, as part of a row and 
column, can be sorted, calculated, and tell 
a story. 

• Cell addresses: Data are entered and 
managed in cells by entering numeric and 
non-numeric data. Each cell in an Excel 
worksheet contains an identification 
address, which is defined by a column 
letter followed by a row number. For 
example, the top left cell A1. This would be 
referred to as cell location A1 (or cell 
reference A1). You can navigate in an Excel 
worksheet with your mouse pointer or 
using the arrow buttons on your keyboard. 

• Column Headings: In Excel, data rarely 
means anything to a viewer if there is no 
context attached to it. Commonly this is 
done through column headings, which 
identify what the content in the column is 
supposed to be. This can also be done as 
row headers instead, but in this course 
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we’ll mostly use the standard column 
headings. 

Rows/Columns 

Rows and columns can be adjusted to help 
make visualizing and analyzing data easier. 

• Resizing: You can resize columns from the 
Home tab Cells group to reveal 
information that looks cut off, or to narrow 
them if there is too much space. Same 
with rows if the row is too tall or seems to 
have cut off anything other than the first 
line of text. 

• Inserting/Deleting: Rows and columns 
can be inserted as needed from the Home 
tab Cells group, in order to expand for data 
to be added. Existing columns and rows 
can also be deleted. 

• Hiding/Unhiding: You may have a 
worksheet with a lot of columns, but really 
only need to see some of the data to 
analyze/decide on an action. Hiding 
columns or rows can help you focus. 
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• Sorts: In addition, information in a dataset 
can be sorted from the Data tab Sorts & 
Filters group, so that a column shows 
information in an alphanumeric order or in 
some more customized order. 

• Filters: A dataset may have information 
about more customers or other content 
than you need: using a filter from the Data 
tab Sorts & Filters group lets you 
temporarily hide unwanted information so 
you can get a snapshot view. 

• Freezing Panes: If a dataset is made up of 
hundreds of record – long enough that you 
need to scroll down several pages to see it 
all, or over enough columns that you can’t 
see the important left-most columns, you 
can freeze a column or two, or the header 
row, so that the information remains in 
view no matter how much you have to 
scroll. 

ACTION: Quick Task 

Back to the image again: 
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• 

MedAttrib: author-generated. MS Excel 
dataset. 

In here, all three batches of data are ‘ranges’ of 
data. This is important, because we may want 
to actually reference them in a tidy way for 
formulas and general reference. As they exist 
now, they are simply designated by the cell 
collections. A1:C7, E1-E6, G1-G5. 

Conditional Formatting – Home 
Tab 

You can apply conditional formatting based on 
specific conditions you want to be highlighted. 
Example: contents of cell is less than a certain 
quantity. 
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Data – Data Tab 

Excel allows you to manipulate data – how it 
is sorted, imported, filtered, validated, and 
grouped. 

• You can import existing data from the 
web, another spreadsheet, a database, 
XML, and more (advanced). 

• You can sort rows and columns, such as for 
alphabetizing. 

• You can filter tables to show only certain 
rows or tables based on criteria you set – 
the rest is simply hidden, not gone. 

• You can remove duplicates of data. 
• You can group info to create subtotals, 

before totaling those. 
• You can use flash-fill to add large amounts 

of consecutive data. 

As noted above, a dataset is simply a range of 
data. However, what needs to happen with 
data is what is important. Formulas that 
calculate data for specific purposes need to be 
able to find the data and easily add it to the 
formula. Sometimes the data will be all the 
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contents of a table. Sometimes it will be only 
a column or two, or a few rows. In these cases, 
being able to “set aside” the data range in an 
identifiable way is crucial. You can do this by 
identifying data ranges. 

• Selecting: You select a data range by 
choosing a selection of row and column 
cells, such as A1 through D10, or A1:D10. 

• Naming: To make that data range useful 
and easy to refer to in a formula, you need 
to name it. This can be done in the 
Formulas tab’s Defined Names group by 
using the Name Manager panel to give the 
data range a name. Once this is done, you 
can see a list of every named data range in 
the Excel Address field. 

• Use in formulas: In a formula, you can use 
the named range as the data range 
reference in the formula. 
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ACTION: MS Excel Try Me Activity 
#4 

This activity is a modification from MS Excel 
BootCamp. 

Let’s now work with an Excel file: 
Excel_datasets.xlsx. This is a dataset from our 
friend Taste du Monde that we can use for 
looking at a dataset, identify ranges of data, 
and set names for two or three of them. 

Save a copy of Excel_datasets.xlsx to your 
Examples / MS_Excel folder, then open it for 
work. It already includes the Taste du Monde 
logo icon and WordArt and link to their 
website. It also includes records of customer 
data including names, addresses, emails, and 
opt-in decisions. 

The whole set of A6 through J36 is a data set. 

• Select only cells A6 through C36. This is a 
range of data of that range of cells of 
customer names and their customer ID. 

• Deselect it. 
• Select only cells A6 through J9. This is a 
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range of data of the first two customer 
records. 

• Deselect it. 

Now, let’s choose a range of data and name it 
for possible later use. 

• Select only cells F6 through H36. 
• With these cells selected, choose the 

Formulas menu ribbon. 
• In the Formulas ribbon, look at the 

Defined names group. Select the 
dropdown arrow of the Defined Name 
button. 

• Click on “Defined name”, which will open 
a dialog box. 

• In the dialog box, in the Name field, type 
TM_Region. 

• In the dialog’s Scope, leave the default of 
workbook. 

• In the comment field, type: Taste du 
Monde customer regions. 

In the Refers to field, note that Excel recognizes 
that you selected as =Customers!$F$6:$H$36, 
which is referring to the worksheet called 
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Customers, and the range of data from F6 
through H36. Click OK. 

• Now, click on the dropdown arrow of the 
Name box in the Excel UI, which usually 
shows the address of the Cell you have 
clicked in. When you click on the arrow, 
you should see TM_Regions listed. This is a 
named data range. 

• Click on TM_Regions in the Name box. 
Excel will select the range of data you just 
named – cells F6 through H36. 

• SAVE your work. 

Moving ranges 

Let’s move a named range. 

If you have not yet saved Excel_datasets.xlsx, 
DO IT NOW, please. We will do a task we may 
not want to keep but you don’t want to lose 
any previous work. 

• With Excel_datasets.xlsx still open, use the 
Name box to choose TM_Regions. Excel 
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will select the cells that make up that 
named range. 

• Right-click and choose Cut (or use the 
shortcut of CTRL X / CMD X for Mac), which 
will ‘cut’ the selection. 

• Place your cursor in cell L6, right-click, and 
choose Paste (or CTRL V / CMD V). 

The named range has been moved. 

• Close the Excel_datasets.xlsx without 
saving it. 

Sorting data 

Let’s work with sorting and filtering data 
ranges. We actually want to work with the 
Excel_datasets.xlsx file again. We just didn’t 
want to save the last set of changes made. 
Please open the Excel_datasets.xlsx file. 

The dataset has a header row, which has been 
emphasized with bold text. This will help us 
identify what we want to sort and filter. 

The important thing to know about datasets 
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and named data ranges is that, although they 
display data in columns and rows, the data is 
not actually connected. Let’s see what this 
means. 

• Select the contents of Column I, Cells 
I6-I36. Copy it, then move your cursor to 
Cell J6. 

• In Cell J6, paste the data you just copied. 
Now you have two columns of Opt-In 
responses. 

• Select the data of Column J: Cells J6-J36. 
Use the format painter in the Home ribbon 
to paint the cell backgrounds a light color, 
like gray. 

• With this J column data still selected, 
choose the Data ribbon. In the ribbon, 
choose the Sort & Filter group, Sort A to Z 
button. 

You should see a sort warning message: 
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MedAttrib: author-generated. MS Excel Sort 
warning. 

• What to do? Let’s choose “Continue with 
the current selection” then click the Sort 
button to observe what happens. 

Review the two Opt-In columns. The J column 
one is out of order compared to the original I 
column. That is a problem. 

Why did we go through this? Well, back in the 
Bronze Age when the author first worked with 
Excel, there were no warnings about sorts of 
data records in relation to a dataset that wasn’t 
actually connected as a table. The author 
hangs her head in shame at the data sorting 
mistakes that occurred. Now, even with the 
Excel sort warning, it can still be easy for an 
inexperienced data analyst to accidentally sort 
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only part of a dataset, which would corrupt a 
batch of data when some information 
becomes untethered from its proper record. 
This would affect the data accuracy, the results 
of pivot summary tables, and definitely skew 
charts based on the data. 

Let’s be more careful and try again. 

• First, delete column J – the incorrectly 
sorted column. 

• Next, select data from Column C, Cells 
C6-C36. This will give us the last names of 
customers. 

• With this selection, again go to the Data 
ribbon, and select the Sort icon. 

• Again, we will get the Sort warning. In this 
case, leave the default selected response 
of “Expand the selection”, then click the 
Sort button. 

Now, Excel will select – for us – the entire range 
of data from Cell A6 through I36. 

• In addition, the Sort panel gives us a 
choice of what to sort. In the Column Sort 
By field, choose CustLName. 
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• In the Sort By field, leave the default of Cell 
Values – Excel will sort based on the 
content rather than some other method. 

• In to Order field, keep the default of A to Z. 
• Click the OK button to generate the sort. 

MedAttrib: author-generated. MS Excel Sort 
panel. 

The whole data range of Cells A6-I36 should 
have been properly sorted, in A-Z order, based 
on the customer’s last name. 

• SAVE your work. 
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Filtering data 

Can we also filter data in a data range? Let’s 
find out. 

• Place your cursor on any cell in the data 
range of Cells A6-I36. 

• Choose the Data ribbon Sort & Filter group, 
and select the Advanced Filter button. 

An Advanced Filter panel opens, which already 
displays the List range of A6-I36. That is 
efficient. So is the default option to filter the 
list in place. However, the filter requires some 
Criteria range to filter in or out. That requires us 
to give a specific data range – like one of the 
columns. 
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MedAttrib: author-generated. MS Excel 
Advanced Filter panel. 

• Click inside the Criteria range field, then 
type f6:f36. This should select the State 
column in our dataset. Then click OK. 

Hmmmm. Looks like nothing happened. Why? 
Well, in the end, we asked for a filter, yet the 
advanced filter didn’t really know what to filter 
for. Given that we were working with an 
unconnected dataset of rows and columns, 
Excel couldn’t comply. Let’s try something else. 
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• Place your cursor on any cell in the data 
range of Cells A6-I36. 

• Choose the Data ribbon Sort & Filter group, 
and select the larger Filter icon. 
Something interesting happens. In the 
header row of our dataset, a bunch of 
small dropdown arrows appears. This 
tethers together the columns and rows, so 
that a filter can work with the range of 
A6-I36. 

• Click the dropdown arrow in Cell F6. 

You can see that the column can actually be 
SORTED. Yay! Let’s click the Sort A to Z. 

• The whole dataset sorts to the A to Z of the 
States. Now, let’s filter out all states but 
Colorado (CO). 

• Click the dropdown arrow in Cell F6. In the 
dropdown, Uncheck the Select all box. 
Then, put a checkmark only in the CO 
checkbox, and click OK. 

There we have it; the dataset has had 
everything filtered out except Colorado. All the 
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data still exists, but we can review only these 
two records until we clear the filter. 

• To clear the filter, click the dropdown 
arrow in Cell F6. In the dropdown, choose 
the Clear Filter from “State”. 

• SAVE your work, and close the file. EXCEL 
ACTIVITY #4 FINISHED. 

Here is the really great news. Next, we will work 
with tables, so that we can utilize Excel’s 
connecting of data records in a range without 
having to go through some of these manual 
steps. 

Tables 

Even though Excel is all about data ranges, a 
very easy and useful way of accessing ranges of 
data is to simply convert them to an Excel table 
object. The table links record rows and columns 
together, and builds in formatting, sort and 
filter capabilities, a header and total row option, 
and can be named as a data range. Tables can 
be inserted from the Insert tab Tables group. 
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Turning a range of cells into an Excel table 
makes related data easier to analyze, visualize, 
and report. Structuring and planning table 
layouts are vital for data integrity. Below are 
guidelines to consider when designing and 
building a table from scratch: 

MedAttrib: author-generated. MS Excel Tables 
info. 

ACTION: MS Excel Try Me Activity #5 

Before you start, you should use your file 
manager utility to make a copy of the 
Excel_tablebasics.xlsx file that is in your 
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DataFiles folder, then paste the copy into your 
Examples / MS_Excel folder. 

Let’s open the file Excel_tablebasics.xlsx from 
the Datafiles MS_Excel folder. This is a variant 
on the previous Taste du Monde information 
with new names/records. The Page Layout 
theme should already be the Berlin theme and 
Aspect color palette, which will give us the 
colors to use in this activity. The workbook 
setup is for Narrow margins, horizontal 
orientation, and legal paper size. 

Create a table 

In the Excel_tablebasics.xlsx file, we have one 
worksheet: Customers. We want to take this 
dataset and convert it into an Excel table 
object. 

Right now, we have a dataset with Row 7 that 
reads FirstName, LastName, Address, City, 
Region, PostalCode, and PhoneNumber. 

• Select the data in Cells A7 through G30. 
• With this range of data selected, go to the 
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Insert ribbon, Tables group. 
• In the Tables group, click the Table icon. 

A Create Table dialog box should open, which 
should already have entered the data range of 
cells you selected into the ‘Where is the data for 
your table?’ field. 

• Click the checkbox next to My table has 
headers, then click OK. 

• The data range will now be encased in an 
Excel table. Now, let’s name the table, then 
change the table design. 

• Click in the table, and then go to the Table 
Design ribbon. In it, overwrite the name 
Table1 with TMcustomers. 

• With the Design ribbon still active, use the 
Table Styles group to choose Tan Table 
Style Medium 14. 

• Adjust the width of the table columns so 
that the content doesn’t overflow. 

• SAVE your work. 
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Context menu 

• Click anywhere in the new table. 

When you activate a table, a contextual Table 
Design ribbon opens near the top right of your 
Excel UI. Click on that tab. 

MedAttrib: author-generated. MS Excel Table 
Design ribbon. 

The ribbon has several groups: 

• Properties: Allows for naming and table 
resizing. 

• Tools: Contains some table analysis tools. 
• External Table Data: For use with linked 

live data sources, like a database that may 
have changes happen to it. 

• Table Style Options: Basic table parts 
designation items. 

• Table Styles: Color and layout styles for 
tables based on the Excel theme, color 
palette, and font palette you choose. 
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For our purposes, we will use the groups of 
Properties, Table Style Options, and Table 
Styles. 

Entering & deleting records 

Tables require constant updating and may 
need calculations. When your table needs 
updating you can add/delete data, by adding/
deleting rows, or columns. Excel adjusts the 
table automatically to the new content. The 
format applied to the banded rows updates to 
accommodate the new data set size. 

When calculations are needed you can create 
a calculated column or use the built-in Total 
Row tool. Excel tables are a fantastic tool for 
entering formulas efficiently in a calculated 
column. Excel allows you to enter a single 
formula in one cell, and then that formula will 
automatically expand to the rest of the column 
by itself. There’s no need to use the Fill or Copy 
commands. This feature can be incredibly 
time-saving, especially if you have a lot of rows. 
And the same thing happens when you 
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change a formula; the change will also expand 
to the rest of the calculated column. 

For now, we’ll just add a little data. 

• Click into Cell A31, and type your own first 
name, then click your keyboard’s Tab 
button. 

• In the next cell, type your own last name, 
then click Tab again. 

• In the third cell, type a made-up street 
address then hit Enter. The table 
expanded its format and range down to 
accommodate the new row of text you 
entered. 

TIP: Adding Rows. It can be tempting to 
insert blank rows further up in a table 
and add data, yet with the ease of 
sorting and filtering, that isn’t really an 
efficient way of adding data. 

First, let’s add a column. We’ll want to add 
some budget numbers. We’ll just do the simple 
thing and add a default number so that we can 
move quickly. 
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• Click in Cell H7, which is to the right of the 
7th header column title. 

• Type ProductSales then click your Enter 
key. Cool! Excel just added a whole column 
of formatted space to our table. 

• In Cell H8, type 25, then press Enter. 
• Copy the contents of Cell H8, and paste 

the data into Cells H9 through H30. 

Why did we do this? We want to add a total row 
to the table using the Table Design tab options. 

Delete Table Columns 

You can easily add and delete columns and 
rows to a table. Let’s delete a column we don’t 
really need – the PostalCode column. 

• Click in Cell F7. Then click on the Home 
Tab, and look for the Cells group. In this 
group, click the Delete dropdown arrow, 
and from the list, choose Delete Table 
Columns. The PostalCode column 
disappears. 
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Total row 

A useful table tool for data analysis is the Total 
Row. You can quickly total data in an Excel table 
by enabling the Total Row option, and then use 
one of several built-in functions provided in a 
drop-down list, per column. The Total row, 
which is added to the end of the table after 
the last data record, can calculate summary 
statistics, including the average, sum, 
minimum, and maximum of select fields 
within the table. 

The Total row is formatted with values 
displayed in bold, the double border line option 
is separating the data records from the Total 
row. 
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MedAttrib: Beginning to Intermediate Excel. 
MS Excel total row. 

• Click anywhere in the Customers table, 
then choose the Table Design ribbon. 

• In the Table Design, click the Total Row 
checkbox In the Table Style Options group. 
This will add a table row. 

Excel redirects you to the bottom of the table 
to view the total row, where a SUM of 600 
defaulted in the Prices column. 

Let’s add a currency format using the Home 
tab Number group Number Format dropdown 
menu. 

Another benefit of Excel table objects is that 
you can sort and filter columns without the 
data being mis-sorted, because the table locks 
a record’s data together. 

Before we close this activity, let’s sort, then 
filter, the Customers table. 

• Click anywhere in the Customers table. 
• Sort the City column with the Filter button 

by opening the dropdown filter options 
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and choosing Sort A to Z. 
• Filter the State column with the Filter 

button by opening the dropdown filter 
options. 

• In the options, uncheck the box for Select 
All. 

• Then check the boxes for only CA. The 
table will have collapsed rows to show only 
the state CA, and the total for only those 
products. 

• SAVE your work, and close the file. EXCEL 
ACTIVITY #5 FINISHED. 

MedAttrib: author-generated Image of MS 
Excel table activity. 

Calculations 

This section reviews the fundamental skills for 
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entering formulas into an Excel worksheet. The 
example used for this chapter is the 
construction of a personal budget. Most 
financial advisors recommend that all 
households construct and maintain a personal 
budget to achieve and maintain strong 
financial health. Organizing and maintaining 
a personal budget is a skill you can practice 
at any point in your life. Whether you are 
managing your expenses during college or 
maintaining the finances of a family of four, 
a personal budget can be a vital tool when 
making financial decisions. Excel can make 
managing your money a fun and rewarding 
exercise. 

As a result, Excel is used for many kinds of 
calculations: mathematical, statistical, 
financial, scientific, reference lookups, and 
more. It is useful in many types of business, 
and is a key tool in cleaning, calculating, and 
analyzing data. 
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Formula Basics 

A main strength of Excel is that you can use 
it to calculate data in many ways. Calculations 
allow for the development of additional data 
for analysis and decision making. A 
spreadsheet full of employees, their salaries, 
and the value of their benefits packages is 
useful. Calculating the annual and quarterly 
costs can be more useful in using for 
comparisons, preparing for taxes, etc. 

Excel formulas are an expression that operates 
on values in a range of cells and return a result. 
They let you do calculations like addition, 
subtraction, multiplication, and division. 

Excel functions are also formulas, but they are 
predefined and perform calculations by using 
specific values, called arguments, in a 
particular order, or structure. 

Formula bar 

We’ve used the formula bar a bit when not 
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directly inputting data into Excel cells. The 
formula bar shows what is in a cell. However, 
its power comes from the ability to write and 
process formulas, to display named ranges and 
how the formula is organized, and in helping 
identify errors. 

In the example, the formula bar is displaying 
a simple calculation for Cell A1. To the left of 
the field, the small fx icon is a way to open 
the Functions panel and access to the Excel 
functions library. The green checkmark is a way 
to approve a formula instead of simply pressing 
Enter. The red X is important because it allows 
you to back out of the formula bar without 
saving what is in it. Why is that useful? It can 
be all too easy to accidentally click in the wrong 
cell and corrupt a working formula, and the red 
X lets you stop before you can save and exact 
the corruption, error, etc. 
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MedAttrib: author-generated. MS Excel 
formula bar. 

Formula Ribbon 

In Excel, you can manually input formulas, as 
we did in the chapter on linking to data cells. 
You can also use the Excel Formula ribbon to 
access common predefined functions and to 
look up a wide variety of functions in the Excel 
function library. This is also where we have 
found the Name Manager tools for naming 
ranges in a dataset. Those named ranges show 
up in formulas in a way that keeps a formula 
from seeming to access random and long 
strings of cell range information. The named 
ranges add context in a formula, especially for 
troubleshooting. 

MedAttrib: author-generated. MS Excel 
Formula ribbon. 
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The Excel Function Library 

Users can access the Function Library from the 
Formulas tab by clicking on the Insert Function 
icon. The Insert Function panel opens and 
allows for a search of formula-related keywords. 
You can also try to browse through the 
category dropdown. This is useful to people 
who work in specific industries in which they 
use a lot of calculations, whereas for basic 
workplace talent, most of the available 
functions won’t mean anything or be useful. 
The use is in context of one’s training in specific 
career areas requiring calculations. 
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MedAttrib: author-generated. MS Excel Insert 
function / Function Library access. 

Thinking out formula scenarios 

A key part of succeeding in using any formula 
or function is to know exactly what you want 
to accomplish. Students in numbers and data-
heavy fields are usually learning the skills for 
what calculation processes are needed, and 
Excel is a tool to accomplish that. Students in 
fields that don’t work with a lot of data or 
computations can find formulating the 

396  |  Chapter 8: Microsoft® Excel®



scenario, or words, for what needs to be 
calculated and why/how. 

Steps 

First, keep in mind that any calculation is a kind 
of combination of a story problem (UGH!) and a 
test of logic. 

• How much is a “service”? 
• What is a bonus for a high achieving real 

estate agent? 
• How many products were sold in the last 3 

months? 
• How many days are in a class quarter? 
• If you know someone’s name and look it 

up in a table, can you tell what region they 
represent or how much property they 
sold? 

SO, the first thing you have to do is make sure 
you understand exactly what is being asked. 
Then you need to figure out what exactly you 
are trying to reference – to look at – so you can 
pull out the information you need. Then you 
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need to ask Excel the right kind of question in 
terms Excel can calculate from. 

Here’s something I learned when I first took a 
class in basic programming: 

• Write out what I think I am being asked to 
do. 

• Drink coffee (or fave beverage). 
• Write out what steps I think I would need 

to do to get at the information. 
• More coffee. 
• Look up / research Excel information to see 

what types of calculations I need to do 
might require. 

• Think about stronger coffee, but likely go 
for calming tea or water. 

• Study the basic logic and format of a 
calculation to see if it can do what I need. 

• Take a break for a serious treat or rest. 
• Experiment. 

Say you are being asked to get a total of the 
sales from the 8 sales reps who sell coffee to 3 
cafes. You would figure (rightly) that you need 
to see a list of all their sales, then get a total of 
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those numbers. You would be looking to get a 
grand totals response in terms of currency. 

Say you need to find out which coffee roasts 
sold well over Fall 2022? you would need to 
figure out how to ask Excel to look up the 
column of roast flavors, see the quantities sold, 
and for the months of September, October, 
November, and December 2022. You would 
need more information to find out if you are 
supposed to find the count for each coffee, or 
the dollar amount sold, etc. Then you would 
need a way to either do a subtotal table, or a 
lookup table, etc. 

Say you (as a teacher) have 30 students who 
have finished the class and need you to 
calculate their final grades. You need to know 
the students’ names, their final points, and 
some table of what points are equal to what 
publishable numeric grade. You would need to 
do some kind of lookup and have the response 
calculate into your student roster next to their 
point count so you could accurately update the 
school grades with the right numeric grade 
(4.0, 3.8, etc.) 
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You usually have to logically process what is 
being asked, and carefully decide what is 
needed. Take your time, map it out if you need 
to, and even write a layman’s English Language 
process. Then figure out how to ask Excel to 
calculate it for you. The Excel Functions menu 
ribbon and Functions lookup provides wizard 
windows for every function, so if you know 
what I need to look for, you can use those quite 
handily. 

Parts of a formula 

When you make a formula in Excel, there are 
several different components that supply the 
source data to the formula and express what 
operations should be performed on that 
information. Depending on the formula 
type, you may need include any or all of the 
following items: 

• Starting the formula:  In order for Excel to 
know the cell content will be a formula to 
be calculated, you need to start by typing 
the EQUALS sign  = This tells Excel that the 

400  |  Chapter 8: Microsoft® Excel®



contents of the cell will be an answer to a 
question, rather than a string of text or a 
basic number to format in some way. 

• Constants: Numbers or text values that 
you enter directly in a formula, like =2*3. 
This is a manual way of telling a formula 
what to calculate with. 

• Cell reference:  A reference to a cell that 
contains the value (item) you want to use 
in your Excel formula, e.g. =SUM(A1, B2, 
C3). This allows you to create formulas that 
can be copied and reused, rather than 
requiring a manual input of the numbers 
yourself. 

• Range reference: To refer to data in two or 
more contiguous (next to each other) cells, 
you use a range reference like A1:A5. For 
example, to sum values in all cells between 
A1 and A8, inclusive, use this formula: 
=SUM(A1:A8). 

• Names: A defined name for a cell range, 
constant, table, or function, for 
example =SUM(TaxCol). In earlier chapters 
we created and used named data ranges 
in part to prepare for working with 
formulas. 
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Operators 

Operators: These are special symbols that 
specify the type of operation or calculation to 
be performed, such as +, *, etc. They tell Excel 
what the operation, or calculation method, is to 
be, like sum, division, etc. For this chapter, we’ll 
only look at arithmetic. 

• Addition: + (plus sign) 
• Subtraction: – (minus sign) 
• Multiplication: * (asterisk) 
• Division : / (forward slash) 
• Percent: % (percent sign) 
• Exponentiation: ^ (caret) 
• Equal to: = 
• Greater than: > (greater than sign) 
• Less than: < (less than sign) 
• Greater than or equal to: >= (greater than 

or equal to sign) 
• Less than or equal to: <= (less than or equal 

to sign) 
• Not equal to: <> (not equal to sign) 

The order in which calculation is performed can 
affect the return value of the formula, so it’s 
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important to understand the order, and to use 
parentheses to change the order to obtain the 
results you expect to see. If a formula contains 
operators with the same precedence — for 
example, if a formula contains both a addition 
and subtraction operator — Excel evaluates the 
operators from left to right. Otherwise, you will 
want to use parentheses to separate/clarify 
sections of a formula. For instance, 
multiplication and division happen before 
addition and subtraction. 

Excel uses the standard mathematical order of 
operations. When writing complex formulas it 
is important to remember this order of 
operations. You want to be sure that your 
formulas will calculate in the order you intend. 
To help you remember which operations will 
be performed first, you can use the acronym 
PEMDAS. 

• P – parentheses 
• E – exponents 
• MD – multiplication and division 
• AS – addition and subtraction 
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Cell References 

Cell References are a way to refer to the 
contents of a cell. 

• Absolute: Absolute references 
remain constant, no matter where they 
are copied. 

• Relative: Relative references change when 
a formula is copied to another cell. This 
allows a formula to be reused and to pick 
up the contents of the record around it so 
that you don’t have to manually input all 
numbers (constants) yourself. 

• Selection: You select one or more cells 
while creating a formula or a location 
reference in another table and/or 
worksheet. 

• Named: You can Define a Name of a cell 
so that the cell remains stable in a formula 
that you copy and paste for further use in 
other cells in a column. This would be an 
Absolute reference. Otherwise, the pasted 
formula will change the cell’s location 
reference to be relative to the new row it is 
seeking to create the formula for. Example: 
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=Fee*20, where the cell I5 has been named 
FEE, is more stable than =I5*20. 

• Circular Reference: This happens when a 
formula is trying to calculate itself, and you 
have an Excel feature called iterative 
calculation turned off. It can also happen 
during indirect references in a formula. It 
results in errors. 

Creating a Basic Formula 

In this chapter, we will keep things 
straightforward and will work with basic 
mathematical formulas. 

ACTION: MS Excel Try Me Activity 
#6 

We will work with the Pets-R-Us sales 
workbook, named Excel_calculations.xlsx. 
Before you start, you should use your file 
manager utility to make a copy of the 
Excel_calculations.xlsx file that is in your 
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DataFiles folder, then paste the copy into your 
Examples / MS_Excel folder. 

Let’s open the file Excel_calculations.xlsx from 
the Datafiles MS_Excel folder. 

In the Pets-R-Us sales file, we have one 
worksheet, which is more of a worksheet than 
a practical company ledger. Let’s start with the 
basic manual math. 

The formulas begin with the = sign, to tell Excel 
something is being calculated, an answer will 
be provided. 

• Cell B15 needs to add 12 and 12, which is a 
sum. In B12, type =12+12 with no spaces. 

• Cell C15 can use this function instead: 
=SUM(12, 12) 

• Cell B16 needs to subtract 978 from 2234, 
which is a difference. =2234-978 

• Cell B17 needs to multiply 322 and 54, 
which is a product. =322*54 

• Cell C17 can use this function instead: 
=PRODUCT(322, 54) 

• Cell B18 needs to divide 330 by 10, which is 
a quotient. =330/10 
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• Cell C18 can use this function instead: 
=QUOTIENT(330, 10) 

• SAVE your work. 

Relative References 

Relative: Relative references change when a 
formula is copied to another cell. This allows a 
formula to be reused and to pick up the 
contents of the record around it so that you 
don’t have to manually input all numbers 
(constants) yourself. 

Now, let’s add some of the things in the Pets-R-
Us table. 

• Cell F6 needs to add Cells B6-E6, and 
because there are several numbers, the 
Excel formula that uses a Relative 
reference to those cells will do the job: 
=SUM(B6:E6) 

• Cell F7 needs to add Cells B7-E7. Let’s copy 
the formula from Cell F6 and paste it into 
Cell F7 and learn what happens. 
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NOTE: Relative Reference. Copying the formula 
from Cell F6 and pasting it Into Cell F7, and 
having that change the formula to calculate 
the sum of Cells B7-E7, is an example of 
Relative References. Excel was able to adjust 
the formula to be relative to the data related 
to Cell F7, instead of simply copying the exact 
numbers from Cells B6-E6. 

• Cell F8 needs to add Cells B8-E8. Copy the 
formula from Cell F6 and paste it into Cell 
F8. 

• Cell F9 needs to add Cells B9-E9. Copy the 
formula from Cell F6 and paste it into Cell 
F9. 

Now, we cannot do this for Cell F10. Why? 
Because Cell F10 is supposed to be the sum of 
Cells F6-F9, the cells above it in the column. 

• Type =SUM(F6:F9) 

Let’s get a little more experience and range. 
Rows 17-22 ask for a little more, and we’ll need 
to think about the order of operators – the 
order of what we calculate – when more than 
one calculation is happening in the formula. 
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• Cell B20: =F6-E6 
• Cell B21: =F10*0.088 
• Cell B22: =F10/2 
• SAVE your work. 

Before we calculate the next three, it would be 
useful to have a named data range instead of 
referring to the range of cells more manually. 
We did this kind of task earlier in this chapter, 
and in Excel_Calculations there is already one 
provided: RegionSums, for cells F6 through F9. 

Now these three functions should work 
properly as typed: 

• Cell B23: =AVERAGE(RegionSums) 
• Cell B24: =MIN(RegionSums) 
• Cell B25: =MAX(RegionSums) 
• Then, lets also try B27: =SUM(B6:B9)*0.88 
• B28: =SUM(C6:C9)/4 
• SAVE your work. 

Absolute References 

Absolute references remain constant, no 

Chapter 8: Microsoft® Excel®  |  409



matter where they are copied. This is useful if 
you need one value (number) in a formula to 
remain the same no matter what rows of data 
are being calculated against it. We’ll do this 
with the Tax Needed cells in Column G. 

However, in a formula, you have to explicitly tell 
Excel that the cell is a constant. An absolute 
reference is referred to differently in a formula / 
function. The idea is the tell Excel to freeze the 
reference so that it remains static – the same 
cell, no matter how it is used in a column that 
might otherwise auto-calculate relative 
references for you. 

The Absolute reference format uses dollar 
symbol ($) before the cell’s coordinates to make 
them absolute. An example would be referring 
to the Cell G12 – a tax amount – as $G$12 in a 
calculation. Let’s try. 

• Cell G6: =F6*$G$12 
• Cell G7: Copy Cell G6 and paste in Cell G7. 

Notice the formula still refers to $G$12, 
which is absolute to Cell G12, which is what 
we want. 

• Cell G8: Copy Cell G6 and paste in Cell G8. 
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• Cell G9: Copy Cell G6 and paste in Cell G9. 

Again, we cannot do this for Cell G10. Why? 
Because Cell G10 is supposed to be the sum of 
Cells G6-G9, the cells above it in the column. 
Note: Even though we just used mixed 
formulas with relative and absolute cell 
references, the following formula does not 
need any absolute formula reference in it. 

• Type =SUM(G6:G9) 
• SAVE your work. 

MedAttrib: author-generated. MS Excel Ch14 
finished calculations. 
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Auditing Formulas 

Excel provides a few tools that you can use to 
review the formulas entered into a worksheet. 
For example, instead of showing the outputs 
for the formulas used in a worksheet, you can 
have Excel show the formula as it was entered 
in the cell locations. This is demonstrated as 
follows: 

• With the Excel_calculations.xlsx file open, 
click the Formulas tab of the ribbon. 

• Click the Show Formulas button in the 
Formula Auditing group of commands. 
This displays the formulas in the 
worksheet instead of showing the 
mathematical outputs. 
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MedAttrib: author-generated. MS Excel Ch14 
finished calculations showing formulas. 

• Click the Show Formulas button again. The 
worksheet returns to showing the output 
of the formulas. 

• SAVE your work, and close the file. EXCEL 
ACTIVITY #6 FINISHED. 

You can also toggle Show Formulas on and off 
using the keyboard. Hold down the CTRL key 
while pressing the ` key. (The ` is known as the 
Tilde key and is to the left of the 1 key on your 
keyboard.) 

Keyboard Shortcut: Show Formulas. 
Hold down the CTRL key while pressing 
the accent symbol . 

Common Error Codes 

Excel presents a number of error codes when a 
formula doesn’t work properly. And, for learners 
who work with Excel for standard/casual 
practice, the codes may not mean a lot or tell 
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you exactly how to fix the problem. Excel tends 
to be somewhat obtuse in explaining a 
problem, because the explanation is general to 
the “type” of issue the program can’t resolve, 
not the exact nature of your actual formula and 
formula data. 

These codes should give you something to 
start with, 

• #DIV/0! Trying to divide by 0 
• #N/A! A formula or a function inside a 

formula cannot find the referenced data 
• #NAME? Text in the formula is not 

recognized 
• #NULL! A space was used in formulas that 

reference multiple ranges; a comma 
separates range references 

• #NUM! A formula has invalid numeric data 
for the type of operation 

• #REF! A reference is invalid 
• #VALUE! The wrong type of operand or 

function argument is used 
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Charts and Graphs 

Pivot Tables 

Pivot Tables are a data summarization tool. 
They are a bit complex and need a fair amount 
of practice time, so we won’t cover them in this 
chapter, although an instructor might choose 
to cover them with a video and exercises 
separately. 

A pivot table can automatically sort, count total 
or give the average of the data stored in one 
table or spreadsheet and display the 
summarized data results in a second “pivot 
table”. Then the pivot table can have certain 
criteria in it filtered and organized so that the 
same data reveals different aspects of how it 
can be summarized. They tend to be listed with 
charts because part of a pivot table’s output 
often includes a companion chart. 
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Charts/Graphs – Insert tab 

Charts allow for a visual representation of 
specific table data. They are not a static 
inserted item, like an image or shape. They 
represent live data that is being interpreted for 
analysis, like percentages of people who eat 
different desserts being shown in a pie chart. 
To create a chart in Excel you need to HAVE a 
table/table data to work with. 

Charts can be initiated from: 

• Pre-designed chart styles. 
• Recommended charts based on the data 

Excel interprets. 
• A chart created from specific data. 

Charts, when clicked to be activated and using 
the Chart Design context tab or the Chart 
Format design tab, also allow for: 

• Modifying chart info source location 
• Chart formatting 
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Chart types 

There are many chart types. Commonly-used 
ones include: 

• Bar or Column charts: Show numbers that 
are independent of each other. Example 
data might include things like the number 
of people who preferred each of cold 
desserts, hot desserts, and no desserts. 

• Line or Area graphs: Show how numbers 
have changed over time to demonstrate 
trends, like average summer times 
temperature in each region of the world. 

• Pie or Doughnut charts: Show how a 
whole is divided into different parts, like 
the percentage of people who like cookies, 
cakes, baklava, cannoli, and fruit tarts. Y 

• Scatter (XY) charts: They use plotted data 
point clusters to show correlations or 
patterns in data. 

Chapter 8: Microsoft® Excel®  |  417



ACTION: MS Excel Try Me Activity 
#7 

We will work with the Ihoosha Online Training 
supplies workbook, named Excel_charts.xlsx. 
Before you start, you should use your file 
manager utility to make a copy of the 
Excel_charts.xlsx file that is in your DataFiles 
folder, then paste the copy into your Examples 
/ MS_Excel folder. 

Let’s open the file Excel_charts.xlsx from the 
Datafiles MS_Excel folder. 

In the Ihoosha sales file, we have one 
worksheet, which has one table from which we 
can derive charts. Let’s start with a Column 
chart, which can compare values across 
categories in no particular order of importance. 
The categories for Ihoosha are the quantity and 
cost, and what will be tracked is the average 
cost per student. 

• Select the data in the table EXCEPT for the 
total row. A total row translated into a 
chart or graph can confuse the data and 
outcome. The data we need includes Cells 
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A9-F20. 
• Go to the Inserts ribbon, and the Charts 

group. Choose the Recommended Charts 
icon to access the selection dropdown. 

• The Recommended Charts offers several 
options; select the first, a Clustered 
Column chart. 

MedAttrib: author-generated. MS Excel Insert 
Charts panel, Recommended charts tab. 
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The chart will appear somewhere on your 
worksheet. Drag it just to the left of the table 

When you click on the chart, the table range 
used in creating the chart is highlighted. Also, 
a contextual Chart Design ribbon and related 
Format ribbon (to its left) appear in the menu 
tabs. 

• The Chart Design ribbon’s Chart Styles 
group lets you pick variants of the 
Clustered Chart format; Choose a variant 
format you like. 

• You can change the base colors of the 
chart with the Chart Styles group as well. 
Click the color variation you like, keeping 
in mind that a chart should be easy to read 
and interpret. 

You can also choose another chart type, but 
the point of a chart is to demonstrate specific 
data for a specific reason, so choosing charts 
for no particular reason isn’t solid Excel or data 
analysis process. 

The chart-related Format ribbon allows you to 
make individual changes to elements of the 
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chart, like the text boxes for the data, the lines, 
etc. At the left of the Ribbon a Chart Elements 
field can help you know what chart element 
you are on when you are making micro 
changes. 

Let’s see if we can make a Pie Chart. Usually 
one of these summarizes one kind of data in 
percentages of the whole of the data, and this 
table may not really allow that. Let’s find out. 

• Again, select the data in the table EXCEPT 
for the total row. The data we need 
includes Cells A9-F20. 

• Go to the Inserts ribbon, and the Charts 
group. Choose the Recommended Charts 
icon to access the selection dropdown, but 
once on the dropdown, choose the ALL 
Charts tab. 

• Look for the Pie Chart option, and notice 
that it does not show a preview. This 
means that this data can’t be used in the 
simple summary chart we want. We need 
to make a pivot table. 

• Exit the Insert Charts panel, but leave your 
data selected. 
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A pivot table is essentially a summarizing table. 
It can get complex and summaries several 
things in several ways, depending on the Pivot 
Panel criteria you choose, which is why it needs 
some practice time. However, Recommended 
Pivot Tables can also give a simple summary 
table, which is what we need. Let’s see if we can 
get a summary of the Items or the Classes, and 
the average cost per student. 

• On the Insert ribbon, Tables group, select 
the Recommended Pivot Charts icon. 

• In the selection dropdown, look at the 
types of recommended summary tables 
offered. Let’s choose the Sum of Average 
Cost by Purpose recommendation, and 
determine if that captures what we want 
the first time. The Purpose is the title of 
Column 2 of the original table – the 
assignments. 

• SAVE your work. 

Yes, it does! It created a new sheet, called 
Sheet1, and placed the pivot table on that 
sheet. The chart is unformatted, as well. 
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MedAttrib: author-generated. MS Excel 
summary pivot chart, unformatted. 

• Go to Sheet1, and select the whole Pivot 
chart. Cut it, and copy it into the 
Action_Charts sheet a couple of lines 
below the main table. 

• Delete the now empty Sheet1 worksheet. 
• Click on the Pivot table. On the right side 

of the screen, a PivotTable Fields panel 
should appear. It shows that the two 
categories of data being summarized are 
the Purpose (the purpose of the materials 
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being the assignments in Column 2), and 
the average cost per person. 

We will not make changes on this panel, but 
you can look it over. 

• Close the PivotTable Fields panel so that it 
is out of the way. 

TIP: Pivot Table Fields Panel access. It 
can be reopened in the Pivot Tables 
Analyze ribbon, Show icon at the far 
Right. The Show Icon’s dropdown shows 
a Field List icon, which is what you 
choose to re-open the PivotTable Fields 
panel. 

Let’s format the pivot table a little, manually. 
First, select all the numbers in the Sum of Avg/
Person. 

• If the pivot chart doesn’t already show 
currency, use the Home tab Number 
group to set these to currency. 

• The pivot table columns look untidy in 
width for their content. Drag the right 
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edge of Column A to the right so the Pivot 
Table’s first column is wide enough to see 
the data. 

• Drag the right edge of Column B to the 
left so the Pivot Table’s second column is 
wide enough to see the data but not 
much more. 

• Click in Cell A25, which reads Row Label. 
For simplicity, just overwrite the text with 
the phrase Supplies. 

Now we have a Pivot summary table that 
might let us create a Pie Chart. Let’s find out. 

• Select the data in the Pivot table, but not 
the total row. 

• In the Insert ribbon, choose the 
Recommended Charts icon and look at 
the Insert Chart panel. 

Look for the Pie Chart option on the lost on 
the left. It seems to have an available Pie Chart 
preview. 

• Select the Pie Chart and click OK. 
• The Pie chart appears on your workspace, 

and may need to be dragged so that it is 
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positioned below the other chart. 

The only issue is that the Pie Chart doesn’t label 
the percentages on the chart; the pie slices 
simply show them graphically. 

• This is very simple to fix. Right-click on the 
Pie part of the Pie Chart, and select Add 
Data Labels. 

• SAVE your work, and close the file. EXCEL 
ACTIVITY #7 FINISHED. 

MedAttrib: Beginning to Intermediate Excel. 
MS Excel pivot chart and regular charts. 

Review and Distribution 

Review and distribution of your work is about 
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preparing it for who will be consuming it. Will 
it stay in a Word document format, be saved 
as a PDF, printed onto paper, added as website 
content, populate an add or newspaper article, 
or be part of a book? It needs to be: 

• Spell checked. 
• Accessibility enabled (alt text, proper use 

of heading styles, accessibility for screen 
readers). 

• Considerate of versioning. 
• Have hyperlinks tested. 
• Cited and attributed properly for 

intellectual honesty. 
• Passed for plagiarism and other content 

integrity needs. 
• Presented for readable print viewing. 
• Secured for limited/no editing by others. 
• If meant for team collaboration, prepared 

for making shared/trackable changes, 
comments, and notes. 

Output/distribute work 

• You can test and adjust your documents 
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and review your content before it goes live 
by looking at the File/Print sections Print 
Preview and settings. 

• In Excel, one worksheet can be printed 
separately from the whole workbook. Also, 
a whole workbook can be printed. Finally, 
you choose only some of a workbook’s 
sheets for output. 

• You can make sure you have added 
metadata for web/online reference by 
updating information in the File/Info page. 

• You can save files in different formats for 
distribution in the File backstage areas, 
like Save As (for current and older versions, 
RTF, text, and HTML), save as PDF, export, 
etc. 

ACTION: MS Excel Try Me Activity 
#8 

We will work with a Taste du Monde workbook, 
named Excel_ distribution.xlsx. Before you 
start, you should use your file manager utility to 
make a copy of the Excel_ distribution.xlsx file 
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that is in your DataFiles folder, then paste the 
copy into your Examples / MS_Excel folder. 

Let’s open the file Excel_distribution.xlsx from 
the Datafiles MS_Excel folder. 

We have one worksheet, which has one table 
that needs to be set up for proper printing. This 
workbook my be emailed to someone, or 
shared on a SharePoint department site, or 
posted to a website, but any viewer might want 
to print it. The document has already had the 
margins, page orientation, and paper size 
established, and is designed to be printed 
wider-then-long on 8.5 x 14 inch sheets of 
paper. 

NOTE: Things we covered in the MS Word 
chapter that behave much the same in Excel 
include the spell check, the accessibility check, 
and the Info Page review of metadata tags. 

We need to look at two things in particular for 
Excel. The first is how the document will print 
out. 

• Click anywhere in the document, then go 
to the File tab, Backstage area, and choose 
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Print. The document has 2 printable 
pages, and as we review them, we can see 
that the columns all look about wide 
enough to see all the content. 

MedAttrib: Beginning to Intermediate Excel. 
MS Excel Print preview page. 

• Exit the Print screen. 

What if we don’t want to print all the columns? 
Let’s set a Print Area that does not include the 
last two columns. 

• Select Cells A1 through G36. 
• Go to the Page Layout ribbon, Page Setup 

group, and click the Print Area icon. 
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• In the Print Area dropdown, choose Set 
Print Area. 

• Go to the File tab, Backstage area, and 
choose Print. The document still has 2 
printable pages, and as we review them, 
we can see that the EmailAdd and the 
OptIn columns are not in the print 
preview. 

Repeating column/row labels 

One significant problem exists for what we see 
in the Print preview. The workbook has 2 pages, 
but only the first page shows the header row, 
which makes interpreting the second page 
difficult, 

Now that you have fixed the cell and text 
formatting, you are ready to review the 
worksheet in Print Preview. You will notice that 
the worksheet is printing on multiple pages, 
and you cannot tell what each column of data 
represents on some of the pages. 

• With Excel_ distribution.xlsx open, click 

Chapter 8: Microsoft® Excel®  |  431



anywhere on the worksheet. 
• On the Page Layout ribbon’s Page Setup 

group, click the Print Titles button. The 
Page Setup panel will open to the Sheet 
tab. 

MedAttrib: author-generated. MS Excel Page 
Setup Sheet panel. 

• Click in the Print Titles / Rows to repeat at 
top field. Be sure your insertion point is 
blinking in that box before moving on to 
the next step. 

• In the worksheet, select Row 6, which is 
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the header row of your table. The text 
$6:$6 should now appear in the Rows to 
repeat at top field. 

• While still in this panel, also choose Page 
Order: Over, then down. While we hope 
that all out columns will stay on one 
“page”, if they do overflow it would be 
easier to sort if the tag-end page printed 
just after its main page, rather than at the 
end of the print session. 

• Go to Print Preview (CTRL P) and look at 
each of the pages. Notice that the first 
header row is now repeated at the top of 
each page. 

• SAVE your work, and close the file. EXCEL 
ACTIVITY #8 FINISHED. 

This should give you a good overview of MS 
Excel skills that you can use in school and as a 
starter for basic workplace support tasks. 
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Chapter 9: 
Microsoft® 
PowerPoint® 

What We’ll Cover >>> 

• Presentation Software 
• Microsoft PowerPoint 
• Slides 
• Slide Formatting 
• Slideshow Design 
• Transitions 
• Review and Distribution 

Presentation Software 

Presentation software is designed to allow the 
user to present information in an engaging 
way with text, pictures, sound, and video. It is 
a way to communicate ideas in a powerful, 
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organized manner. It utilizes sequences 
of slides that accompany an 
audio presentation. The presentation may also 
be recorded and posted online. The slides are 
consolidated in virtual files called slide 
decks. Communication skills are necessary for 
many careers. Presentation software can help 
to deliver a message online or in-person to 
a large audience or small group. The goal is to 
create a presentation that will leave an 
impression on the audience, and not distract 
them from the message you are delivering. The 
ultimate goal is to create dynamic, interesting 
presentations that engage your audience. 

Presentation software can be part of an 
integrated suite of tools, or be stand-alone. It 
can be installed on a computer for full and 
robust features and integration with other 
resources; it can be accessed on the web in a 
light format, and it can be a basic utility tool, 
like text editing applications. Some programs/
suites are payware, such as those used in many 
workplaces; others are shareware or freeware. 
Information in this chapter should offer you 
transferrable skills for use in any word 
processing application. 
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Common presentation software 
programs 

• Microsoft PowerPoint: Available across 
many platforms including mobile devices 
for ease of use. Integrates well with 
Microsoft Office. 

• Apple Keynote: Included with most Apple 
devices. Real time collaboration. Use Apple 
Pencil on your iPad to create diagrams or 
illustrations that bring your slides to life. 

• Google Slides: Integrates with other 
Google Apps, Q&A feature, Advanced web 
publishing features. 

• Smartphone apps that allow for quick use 
and editing on-the-go. 

• Word processing apps in free/open source 
office suites. 

Microsoft PowerPoint 

Since Microsoft® PowerPoint® (MS 
PowerPoint, PowerPoint) is widely used in 
business, and we are using Windows, we will 
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focus on this presentation software. There are 
many similarities across presentation software, 
so the skills we are learning can be translated 
to other systems. Some of the tasks in 
PowerPoint may seem familiar because they 
were used in other applications. The following 
Try Me activities are designed to be completed 
using Microsoft PowerPoint in Office 365 on a 
PC with Windows 10 or higher. 

DEMO EXAMPLE follow-through 

Accessing PowerPoint 

• In your Computer, use the relevant start 
menu to open MS PowerPoint (look for 
little red icon). On a PC this is a start 
button on the keyboard, and/or menu on 
the lower left of the screen. On a Mac, this 
should be in the top-screen Menu option. 

• PowerPoint will open with options to 
create a blank slideshow, open an existing 
file, and use templates. 

• Observe the various Menu ribbons to learn 
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what they offer. 

The User Interface (UI) menus 

MedAttrib: author-generated. MS PowerPoint 
user interface screen. 

In PowerPoint, the user interface contains 
several menu tabs (tab), with ‘Ribbons’ (ribbon) 
that display icons (like buttons) with text 
descriptions of various activities related to a 
task. On a ribbon, you will often see groups 
(group) of icons for tasks that relate to one 
another, like the Home ribbon’s Font group, 
Paragraph group, etc. Some of these icon 
buttons will do a simple task in one step, while 
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others may open a panel (panel) which is a 
detailed, multi step or tab window of options. 
Sometimes you may instead see a context 
dropdown (dropdown) menus of options. 
Shown (in the program’s order) are: 

• File: Accesses the program backstage area 
for various options. Set your preferences 
for workflow and productivity. 

• Home: Basic text functions –  formatting, 
positioning, styles 

• Insert: tables, images, shapes, charts, page 
sections 

• Draw: For more effects your can add to a 
slide, like “circling” an important point. 

• Design: Layout of the slides – margins, 
themes, colors, etc. 

• Animations: Transitions and sound. 
• Slideshow: For timing and practice. 
• Record: For audio recording the slideshow, 

and for exporting the show to video. 
• Review: Spelling, language, tracking, etc. 
• View: screen views, rulers, gridlines, 

windows. 
• Additional add-in/specialty tab menus: 

These are dependent on having MS Word-
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related add-ins like Acrobat, a reference 
manager, etc. 

• Contextual tab menus: These are 
contingent on a specific item in the 
program’s workspace being activated. For 
instance, clinking on an image, table, or 
header / footer will activate a context 
menu/ribbon on the right side of the UI 
that shows a menu dedicated to actions 
that can be done specifically for the active 
item (picture editing). 

About Presentations 

Presentations are a multi-page slideshow used 
to present a cohesive set of information/
images. They are routinely used to support 
other documentation, not be the primary 
report or documentation. This means that a 
slideshow should focus attention on a few key 
points with a few bulleted supporting points, 
not use long paragraphs of text. Use a 
consistent layout, color palette, image layout/
type, and transition style for professionalism. 
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• Information to be shared should be 
highlights of main points, which are 
shared in small amounts that can support 
a more detailed audio presentation with 
report and other print handouts. The 
slideshow highlights, it doesn’t act as the 
main word-processed document, 

• Customary is Title Page, Title and content 
pages, and Image/Caption pages, with as-
needed comparison pages and blank 
pages with a specific image/content 
design you need for the show. 

• Use rulers and guides to help align your 
work. 

• Presentations can be short to very long, 
use audio media, and be timed for a 
specific flow of information. 

• Create transition slides for large section 
transitions. 

• Use section and subsection titles to break 
up information in long shows. 

• Use an easy-to-read font/color/style for 
excellent contrast info reading. Using a 
good sized-font at every hierarchy level 
makes the whole slideshow readable, even 
from the back of a room. 
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Slides 

Slideshows are made up of slides with content. 
Their common MS PowerPoint native (editing) 
file extension is .pptx, and their PowerPoint 
show file extension is .ppsx. They can contain: 

• Text paragraphs and lists. 
• Images, tables, and clip art. 
• Headings, subheadings, captions, and 

paragraph text. 
• Transitions, animations, media, and timed 

content. 

Slideshow Workspace 

The default workspace for slideshows is a left-
hand pane of slide thumbnails, the active slide 
being edited in the workspace, and a Notes 
pane below the workspace. 

You can navigate through your slides by 
clicking on the thumbnails, or scrolling down 
the main workspace. 
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MedAttrib: author-generated. MS PowerPoint 
user interface thumbnails, workspace, notes 
pane. 

Views – View Tab 

• You can see different views as part of the 
main interface – lower right-hand side of 
the user interface, and also from the View 
tab’s ribbon. 

• You can set rulers on or off. 
• You can also set guides for aligning text 

and images. 
• You can choose the window view you like 

to work in, such as normal, outline, slide 
sorter, notes page, or reading view layouts. 
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Preferences – File tab 

Like MS Word and MS Excel, PowerPoint has 
a File tab Backstage area which lets you save 
slides in different formats, prepare them for 
print, and change the program’s options. You 
can set your PowerPoint program preferences 
for slides and program workflow, for smoother 
productivity, in the ‘backstage’ area of the 
program. 

Same layout as Word, Excel, and Access and 
allows personalizing, print, save, and publish 
settings. 

Slideshows are saved in the native editing 
format of PPTX, and when a show is meant to 
be actually shown when it opens, it is saved as 
a PPSX (show) format. They can also be saved in 
PDF format, and individual slides can be saved 
in image formats. 

• You can set a slideshow up for printing out 
using the Print preview screen. Open the 
Print Preview screen to see the similar 
layout to Word and Excel. 

• Go into the Info screen to inspect the 
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slideshow for Accessibility and 
compatibility, and to protect a slideshow. 

• Go into the File tab Options section, which 
you can use the change program settings. 

MedAttrib: author-generated. MS PowerPoint 
user interface screen. 
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Slide Formatting 

Text placeholder fields 

In slideshows, you input text into editable fields 
(placeholders), with headings, paragraphs, lists, 
tables, images, etc. Text formatting includes 
indenting, spacing, and alignment. For 
instance, the alignment of text can be left, 
right, centered, or justified alignment; this 
paragraph is in Left alignment. 

These fields also guide the kind of content you 
might put in them. Gor instance, a slide might 
have placeholders that state “Click to add title”, 
“click to add subtitle”. Etc. 

Placeholder fields let you add text, and they 
also offer the option to add other items instead 
by showing icons that represent a table, an 
image, a video clip, and more. 

Also, when you use a placeholder field for text, 
the text will routinely be added already in 
bulleted format. To decrease the level of the 
text, you need to click tab for an indented 
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second-level of bulleted text. The thing to keep 
in mind here is that the bulleted text can get 
smaller quickly, so it is useful to look at your 
text formatting, make the bulleted text large 
enough to read, and to make the sub bulleted 
text, and sub-sub bulleted text, also sized to be 
readable. 

Creating new text 

If you don’t yet have text to work on yet when 
creating a document and setting paragraph 
formatting to use later as a saved style, 
consider using Lorem Ipsum, or one of its 
variants. Fun text fillers can include KittyIpsum, 
BaconIpsum, or ZombieIpsum. You can find 
Ipsum generators free online and copy/paste 
gibberish paragraphs into your document so 
you can play with some chunks of text. Let’s try 
some KittyIpsum now! 

[Nap all day cat dog hate mouse eat string 
barf pillow no baths hate everything but kitty 
poochy. Sleep on keyboard toy mouse squeak 
roll over. Mesmerizing birds. Poop on grasses 
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licks paws destroy couch intently sniff hand. 
The dog smells bad gnaw the corn cob.] 

Home tab – Clipboard Group 

At the very left of the Ribbon is the same 
clipboard group as we worked on in the Word 
and Excel chapters, which is a small set of tools 
you can use in relation to when text, images, 
and styles have been saved to the clipboard as 
you work. Clipboard-related activities include 
copy, cut, paste, and the format painter. 

Home tab – Slides group 

Every slide can be the same, or a slideshow can 
use a mix of pre-designed slide formats. 

The slide text fields indicate what kind of 
slideshow page you are working on. A fully 
designed slideshow might have a title slide, 
title and contents pages, section header pages, 
comparison tables, image slides, and/or 
content (or a picture) with caption slides. You 
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also can choose a blank slide without the 
editable regions on it fir full flexibility. The 
Slides group gives you the common slide 
layouts to choose from. 

Home tab – Font Group 

“Fonts” refer to the letters (characters) used in 
text. Font formatting includes resizing, 
changing the font family, adding bold or 
emphasis, adjusting spacing between letters, 
and more. You can right-click on a word or 
cluster of words for the contextual menu, or 
use the Home Tab’s font group options. These 
include font style, size, color, effects like bold 
/ italics / underline, highlighting, and spacing 
formatting. 
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MedAttrib: author-generated. MS PowerPoint 
Fonts panel. 

Home tab – Paragraph Group 

You can modify your slide text paragraphs/
bulleted lines in several ways. You can right-
click on a piece of text, and choose “Paragraph” 
from the contextual menu. You can instead 
select some text, and use the Home ribbon’s 
one-touch paragraph group icons. You can also 
select some text, and choose the Home Tab’s 
paragraph group panel opener. With any of 
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these, you can do alignment, spacing, indents, 
lists (bullets and numbers), shading, and 
borders. 

Paragraph panel 

The paragraph panel, which you can open from 
the lower right corner of the Home ribbon’s 
paragraph group, reveals a panel with several 
tabs of options: spacing before and after 
bulleted lines, specific indents, and line 
spacing. 
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MedAttrib: author-generated. MS PowerPoint 
Paragraph panel. 

Inserts 

Inserts are basically anything you can insert 
into a slideshow that supplements your text 
content. You use the Insert Ribbon to choose 
what you want to add into a document: 
pictures, online art, icons, shapes, SmartArt, 
media, and text-related effects like WordArt. 

Options for inserts – Insert tab 

Just like Word and Excel, you can modify 
inserts using a contextual menu designed for 
the specific insert type: size, color, theme, 
position, etc. These Tab menu options only 
appear when you select an inserted item you 
want to modify. 

ACTION: MS PowerPoint Try Me 
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Activity #1 

Let’s create a new slideshow, and then learn a 
few slide formatting tasks. 

• Open PowerPoint. 
• Open a blank presentation. 
• Before you do anything else, save the new 

file into your Examples / MS_PowerPoint 
folder as PP_formatting.pptx. 

In the blank slideshow, you should see a single 
page, It shows placeholder text boxes that 
PowerPoint uses to help creators guide slide 
content creation and display. You type into 
them with your content, and PowerPoint styles 
the content – per the in-use theme – by 
hierarchical bulleted lists. 

Before adding any text, let’s add more blank 
slides. 

• On the Home ribbon, Slides group, click 
the New Slides, which gives a dropdown of 
possible slide layouts. 
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MedAttrib: author-generated. MS PowerPoint 
new slides panel. 

Since the new slideshow already opens with 
the Title Slide, lets add a few pages that 
represent other slide layouts. 

• In the New Slide dropdown, choose Title 
and Content. 

• Add another slide using the New Slides 
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icon: Two Content. 
• Add another slide using the New Slides 

icon: Content with Caption. 
• SAVE your work: CTRL S / MAC CMD S. 

You should have mostly blank 4 slides in your 
show now – blank except for the placeholder 
fields. 

When using the editable fields, PowerPoint’s 
default is to offer common heading and 
subheading styles, text styles, and bulleted 
hierarchy styles. This design becomes more 
important when using animations in a show, 
and how they are prioritized during a finished 
presentation. 

• Go to the first slide. In the first placeholder 
that reads Click to Add Title, click inside 
and type First Show. 

• In the second placeholder, type By 
YourName. 

• Go to the second slide. In the first field, 
which reads Click to add title, type Slide 
Basics. 
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TIP: Slide Title placeholders. The 
placeholders that are for adding titles 
don’t mean that ever slide with one 
needs the title of the whole slideshow 
added there. They can also act as titles 
for a page, or within a section, to help a 
slideshow’s organization seem more 
cohesive. 

The second placeholder is multi-purpose. You 
can immediately start typing text in it and use 
it in that way. However, a semi-transparent set 
of icons is also in the placeholder, which 
indicates that you can instead click on one of 
them to add content that the respective icon 
represents. 

MedAttrib: author-generated. MS PowerPoint 
placeholder content field options. 
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In this slide, we’ll just add text to see how it 
works. 

Type these lines, pressing your keyboard’s 
Enter key after each: 

• Main point 
• Supporting point 
• Third-level point 
• Paragraph text 
• Place your cursor in from of the line 

Supporting point, and press Tab. 
• Place your cursor in from of the line Third-

level point, and press Tab twice. 
• SAVE your work: CTRL S / MAC CMD S. 

Observe how PowerPoint “demotes” the bullet 
levels so that they get smaller. This is a good 
time to learn that using more than one or two 
levels of bullets is as far as a viewable 
presentation should use, although you can also 
enlarge the size of the text of each bullet. 

• Place your cursor in front of the line 
Paragraph text. 

• On the Home ribbon, Paragraph group, 
click the Bullets icon to ‘turn off’ the bullet 

Chapter 9: Microsoft® PowerPoint®  |  457



on this line. This demonstrate that you do 
not have to use bullets. 

Go to the third slide, which has 3 placeholders. 
This is a standard comparison slide, which 
simply describes that you can have two sets of 
information side-by side. These could be text 
and graphic, table and graphic, two fields of 
text, etc. 

• In the 1st placeholder, type Comparison 
Slide. 

• In the 2nd placeholder (left one), type Item 
Description. 

• In the 3rd placeholder (right one), click the 
Online pictures icon, and use the search 
field that opens to search for (and insert) 
an image you like. 

Go to the fourth slide, which has 3 placeholders. 
This is a standard content with caption slide, 
which simply describes that you can have 
captioned information side-by side with a 
table, a graphic, etc. 

• In the 1st placeholder, type Text header. 
• In the 2nd placeholder (left one), type Add 

458  |  Chapter 9: Microsoft® PowerPoint®



some text here. 
• In the 3rd placeholder (right one), click the 

Table icon, and use the dialog box that 
opens to type 3 in the Number of columns, 
and 4 in Number of rows. 

• SAVE your work: CTRL S / MAC CMD S. 

Now we have a basic slideshow with 
components we can practice manual font 
formatting. 

Like in Word and Excel, formatting options 
happen mostly in the Home ribbon, with the 
Font group and Paragraph group. 

Go to the first (Title) slide. 

• Select the title text and use the Home 
ribbon Font group to make the text Bold, 
and dark blue. 

• Select the subtitle text (your name) and 
use the Home ribbon Font group to make 
the text italicized. 

Go to the second slide. Let’s make the content 
text larger. 
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• Select the 1st bulleted item, and use the 
Home ribbon Font group to make the text 
36 pts. 

• Select the 2nd bulleted item, and use the 
Home ribbon Font group to make the text 
32 pts. 

• Select the 3rd bulleted item, and use the 
Home ribbon Font group to make the text 
28 pts. 

• Select the paragraph text, and use the 
Home ribbon Font group to make the text 
32 pts. 

Go to the third slide. Let’s edit the image. 

• Click on the image. Like in Word and Excel, 
an activated image (or other insert) opens 
a new contextual menu/ribbon. For this 
image it is a Graphics Format ribbon. 

• With your online image active, use the 
Graphics Format ribbon, Size group, to 
make the image 6 inches wide. 

• Use your cursor to click and drag the 
image to make it seem more centered, if 
the resizing moved or altered its centered 
appearance. 
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• Click the image, and use the Graphics 
Format ribbon, Accessibility group, to add 
accessibility content. 

• Click the Alt Text icon, which will open a 
docked Alt Text panel on the right of your 
workspace. 

• In the Alt Text field, you may already see 
some text. However, replace it with: “Stock 
image of a (whatever the image is of).” This 
tells a screen reader that there is an image 
and what the image is. 

Go to the fourth slide. 

• Make the Text Header line bold and a 
medium-dark gray. 

• Use the Home ribbon Font group to make 
the paragraph text below the Text Header 
24 pts in size. 

Let’s work on the table. Like in Word and Excel, 
tables should have a header row, and 
PowerPoint defaults to adding formatting form 
one to an inserted table. 

• Click in the table’s first cell, which should 
be in a darker colored row – the header 
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row. 
• In the 1st header cell, type Fave Weekday. 
• In the 2nd header cell, type Fave Activity. 
• In the 3rd header cell, type Saturday Fun. 
• If you’d like, you can fill in your faves in the 

table cells below. 

Click on the table, and observe that a Table 
Design ribbon and related layout ribbon to its 
right appear. 

• In the Table Layout ribbon, Table Styles 
group, choose a different table color and 
intensity. 

• SAVE your work, and close the file. 
POWERPOINT ACTIVITY #1 FINISHED. 

MedAttrib: author-generated. MS PowerPoint 
example 4-slide show with edits. 
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Now we’ve had a good introduction to new 
slides and basic manual font formatting. 

Slideshow Design 

Text and paragraph formatting are parts of 
what happens in a slide. This section is about 
the overall slideshow itself – how it will present 
when given as an active animated slideshow, 
printed out, and consumed by users. Slideshow 
formatting is characterized by actions that can 
affect the whole document, and in so doing, 
add efficiency and steps-saving to general text 
and paragraph formatting. These include 
document layout, themes and styles, headers 
and footers, and some use of sectioning. Much 
of this will seem familiar from Word and Excel. 

Master Slides – View tab 

In the View tab Master Views group, you can 
access a slide master view to show all the 
potential pages that you can use in a slideshow 
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theme. This is useful, and a good first step to 
using a theme, so that you can add footer 
information, make sure your show’s title usage 
is consistent and correct throughout the show, 
and make specific style changes to the actual 
master pages of the show’s theme. You want 
to minimize having to touch individual slide 
designs. 

The footer section in the slide master lets you 
add a page number, date, other footer content, 
and style it so that it appears the same way 
each time that slide is used. 

One thing to not, and this is a reason why the 
master slides are considered more 
intermediate in skill; each and every possible 
style page in the master view needs to be 
edited for consistency, or else you may insert 
slides from your modified theme and still see 
some differences. For instance, if you change 
the size and content of a slide’s footer in one 
master view page, you need to make the same 
change to all the master view slide variations. 
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MedAttrib: author-generated. MS PowerPoint 
Slide Master interface. 

Setting up slideshows – Design 
tab 

The Design tab allows you to set the physical 
format of your slideshow, which is a good first 
starting step in developing a slideshow. This 
determines how large the slides will be, the 
orientation of the document, etc. In the Design 
tab Customize group, the Slide size icon 
dropdowns lets you choose an existing size or 
set a custom slide size. 
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MedAttrib: author-generated. MS PowerPoint 
themes, and color / font palettes. 

Designing documents – Design 
tab 

Themes apply decorative styles to your 
PowerPoint document (just like in Word and 
Excel), such as fonts, colors, effect options, 
paragraph spacing, etc. They can give a 
slideshow a consistent and attractive 
appearance and efforts look more professional. 
In business, they are best used as part of a 
“package” of documents, such as a slideshow 
accompanying an annual report with Excel 
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graphs and charts inserted. They can enhance 
what you want to communicate by adding 
company branding colors and fonts. You can 
also: 

• Make your slideshow more readable than 
just black-and-white text 

• Tie consistent inserts, like shapes and 
borders, together with the rest of the 
document’s “look” 

• Use different colors and font styles to 
punctuate headings from text 

• Help your reader respond and/or act in the 
way you need, and 

• Easily update the whole look of your 
document just by changing the color or 
font variants 

Design: Theming / Design Tips 

Like Word and Excel, using themes can be a 
double-edged sword. While they can add 
attractiveness to your documents, they can 
also, if misused, make your work look 
confusing, be hard to read, and muddy your 
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communication message. Certain types of 
work should not use themes, like cover letters 
and resumes, which are routinely expected to 
be plain and standardized and which the 
receiver will likely scan into a program for 
database acquisition. 

• Choose theme colors that make sense for 
the product, service, or idea(s) you are 
trying to communicate 

• Choose theme backgrounds that have 
good contrast and allow text to be very 
easy to read 

• Choose fonts for readability, based on need 
for headlines, lots of paragraph texts, easy 
bulleting, etc. 

• Remember that less is more – more colors 
and font variations in one document can 
look unprofessional and take away from 
your message. 

• Use themes only when you have full 
control over your own document – if you 
have an instructor or employer who does 
not want them used, then instead focus on 
using a template of the required styling. 
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Design: Theme Variants 

Theme variants let you change aspects of a 
theme you select to apply a different core font 
family to it, or to change the color palette it will 
work with. 

• Fonts: Font families in themes are 
designed and sized to be readable and 
hopefully scannable by screen readers for 
accessibility use. The style will offer a font 
for titles/subtitles, and another for general 
text. Available font families come installed 
with the computer’s operating system, 
and may also be accessed from the word 
processing software’s installation or cloud-
based accessories. 

• Color Palettes: Like fonts, color palettes are 
included in a style, and can also be 
changed independently to modify and 
create a new style. For instance, the overall 
design style of a theme may work for you, 
but the color palette assigned to it may 
not have enough contrast for your 
audience, or your company may focus on a 
different rage of core colors. 
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• Effects: These are subtle styles that can be 
attached to some inserted items, like 
image borders, shapes, SmartArt, etc. 

Theme Variants 

• Page Color: This allows assigning a color to 
a slide template, with previews of several 
colors in the theme’s palette. 

• Design: The Design tab has a Designer 
group, with a Design icon that can help 
you generate additional layout ideas for 
your show. 

ACTION: MS PowerPoint Try Me 
Activity #2 

Let’s work on slideshow design. 

Before you start, you should use your file 
manager utility to make a copy of the 
PP_design.pptx file that is in your DataFiles 
folder, then paste the copy into your Examples 
/ MS_PowerPoint folder. 
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• If MS PowerPoint isn’t open yet, open 
PowerPoint. 

• Go to the Tile tab Backstage and Open a 
file, then use the browser dialog panel to 
find the PP_design.pptx file that should 
be in your Examples / MS_ PowerPoint 
folder, then open the file. 

You should have a show with six slides of 
different layouts. We’ll use this for slide 
formatting practice. Our goal is look at Master 
slides, set a theme, and view the slideshow 
layout. 

• Let’s choose a theme. Use the Design 
ribbon, Themes group, to pick the Facet 
theme. 

• Scroll through the slideshow to see how 
the theme affects each slide. 

• If you see that some text looks off center, 
you can drag the text box to center it, and 
also use the Home ribbon’s Paragraph 
group to change the alignment of the text 
(like centering). 

• Use the Design ribbon, Variants group, to 
pick a variant color of the Facet theme 
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that you like. 
• If you don’t like the selection, click the 

small arrow at the lower right-hand corner 
of the Variants group to open a dropdown 
menu that offers a colors palette, font 
palette, and effects options. 

• Choose a different color palette from the 
selection. 

• Choose the Effects option from the 
Variants group dropdown, and pick one 
you like. 

In the last activity, we manually changed the 
font size of some of the bulleted text. Let’s do 
that here, using the Slide Master view, so that 
existing slides, and new ones, have larger body 
text (first three levels of bullets). 

• Go to the View ribbon, Master Views group, 
and click Slide Master. The Slide Master 
view will show thumbnails at the left of 
each kind of page the show has built-in, so 
that you can touch any of them up and 
have newly created slides follow these 
Master Page changes. It also provides a 
Slide Master ribbon, which has the themes 
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and background options, as well as a 
button to Close Master View. 

• From the Thumbnails, choose the top 
slide, which has the key styles for all 
bulleted text for the slideshow. Clicking 
this thumbnail will place an editable 
version into your workspace. 

Notice that there are several placeholders, 
including three at the bottom that act as footer 
information. 

• In the Slide Master, select the 1st line of 
bulleted text, and use the styles toolbar 
that opens (or the Home tab Font group 
options) to change the font size to 28 pts. 

• In the Slide Master, select the 2nd line of 
bulleted text, and use the styles toolbar 
that opens (or the Home tab Font group 
options) to change the font size to 24 pts. 

• In the Slide Master, select the 3rd line of 
bulleted text, and use the styles toolbar 
that opens (or the Home tab Font group 
options) to change the font size to 24 pts. 

• Close the Slide Master view. 
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What this does is enlarge the base size of the 
overall slideshow text. To get more granular 
changes to every slide, we would need to touch 
every master slide. 

• SAVE your work: CTRL S / MAC CMD S. 
• Let’s find out what the slide size is. Use the 

Design ribbon, Customize group, and 
choose the Slide Size. 

The Slide size defaults to Standard (4:3), with an 
alternative of (16:9) and of Custom Slide Size. Do 
not change the size. 

TIP: Changing slide size. When slides 
change to a new size, but any Master 
Slide changes will revert to the new 
size’s Master Slide defaults. 

• SAVE your work, and close the file. 
POWERPOINT ACTIVITY #2 FINISHED. 

Transitions 

Transitions are one design item that is unique 
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to PowerPoint. Because a slideshow is meant 
to be active and engaging, and because it may 
have many slides, one way to keep viewers 
from having a jolt from immediate slide 
changes is to program in transitions. A 
transition might take a couple of or a few 
seconds, provide a ‘slide separation’ effect, and 
help keep a show engaging. 

Slide transitions – Animations 
tab 

PowerPoint offers a number of build-in 
animated transition and layout actions. They 
can be used for an entire slide transition, or 
a specific in-slide item transition/animation. 
These give the feel of interaction and 
movement in presentations and allow creation 
of complex animated slideshows that can look 
like Flash Movies.. 

• Common animation thumbnails appear in 
the Transitions ribbon. 

• The left-most is the Current animation 
theme. 
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• Clicking other thumbnails to the right of 
the Current  will change to that of the 
thumb you choose. 

• You can also change the transition speed 
and sound. 

• You can set slide advancement timing so 
that the presenter stays on a specific 
schedule. 

• A transition can be applied to the current 
slide, or all slides in the show at one time. 

• For a professional and non-jittery feel, you 
can consider applying the same transition 
to all the slides. 

ACTION: MS PowerPoint Try Me 
Activity #3 

Let’s do some work with transitions, and maybe 
a simple animation. 

Before you start, you should use your file 
manager utility to make a copy of the 
PP_transitions.pptx file that is in your 
DataFiles folder, then paste the copy into your 
Examples / MS_PowerPoint folder. 
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• If MS PowerPoint isn’t open yet, open 
PowerPoint. 

• Open a file, and use the browser dialog 
panel for the PP_transitions.docx file that 
should be in your Examples / MS_ 
PowerPoint folder, then open it. 

You should see six formatted slides. A theme 
has already been selected, and the Master 
Page has been updated to have larger base 
fonts. Our task here is to set slideshow 
transitions, maybe an animation, and to test 
the slideshow. 

Transitions can be applied one page at a time, 
or on all slides. We’ll start small then learn more 
efficient practices. 

• Go to the first page of the slide show. 
• Activate the slideshow as it currently is. We 

want to observe how the slideshow works. 
When you start a slideshow viewing, by 
default it will begin from the slide you are 
currently on, unless you tell PowerPoint 
otherwise. 

• Using the Slideshow ribbon, Start Slide 
Show group, choose the From Beginning 
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icon. You can also use the Status bar’s 
Slide Show icon. The Function 5 key also 
starts a slide show. 

Okay, now we see the first slide. It is just stuck 
there. What’s up? The default for moving pages 
along is to press the keyboard enter button, to 
click the mouse, or the keyboard Page Down 
button. 

• Press the enter button, and the slide show 
changes pages. Keep pressing Enter, and 
the slideshow will progress until you reach 
the last slide, then it will exit back to the 
Edit mode. 

That was nice. It will be nicer if the pages 
transition with some kind of effect. 

• On the first slide, go to the Transitions 
ribbon, Transition to this Slide group. 

• Click the dropdown to open the dropdown 
transitions selector. Choose Random Bars 
from the “Subtle” area. 

• SAVE your work: CTRL S / MAC CMD S. 

Look at the thumbnails of the slides. The first 
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slide, which we applied a transition to, has a 
small star to its left – this indicates there is a 
transition. 

• On the Transitions ribbon, a Preview Icon 
becomes available at the left. Click it once 
to preview the transition. 

• Now, use the Function5 key (F5) to start 
the slide show. 

The slideshow starts with the transition. You 
need press Enter to advance the show, and. . . 
there are no more transitions. 

• Use the Escape button to escape the 
slideshow. 

A transition needs to be applied to every slide 
for every slide to use it. You can set transitions 
on every slide at one time two ways: 

• Select all slides by clicking the first 
thumbnail, pressing the shift keyboard key, 
and then selecting the last thumbnail. 
Once all slides are selected, choose the 
transition, which will apply to all. Or, 

• Use the Transitions ribbon, Timing group, 
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and choose Apply to all. 

In our case, make sure you are on the first slide 
which has the transition, then click the Apply to 
all. Now all the slides have the star icon. 

• Use F5 to run the slideshow, and press 
Enter to advance the slides. Note that the 
most pronounced version of the transition 
happens when the show opens; the 
remaining pages transition more subtly. 

• On the first slide, choose a different 
transition, such as the more “exciting” 
Honeycomb. 

• On the Transitions ribbon, click the Apply 
to all, so that the new transition replaces 
the old one. 

• Use F5 to rerun the show. 

Can we change the time on a transition? Yes. 
Make sure you are on the first slide 

• Using the Transitions ribbon, Timing 
group, change the Duration to 1.50. 

• Add sound by using the Transitions ribbon, 
Timing group, and clicking the Sound 
dropdown. Choose the Chime sound (or 
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another you prefer). 
• From the First slide, use the Transitions 

ribbon and click the Apply to all to add the 
timing and sound to all the slides. 

• Use F5 to rerun the show. The show is 
more dynamic, and seems to run faster. 

Can we use some other method to advance the 
show besides the Enter button or mouse click? 
Yes! 

Be on the first slide again. 

• Using the Transitions ribbon, Timing 
group, and unclick the On Mouse Click. 
Put a check in the After checkbox, and 
adjust the time to read 00.03. 

• From the First slide, use the Transitions 
ribbon and click the Apply to all to add this 
change. 

• Use F5 to run the show. The slides will 
automatically advance every 3 seconds. 

• SAVE your work: CTRL S / MAC CMD S. 
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Animations 

Animations are another design item that is 
unique to PowerPoint. An animation can be as 
simple as using a transition-like effect on an 
item, like fading out a picture. Or it can be used 
to bring in a list of text one bulleted line at 
a time. You can create an animated and 
programmable ‘button’ to advance pages on 
a slideshow with a click. You would use the 
Animations tab to add and time animation 
content so that the show feels like a movie. 
Animations can be applied to text, to pictures, 
and to ither inserts like shapes, clipart, 
WordArt, etc. 

You can also open an Animation pane in the 
Animations tab Advanced Animation group. 
This pane is necessary because if you have 
multiple animations in a slideshow, and even 
on the same page, you will need to tell 
PowerPoint several things: 

• What order to serve the animated items. 
The standard order is that the first things 
on a slide animate first – BUT, this can 
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mean the first thing created on the slide, 
not the first thing in the order you ‘see’ the 
items. 

• The timing of and between animation 
actions. 

• The speed of an animated effect. 
• How an animation should start – on a 

mouse click, on a timed delay, etc. 
• How you choose to change the order of 

animations. 

Let’s try an animation. 

• First, go to the first slide, and then reset 
the Advance Slide option back to On 
Mouse Click, and uncheck the After 
checkbox. Otherwise, the automatic slide 
timing will conflict with any animation you 
create. 

• From the First slide, use the Transitions 
ribbon and click the Apply to all to add this 
change to all the slides. 

• Go to Slide 2, and in delete the contents of 
the right-hand placeholder, so that you 
can see the icons to add content. 

• Choose the Stock Images, and find some 
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vacation image from another country to 
import. Once the image imports, it will size 
itself to the size of the placeholder field. 

• Click on the image, then go to the 
Animations ribbon, Animation group, and 
choose the Fade animation. 

• On the Animations ribbon, Preview group, 
and click Preview. 

• On the Animations ribbon, Timing group, 
and set the Duration to 1.2, then preview 
again. 

• Go to slide 1, and use F5 to run the show. It 
should need you to press enter or use a 
mouse-click to advance the slides. 

• Advance to slide 2 and stop. Notice that 
there is no image. 

• Click the mouse or press Enter. The image 
should fade in. 

• Press Enter again to continue advancing 
the show, or press Escape to escape the 
show. 

• SAVE your work. 

Shall we try an animated list of text? Go to Slide 
3, which has 4 lines of bulleted text. Let’s 
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determine how we can make each of these line 
appear one at a time from top to bottom. 

• Click on the Slide 3 placeholder with the 4 
lines of bulleted text. 

• Go to the Animations ribbon, and choose 
Fly in from the Animation pane. 

• Use the Go to the Animations ribbon 
Preview icon to see the animation. This is 
how the lines should ideally come in, 
considering timing, etc. 

Look at the Placeholder box’s text, and notice 
that to the left of each bulleted line, a number 
appears. 

Chapter 9: Microsoft® PowerPoint®  |  485



MedAttrib: author-generated. MS PowerPoint 
text slide. 

The numbers display the order in which the 
text will appear. In this case, we do not need to 
change the order. 

• On the Animations ribbon, Timing group, 
and set the Duration to 1.5, then preview 
again. The lines appear more slowly. 

• On the Animations ribbon, Timing group, 
look at the Start field, which shows On 
Click. There are other options, but we’ll 
stay with this default. 

• SAVE your work. 
• Go to Slide 1, then run the slideshow with 

F5. Use your mouse click or Enter button to 
advance each slide and animation. 

For your own practice, you can try animating 
the text placeholder contents on slides 4 and 5. 

On the final slide, let’s add a large image from 
your favorite travel place. In this case, you will 
need to remove the text-only placeholder, and 
simply import an image in to the page. 
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• Use the Inserts tab, Images group, 
Pictures / Online pictures, and search for 
an image. 

• Import the image, and resize it to be about 
10 inches wide. 

• Use the Picture Format context ribbon to 
add a predesigned border from the 
Picture Styles group gallery. 

• Click the image, and use the Animations 
ribbon, Animations group to pick an 
emphasis animation to apply to the image. 

• Use the Animations ribbon, Timing group 
to change the Duration to 1.25. 

• SAVE your work. 
• Run the slideshow from the beginning. 
• SAVE your work, and close the file. 

POWERPOINT ACTIVITY #3 FINISHED. 

Review and Distribution 

PowerPoint is about presenting work – in 
person, as timed online presentations, etc. It is 
used in meetings, conferences, sales contacts, 
on websites, in streaming threads, etc. The 
various illustration, transitions, and animation 
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tools make PowerPoint uniquely capable of 
having interactive data presentation. 

You can also create slide notes, to appear below 
slides, and/or to be printed out for a separate 
handout in a meeting. 

Output – File tab 

Review and distribution of your work is about 
preparing it for who will be consuming it. Will 
it stay in a Word document format, be saved 
as a PDF, printed onto paper, added as website 
content, populate an add or newspaper article, 
or be part of a book? Like Word and Excel, a 
PowerPoint file needs to be: 

• Spell checked 
• Grammar- and language- reviewed 
• Accessibility enabled (alt text, proper use 

of heading styles, accessibility for screen 
readers). 

• Have versioning considered. 
• Have hyperlinks tested. 
• Be cited and attributed properly for 
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intellectual honesty. 
• Passed for plagiarism and other content 

integrity needs. 
• Presented for readable print viewing. 
• Secured for limited/no editing. 
• If meant for team collaboration, prepared 

for making shared/trackable changes, 
comments, and notes. 

Output/distribute work 

• You can test and adjust your documents 
and review your content before it goes live 
by looking at the File/Print sections Print 
Preview and settings. 

• You can make sure you have added 
metadata for web/online reference by 
updating information in the File/Info page. 

• Slideshows can be saved in as a slideshow, 
native slide prepared format, as a 
template, and in other formats, like images 
and PDFs. 

• You can save files in different formats for 
distribution in the File backstage areas, 
like Save As (for current and older versions, 
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RTF, text, and HTML), save as PDF, export, 
etc. 

This should give you a good overview of MS 
Word skills that you can use in school and as a 
starter for basic workplace support tasks. 
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Chapter 10: 
Databases 

What We’ll Cover >>> 

• Database Concepts 
• Microsoft Access 
• Tables 
• Queries 
• Forms 
• Reports 
• Review and Distribution 
• Special Concerns 

This textbook does not train on database work. 
Why? Databases are intense, complex, and very 
detail-oriented repositories of information that 
requires time, review, and practice that should 
be offered in a databases-specific course. 

At the same time, MS Office provides Access 
Database as one of the key applications for 
relational database work. And, much of work 
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in the computing / digital word is reliant on 
database data, analysis, connection, and data 
entry. Therefore, this chapter is an overview of 
MS Access database concepts so that you can 
understand the breadth of now information/
data means in the scheme of computing and 
information access. Other instructors may 
choose to add practical activity examples and 
homework. 

Database Concepts 

A database is an organized collection of data, 
generally stored and accessed electronically 
from a computer system. Data stored in 
databases might include facts about people, 
events, things or ideas. This 
provides information, which generates usable 
knowledge and actions. 

In a way, a database is like a huge warehouse 
of information that is necessary for data 
acquisition, analysis, reporting and 
computations, but the database itself does not 
do that work. It holds the data for exporting 

492  |  Chapter 10: Databases



to other applications that can do the work, like 
Excel for computations, data analysis query 
tools, etc. 

For a database to be useful for basic work, the 
information in tables of data have to have some 
relationship to each other, or else one would 
be comparing apples to giraffes in a futuristic 
world in which dinosaurs roam a starship. We 
will focus on relational databases which have 
ways to link seeming unrelated information 
from multiple tables/sources. Nonrelational 
databases also have an important place in the 
computing workplace but are beyond the 
scope of this book. 

The following are common relational Database 
Management Systems, (DBMS): 

• AWS for Data 
• Microsoft Access 
• MySQL 
• Oracle 

Databases are part of our lives in every way, 
even when we don’t recognize it. If you ever 
have to ask for a massive amount of 
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information to sort/filter itself and give you a 
specific response, chances are that you ad 
dealing in someway with a database or 
database output. Examples: 

For my birthday, I treat myself to 3-4 new (or 
missing from my Kindle library) books by 
favorite authors. I go to Amazon’s Kindle 
section and look for the newest Stephen King 
book so I can buy it. 

• Amazon’s entire collection about Kindles, 
books, authors, book titles available books, 
prices, and capability for purchase of a 
book, is part of their database. I query 
Amazon in the Kindle Search field and the 
database reports back (in the list of 
Stephen King Kindle books) that Stephen 
King doesn’t yet have a newly published 
book, and also lists other books. I 
recognize one I am missing from my 
Kindle library, and I treat myself to a 
purchase of it. 

I am drafting this OER textbook about Business 
Technology, and I need more information 
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about accessibility issues for populations with 
differing accessibility needs. 

• I use Google as a search engine and in the 
search field look for “assistive technology 
for cognitive disabilities” and Google 
returns a list of linked web pages that 
might give me some information I need. 
Google’s search engine has queried their 
massive database of websites and topics 
and reported out search results. 

Database preparation 

Effective database design is critical, and must 
be planned out before the database is built. 
One of the first steps in designing a database 
is to ask ‘What questions should this database 
be able to answer?’ The goals of the database 
should be to store data in a way that makes it 
easier to answer these questions. 

The database should be user friendly, easy to 
input data into, and able to prevent duplicate 
records from being created. Redundancy in 
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the data can cause the integrity of the 
database to be compromised (questions can’t 
be answered accurately). 

Practical database design also has to focus on 
accuracy and consistency of the data – reliable 
and standardized formats, with data input 
controls that ensure consistency. Spelling and 
naming conventions must be precise and 
uniform. 

Database objects 

Databases contain objects to store or reference 
data. A data object is a structure used to either 
store or reference data. The database objects 
we will focus (in order of use) on are: 

• Tables: storage of information 
• Queries: questions about information 
• Forms: input of information 
• Reports: output of information 
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Microsoft Access 

Since Microsoft® Access® (MS Access / Access) 
is widely used in industry, and we are covering 
Microsoft® Windows® and Microsoft® Office® 
in this textbook, we will focus primarily on 
Access as an example of a relational database 
management system. There are many 
similarities across relational database 
management system standards, so the skills 
we are learning are translatable. 

MedAttrib: author-generated. MS Access user 
interface. 
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Tables 

Tables contain data. Columns and rows of 
tabular data can be indexed, sorted, filtered, 
and later queried for finding information in the 
database. Tables are read by columns (column 
head for table field data identification) and 
rows (each row is a separate instance, like a 
customer or product). 

• Table Record: A table’s row of information 
about a particular item the table is about, 
like a customer record. 

• Table Field: Like a cell in Excel, a field 
contains one piece of data about one part 
of the table subject, such as first name of a 
customer. The item inside that field is its 
value. 

• Table Field property: The format that a 
table’s field takes, like text for the 
customer’s first name, or currency for an 
entry about salary. 

• Data Types: Like Excel a database will have 
types of data, like text, currency, email 
addresses, a hyperlink, a date/time, a 
number, and so on. 
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Connecting tables of data 

Relational databases have many tables of 
information in them. A common standard is 
that if an item in a table can be broken down 
into another table, then linked to the main 
table in a query, it needs to happen. For 
instance, in a Customer table: 

• BotWa031323, LJ, Bothell, 1234 Main Street, 
WA 

• In this record (row) of information, my first 
and last name is unique to me. The street 
address is generally also unique, although 
other people in the table may actually live 
at the same condo complex. However, 
what is definitely not unique is the state 
abbreviation. Yet, when a data entry 
operator inputs a couple of hundred new 
rows/records, they may refer to 
Washington State as WA or Wash in 
different records. What a mess! 

• Another table for just abbreviations of 
States should be made 

• Then, the Customer table and the States 
table needs be linked so that Customer 
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table would have a dropdown option for 
the State field, which links to the list of the 
State abbreviations in the States table. 

This kind of relationship-building, which one 
really needs to learn, absorb, and practice in a 
database course, looks like this: 

In every single table, there should be one 
column of information that can never, ever 
have a duplicate – like a field value of a unique 
customer number. This unique field value 
would be given a “Primary Key.” Which is an 
Access database way of ‘locking’ the unique 
field value from being duplicated. 

The States table would also need to have a 
column of totally unique information field 
values, so that each state could be considered a 
unique entry. Because the state abbreviations 
ARE unique, the abbreviation field values could 
also act at the primary key for that table. 

Then, in a query, those two primary keys could 
be referenced, and the tables would be ‘linked’ 
to pull information from them. 

Okay, that’s enough techy detail. 
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Queries 

A query in a relational database is just a way of 
asking the database a question about data that 
may reside in part in several tables. The idea is 
that you can query data in a separate customer 
table, product table, and sales rep table, and 
get an answer that identifies which sales rep 
represented which products for which 
customers. Why? You might want to know 
which sales reps have the most sales, or which 
customers bought which products. 

Why a database instead of Excel? Because a 
relational database is designed to hold tens of 
thousands of customers, thousands of 
products, hundreds of sales reps, all their data 
like addresses, ID numbers, payments, tax 
amounts, dates, etc. 

• Excel would be used after you narrow 
down a lot of data to just what you need, 
then export it to Excel so you could use the 
worksheet to calculate formulas about the 
money, count of products, average order 
size, etc. 
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• Access and other databases don’t do 
calculations, or graphs/charts. 

• Excel can’t efficiently process thousands of 
multiple columns and rows of seemingly 
redundant data. 

TIP: Queries in databases like Amazon 
and Google. The Amazon query is the 
Search bar. The query in Google is also 
the search bar. The search for a Stephen 
King book at Amazon queries the 
database, and the Google search for 
Assistive Technology queries the Google 
database. 

Forms 

Database forms are used for inputting data into 
the tables of the database. 

In Excel, one generally works with the actual 
raw data ranges or tables of data. In a database, 
however, working with the native table can 
lead to costly and messy inconsistency 
mistakes being entered into the fields. 
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Instead, an efficient and secure database uses 
one or more input forms for data entry input 
into tables. For instance, if we refer back to the 
separate customer table, product table, and 
sales rep table, what if you are doing data entry 
for new customer orders that need to populate 
fields in all THREE of these tables at once? 

The form would be designed – using the 
relationships between the tables (via the 
Primary keys and other database magic). Then, 
the data entry specialist would simply open a 
dashboard form. Fill in all the customer order 
information, and the database would place the 
relevant data for each pf those 3 tables into 
them. 

Reports 

Access and other relational databases can also 
‘report out’ information from tables and 
queries. It isn’t an optimal use of reporting, but 
if no calculations or graphics are needed (hey 
Excel!) but some basic narrowing of data is, 
Access can generate a moderately attractive 
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form so you can print it, save it as a PDF, or 
otherwise distribute the report. 

Review and distribution 

In Word, Excel, and PowerPoint, one big step 
before distributing the work product (printing, 
PDF, etc.) is to do a spell check. You can also 
do this in Access and other databases, but the 
concern can be that data could be corrupted if 
a field of information that a query relies upon 
suddenly has a spell-checked batch of 
corrections hit it. Be very careful. 

Another standard pre-distribution check for 
Word, Excel, and PowerPoint is an Accessibility 
check. This is to be sure that tables, inserts like 
images and SmartArt, and other document 
items that may go through a screen reader can 
pass basic accessibility standards. 

The database, however, isn’t so easy to do this 
with. The tables of data, the queries, and the 
input forms aren’t designed for a real 
accessibility check. Instead, Microsoft works to 
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add accessibility tools to the overall Access 
interface. 

However, the output Access database report 
can and should go through an accessibility 
check, just to verify that any design/formatting 
images can get alt text and other accessibility-
related hiccups can be caught and corrected. 

Special concerns 

Future of databases 

A future of databases is happening now. The 
chapter mentioned flat databases, which are 
not relational, and relational databases (Like 
MS Access). However, as more data is 
accumulated, needed, and has to be combined 
and synthesized for analysis, solitary non-
relational databases of some complexity are 
needing to be accessed and used. This is due to 
so many database systems now being ‘legacy’ 
on legacy machines. The data is important, but 
can’t be easily accessed, merged elsewhere, 
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and analyzed. Some U.S. Government database 
systems have this problem. 

Applications are being developed to assemble 
multi-model databases, which are database 
management systems that organizes many 
NoSQL data models using a single backend, a 
unified query language, and API. They allow for 
several non-related databases, from different 
servers and systems, with different forms of 
data formatting, to be accessed and queried. 
The query then creates big data which can 
then be repurposed into a more central and 
secure database with more processing power 
access. 

It is also likely that in future quarters, students 
may find themselves treated to very basic SQL 
coding for relational database work just to learn 
how to develop a very simple database. 
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Part 3: Internet 
Fundamentals 

We’ve had an overview of computing essentials 
and some productivity applications. Now we’ll 
discuss the Internet itself, and our relationship 
to it. Why is this important? 

The Internet and Web give us almost unlimited 
access to information and connection. It seems 
to have democratized knowledge and opened 
doors to avenues of work, play, creativity, and 
influence. Free speech, paired with our need 
to absorb and parse incredible amounts of 
information, leads to both opportunity for 
growth and unintended consequences. We 
have to consider access, responsibility, privacy, 
security, policy, and what digital citizenship 
means. 

We have become global digital citizens, which 
demands responsible use of technology by 
anyone who uses computers, the Internet, and 
digital devices to engage with society. At work, 
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in education, and in our personal lives, we have 
an effect in the world around us. Let’s find out 
more. 
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Chapter 11: 
Internet Basics 

What We’ll Cover >>> 

• Internet Concepts 
• Networking 
• Interfacing with the Web 
• Email Communications 
• Remote access / VPNs 
• Wi-Fi Networks 
• Home Networks 
• Security 
• Information Tools 
• Information Sharing 
• Information Use 
• Intellectual Property 
• Downloading/Sharing 
• Net Neutrality and Laws 
• Website Information 
• Special Concerns 

As digital citizens, a big part of our education 
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and responsibility requires that we examine the 
playing field of which we are a part. 

Internet Concepts 

The Internet is a worldwide system of 
computer networks with billions of computers 
and devices linked up. Users at any one 
computer can “go online” to connect to and 
access information from any other computer 
with a series of network permissions. This 
allows people to communicate with anyone 
anywhere, share information, and add their 
own influence to the pool of knowledge we 
share. 

What is the World Wide Web? 

Often referred to as the Internet, the World 
Wide Web (web) is actually specific part of it, 
not all of it. The web consists of websites 
accessed through the Internet. A website 
essentially an easy user interface for 
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information, and included text, images, and 
other resources full of information. 

MedAttrib: geeksvgs.com/public domain. 
World Wide Web illustration. 

Websites simulate various forms of media, like 
presentations, brochures, video programs, 
games, articles, workplace portals, and so on. 
The purpose and style of websites can seem 
endless: advertisement, video media center, 
blog, newspaper, an online library, a forum for 
sharing content and images, an information 
portal, games, expanded instant messaging, 
streams of video activity, etc. 

Part of the development of the web 
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community was to include some form of 
address to each website. This is what appears in 
the address bar of a browser and by default is 
to the home page of a website.. It is a unique 
“Uniform Resource Locator” (URL) address: 
http://www.domainname.domaintype. Longer 
form example: 
http://furnishings.shilpcrafts.com/decor 

• Domain: This tends to be the location/
ownership of the site. The domain name 
would be, say, a company’s or schools 
name. The domain type would be the 
entity your organization registers as on the 
internet, like commercial (com), business 
(biz) school (edu), government (gov), 
country (us), network (net), etc. 

• Scheme: https//, which means Hypertext 
Transfer Protocol. Other schemes include 
https (secure), mailto:// (email), and ftp:// 
(file transfer location) 

• Sub domains: A website usually has a 
number of sections/pages, and when one 
of these appears in the URL, it means that 
the address is taking you to a specific 
section of the website, not the default 
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home page. 
• Subdirectory: The specific section of a 

webpage. 

Since websites usually have more than one 
web page, they need to link those pages 
together so visitors can navigate to them. We’ll 
discuss more about website parts and content 
later in the chapter. 

Networking 

Some types of physical networks 

• LAN: Local Area Network, which is a 
network that connects computers and 
devices in a limited geographical area 
such as home, school, or office building. 
Uses existing home wires (coaxial cables, 
phone lines and power lines) and Ethernet 
cable wiring. 

• HAN: Home area network, which is a 
residential LAN used for communication 
between digital devices typically used in 
the home, like personal computers and 
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peripherals. 
• MAN: Metropolitan area network, which is 

a large computer network that usually 
spans a city or a large campus. 

• WAN: Wide area network, which is a 
computer network that covers a large 
geographic area such as a city, country, or 
spans even intercontinental distances. 
Combines many types of communications 
media such as telephone lines, cables, and 
air waves. 

Wired Connections 

• Wired connections allow you to connect 
with other computers through physical 
wired technology that uses existing 
infrastructure. 

• Host Ethernet Adapter: A physical 
Ethernet adapter that is integrated directly 
into the GX+ bus on a managed system. 
Needs an Ethernet cable to a router that in 
turn is wired to a service (like Broadband). 
Can automatically detect another 
computer connected with a straight-
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through cable and then automatically 
introduce the required crossover. 

• Voice Modem: A device that modulates an 
analog carrier signal to encode digital 
information, and also demodulates such a 
carrier signal to decode the transmitted 
information. Older computers had a 
modem installed, which could work with 
telephone lines to transmit 
communications data to other computers. 

Wireless connections 

• Wireless connections allow you to connect 
with other computers using radio 
communication. 

• There are wireless LANs, WANs, MANs. 
• Cellular Network: radio network 

distributed over land areas called cells, 
each served by at least one fixed-location 
transceiver, known as a cell site or base 
station. 

• Bluetooth: A wireless technology standard 
for exchanging data over short distances 
(using short-wavelength radio 
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transmissions) from fixed and mobile 
devices, creating personal area networks 
(PANs) with high levels of security. 

• Radio modems: Used for long-distance 
wireless connections, such as for direct 
broadcast satellite, Wi-Fi, and mobile 
phones. 

Interfacing with the Web 

The biggest hurdle to accessing information is 
being able to get to it. The web evolved in order 
to build the user interfaces (websites) in 
appealing and dynamic ways for us to get at 
information, and the addressing to locate the 
site. However, what also had to develop was 
how to find the address of and be able to reach 
these millions of websites. That is what a Web 
Browser (browser) is for. 

When a user requests a web page from a 
particular website, the browser searches for 
and retrieves its files from a web server and 
then displays the default home page (usually) 
on the user’s screen. 
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Browsers are used on every computing device 
that can connect to the Internet. The browser 
concept and design has become so standard 
that many software applications have adopted 
the browser format for presenting information 
and app section linkages, even when not an 
actual website. The website is the medium for 
the website owner’s information, and the 
browser is the visual medium that interprets 
website code and displays it to the viewer. 

There are dozens of browsers, which are free to 
use and often come paired with a computing 
devices OS. While browsers are generally 
universal (Google Chrome, Opera, Firefox), 
some are more tailored to an OS than others: 

• Mac: Safari 
• Windows: Edge 

A browser lets you find and display a website. 
The Search Engine is the mechanism that 
queries the Internet to search the Web of pages 
and report back the results as a list of 
hyperlinked websites (often with summarized 
information.) The search engine behaves like 
the query of a database (the Internet database 
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of websites located by addresses), and the 
search results would be the output report. A 
Web Crawler is a search engine bot that does 
the searching. What makes this so fast is that 
web pages that are located are added into a 
data structure called an Index that adds data 
about the web page, like keywords and recency 
of use. 

Search engines can search with a single word 
(like a company name),keyword (coffeehouse) 
a specific phrase (Assistive technology for 
disabled persons), or a concept (new horror 
novels like Stephen King). 

Email Communications 

Email is electronic mail, the mode of 
communication that uses electronic devices 
and data transmission to deliver messages 
between different computers. We covered 
email usage and tips in Chapter 6. This section 
is about the more technical aspects of how the 
email process of the Internet works. 
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When you send an email to contacts, there is 
a series of processes that happens in the 
background from when you send the email 
until the email is delivered to the recipient’s 
Inbox. Here is a refresher from Chapter 6. 

Email Processing 

• Create then send the email. 
• The email client (such as Gmail) connects 

to an outgoing email Simple Mail Transfer 
Protocol (SMTP) server. 

• The email is handed over in a MIME 
(internet-standard encoded file) format, 
and the outgoing server validates sender 
details before processing the message. 

• The mail goes into the SMTP server’s 
Outgoing queue. 

• The SMTP server looks up then connects 
with the Recipient email server mail 
transfer agent (MTA) and sends the email. 

• The Recipient server initiates various 
security checks then accepts the email if it 
passes. 

• The Recipient server validates the recipient 
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account and delivers the email to the 
user’s mail account, based on the 
incoming email policies set for the 
account. 

MedAttrib: author-generated. Email 
processing. 

Email Access 

Email can be accessed through an email client 
(like MS Outlook) or a web interface (like Gmail). 
These user interfaces often provide additional 
functionality for sorting and organizing emails, 
formatting your own outgoing emails, creating 
a contact list, modifying interface layout 
settings, filtering/blocking emails, and instant 
messaging. 
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Email Servers: 

• IMAP: Internet Message Access Protocol, 
which has two-way communication with 
servers, and which saves a copy of every 
message on the server so multiple email 
clients can get them. 

• MDA: The incoming email Mail Delivery 
Agent server 

• POP: Post Office Protocol which gives the 
email user access to emails stored in the 
user account. Email travels one way, and is 
less effective because it doesn’t manage 
different email interfaces. 

• SMTP: The outgoing email Simple Mail 
Transfer Protocol server 

Remote Access / VPNs 

Remote Access to computers 

In both the office and home environment, you 
may need to remotely access a computer to 
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get at work files, information for an 
assignment, or your own files when you are 
away from your own computer. With remote 
access, a computer or network you are 
accessing determines you are physically at its 
location instead of accessing it from elsewhere. 

This technique is also useful when one person 
needs to assist another in solving a computer 
technical problem but can’t physically do so. 
Tech agents at computer manufacturers do 
this to resolve problems for customers, such as 
when a computer microphone seems to stop 
working and the user contacts technical 
support. A tech rep at one’s company can help 
with work-related computer issues, as another 
example. 

Virtual Private Networks 

A Virtual Private Network (VPN) creates an 
encrypted connection to another location on 
the Internet. The VPN provides an IP address 
instead of the user’s, so that Internet traffic 
emerges without signs of where a user is 
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connecting from. VPNs can be installed on 
your computer, mobile phone or tablet. VPN 
services usually charge for their services. 

A visited website knows the user IP address, 
and keeps server logs of what pages on the 
web site are visited, how long was spent on 
each page, etc. The VPN makes web browsing 
more private, since the visited website records 
the logs with the VPN’s IP address, rather than 
an IP address that could more easily be 
associated with the user (e.g. home Internet 
connection). 

VPNs can enhance online privacy, especially in 
public computing locations and for financial 
transactions. They are commonly used in the 
following circumstances: 

• Adding encryption to unencrypted 
communications. 

• Streaming media that is licensed for 
viewing in some countries, but not 
available in others. 

• Watching geographically restricted tv & 
movies. 

• When using a public Wi-Fi hotspot. 
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Access work network when out 
of office 

A workplace may have software or files that 
can only be accessed from a computer that 
is connected to the office network. This helps 
keep these files and software more secure, as 
they are not directly accessible to the Internet. 
However, many people work from home, so 
how do they access these restricted resources? 
VPNs are one way of allowing this access. To 
the office network, employees connected via 
the office VPN can have all the rights to access 
software and files that they normally would if 
they were physically present in the office. 

Wi-Fi Networks 

Wireless (Wi-Fi) networks use a radio frequency 
signal instead of wires to connect devices to 
the Internet and to each other. The signal can 
be picked up by any wireless-capable device. 
Like a laptop, mouse, and smartphone certain 
distance in all directions. 
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Encryption 

Encryption is the process of hiding the 
contents of information, which is particularly 
important as users send and receive 
information (like passwords, credit card 
information, other personal information, etc.) 
on personal and sometimes less-than secure-
computing devices (smartphones while in 
public, for instance). 

Encryption strength is measured in bits (e.g. 64 
bit, 128 bit, 256 bit, 512 bit, etc.) The larger the 
number, the stronger the encryption. Currently 
256 bit encryption is considered strong (i.e. 
difficult to decrypt without a key). 

As an example, “dpnqvufs” is a simple form of 
encrypting the word “computer” by shifting 
each letter to the next one in the alphabet (i.e. 
“c” becomes “d”, “o” becomes “p”, etc.). 
However, simple encryption like this 
encryption could be considered very weak if 
it could be decrypted easily by a computer 
program. 

When using a web browser on the Internet, 
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ideally a user should only deal with encrypted 
web sites (so that someone intercepting the 
communications between them, and the 
website can’t easily decipher these 
communications). Financial and other websites 
that need personal and sensitive information 
are usually encrypted. 

TIP: Encryption. The website’s URL 
address should begin with https://, with 
the “s” indicating ‘secure’. Alternately, 
the URL may show an image of a locked 
padlock before it. An UNencrypted 
website will show “http://” before the 
website address and/or an image of an 
unlocked padlock. 

E-Commerce sites (banks, retailers, etc.) have 
typically always used encryption to protect 
financial transactions; however, there is a trend 
to having all websites use encryption. 

Public Access Points 

Public locations, like a hotel lobby, airport, or 
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some coffee shops may offers free Wi-Fi for 
public use. Unencrypted Wi-Fi networks won’t 
require a password to join them, but. encrypted 
networks will. 

When a user’s device is in range of Wi-Fi 
connectability, a list of available networks will 
appear when trying to connect. Encrypted 
networks should show a closed padlock beside 
the networks name on the list. 

On Wi-Fi networks without encryption, all 
communications between your device and the 
Wi-Fi router can be accessed by others. This 
can be a problem if a user is doing a financial 
transaction (paying online with a credit card), 
reviewing personal information (a workplace 
interface login), calling friends (showing access 
to one’s contact list), and so on. 
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Home Networks 

Routers 

Many people have Internet service at home, 
and an Internet Service Provider (ISP) (like the 
local cable company) usually provides a router 
with Wi-Fi. Securing a home network is critical 
in order to keep Wi-Fi processes from being 
hijacked and opening the home and 
computing tools to outside users. A first step 
should be immediately enabling encryption, 
and creating a unique password to access the 
router’s settings. The router’s password should 
be different from the Wi-Fi network password. 

If a new router device has a standard 
manufacturer’s password, the user should 
change it immediately. 

Whole Home Wi-Fi Coverage 

In many homes, a single router will provide a 
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Wi-Fi signal to all parts of the home. In large 
homes, or homes (apartments) with concrete 
construction, sometimes the Wi-Fi signal is 
weak in certain parts of the home. The weak 
signal can be strengthened by either a: 

• Mesh Network: This is more expensive 
technology will involve replacing the 
existing router and that can provide whole 
home Wi-Fi coverage using 2 or more 
nodes. It provides a more seamless Wi-Fi 
connection when moving from room to 
room, plus faster speeds. 

• Range Extender: If it’s just one room in the 
home with a weak signal, an extender can 
help. It extends the existing Wi-Fi network, 
and is a less expensive option than a mesh 
network. 

Security 

Firewall use 

Firewalls are hardware and/or software that 
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inspects the Internet traffic coming into and 
out of a network or computer. It uses a set of 
rules (that can be configured) and it is 
designed to block malicious communications 
to your computer. A firewall is meant to assist 
in preventing a computer from being infected 
with malware: it doesn’t provide any assistance 
in scanning or removing malware that is 
already on the computer: for that you need 
anti-virus / anti-malware software. More 
information on security measures will be in 
Chapter 12. 

A home router (hardware) likely provides some 
firewall capabilities, as does a user’s computing 
devices’ operating systems. 

Information Tools 

Aspects of information tools have been noted 
in other chapters. This section combined a 
general overview since the following tools are 
specific to Internet/Web access and use. 

• Browser: Browsers were developed to view 
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sites on the Web. Websites are an interface 
that gives access to the information and 
tools of the Internet, such as locating and 
reading the information on a webpage. 
The browser allows for searching for, 
finding, and viewing websites. Some 
browsers also offer options for accessing 
email, reading newsgroups, and/or 
connecting to a chatrooms. 

• Chat : Online chat is like being in a room 
with other people, but not physically in 
person, Chat can be one-on-one, getting 
help from a retail website, in a conference, 
in an online seminar, etc. It is a tool paired 
with online conferencing programs like 
ZOOM and MS Teams and allows for silent 
chat to happen online while someone is 
presenting, or a group discusses 
something. 

• Domain/Domain types: A domain is part 
of a web page address which indicates the 
entity that owns or licenses the use of the 
address and related entity name. Names 
like microsoft, starbucks, and shoreline 
would be examples. 

• Download / Upload: Programs, work files, 
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videos, and other items are transferred 
from one computer to another. 
Downloading is when a user gets the 
file(s) from another computer. Uploading 
is when a use gives files to another 
computer. 

• Email: Electronic mail allows user 
communication on the Internet. Messages 
are sent and received, and can be 
responded to, forwarded, stored sorted 
and filtered, and deleted. 

• FTP: File transfer protocol which is a 
program for uploading and downloading 
files through the Internet from one 
computer to another. FTP is used for 
uploading website files, downloading work 
files and music. FTP needs an interface 
that shows an available directory structure 
of each computer so data can be 
transferred from one to the other in a 
matching directory location. 

• HTTP: Hypertext transfer convention 
which is a communication protocol. Used 
as part of a web page’s address, it tells a 
web browser about what kind of file is 
being requested so it will be displayed 
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correctly. http://. . . 
• Mailing List / Contacts: A list of email 

addresses that can allow an email to be 
sent to one or several people at one time. 
It can be used as a listserv for coworkers, a 
group for people working on a project, a 
personal contacts list, a list for sending 
something like newsletters. 

• Search engine: An application used in a 
browser to search for web pages and files. 
The search engine is a form field a user 
enters a keyword or phrase into, and the 
engine uses web crawling ‘bots’ developed 
to scan the internet for web content that 
meets the criteria based on the web 
content’s own keywords and information. 

• Server: A computer that a user connects to 
when visiting a web site. A server can be a 
single desktop computer, a mid-range 
computer connecting several other 
computers, and large computers in a 
server farm/data center that have 
petabytes of space. 

• Web page: A page is a text file that 
contains codes that tell a browser how to 
display the contents of the page. Web 
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pages can contain text, images, audio/
visual media, and applications that 
perform in the browser. The code – written 
as Hypertext Markup Language (HTML) 
and styled with Cascading Style Sheets 
(CSS) – is interpreted by the browser based 
on developed universally-accepted 
standards for translating code language 
into user-friendly viewing. 

Information Sharing 

Sharing information means exchanging of data 
between organizations, people and 
technologies. 

• Downloads: Users can get, use, and store 
information from web sources, like 
document files, PDFs, music files, videos, 
zip files containing data and/or executable 
files, etc. By default, browsers assist in 
downloading, as does the host of the web 
space that has the files. A user can 
download by using an FTP program, or by 
clicking a link on the file’s website, or right-

534  |  Chapter 11: Internet Basics



clicking the item to be downloaded for a 
context menu that offers a download 
option. 

• RSS Feeds: Really Simple Syndication (RFF 
feeds) allows for the real-time acquisition, 
organizing, presentation, and automatic 
updating of information like newsletters, 
online newspapers, a website’s updates, 
notifications, etc. The information can be 
converted into an HTML format of 
headlines and summaries with longer-info 
hyperlinks, for easier browsing and 
absorbing. News aggregators and online 
publications also use RSS feeds to 
automate the availability and access to 
current information like stories and 
announcements. 

• Synchronization: Synchronization (Sync, 
Syncing) enables users to keep 
information automatically synchronized 
across phone, tablet, laptop and desktop 
computing devices. This can include 
profile information, bookmarks, history, 
passwords, and preferences. With syncing 
on, changes a user makes (like adding 
browser bookmarks) are updated, Then 
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they are able to be used on the user’s 
other computing devices and applications 
that use the account (like the Chrome 
browser on a laptop and on another 
tablet). Turning off sync still allows access 
to the various settings, but they will not 
update or sync to other devices and 
applications on the account, or accept 
changes from the other devices that 
might still have sync on. Turning off sync, 
however, can help if a service intrudes with 
constant login demands, or if battery life is 
draining fast due to data usage. 

• Throttling: Internet throttling is when an 
Internet Service Provider (ISP) deliberately 
slow down connection speeds for high-
bandwidth activities like downloading 
files, streaming activities, gaming, or using 
social media interactive options. Throttling 
is often about an ISP’s attempt to balance 
or control computer network traffic, 
optimize performance, decrease Internet 
response time, and/or boost bandwidth. 

• Uploads: Uploading puts web pages, files, 
and other data onto a web server using 
some kind of upload utility application for 
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file transfer protocol (FTP). 

Information Use 

The Internet, with all the files, web pages, and 
applications, seems to be free. There are 
discussions and expectations about what is 
and should be free for use, what should require 
payment, and what needs legislation. These are 
complex discussions, and several will be 
initiated in Part 4 of this textbook. 

What is free information? 

Free access and use of information, downloads, 
and online applications’ use can mean that a 
user doesn’t have to pay fees, and/or that ads 
appear that provide the creators with the 
revenue. Non-paid content is free for use, even 
though it likely takes effort/time/funds to 
create, develop, maintain, update, and monitor 
the results. For instance, consuming website 
content is free, online library contents are free, 
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using online government services and forms is 
free, and trying online cooking recipes is free. 
Open-source applications are free to use and 
modify. This textbook, which consists of years 
of the author’s work and teaching experience 
and many ours of writing and editing, is being 
offered for ‘free’ through open educational 
resource options like Pressbooks. 

Alternately, free can also mean that the user 
has no obligations when accessing and using 
online content. It isn’t about money, but about 
who owns the rights, license, and usage of 
materials like images, music, programs, tools, 
etc. And about how it can be used by others. 

Other information on the web does require 
fees, like an online subscription as a service 
(SaaS) for use of an application. There can be 
fees to legally download music files, or a charge 
to stream a film, or payment to download the 
components to start some online games. Some 
providers offer a free version of a program as 
a teaser for the full version; a free introductory 
level or time period hooks the user into making 
a purchase or signing up for a paid 
subscription. 
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Some information also comes under donations 
and gifts. Applications like Twitch and other live 
interaction/streams offer inducements of small 
monetary charges for rewards, attention, etc. 

Intellectual Property 

Who owns information, how, how much, and 
why? Intellectual property has to do with 
copyright, trademarks, registrations, fair use, 
and attribution (citations, referencing) of 
information. Just because the Internet has lots 
of ‘free’ information, that doesn’t mean it is free 
from user responsibility, respect, and 
appropriate use. The same way that free 
speech offers much open speech, it also 
demands responsibility for the consequences 
of that speech and some education on how 
and why society can’t be a free-for-all (no pun 
intended) on speaking one’s truth. 

Intellectual property law encourages creation 
and distribution of intellectual goods, like 
medicine, researched textbooks, series of 
novels, music for ballet and karaoke, clothing 
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designs, design plans for housing and multi-
family complex buildings, etc. After all, most 
people don’t want to work for free, since we 
need to eat, have shelter, have personalized life 
options / tools / experiences, get places for work 
and fun, take care of our health, raise children, 
and so much more. If we expect to get paid 
for work, why wouldn’t someone who creates 
a new product line, a new source of jobs, new 
kinds of cars and computers and medicine and 
new restaurants? Especially since that 
intellectual knowledge goes well above and 
beyond just a day’s work, and can represent 
hours, months, or years of costs, research and 
development, time away from the rest of life, 
and various sacrifices from failed attempts and 
delays. 

Intellectual property should not be confused 
with real/tangible property, like a home, car, 
physical products, equipment in a workplace or 
library, etc. 

So, any song on the radio, which seems freely 
played, is actually paid for by radio ads. So are 
television shows on network channels. Shows 
on streaming services and cable channels are 
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in part paid for by subscriptions. Even if a band 
puts out some free samples of their songs, and/
or allows filming and distribution for a live 
concert, they still need to eat, pay for travel, 
keep musical equipment in good repair, etc. 

To achieve this, the law gives people and 
businesses property rights for a limited 
timeframe (years) for the information and 
intellectual goods they create. This allows 
creators to protect their ideas, prevent copying, 
and benefit from the time and resources used 
in the usually long and often costly research, 
development, and creation process. 

Let’s consider aspects of intellectual property 
(IP). 

• Abandonware: Property like websites, web 
applications, games, and other inline 
content is ignored by the owner after a 
period of time, and seems abandoned. Any 
product support, updates, notes and 
memos, and possibly copyright 
enforcement are also “abandoned”. This is 
not an automatic process, and no 
assumption that the work can be simply 
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taken and repurposed should be made. 
• Attribution: Attribution is the process of 

citing, giving references, and/or attributing 
the source of a work product. For instance, 
this textbook gives attribution to several 
other textbooks that influenced some core 
content. A term paper giving evidence for 
a pro-con argument needs to cite 
examples and provide references so a 
person accessing the paper can verify 
information and read the source materials. 

• Copyright: A creator/owner has exclusive 
right for a limited time to copy, distribute, 
adapt, display, & perform a creative work. 
Uses a copyright mark but is assumed for 
a creator even without a formal copyright 
registration process. A book copyright is an 
example. 

• Domain hijacking: Domain theft is when 
the registration of a domain name is taken 
and/or changed without the permission of 
its original registrant. Domain squatters 
can watch for domains to reach their 
annual re-registration period, and if a 
domain owner responds at all late, the 
squatter can quickly register the domain 
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themselves, then ransom it to the original 
domain owner. 

• Fair Use: The right to use a copyrighted 
work under certain conditions without the 
creator/copyright owner’s permission. An 
example would be an image in this 
textbook of an Excel spreadsheet, which 
shows some of the Excel user interface and 
worksheet workspace in an assignment 
example. 

• Licensing: A licensing agreement means 
that a creator/owner of intellectual 
property allows a user to pay for the right 
for some limited use of a product. An 
example would be the use of stock images 
under a specific paid license for web 
advertising for up to one year. 

• Open resources: A license that allows a 
user to freely use a copyrighted work for 
some combination of access, adoption, 
revision, and distribution. There are several 
open educational resource licenses 
available. This textbook, for instance, is 
licensed for others to freely use to read, 
download, print, and use in part or in 
whole in a classroom curriculum. 

Chapter 11: Internet Basics  |  543



• Open source: A work product that can be 
shared, modified, and published because 
the design is publicly accessible. An 
example would be mods created from 
code used in online games like 7 Days to 
Die or Sims 4. 

• Patents: The creator/owner the legal right 
to exclude others from making, using, or 
selling an invention for a limited period of 
time. A new medicine is an example. 

• Public Domain: Creative materials that are 
not protected by intellectual property laws, 
usually because they have passed the 
standard copyright/protection date 
without renewal, or because they are 
provided as part of government or other 
public sector information. An example 
would be a photo from the NOAA website. 

• Registration: The registering of intellectual 
property for some kind of legal status/
protections, like copyright, patent, 
trademark, etc. 

• Trademark: Identifies a brand creator/
owner of a specific product or service and 
uses the TM mark. A product like a new 
juice drink is an example. 
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• Trade Secrets: The creator/owner has right 
to restrict others from disclosing trade 
secrets of processes, formulas, designs, 
instruments, and/or a collection of 
information. A process like the 
development of a new computing system 
would be an example. 

Infringement 

Intellectual property rights infringement is a 
pervasive problem on the Internet. Users have 
become accustomed to the seeming free 
access to information, free applications and 
browsers, and the ongoing social media 
discussions of ideas and creative solutions. In 
addition, aggregators (collectors or related 
content) like Google Images often don’t have 
IP attributions and they make tons of content 
seem free for any use. Different countries have 
different expressions of intellectual property 
and its protection. Security and privacy get 
bypassed by apps and browsers, so info seems 
free when it was considered protected. People 
even “lose’ the right to their own photos and 
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content when they share it, since some services 
may claim that posting/sharing content give 
the service itself some intellectual property 
rights. 

One thing that every user must take 
responsibility for, and must know: YOU are 
responsible for your own activity for each and 
every info object, app, transaction, and sharing 
of any information or resource. It comes down 
to YOU knowing and having good internet 
hygiene. 

ACTION: Quick Task – Intellectual 
property and free use of 
information 

• Should all online products/content be 
free? 

• What do you think the hidden costs of 
having no intellectual property protections 
would be? 

• If you wrote a book, or created songs with 
a band, or created complex artwork, do 
you think everyone should have it for free? 
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Downloading/Sharing 

While the process of downloading and sharing 
has been mentioned before, this section calls it 
out because it is a big issue for infringement 
of intellectual property. There have been legal 
battles about it, with many users being the 
losers. Peer-to-peer sharing of files has caused 
losses of revenue for creators of music, books, 
apps, movies, games, and other creative 
products. 

• File sharing: File sharing is part of P2P. 
Users may think of it as buying a book and 
letting friends read it. However, when this 
is done with products that are supposed to 
be paid for by subscription, downloaded 
for a specific fee, or limited use only, this is 
a form of stealing. It is still difficult when 
one looks at the lending friends your 
favorite book example, but in that case, the 
friend doesn’t actually copy the book and 
give more copies of it out. 

• Peer-to-peer (P2P): Peer to peer sharing is 
when a user downloads items then shares 
them with other users who can download 
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from the sharer. The sharing user might 
also upload items for sharing instead. An 
example would be a YouTube playlist in 
which a user has added links to videos that 
are not supposed to be free, and others 
can download the videos instead of 
purchasing them. 

• Piracy: Piracy is the intentional copying 
and/or stealing of products from the 
intellectual property owner / business that 
handles them, and making the products 
available for sale or free download. This 
happens with movies, games, apps, music, 
and other things many users don’t want 
(or can’t) pay for. 

Net Neutrality and Laws 

Net neutrality is the concept that an internet 
service provider (ISP) needs to provide access 
to all sites, content and applications at the 
same speed, under the same conditions. An ISP 
shouldn’t block or throttle speeds to give 
preference to some content or to content 
provider services. It shouldn’t discern whether 
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the user’s need is for work, entertainment, free 
content, or paid services. It also shouldn’t 
promote the practice that a content provider 
should pay the ISP more for preferential 
service, or that the user should have to pay 
more for faster access. The goal should be 
equity of access, speed, security, and reliability 
for all users in any location. 

The issue comes up that ISPs need to upgrade 
equipment, especially when content providers 
and users need and demand high 
performance. ISPs also have to balance their 
own use of power and resources to manage 
all users’ access. Also, speed and other 
shortcomings may have to do with the content 
provider’s product, the pushes for users to 
respond, the types of online transactions that 
are happening, and a region’s infrastructure for 
Wi-Fi, broadband, and related equipment. 

Concept: Open internet 

An open Internet means that all resources in, 
and needed to access & use those resources, 
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should be free and easy to use, including fully 
accessible. Open internet doesn’t consider 
licensing, intellectual property, costs of 
infrastructure and resources, time and 
management costs, etc. 

The idea is that no one entity should have 
power over information, access, censorship, 
free speech, standards, speed and quality, etc. 

Concept: Closed internet 

Closed Internet is about having a specific 
determining power structure that monitors, 
censors, controls, and restricts access as 
desired or perceived as needed. Other than 
perhaps open libraries and repositories, all 
content would be managed as a product/
service, with costs, limits, and filters. Policing 
and monitoring would be a part of this, and 
user tracking would be pervasive. Some would 
benefit, others would go without. 

There are countries that practice some level of 
this, particularly when having blackouts of 
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certain products, media/news information, 
games and entertainment seen as subversive 
or democratizing, and so on. 

Part of net neutrality is the discussion, 
argument, and work towards a healthy balance 
for users, creators, ISPs, and the need for access 
to Internet resources. Some content and 
resources does need privacy, intellectual 
property protection, and infrastructure / 
equipment care. Some activity does 
recommend monitoring and limiting, such as 
illegal activity and content not meant for 
children. Much content may cost more and 
demand more intrusion on users than it 
should, which should be balanced and have 
barriers minimized/erased. Some costs might 
need to be assumed by the creators/owners 
that generate the most drain on infrastructure 
and harnessing of power and climate-affecting 
energy. Services and products people need and 
pay for in real-world situations can have 
comparable aspects on the Internet. Anything 
that is part of education, training, social 
knowledge, healthy interaction, social 
connection, etc., is something that needs 
neutrality and responsible democratization. 
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ACTION: Quick Task – Net Neutrality 

• Should the Internet be neutral? 
• Can the Internet be neutral? 
• What minimal practices do you think are 

needed to balance the arguments 
between open and closed Internet needs? 

Website Information 

Given that websites are a primary way users 
access and consume information on the 
Internet, it is work taking a look at them – what 
they do, what they are for, and how they work 
(in terms of visitor interaction) 

Websites can be commercial (products), public 
service (government/informational), social 
(social media) and utility (providing resources). 
Some exist to sell and make money; some exist 
to provide work, education, and lifestyle 
information. Some exist for social interaction. 
Influence and related entertainment. Some 
exist to provide tools, knowledge, and 
applications for getting things done. 
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Website hosting 

Web hosts are the servers on which websites 
live and function. It is the server space for web 
page content, files, images, interactive tools, 
etc. 

Basic parts of a website 

The goal of a website is always to move a visitor 
to take some kind of action. It may be for a 
visitor to make a purchase, to willingly provide 
information, to allow access to their own 
resources, or to change their behavior. A 
successful website design will seamlessly do 
this by drawing in a visitor, identifying and 
solving visitor needs, and not intruding on the 
visitor’s time and patience. 

Some components of websites are essential to 
web design that all sites need to utilize them 
for proper results. 
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MedAttrib: Creative Commons 2023 website 
image, fair use. 

Above the fold 

We are inundated by so much more 
information and stimulation than likely any 
other time in our recorded history. We 
experience thousands of demands for 
attention, action, decisions, and commitments 
every day, in multiple and attention-draining 
ways. A website has to compete with this; often, 
its only advantage is that a visitor may have 
deliberately come to access it for a pre-existing 
reason. Otherwise, the website has to compete 
for attention and action. 
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A crucial way is for a website to provide key 
content and action prompts ‘above the fold’. 
Above the fold refers in part to the newspaper 
term of what a reader would discover on a 
newspaper’s front page before unfolding it. A 
website has to prompt attention and action on 
every page of the site at a user’s first glance, 
which on a computer tends to be the average 
size of what appears on the computer screen. 
Smartphone have an entirely different size and 
“fold” dynamic, and websites have to be 
designed so that smartphones and small tablet 
equipment can still give critical information 
and action activities before the first ‘swipe’. 

Header 

The header of a website tends to be the top 
segment that visitors experience first. At the 
top, it suggests top priority for attention, and 
would include the website owner’s identity, 
affiliation, and topic/purpose of the website. 
This gives a visitor a sense of place and purpose. 
The header should be in some way replicated/
mimicked on every page of the website, 
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although the home page header might be 
more prominent. 

Navigation 

Website navigation needs to be designed to 
move the visitor to desired pages of the website 
that prompt the user to behave and perform 
in specific ways. For instance, for a commercial 
site, the navigation should take visitors to 
enticing content and the purchase funnel 
page. For behavior-changing sites, the visitor 
should be exposed to likely conflicts and 
problem-solving content. 

Navigation needs to be prominent, not too 
complex, easy to follow, and also replicated on 
every page of the website so visitors don’t get 
lost. If a website has more than five or so key 
sections, navigation might need sub 
navigation to direct visitors to sub content. 
Navigation should be near the top or on one 
side of the website page, and in the initial field 
of influence (above the fold). 
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Content 

The website content is all the information, 
imagery, links, non-main navigation prompts, 
media, etc. It informs, convinces, leads, and 
instructs visitors what the website owner 
needs. It could be the database interface for a 
library, the attractions for a product, the lead-
in to a streaming video, the chat section of a 
social media forum,, the demonstration of a 
product, the pricing of a service, or the 
shopping cart and purchasing process. 

Streamlined, attractive, and accessible website 
design keeps things simple, elegant, and 
moves the visitor with an invisible sense of 
steps from beginning to end of the desired 
behavior transaction. The more garish, 
animated, jumpy, discordant, and/or slow-to-
load a web page is, the more likely a visitor will 
lose patience and move on to another location. 

Footer 

The footer of a website in the bottom segment 
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(below the fold) that provides ‘utility’ 
information. Not information about computing 
utilities, but important yet secondary website 
structure utility. A footer would include 
copyright info, links to a website disclaimer, 
accessibility statement, privacy statement, 
website owner’s contact information/address, 
and other need-to-know information about the 
access to the website owner/entity. The footer 
should also be replicated on every web page. 

Links 

Hyperlinks are part of websites, in that they are 
part of how the navigation links visitors to other 
pages on the site. In-content links may push 
visitors to other places on the page (like a table 
of contents linking to the headers of particular 
page sections), Other in-content links may 
push a visitor to related website owner 
resources, like a blog, forum, social media sites, 
and so on. Other links may take a visitor to 
other information sources, allow for downloads 
of documents, or activate apps to help the 
visitor accomplish something like uploading a 
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file or experiencing a video demo of a product’s 
use. 

Disclaimer 

The website disclaimer can be a single page, 
or more likely a linked section of appropriate 
‘’need to know’ documents. The disclaimer tells 
visitors how any collected data will be used, 
what the website owner’s responsibility is and 
is not for service, and legal/mediation-related 
information in case of conflicts. It may also 
attribute credit on the website for the use of 
other users’ content, like images. 

Additional disclaimer-like information includes: 

• Privacy notice: Required by digital privacy 
law. Visitors can learn about their digital 
rights and how their personal data will be 
collected and processed. They may access 
options for setting consent preferences. 

• Accessibility statement: Visitors can learn 
the website’s policies on accessibility, 
standards the website follows, contact info 
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for reporting difficulties. 
• Index/Site Map: A website can consist of 

dozens to hundreds of pages, organized 
into sections. A site index or site map page 
can be a much more detailed form of site 
navigation for the visitor to look for 
something specific. 

Other options 

Websites routinely offer additional options for 
organizing content and directing visitors to key 
behaviors and actions. These can include: 
sidebar, forms, forum, blog, calls to action, 
videos, and files. 

Special Concerns 

The Dark Web 

One security concern that users face is 
something called the Dark Web. It is referred 
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to in reports and statements from security 
services like LifeLock. It is considered to be a 
part of the Web that houses access to unsecure 
and unconfidential information and the 
players/tools to access and abuse that. 

The image below suggests the surface web, 
which is mostly want this textbook discusses. It 
demonstrates a deep web, which is where a lot 
of business and proprietary information resides 
that is not free or accessible for daily user life 
and needs – this would also be routine, just not 
obvious to all users at all times for most needs. 

The dark web is a segment of the Internet / 
website presents with resources that focus on 
anonymity, less-than-straightforward daily 
activity actions, and insecurity issues. It is 
designed to provide anonymity for users and 
website owners and cannot be accessed with 
standard browsers. Currently TOR (The Onion 
Router) is the way to access it. No, the author 
does not have that information or link, so don’t 
even ask. 
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MedAttrib: “The Surface Web, Deep Web & 
Dark Web” by Ranjithsij. Modified by 
Flori4nK for a more accurate representation; 
licensed under a CC BY-SA 4.0 license. 

The dark web can be used for: 

• Activists and revolutionaries who want to 
organize with secrecy. 

• Illegal activities like piracy and stolen 
information/resources. 

• Users behind government firewalls who 
wish to anonymously access information 
(other than that provided by the state). 
Military uses may be included. 
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• Users in regions/countries who 
punishment for attempting free speech, 
like activists, journalists, sone politicians, 
some students. 

• Whistleblowers and information-leakers. 
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Chapter 12: 
Technology 
Privacy and 
Security 

What We’ll Cover >>> 

• Technology Privacy and Security Concepts 
• Privacy on the Internet 
• Security on the Internet 
• Internet Ethics 
• Cyber Threat Prevention 
• Information Security in the Workplace 
• Special Concerns 

This chapter focuses on privacy and security 
related to technology – computing and the 
Internet. Some of this has been touched on in 
other chapters as was relevant to that chapter. 
This chapter is an overview of privacy and 
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security overall, including tips and techniques 
for managing your own. 

For instance, during the drafting of this course 
textbook: 

• A ransomware attack hit the author’s 
college workplace during Winter Quarter 
(finals) week, which had potential effects 
on the student population’s access to 
communications, final project materials, 
due dates, end-of-quarter transcript 
updates, and stress levels. 

• The author’s data security vendor sent 
information about a possible data breach, 
which had potential effects on the author’s 
secure identity information. 

• An online sandbox/MMO game that the 
author enjoys had a server hacked and 
corrupted which required a several-play-
days rollback to correct. On another server 
new players used hacking code broke into 
player bases to steal everyone’s hard-won 
assets – just for kicks. 

Because of the nature of online access to 
information and data, and contributed to by 
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human nature, online lives have exposed users 
to unprecedented risks and areas of concern 
about how their own information and property 
is secured and used. 

Technology Privacy and 
Security Concepts 

• Privacy in technology / computing / 
Internet has to do with user information 
and how it is accessed, used, protected, 
bought and sold, and sometimes abused. 

• Security in technology goes to an 
additional level. Not only do users need to 
be aware of, and careful about, their own 
private data, they also need to deal with 
insecurity in the computing and digital 
equipment and resources. Sometimes 
there is a fine line between privacy 
intrusion and outright security risks on 
data. 
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Privacy on the Internet 

Personal data has become a commodity, even 
with users reading disclaimers and signing off 
on forms regarding apparent acceptance of 
data use. In many ways every day, a user’s right 
to privacy and control over their own 
information has been lost, byte by byte (yes, 
a pun). Laws are barely keeping track, much 
less offering and standardizing user control, 
protection, and full disclosure / opt-out. 

• Browsers capture information: Searches 
and search results, and about which 
results were clicked and reviewed. Cookies 
indicate what sites were visited and what a 
user did. Addresses, payment info, and 
passwords can be recorded. Looking up a 
subject can be get linked on online 
retailers that start showing personalized 
ads for a related product or sending 
emails. 

• Computer usage: Leaves traces about the 
computer, the identity of the computer 
user, and the applications/resources on 
the computer. Computer users have 
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accounts for the computer and many 
applications on it. The hard drive is full of 
personal data, like documents, homework, 
music, pictures, game settings, and 
application preferences. The computer 
also stores logs of usage: times, dates, 
prioritized systems, and more. 

• Internet resource visits: Information is 
picked up about the user. How many 
hours did a user play a game through 
Steam? How many calls and chats did a 
user make with a technical problem? 
Downloads and uploads are logged by 
applications and the affected servers and 
processes. How long was a user on a 
website and which pages were visited? 
What was purchased and how was it paid 
for? Is there a chat log of the transactions? 

• Internet usage: Our usage leaves traces. 
Emails carry information about the sender, 
as well as the email content. Having online 
accounts for bills provides surface info that 
hackers try to use to get direct contact 
with a user. Any communication 
application logs dates, times, what, how, 
etc. Cameras and microphones pick up 
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traces during meetings and streams. 
• Real-life activities: In the presence of 

electronic devices, real-life has also been 
affected. Persons can find themselves 
directly or indirectly captured on 
smartphones then find themselves on 
someone’s social media. Social media itself 
encourages quick and responsive behavior 
to offer entertainment and drama, while 
the evidence may never leave the records 
of the web. Some crimes are captured by 
cell phone; people’s behavior in street 
protests are caught on camera and 
broadcast on the web. 

• Workplace and public services portals: 
Pick up times, dates, and length of usage 
in the workplace and for the use of 
services. 

Much of this was designed to improve speed, 
offer convenience, and personalize settings 
and options for users, such as for personal news 
aggregators or dashboards of favorite 
entertainment. Much was also enhanced and 
accelerated by vendors trying to increase sales, 
decrease their advertising costs, and make 
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getting users to part with their money much 
easier and more routine. 

Web Browser Cookies 

Web browser cookies are a small text file that 
records information about a user’s visit to a 
website. The next time the user returns to the 
website, the browser reads the cookie file. 
Similar to a fortune cookie, a browser cookie 
contains a small amount of text or a message. 

• Cookies aren’t malicious, and don’t harm a 
computer like malware potentially can. 

• Cookies help customize web pages for 
future interaction. 

• Cookies don’t steal information; they only 
know what the user does on the website. 

• Cookies don’t have the ability to look at 
other files on a computer to access 
information. 

• First party cookies are created by the 
website the user visits. 

• Third party cookies are created when the 
visited website temporarily redirects the 
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user to a cookie tracking website. 

Third party tracking cookies are considered a 
privacy issue, and government legislation has 
made many websites obtain your consent 
before they use a cookie on a site you visit. 
Currently, almost every commercial website 
immediately seems to pop up a ‘cookies 
acceptance’ alert. 

Identity Security issues 

Reports of data security breaches and 
cybercrime occur frequently. There is real-life
damage that can and does happen when 
personal data is insecure. 

• Cyberstalking: Use of electronic means to 
stalk, terrorize, harass, or otherwise control 
an individual, a group of individuals, or an 
organization. 

• Cyberterrorism: Scams and attacks that 
are part of an organized effort by 
cyberterrorists and/or foreign intelligence 
services. Can include cyber warfare. 
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• Fraud: Unscrupulous people use data 
about you online to target you for phishing 
scams, access your money, and to commit 
other crimes. 

• Harassment: Directed obscenities and 
derogatory comments at specific 
individuals focusing on gender, race, 
religion, nationality, sexual orientation, etc. 
May include actual specific threats. 

• Identity Fraud/Theft: Stealing or using 
someone’s identity in order to access 
resources, information, obtain credit, and/
or steal finances or other benefits in that 
person’s name. Identity fraud victims often 
do not know how their personal 
information was obtained – through 
malware, cyber attacks, skimming 
financial card info, finding published user 
information and privacy details, etc. 

• Identity Security: The security and 
protection of your identity, accounts, and 
finances from intentional misuse and 
crime by others. Identity security is 
different from identity privacy (personal 
information shared/sold), although they 
have some overlap in effects to you. 
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• Skimming: Occurs when devices illegally 
installed on ATMs, and other payment 
card-access devices capture data or record 
cardholders’ PINs. The data can be used to 
create fake debit or credit cards and steal 
from accounts. 

Security on the Internet 

While sharing information about security 
issues below, one important thing to note is 
that a user can protect their information 
security (and privacy) best by being aware, 
careful, and investing time in being diligent 
rather than being focused on convenience, 
speed, social acceptance, and open access. 

Contextual situations 

• Communications: Communications is an 
area in which the user has to take as much 
control as possible in order to boost 
privacy and security. Any of the standard 
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home tools, and expectations of workplace 
and transaction business tools being in 
play are likely not enough. A user needs to 
take more control over their own outgoing 
information, their own communication 
and access habits, and their own 
equipment and information management. 
Choosing quality and highly reputable 
programs, equipment, tools, and services 
can help minimize the issues that can 
come up with newer, more casual, and 
revolving-door type of service/product use. 

• Email: Minimize the amount of personal 
information you keep in an email program. 
Have a professional-oriented attitude 
about outgoing emails. Avoid clicking 
email links, attachments, ads, and URLs. 
Assume that any email asking for personal 
information of any kind may be a scam. 

• Geolocation: Geolocation is the ability of a 
computing device to know a user’s 
location. ISPs can determine the location 
of the user’s computer, and smartphone 
service providers can trace cell tower 
locations. When a user approves a device’s 
OS ability to share a location, that can 
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become the default. While GPS can make 
using a map on the road more convenient, 
it also makes finding the user on the road 
easier. 

• Home/Personal: Security can begin with 
equipment. While equipment can come 
with default security options, and many 
manufacturers make continued 
investments in upgrading security tools 
and applications, users might not take full 
advantage. This is in part because some 
security measures also intrude on the user 
– the speed of booting up the computer, 
the waiting to log in, the remembering of 
many passwords, the pausing of outgoing 
emails. In addition, many of the OS 
provided options are generalized, which 
isn’t bad, yet likely not enough. 

• Social media: Over the past few years, 
many users have learned that social media 
is not a friend. It may add drama, spice, a 
place in social hierarchy, and a sense of 
connection to life. At the same time, any 
video, chat, messaging, meming as a 
message, political and personal opinions, 
and a lot of bad behavior is also out there. 
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• Streaming: A user who is a streamer may 
thrive on attention, a casual social 
presence, and divulging personal 
information as part of the show. Anything 
you divulge, film, and tell is out there. 
Likely for always. 

• Transactions: Organizations that provide 
transactions – financial, health, retail, 
government services – also have to have 
the kind of IT department services and 
expectations. Companies that have 
insecure financial transactions, poorly 
designed customer/product databases, 
and data breaches face legal issues, loss of 
customers, and a potential drop in market 
share that impacts portfolios and the 
company’s own financial status. 

• Workplace: In a workplace, the employer 
needs to worry about employee data, 
customer information, intellectual 
property, hardware security, software 
vulnerabilities, data breaches, and the 
behavior of the employees. For instance, 
employees using personal cell phones on 
the employer’s wireless network can pass 
malware. Employees can open work 
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computers to malware during gaming 
breaks, doing personal business at lunch, 
downloading non-work files, and so on. 
Employee emails can be phished from 
outside senders. Work files accessed from 
home for home-office work may be 
vulnerable to the employee’s computer or 
network weaknesses. 

MedAttrib: Reese Wang (CC BY-NC-SA 4.0). 
Insecure data. 

Common Internet security 
issues 

• Computer virus: A computer virus is a 
specific type of malware that is designed 
to replicate (copy) and spread from one 
computer to another. It can make a copy 
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of itself over and over again, and spread 
between computers through email 
attachments, removable storage devices, 
and infected downloads. It can damage a 
computer by corrupting system files, 
sending spam, stealing data and personal 
information from the computer, destroy 
data, and/or delete everything on a hard 
drive. 

• Hackers: A hacker refers to a person who 
can gain unauthorized access to (break 
into) a computer or a network to commit 
crimes, like: 

◦ Hijack usernames and passwords. 
◦ Gain access to personal information 

(credit card numbers, bank account, 
Social Insurance Number, etc.). 

◦ Steal, change, exploit, sell, or destroy 
data. 

◦ Damage or bring down the system. 
◦ Hold the system hostage to collect 

ransom. 
• Malware: Malicious software (Malware) is 

designed to damage, disrupt, or infect 
computers. It refers to different types of 
safety threats like a virus, Trojan horse, 
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worm, spyware, etc. Malware can gain 
unauthorized access to a computer and 
continuously work in the background 
without the owner’s knowledge, causing 
either immediate damage or damage over 
time (DOT – gamers should get that 
reference). 

• Phishing: Phishing is a common attempt 
to scam information. Deceptive emails or 
websites can try to obtain valuable 
personal information like a user’s 
username, password, account number, 
social security number, and credit card 
information. It is problematic because an 
email may seem to be by a product or 
service provider a user actually works with, 
like a retail store or utility company. It also 
may suggest some urgency that the user 
needs to solve a problem, like a declined 
credit card or some change in the user’s 
account status that needs to be handled 
through email. It is like the email version of 
scam phone calls. Sometimes a text can 
be sent to your phone that behaves the 
same way. 

• Spyware: Spyware is a form of software 
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that secretly monitors (spies) on user’s 
online behavior and gets sensitive 
information about a person or 
organization without the user’s 
knowledge. It can record a user’s Web 
browsing habits, email messages, 
keystrokes on online advertisements, and 
personal information. Then it can forward 
that information to a third party. For 
instance, advertisers can use spyware/
adware to target specific ads to a user’s 
preferences. Spyware can also collect 
financial information (banking accounts, 
credit card information, password, etc.), 
then forward it as a data breach so your 
accounts can be accessed. 

• Trojan horse: A Trojan horse (Trojan) is a 
type of malware that seems harmless but 
can cause harm to a computer system. It 
misleads users of its true intent, like 
claiming it can to get rid of viruses while 
actually introducing viruses onto the 
computer. A Trojan can take the form of 
innocent-looking email attachments, 
downloads. 

• Worm: A worm is similar to a virus in its 
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spread. However, a worm does not require 
human action to replicate while a virus 
does. A virus spreads when a user opens 
an affected file whereas a worm spreads 
without the use of a host file. 

Internet Ethics 

Several things are considered unethical: 

• Trying to gain unauthorized access to the 
resources of the Internet. 

• Disrupting the intended use of the 
Internet. 

• Destroying the integrity of computer-
based information. 

• Compromising the privacy of users. 

ACTION: Quick Task – Personal 
Internet Ethics Questions 

• Is it ethical to download music and videos? 
• Are Peer-to-Peer sites/resources ethical? 
• Is it ethical to repurpose images, text, and 
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media you get from the Web? 
• Is it ethical to use employer internet 

resources for personal items? 

Internet Ethics Considerations 

In personal usage, you also need to consider 
the ethics of several things: 

• Location, time, and amount of surfing that 
is not on your own time. 

• Types of surfing and saving of information 
– porn, illegal downloads, selling 
information or work of others. 

• Inappropriate use of email and other 
communications. 

• Defamation of other people’s reputations 
and information, libel and slander. 

• Creating false and inaccurate personal 
profiles for yourself in order to mislead 
others. 

• Understanding the technology and 
internet policies of your workplaces and 
school. 

• Appropriate use and citation of Internet 
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resources, like text, images, and media. 

Cyber Threat Prevention 

Home/Personal 

Security can begin with equipment. While 
equipment can come with default security 
options, and many manufacturers make 
continued investments in upgrading security 
tools and applications, users might not take full 
advantage. This is in part because some 
security measures also intrude on the user – 
the speed of booting up the computer, the 
waiting to log in, the remembering of many 
passwords, the pausing of outgoing emails. 
Computers tend to come with a few basics: 

• Browser firewall: The default browser that 
comes wrapped with a computing device’s 
OS can have a panel for setting some 
browser security choices. 

• Default system/hidden files protection: 
An OS can default to keeping system and 
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hidden files inaccessible to any user but 
the computer’s administrator, and require 
that admin to respond to every attempt. 

• Internet security settings: The computer 
may come with basic Internet security 
settings for the user to select. 

• Login PIN / other options: Computers can 
have a mandatory login process, with a 
password, or PIN, and/or optical or 
fingerprint recognition. 

• Network firewall: Computers can have a 
protocol to allow/disallow network 
connections. 

• OS Virus protection: An OS may come 
with some level of virus protection, which 
the user can schedule as part of regular 
maintenance. 

• Updates: An OS, and other computer 
programs, can have an update alert when 
a software or hardware update has been 
offered and needs to happen. Updates can 
add more security protocols, may add 
more data to virus definition files, and may 
help equipment be more imperious to 
tampering. 

• User account control: The controls for user 
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accounts can let a user be an 
administrator, set limits to other users who 
share the machine, and add extra 
protections for children. 

A home computing device may come with a 
number of default security options, but they 
are just starting points for a user’s computer. 
They may little effect on a user’s programs, 
access to and use of Internet resources, 
personal and private data, in-the-moment virus 
and hacking problems, and so on. They may 
offer some coverage for the one computer, but 
not synchronized devices. They may not be 
able to support much from email or ad-
delivered malware. They can’t defend against 
other users that prioritize invading and abusing 
people’s computing devices, information, files, 
work products, and personal life data. 

Additional security options 

Good Internet hygiene is a must. This means 
creating and maintaining a routine of actions 
to protect your data and equipment. It means 
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developing practices that put privacy and 
security above convenience, casual speed-
oriented activity, and being accessible to 
anyone who asks. Consider: 

• Avoiding download sites that specialize in 
free files, pirated files, or promised free 
downloads. 

• Avoiding clicks on ads and free games. 
• Backing up files and storing them in 

different locations. 
• Clearing browser history, cookies, cache, 

and temp files. 
• Creating secure and strong password 

protocol. 
• Deleting suspicious/unknown emails. 
• Ignoring / not responding to any pop-up 

windows. A user’s response is what can 
initiate the scam / intrusion, not the pop-
up or urgent message itself. 

• Not opening links, images, attached files, 
or forms in emails. 

• Not responding to any personal data 
requests in emails. 

• Using a specialized virus / security 
application designed to clean a computer, 
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prevent intrusions, and quarantine 
questionable files. 

• Using a backup service that protects data 
on its own server in case the user needs to 
recover data for a compromised computer. 

• Using an online security service designed 
for information protection, both personal 
data and financial resources. 

ACTION: Quick Task – Personal 
Internet Security Questions 

• What do you currently use to check for 
computer viruses? 

• What do you think of the risks of clicking 
on an ad or image of something appealing 
when a friend sends it to you? 

• Is it safe to use websites designed to give 
free games or that promise faster 
downloads of content you want? 

• Should you ever give any personal 
financial or security information out in 
response to an email from one of the 
services you pay bills to? 

Chapter 12: Technology Privacy and Security  |  587



Browser security 

Browsers have an option to change to a private 
browsing mode. This can be useful in a 
workplace at lunch, at a public location, and 
when doing personal transactions like banking. 
Different browsers have slightly different 
names for the private browsing mode: 

• Chrome: Incognito 
• Edge: InPrivate 
• Firefox: Private 
• Safari: Private 

For each of these browsers look for three dots, 
three lines or a new window tab near the top 
right corner of the browser, clicking on this will 
open a menu, and then a new window in a 
private browsing mode. 

The private browsing mode in the popular 
browsers provides some extra security in that 
web history is not saved on the computer being 
used; however, the IP address is still trackable. 
For an extra level of anonymity, there are 
browsers designed for private browsing which 
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hide history, mask the IP address and physical 
location, and can be encrypted to increase 
anonymity. 

Information Security in the 
Workplace 

In the workplace, an employer will use an 
Information Technology (IT, other acronyms) 
department/team of some kind which 
specializes in assessing and maintaining 
workplace privacy, security, and work product 
protection. An IT department is responsible for: 

• Accounts: employees, external users and 
customers. 

• Company website and Internet services 
support. 

• Data loss prevention. 
• Equipment/infrastructure upgrades and 

security applications. 
• Internet access authentication and 

encryption processes. 
• Intrusion detection and prevention. 
• Malware and virus prevention. 
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• Network firewall. 
• Preparation against cybercrime. 
• Security event management. 
• Software management of licenses. 
• Storage of data. 
• Technical support for employees and 

sometimes customers. 

Special Concerns 

What kind of privacy rights do employees have 
in the workplace? What is the workplace is in 
the home office although using the employer’s 
network and data? 

Employers need to balance legitimate business 
interests with employees’ legitimate privacy 
expectations. Decisions need to be legally 
sound, transparent, well communicated, and 
invite discussion. It needs to consider employee 
conduct, the employment setting, and an 
employee’s expectation of privacy. 
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Employee 

Employees have a right to keep private facts 
confidential, such as home life issues, health, 
finances, religion, politics, partners, social 
media accounts, use of private time, etc. They 
also expect that their own property, like 
personal phone, personal calendar, auto, and 
personal computer (if applicable) falls under a 
right for privacy. They expect that their break 
time, lunch time, time away from the 
workplace, holidays, and weekends belong to 
them. They expect that personal leave and the 
appointments they need to keep are part of 
their right to privacy. They expect reasonable 
space from monitoring and scrutiny, and other 
invasive behaviors on behalf of the employer. 
Other than a general credit and pre-
employment check, employees need respect 
for their privacy. They expect if there will be 
changes in policies, they should get sufficient 
notice and opportunity to adapt. 

Employees also have various legal 
expectations: 
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• Americans with Disabilities Act (ADA) 
• Fair Credit Reporting Act (FCRA) 
• Family Educational Rights and Privacy Act 

(FERPA) 
• Family and Medical Leave Act (FMLA) 
• Federal Wiretap Act (FWA) 
• Health Insurance Portability and 

Accountability Act (HIPAA) 
• Labor-Management Relations Act (LMRA) 
• National Labor Relations Act (NLRA) 

While each of these laws establishes 
requirements and standards for employers, 
there is one commonality to substantiate a 
claim for a violation of an employee’s right to 
privacy: For an employer’s conduct to be 
actionable, it needs to amount to a highly 
objectionable or offensive act. 

Employer 

No matter what an employer’s policy is about 
privacy and company security, the employer 
has a responsibility to be transparent, current, 
and respectful about the policies and 
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procedures with employees. At hire, as 
modifications happen, at annual reviews, and 
as part of annual refresher trainings, an 
employer would be most transparent by 
refreshing privacy and security policies in 
simple, respectful, and employee-facing 
methods. The policies should also be available 
in Human Resources and posted in a group 
employee setting, like a lounge or cafeteria, as 
OSHA requirements, Minimum Wage 
information, and other employee-related 
information already is. If the employer has an 
intranet for employees, policies should be 
readily accessible there for viewing and print; 
if no intranet is in place, then a segment of 
the company website should post it. A policy 
manual should be provided to employees, as 
well. 

In addition, if there are specific computing 
concerns and policies, a short reminder 
message should be part of the company 
computer boot-up / in-company network. 

An Employee Privacy Policy is a document that 
employers can use inform employees about 
personal data usage. It should be transparent, 
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and clearly stipulate instances in which an 
employee should not assume their data and 
communications are private. These could 
include: 

• Basic video security for common areas for 
the safety of the workplace and 
employees. 

• Behaviors that affect data and equipment 
security. 

• Behaviors that indicate poaching of 
customers, vendors, or other resources. 

• Communications that are transmitted on 
company-owned equipment. 

• GPS tracking of company vehicles. 
• Monitoring/tracking of actions like 

accessing the network and work with 
company assets. doing 

• Use of company equipment, time, and 
resources for personal use and projects. 

• Use of company vehicles and machines, in 
the office and/or at a home office. 

• Use of timesheet / time-keeping methods 
for confirming work activity. 

ACTION: Quick Task – Personal 
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Employment Resources Security 
Questions 

• Should you use company computers for 
private use, even if it is just at lunch or on a 
break? 

• Should you use a company vehicle for any 
private business, even while on a break? 

• Should you assume that any email you 
send out on an employer’s system is 
private to only you? 

Privacy Intrusions 

There are intrusions that can trigger liability for 
employers under state and federal law. These 
include: 

• Appropriation of employee’s name/
likeness. 

• Giving employee information out for non 
job-related reasons. 

• Inappropriate intrusion on employee’s 
personal space. 

• Publicity of employee’s private life. 
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• Publicity which distorts the employee in 
the public eye. 
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Chapter 13: 
Communications 
Media Accuracy 

What We’ll Cover >>> 

• Communications Media Concepts 
• Digital Citizenship 
• Information Accuracy 
• Information Bias 
• Information Integrity 
• Information Bubbles 
• Social Media 
• Your Online Presence 
• Reputation Management 
• Special Concerns 

This chapter will focus on the various ways that 
online communication and media affect 
perceptions of information, information 
integrity, and analysis/critical thinking. 
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Communications Media 
Concepts 

Communications media includes anything 
that fosters, provides, and spreads information. 
In the context of this chapter and Internet 
fundamentals, we’ll consider topics that affect 
accuracy and bias of information, and 
reputation. Mediums include standard media 
sources, social media, info research, and 
personal profiles. 

MedAttrib: researchleap.com (CC BY 4.0). 
Communications media. 
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Who are the players? 

We are all the players in the world of 
communications and information. We have the 
data, we create and organize and distribute the 
data, and we often ARE the data. 

• Controllers: The controllers of information 
are those that compile it, store it, and 
distribute it. This includes repositories like 
libraries, or public sector data warehouses 
for data analysis. It includes the owners of 
websites that present content to inform or 
push action – their own and content from 
contracted providers. It includes product 
and service providers that decide how 
marketing and advertising shapes public 
perception. It includes news and media 
outlets that report and inform the public. 

• Customers: Customers provide much 
more information that they might expect. 
As discussed in an earlier chapter, all 
behaviors and actions of prospective and 
real customers is routinely collected, 
stored, and used for advertising, setting 
policy, prompting behaviors and actions, 
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and pushing financial agendas. 
• Users: Users of any computing and digital 

resources provide information by their 
actions, preferences, communications, 
downloads, info sharing, etc. Users can be 
students, employees, travelers, 
homeowners – essential people from any 
and every interest and lifestyle group. 

Digital Citizenship 

Digital citizenship refers to the responsible use 
of technology by anyone who uses computers, 
the Internet, and digital devices to engage with 
society on any level (CITE1). 

That makes most of us digital citizens of some 
kind. 

Positive digital citizenship: Users who are 
flexible, engaged, connected with one another, 
develop empathy with and for each other, and 
create lasting relationships with digital tools. 

Damaging digital engager: Users who behave 
in antisocial ways – as predators, bullies, 
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irresponsible social media generators, and 
users with reckless and unsafe Internet 
behaviors. 

We’ve observed the results of damaging digital 
engagement. Misleading media stories, 
cyberbullying, data breaches, trolling on social 
media, influencers with little regard for the real 
people in the audience, hacking, etc. 

In the end, all any technology user can do is 
work to themselves aim to be a positive digital 
citizen. This takes the effort of getting informed 
and using computing and Internet resources 
respectfully and, whenever possible, 
holistically: 

• Developing empathy: Aim to understand 
motivations and situational awareness, 
rather than snapping to judgement and 
execution. 

• Focusing on digital wellness: There IS a 
real life offline, and it IS possible to turn off 
the smartphone and dm tools. Live a little 
for oneself, without need for online 
attention or feedback. 

• Making digital device usage secure: Do 
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your own part to secure your devices/data 
and not create insecure situations for 
other users. 

• Practicing digital and Internet literacy: 
Focus on accuracy and minimal bias in 
using and spreading information. Also 
respecting intellectual property. 

• Recognizing the digital divide: 
Acknowledge and understand the 
disparity of users who don’t have the same 
access to technology, resources, or support 
for digital citizenship. 

• Respecting and protecting user data: 
Avoid data mining for sales and/or 
malicious use, and for protecting one’s 
own data and reputation. 

• 

ACTION: Quick Task – Who are you 
as a digital player? 

• Do you consider yourself a positive digital 
citizen? 

• Are there areas you can improve your 
digital footprint in practicing your own 
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digital literacy? 
• Is it okay to make judgements about 

people and situations based only on what 
you get in an Internet communications 
media transaction? 

Information Accuracy 

Information accuracy is one of the most 
alarming casualties of the democratization 
effects of the Internet. What has become most 
alarming – especially to the generations before 
the daily use and push of all things Internet 
– is just how much information is inaccurate, 
biased, misrepresented, and misunderstood by 
people encountered in classrooms, social 
media, town halls, the workplace, and 
community spaces. 

When discussions arise about polarized views, 
disparate values, and who is ‘right’ or ‘wrong’ 
on an issue, a lack of information accuracy 
becomes apparent. Inaccurate info – based on 
unsubstantiated perception, ‘alternate facts,’ 
‘personal truth’, and misleading language – 
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leaves people unable to use critical thinking 
skills to recognize, express, address, and resolve 
problems. Instead, more problems arise, and 
people seem to retreat to separate corners of 
the room. Even more concerning is how much 
seems to happen in uneven power structures 
in which people depend on truthfulness and 
accuracy; the result questions who is in control 
of any given information and situation arising 
from it. 

What does inaccurate information include? 

• Agendas with alternate ‘truths’: basing 
decisions and/or actions on an agenda of 
control, rather than fully and accurately 
informed consent. 

• Emotion-provoking language: headlines 
and presumptions of culpability that can 
stir fear, anger, angst, apathy, and 
damaging action. 

• Fuzzy logic: overgeneralized standard 
logic which offers only a degree of truth. 

• Gossip and opinion presented as fact: 
assumptions that people should act upon 
irresponsible use of free speech. 

• Insubstantial arguments: straw-person or 
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bipolar either-or arguments designed to 
box in perceived opposition. 

• Lies and half-truths presented as facts: 
prompts for behavior and action based on 
deliberately false and misleading 
information. 

• Misleading priorities: information 
prioritized to lead someone(s) to specific 
behaviors rather than to inform / debate 
accurate information. 

• Not in Good Faith: The concept of ‘in good 
faith’ is that open and honest dealings 
yield sustainable results. Information not 
presented and articulated in good faith 
can lead to bad decisions. 

• Replacement of facts and data with 
perceptions: used in challenging accepted 
and educated work and conclusions, and/
or suggesting if one thing is still under 
consideration the entirely is false. 

• Unattributed information: disrespect and 
ignorance of intellectual property. 

How does a digital citizen treat information? 
How do we assess information accuracy, and 
analyze content to make more informed and 
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empathic decisions? Here is a rather long list to 
consider, yet it needs to be recommended to 
information pass the ‘sniff text.’ 

• Authority/Reputation: This is considering 
the source. Does the source have a 
sustained history of minimal bias, of 
neutrality, of informing rather than trying 
to ‘convince’? Is there research, cited 
sourcing, and reference listing? 

• Comparison of sources: Given neutrality 
and a solid reputation, does more than 
one source share similar core facts and 
information? 

• Coverage: Is the coverage both targeted to 
the information/issue at hand, and still 
provide enough range to draw the full 
situation? 

• Currency: Is the information current or 
contemporary to when the issue at hand 
was occurring? 

• Integrity of data: Does the data and detail 
provided have integrity in treatment, 
range, and fact vs opinion? Is it balanced? 

• Neutrality: Is the language used neutral, 
appropriate to the concepts and 
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conventions of the subject at hand, and 
focused in informing rather than 
persuading? 

• Objectivity: Does the treatment rely on 
objective content rather than assumptions 
or subjective opinion? 

• Placement: How is the information 
placed? Is it part of a campaign? Is it 
surrounded by ads? 

• Relevance: Is the content relevant to what 
needs to be presented; does it stay on 
track, and have a context and structure 
that supports the discussion? 

• Researchability: Can the content be 
followed-up on? Are there accurate 
citations, attributions, and sources that 
can be fact-checked? 

• Sustainability: Does the information meet 
the goals of the objective without 
sacrificing other needs and accuracy? 

• Value: Does the information add value to a 
pool of knowledge needed for 
consideration and action? Or does it 
rehash and offer empty summaries of 
previous works? 

• 
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ACTION: Quick Task – How do you 
confirm the accuracy of 
information you consume? 

• Do you look at more than one source for 
news and event stories? 

• Do you look at citations/ references in 
articles and online content to get more 
information? 

• Can you determine if content language is 
dramatic and emotion-provoking? 

• How do you determine the authority/
reputation of the information source? 

Information Bias 

Information bias is a phrase used in various 
contexts, including research and science fields. 
In terms of cognitive thinking – like what this 
textbook is touching upon, information bias is 
a form of inaccuracy based on perceptions and 
belief systems, like prejudice or not having all 
the needed detail yet rushing to a decision. 
Information bias can fall into: 
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• Artificial construct: Misrepresent or ignore 
uncomfortable facts and details, which 
fashions an artificial context. 

• Isolation: Calls out something that isn’t 
really relevant to the context of the 
subject. 

• Invisibility: Excludes relevant and needed 
sourcing from content due to perceived 
lack of importance. 

• Language: Language used to evoke 
specific responses and behaviors, often 
about a group of people or a perceived 
conflict. 

• Selectivity: Presents only one 
interpretation of an issue, situation, or 
group. Not balanced. 

• Shared information: A tendency for group 
members to focus on already familiar 
content and less time and energy dealing 
with the problem to be resolved. 

• Stereotypes: Gives an objective set of 
characteristics to a selection/group instead 
of acknowledging nuances. 

Information bias can lead consumers of data 
and information to focus on the wrong 

Chapter 13: Communications Media Accuracy  |  609



observations, details, and priorities. For 
instance, consider a discussion on “being 
offended” when it focuses on the language and 
assertiveness expressed in a discussion, instead 
of the actual issue that is at hand: the problem 
of too-expensive housing which left a large 
number of people homeless during Covid. The 
offensiveness is supposed to be the situation, 
not whether someone misspoke, misspelled in 
a chat comment, or spoke loudly and urgently 
from experience. 

Some observations can help discern 
information bias in an article, online discussion, 
social media argument, etc.: 

• Endorsement-directed 
• Entertainment-slanted 
• Extreme language and temperament 
• Facts/ingredients belong to a product by a 

seller 
• Frame with only selected info that pushes 

an agenda 
• Ideologically/politically motivated 
• One-sided/opinionated and unbalanced 
• Persuasion-oriented 
• Sales-oriented 
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• Sensationalized 
• Sense of urgency / time limit 
• Unknown expertise or authority 
• Unsupported / generalized claims 
• Source is advertising / sales-oriented 

ACTION: Quick Task – What are your 
own information bias challenges? 

• How do you know that news or 
information from a social media contact is 
unbiased and balanced? 

• Do you consider information sources from 
different countries, perspectives, and 
coverage style? 

• Can you tell the difference between 
established talking points and discussion-
intended prompts? 

• How do you feel about information if 
someone ties urgency and/or a time limit 
to act upon it? 

• How do you determine if article content is 
neutral or pushed by sales/marketing? 
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Information Integrity 

Information integrity is the dependability and 
trustworthiness of information and its 
sourcing. It should be accurate, reliable, and 
consistent so that it can be approached with 
critical thinking and enough detail for 
sustainable problem-solving. Aspects of 
information integrity include: 

• Academic integrity: Honest, respectful, 
and responsible work derived from valid 
and attributed sources. Work is not reliant 
on cheating, copying, or false information. 

• Attribution integrity: Giving proper 
attribution for any and all use of 
intellectual property, like quotes, examples, 
images, etc. Attribution should include 
citations, references, foot- and end-noting 
as appropriate. Not using copyrighted/
patented/trademarked work or products 
without permission. 

• Ethical integrity: “In good faith” 
presentation of content with balance, 
needed facts and data, and an aim to 
inform and help expand a pool of 
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knowledge and opportunity. 
• Intellectual integrity: Originality of work, 

research, discussion, and conclusions. 
Based on solid qualitative and quantitative 
information that can be reviewed. An 
example would be a research paper, a 
newspaper article. Variants include a novel, 
a music piece, a clothing design, a 
schematic, and other creative work 
derived from original skills, experience, 
and information. 

Information Bubbles 

Access to reliable information is a needed for 
the social contract of which people are a part. 
Information spreads quickly, and if without 
checks and balances in the moment, it can be 
polluted. People can respond based on mood, 
perceived urgency, or on what seems tribal or 
popular. It can result in division and conflict for 
little reason other than having been reacted 
upon without validating it and using critical 
thinking. This is an issue when information 
bubbles come into play. 
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MedAttrib: peerj.com, CC BY 4.0. Image of 
information bubbles. 

An information bubble is the sphere of 
information that a person accesses. It can be 
curated by machine-learning algorithms that 
predict familiarity and preferences, based on a 
user’s past consumption and social network. It 
acts as a way to filter out what the user doesn’t 
consistently consume or look for, and leaves a 
user with a small pool of information that 
seems to cover most needs while actually 
being imbalanced and incomplete. Examples 
include a news aggregator that pulls stories 
from news sources leaning in a particular 
ideological direction, or songs only like those in 
a listener’s online playlist, or movie selections 
based on one or two categories that the viewer 
recently chose movies from. 
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On the Internet, social media and aggregators 
drive a lot of a user’s access to content. It gets 
automates based on algorithms using data 
from past purchases, browser searches, visited 
websites, social media activity, livestreams 
watched, etc. A bubble then recommends 
content, social media groups, specific 
products, particular resources, and the other 
users that offer them. However, it also can 
seem representative of overall reality, while 
leaving out a lot of diversity, detail, and 
richness. 

Beating information bubbles 

While it is useful and often necessary to limit 
the influx of information that demands 
attention, adding abundance and diverse 
choices in the content that enhances life is also 
useful. This means pushing past the familiar 
and standard, and being open to a vigorous 
range of options and content experience. How 
to start? 

• Recognize what an information bubble is: 
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It tends to be an imbalanced, one-size-fits 
all but based on your own preferences and 
past activity. 

• Acknowledge when you are in one: If you 
feel caught in a rut with the same people, 
same viewpoints, same conflicts, and same 
decisions, it’s a good time to move away 
from the norm and consider what else you 
might also need. 

• Take steps to exit it: This is as simple as 
looking for information that is different 
and varied from what you already 
consume. Look for additional sources and 
viewpoints. Add more voices of different 
perspectives in your social media. Do more 
real-life non-digital things too. 

• Avoid getting into another bubble: With 
any new endeavor, there can be a 
honeymoon period when everything is 
exciting, before being tempted to relax 
and settle into a new normal of new 
familiar options and assumptions. 
Consider how you can break routine 
regularly, and keep enhancing and 
expanding what you experience in digital 
media. 

• 
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ACTION: Quick Task – What is your 
own information bubble? 

• Do you have a particular political identity 
that is the main focus of all your 
information about current events and 
legislation? 

• Do you focus your daily information 
consumption on social media? 

• What do you think the main 3-4 areas if 
interest are that your daily information 
relates to? 

Social Media 

Social media consists of online platforms that 
allow sharing and collaborating with an online 
community. A user can post, comment, upload 
and download items, and interacting with 
others in chat, live feeds, and in some cases 
online meeting. 

• Attractions: Social media can have loads 
of pictures, memes, anecdotes, film clips, 
links to other media, news, satire of news, 
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opinions, and feedback on any number of 
topics. It is immediate gratification, a way 
to check on friends, a place to connect 
with others with similar likes, an 
opportunity to argue and share insights, 
etc. You can get reminders, instant 
messages, links to other media, and 
invitations to like and/or participate on 
others’ pages and posts. You can be 
exposed to other ways of life, cultures, 
choices in products and experiences like 
restaurants, movies, games, and events. 

• Consequences: It can also be addictive, 
prompting a need to check back 
repeatedly for feedback and perks. 
Friendships bloom fast and die even faster, 
with drama and user blocking. Users feel a 
need to ‘share’ everything, with strangers. 
And it is so instant, with so many people 
showing images and videos of aspects of 
their lives, a user can get bored with real 
life. Opinions and gossip are popular and 
dramatic, and feedback is rapid. Many 
don’t have any facial expressions or body 
language involved, so users can totally 
miss social cues, hurt feelings, 
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misunderstandings, etc. Young users can 
tie social media opinions and bullying into 
their own sense of self worth. 

• Ownership: Some social media platforms 
can try to lay claim to your own content – 
images, opinions, creative work you 
demoed, etc. They can try to establish that 
they own the right to your pictures of your 
pet or example of your own artistic sketch, 
because you distributed it on their 
platform. 

• Privacy Issues: Social media platforms let 
you share details of life, family, work, travel, 
pets, etc. It can be easy to overshare, 
especially since when it goes online, it can 
be picked up and passed around and 
never go away. Your reputation, privacy, 
and security can be affected. Also, the 
default privacy settings may be too broad, 
allowing a larger audience than you might 
intend to have access to drunk pictures, 
snide comments, political views, 
confessions of workplace errors, etc. 
Imagine the setting being public enough 
that your boss can scrutinize your timeline 
and work-related comments? Oops! 
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• Security issues: Also, details that are public 
can be “scraped” (collected by software 
that also records the information). That 
data can show up elsewhere without your 
knowledge or permission. Recent stories 
indicate that hundreds of millions of users 
had fata scraped from LinkedIn and from 
Facebook. 

Tips to minimize privacy issues: 

• Avoid buying things through social media. 
• Avoid sharing real information that could 

reveal security question answers. 
• Don’t feed the trolls. 
• Keep phone numbers, birthdate, address, 

and other trackable information private – 
or don’t list it at all. 

• Limit how much of your personal 
information is public or shared. 

• Limit the audience of your posts to friends; 
get off ‘public’ 

• Minimize details in your profile. 
• 

ACTION: Quick Task – Is Social 
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Media your frenemy? 

• How many daily/weekly social media 
sources do you participate in? 

• How often daily do you check your favorite 
social media provider? 

• How much of your real-life time do you 
capture and share with social media 
connections? 

• Do you know that employers can probably 
see most of your social media presence – 
including your embarrassing moments, 
colored comments, and real opinions? 

• If you could use your social media only a 
couple of times a week, for checking on 
only the real, important people you know, 
could you? 

• 

Trolling 

Whether for drama, social awkwardness, or 
being a damaging digital engager, there are 
users who troll. Trolling is when a user focuses 
on upsetting others, while starting fights and 
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provoking conflict. It may or may not be 
malicious in intent, but the result can be. The 
behavior can be bullying, racist, homophobic, 
argumentative, misogynistic, and/or spammy. 
Just like a Terminator, a troll “can’t be 
bargained with, it can’t be reasoned with, it 
doesn’t feel pity or remorse or fear, and it 
absolutely will not stop… EVER, until your head 
explodes!” CITE2 

There is just one solution: Don’t feed the trolls. 
They can be ignored, quietly blocked, and 
otherwise removed from the posts/reaction 
cycle. 

Your Online Presence 

Compiled online data about each of us creates 
a representation of who we seem to be. This 
online presence is taken in by employers, 
friends, community, government, advertisers, 
news media, social media contacts, and 
disruptors. Some is for our convenience, some 
is to push purchasing or social behavior, some 
is to build socio-economic demographics data, 
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and some is unpredicted consequences of 
social media and our interactions. 

Most of the data is pulled from sources a user 
doesn’t consider or have deep awareness of. 
Everything you do in the digital world is 
captured, shared, sold, sorted, stored, analyzed, 
and used, and has been with increasing 
frequency over the past twenty years. Everyone 
seems to have a piece of you. 

Moreover, much of the data seems hidden, 
fixed, and to be assembled and analyzed in 
ways that remove you as a person and reframe 
you as ‘material.’ 

Sources of information 

• Activities: Browser searches, website visits, 
clicks, uploads and downloads, 
preferences, information bubble, blogs, 
forum posts, gaming, comments and 
reviews, cookies, website policies 
agreements. 

• Collateral contact: Mentions of you by 
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others, other people’s streams and photos, 
wrong place at wrong time, news media, 
accidents, group activities, presence in 
online meetings and workshops, facial 
recognition, being a witness 

• Computing devices: Computer usage and 
connections with websites, email, services, 
website cookies, wireless home, 
smartphone, fitness and apps, passwords. 

• Demographic captures: Employment 
applications, demographic questions, 
health care access, big data. 

• Life experience: Education history, work 
history, classmates, dating, trainings, travel, 
accomplishments (creative, professional), 
law-related incidents, political affiliations, 
medical care, consumed films / books / 
music. 

• Professional networking: Work-related 
groups and trainings, workplace activities, 
professional profile, resume, skills-building, 
student loans and grants. 

• Purchasing/financial: Browsing products, 
purchases, online banking, credit card, 
credit scores, car-research and licensing, 
taxes, healthcare, fitness, home-related 
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needs. 
• Social media: Interactions with any social 

media comments, posts, images, 
livestreams, gaming, commentary and 
reviews, trolling, dating, political groups, 
selfies. 

MedAttrib: “Social media dataflows” by Anne 
Helmond is licensed under a CC BY-NC-ND 2.0 
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Reputation Management 

As part of the hiring process for many 
companies, a Human Resources (HR) 
department surveys the online presence of 
potential job applicants. A top candidate may 
not be offered a job after their online presence 
has been searched. 

An opportunity for being published, included 
in a valuable workshop, renting an apartment, 
being considered for a loan, getting decent 
loan rates, or having your expertise taken 
seriously can be affected by online data and 
reputation. 

In addition, during legal proceedings like being 
under suspicion, being arrested, being a 
potential witness, and even being a victim can 
be influenced by your online reputation. So can 
travel, especially outside your own country of 
residence. 

Personal reputation is like personal hygiene, 
where you define your own life. Consider 
searching your own name using a search 
engine and notice what you find. This will 
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usually be surface-level information, and that 
which prospective employers, lenders, and 
other professionals can discover. 

Your surface-level presence and reputation will 
likely have many quirks, most of which are 
situational and easily dismissed or not even 
noticed. However, some things can rise, like 
bad behavior, unprofessional dealings, a 
noticeable mistake, involvement in a publicized 
event, and/or a general disadvantaging angle 
to your overall online presence. What options 
do you have? What can you do? 

Here are a few tips – not all inclusive, and with 
some in need of work on your part to find 
reputable, current, and of-value tools. 

• It is what it is: A useful axiom to add to 
your life is: 99% of everything that happens 
to you, with you, around you, and even 
seemingly catalyzed by you, is not ABOUT 
you. The world moves in a blur around us, 
and we have very little control over 
anything not in our immediate sphere of 
influence. Everything else is just out there, 
and stressing about it, being angry, or 
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committing to ‘disappearing’ likely won’t 
enrich your life. This pertains mostly to big 
data and you as a commodity. Accept 
what is and move forward. 

• Identify weaknesses and gaps: Learning 
more about life as a digital citizen is one 
way to recognize problems that combine 
to influence your own online identity. Gaps 
to be shored up include understanding 
how social media and other 
communications are not your “friend.” 
That any purchasing/financial-oriented 
activity is not about serving and valuing 
you but about someone else’s bottom line. 
That falling for your conveniences is a big 
part of what has made you a product and 
consumer, rather than a customer, website 
visitor, patient, friend, etc. That being 
involved in ‘influencing’ doesn’t make 
someone really influential to 99% of the 
entities that really matter in life. Dealing 
with the weaknesses comes from 
identifying your computing device habits 
and lack of security; how you choose to 
interact with websites and entities that 
provide products and services, and your 
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own social communications and activities. 
• Minimize continued data leaks: Secure 

your computing devices and practice 
regular, consistent, and effective habits 
that you control. Retreat from having a lot 
of accounts and social interactions while 
selecting a very valued few and 
monitoring them regularly. Turn off 
cameras, microphones, and smartphones 
expect for deliberate and necessary use. 
Use strict security settings on accounts, 
and avoid using information from your real 
life as identifiers, passwords, and security 
answers. 

• Change the narrative: You can’t change 
any demographic, shopping, or past 
activity. You can refocus on what is really 
important and invest time and energy into 
that. Are you a student? Work with 
student and career-related activities that 
help design the impressions you want to 
move forward with. Employee? Focus on 
upskilling and professional behavior/
connections, rather than binges of 
‘weekend in Vegas’ behavior in social 
media circles. Like music / films / reading? 
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Add thoughtful reviews, discussions, meet 
authors/creators, and become a presence 
people value. 

• Develop a personal profile: Create and 
routinely manage your own single-source 
web page profile about yourself. Include 
authenticity, a careful resume, information 
you want people to know, updates on your 
education and professional 
accomplishments, and a link to an 
ePortfolio; this may be a self promotion 
piece but promote your value, not your 
opinions or fluff. If you don’t want your 
own web page, look for a reputable 
professional network that lets you do that 
instead, and use strict privacy and security 
settings. LinkedIn has been around for 
years and may serve as an option. 

• Create a lifelong ePortfolio: It is never too 
late to develop an ePortfolio of the 
accumulation of your education, work, and 
accomplishments. It should be a collection 
of work (evidence) in an electronic format 
that showcases learning and 
accomplishment over time. Link it to your 
resume, your online profile, and whatever 

630  |  Chapter 13: Communications Media Accuracy



professional network you participate in. 
• Manage information routinely and 

consistently: Beyond minimizing 
continued data leaks, learn how to 
manage your own reputation. Look into 
well-established and vetted online 
reputation management sources and their 
tips/advice (not necessarily their services 
or paid options); some privacy and security 
software options may also include 
reputation management options. When 
you develop an online profile / ePortfolio / 
professional network presence, learn how 
to direct search engine results to go there 
first. Find out what is in public records 
about you and determine what can be 
removed. If something bad is mentioned 
about you, take the high road and be 
gracious while firmly setting the record 
straight – if the situation is something that 
can’t be just ignored. Stop trying to 
influence with opinions and build real 
expertise to contribute to non-digital 
community. Remove damaging / 
unhelpful images, clips, comments, and 
other social media problems from your 

Chapter 13: Communications Media Accuracy  |  631



own account. Be consistent and 
professional in all your future interactions. 
Consider deleting and restarting a social 
media account fresh, and stick to just one 
or two really valued ones. Much less is 
more. 

• Manage information routinely and 
consistently: Beyond minimizing 
continued data leaks, learn how to 
manage your own reputation. Look into 
well-established and vetted online 
reputation management sources and their 
tips/advice (not necessarily their services 
or paid options); some privacy and security 
software options may also include 
reputation management options. When 
you develop an online profile / ePortfolio / 
professional network presence, learn how 
to direct search engine results to go there 
first. Find out what is in public records 
about you, and consider what can be 
removed. If something bad is listed about 
you, take the high road and be gracious 
while firmly setting the record straight – if 
the situation is something that can’t be 
just ignored. Remove damaging / 
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unhelpful images, clips, comments, and 
other social media problems from your 
own account. Be consistent and 
professional in all your future interactions. 
Consider deleting and restarting a social 
media account fresh, and stick to just one 
or two really valued ones. Much less is 
more. 

• Live out loud: All this being considered, 
LIVE! Rebalance life between real activity 
and the allure of being digital. Shut things 
off, get out and live without selfies and 
livestreams. Be a person who lives first, has 
fun just for fun, and explore new places, 
taste new food, go for drives and walks, 
and pet-sit. Explore more culture and 
other cultures, groups, hobbies, skills-
building, contributions, civic participation, 
etc. You do you. 

ACTION: Quick Task – Do you know 
what your online reputation really 
is? 

• What are the first 5 search results about 
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you that come up in an online search for 
you? 

• If a prospective employer looks you up as 
part of a pre-interview process, would they 
actually choose to interview and maybe 
hire you? 

• How much personal data do you put out 
yourself that others could use to crack 
your passwords and personal identifiers? 

• Have you made a practice of creating and 
maintaining a balanced and proactive 
online reputation/portfolio? 

Special Concerns 

Bots and information 

A web robot (robot, bot) is a software app that 
completes automated tasks (scripts) over the 
Internet. Internet bots mimic human activity, 
like messaging, but on a large scale. A bot acts 
in a client-side role, and performs automated 
simple repetitive tasks much faster people can. 
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IMAGE NEEDED 

• Censorbots: Some bots act as censors for 
profanity. Some use pattern matching to 
help translate conversation attempts. 
Some are part of algorithms used in social 
media apps to block – or promote – certain 
communications. 

• Chatbots: Bots that perform instant 
messaging tasks, like the automated chat 
on a retail or tech site Depending on their 
programming and the complexity of 
customer-needed assistance, bots may be 
the entire chat option, or the entry point to 
guiding the user to a live person for more 
extensive assistance. 

• Malbots: Bots have been used to carry out 
denial-of-service attacks. They can execute 
click fraud, generate spam, and attempt to 
register on sites (a reason for CAPTCHA 
protection). They can scrape data from 
websites for incorrect use or sale. They can 
redirect users to malicious sites. 

• Socialbots: Algorithms that imitate human 
behaviors to converse with patterns similar 
human user. Users might think they are 
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talking with other users in a social media 
conversation, and not be. Botnets 
(collection of malware infected bots) allow 
a computer to be remotely controlled by 
an external operator 

• Viewbots: Bots created to “watch” videos 
or live streams, which affects the number 
of live view counts, channel statistics, and 
the perception that the program is more 
influential than it is. A staple of driving 
unreal messaging perceptions and ‘fake 
news.’ 

• Web crawling: Bots ‘crawl’ the web when 
a user queries a search engine. An 
automated script (the bot) fetches, 
analyzes and files information from web 
servers, then returns the results to the 
user. 

Recent issue: USA Presidential 
elections 

Were bots influential in social media? Currently, 
insufficient resources seem to be available to 
fact-check how much social media activity was 
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politically programmed bot-generated. The 
concept is that bots were programmed with 
search filter capabilities that targeted 
keywords and phrases that favored political 
agendas, then repeated and spread them. This 
could have contributed to additional 
polarization and volatility of social media users, 
arguments, and possibly influence of votes. 
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Part 4: Global 
Business 
Technology 

In this section, we’ll discuss business 
technology in terms of the world around us. 
While this part of the book is referred to as 
‘global’ business technology, the emphasis is 
more on the impact of and on us of our digital 
reality. Big data, changes and advancements in 
technology, issues of privacy and security, use 
of supply chains and energy, worldwide 
connectivity, and our own places in the 
workplace qualifies because we live in a 24/7 
multinational market of products, services, 
experiences, jobs, and peoples’ diverse needs. 

This textbook is meant to be a starting point for 
instructors and interested readers. Instructors 
may choose to add specific global topics and 
context into their curriculum as they relate to 
business technology. Also, world events, 
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politics, situations, challenges, and influences 
of and on us are complicated, vast, and more 
suited for coverage and discussion in specific 
courses/programs like: 

• Anthropology 
• Civics 
• Ecology (and related) 
• Economics 
• History 
• International Studies 
• Journalism 
• Business (marketing, supply 

management) 
• Multiculturalism 
• Political Science 
• Sociology 
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Chapter 14: 
Current Issues in 
Technology 

What We’ll Cover >>> 

• Issues in Technology 
• Impacts of Technology 
• The Digital Divide 
• U.S. Government and Digital Policy 

Issues in Technology 

Technology is ever-changing, and new 
advantages, concerns, and challenges come up 
frequently. Current discussion on relevant 
topics is something that instructors using this 
textbook can select and add to their own 
curriculum as the topics come up. This chapter 
will mention some issues that seem to be long-
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term, to be affecting the present (early/mid 
2020s), and likely will be future-influencing. 
Some have been referenced elsewhere in this 
book, but are being aggregated here for 
timeliness and convenience. 

• Artificial Intelligence and Machine 
Learning: Part of automation (listed here). 
Artificial intelligence (AI) and machine 
learning are processes behind the 
functionality of automation tools. Finding/
developing the needed AI / machine 
learning algorithms for business is a 
challenge because this development is still 
in its infancy and affected by costs, need 
for more testing and long-term use, etc. 

• Automation: Doing more with less, more 
efficiently, and for lower cost is always a 
business objective. Industries/demands 
like manufacturing, machining, auto 
assembly, packaging, and quality control, 
use automation to accelerate process, 
reduce cost, and increase employee safety. 
Mundane and repetitive forms of work are 
using more automation in the form of 
robotics and AI programming. Other 
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businesses use automation tools to 
manage big data and work product 
inventory. Automation affects the normal 
operations of companies and employee 
training/workflow. 

• Cloud solutions: Cloud networks provide 
space, support, ease of access, and data 
security for big data and business 
materials. They need dedicated support 
and service to integrate them into 
business operations and develop security 
contingencies. Businesses also need to 
move from legacy systems that are often 
incompatible with cloud-based 
technology. 

• Data management: Employees need to 
securely access business data unique to 
their jobs to facilitate operations. Risks 
include various kinds of cyber attacks to 
access, steal, corrupt, and repurpose 
business data and work product. 
Employees’ use of multiple devices 
(computer, smartphone) can contribute 
avenues to outside access of company 
data. Businesses need data management 
strategies to minimize unauthorized 
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access and compromised data assets. 
• Data security: Data breaches are 

continuous and costly challenges. They 
affect the reputation, financial health, and 
competitive advantage of a business. They 
also affect the customers of the business, 
whose data and financial dealings can be 
misused. Continued creation and 
implementation of malwares, bots, and 
scam strategies keep this challenge active. 

• Digital transformation: Organizations are 
tasked with developing digital integration 
plans for bringing business resources and 
operations into a reliable, secure, and 
future-facing system. Many businesses 
faced making rapid decisions and 
changes, which led to often unintegrated 
systems and uneven results. Others 
haven’t had the budget or the time/
personnel bandwidth to do more than 
cosmetic change. Others have been forced 
into dealing with security issues quickly, 
but not much else. The US Government’s 
huge agencies still use many legacy 
computing systems that can’t keep up or 
scale with current and projected needs. 
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• Infrastructure: Major changes, like new 
server systems, computing equipment, 
digital security tools, and other IT 
infrastructure are expensive and 
disruptive. Employees need to work 
around changes, upskill, deal with updates 
and patches to new software and 
hardware. 

• Integrations/Upgrades: Upgrades, 
patches, and integrations of enhancing 
technology are necessary, ongoing, and 
often disruptive to workflow and data 
consistency. 

• Internet Of Things (IoT): The IoT is the 
name given to a set of technologies which 
allows exchange of information between 
two or more devices connected to each 
other through a communications network. 
It isn’t the Internet as we think of it, but a 
mini net for connected devices. 
Technology infrastructure in a business 
need to account for this as well as their 
overall technology plan and Internet-
related network(s); otherwise, small but 
significant device and data insecurity can 
result. IoT devices can be accessed which 
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can compromise business data. 
• IT talent shortage: IT professionals are in 

high demand due to all the technology-
facing infrastructure, data management, 
and networking support that businesses 
require. Some businesses have IT 
departments; others outsource, 
depending on cloud-based systems’ use. 
The availability of trained and experienced 
IT professionals may not meet demand. 

• Remote workforce: Changes in workforce 
deployment to home offices during Covid 
has changed the consciousness of many 
employees about the work environment. 
Much non-industrial work can be 
accomplished in home offices and mobile 
locations rather than in a static business 
complex cubicle or conference room. 
“Work from home” policies have been 
evolving to accommodate the availability 
of employees, ongoing health concerns, 
and the lowered costs from needing less 
physical business infrastructure. At the 
same time, IT departments and business 
systems need to develop and manage 
secure, cost-effective, and efficient remote 
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workplace support, like cloud-based 
solutions. 

• Social media: Employee use of business 
time and resources on social media 
activities is a challenge. Business 
infrastructure and networks can be 
affected by insecure social media access. 
Time, focus, and productivity is affected if 
employees move beyond break and lunch-
time use, especially since social media can 
be addictive and seems to require 
frequent check-ins. Company 
environment and product confidentiality 
can be affected if social media includes 
interactive streaming, taking pictures, and 
chats with microphone and cameras on. 
Even work-at-home environments can be 
an issue if the business network can be 
affected. 
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MedAttrib: webgrrl.nl, CC BY-SA 4.0. Art image 
of IoT. 

Impacts of Technology 

These are not exhaustive, yet they can be useful 
indicators of what we face. 
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Advantages of technology 

• AI/machine-supported workforce. 
• Continuous learning opportunities. 
• Cost-savings from downsized physical 

infrastructure. 
• Data-driven sales leads. 
• Easy, fast and efficient communication. 
• Efficiency improvements in inventory 

management and ordering systems. 
• Employee productivity. 
• Lowered costs (potentially) for consumers 

of care, support, and products. 
• Mobility in enterprise/devices 

management. 
• More efficient and automated 

manufacturing techniques. 
• Robust and networked marketing and 

promotion options. 
• Tech-enabled solutions development. 
• Technology solutions providers with 

storage, security, and support capacity. 
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Challenges of technology 

• Always “on” employees and burnout. 
• Closures of physical spaces favor of online 

business. 
• Continuous employee upskilling needed. 
• Costs to replacing legacy systems and 

managing upgrades. 
• Cybercrime. 
• Data and cyber security risks. 
• Hot zones of technology presence and 

energy needs. 
• Increased dependency on technological 

solutions. 
• Insecure communications. 
• Jobs affected/cut. 
• Malfunctions that stop workflow. 
• Off-site and vendor-reliant data 

management. 
• Over-monitoring and surveillance of 

workplaces. 
• Regulatory and legal policies that are 

inconsistent/lack currency. 
• Slow adoption/catch up – government, 

small businesses, legacy systems. 
• Students/employees soft-skills and life-
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management readiness deficits. 

Behavioral impacts of 
technology 

• Mental health: burnout, anxiety, 
depression, attention deficit. 

• Physical health: Sleep deprivation, 
sedentary lifestyle, repetitive motions, eye 
strain, lack of exercise. 

• Preparation: Lack of support with learning 
and disability barriers, constant upskilling, 
reputation management, loss of personal 
data control, constant refocus on what 
skills are needed. 

• Communication: Decreased in-person 
communication, fewer social cues, 
decrease in intimacy, lowered empathy, 
increased reactivity. 

• Behaviors: Cyberbullying, rapid 
judgement, technology dependency, time-
wasting, procrastination, distraction, 
cheating through technology, binary 
polarization. 

• Security: Loss of privacy, cybercrime 
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victimization, data inundation. 
• 

• 

MedAttrib: internetprovider.org, CC BY-SA. 
Hyperconnectivity / partial infographic) 

ACTION: Quick Task – Technology 
advantages / challenges 

• What are your top 3 most valued 
technology advantages? 

• What are your top 3 biggest technology 
challenges? 

• Do you ever feel that you can turn 
completely “off” from technology 
intrusions? 
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• Do you feel able to keep upskilling to stay 
current? 

• What kind of technology-impacted jobs do 
you see affecting you in the next 5-10 
years? 

Digital Divide 

Access to technology is a key part of how much 
technology can be leveraged and the lowering 
of costs for the people participating in it. Even 
now, in the first quarter of the 21st century 
United States, we still face big challenges in 
inexpensive and available access to computing 
tools, connectivity, and systems. People are 
required to depend on technology for their 
jobs, education, access to products and 
services, communications, and socio-economic 
problem-solving needs. What happens when 
that access isn’t available, low-cost, or 
supported? 
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MedAttrib: Learning in the Digital Age. 
Infographic of Digital Divide. 

Digital Divide: The divide refers to unequal 
computer and internet access due to 
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socioeconomic & geographic barriers. It exists 
across the world, with different nations’ policies 
and reasons. It also exists in parts of the United 
States. The Pew Research Center indicates that 
statistically, it is experienced most by lower 
income persons. Non-white ethnicities seem to 
have lower adoption/access, as do persons in 
rural regions compared to urban regions. 

The digital divide continues to persist in part 
because of: 

• Access locations: Public locations that can 
offer broadband and Wi-Fi access can help 
bridge the access gap. These include 
schools, workplaces, libraries, community 
centers, café hotspots, and lobbies, and 
other shared community spaces. Many 
were closed during COVID and the 
resulting economic difficulties, which left a 
lot of users unable to access the Internet. 
Many remained closed if funding didn’t 
reappear to open them, or employees 
return to provide support. Other locations 
in rural and underserved areas of the 
country don’t have enough supportive 
infrastructure. 
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• Affordability: Personal costs are a problem 
for depressed regions which experiences 
job losses, underfunding state 
government services, and the general 
costs for equipment and Internet access 
subscriptions. Families don’t have the 
disposable income after primary bills and 
monthly crises are handled. \Add the lack 
of funding for expanding digital 
infrastructure and closures of public spots, 
and even minimal computer tech doesn’t 
have the Internet access. Smartphones 
don’t require broadband, so they are 
frequently used instead of other 
computing devices. 

• Desire: Urban environments, with a lot of 
business and school presences, tend to 
need and use connectability and 
technology for daily life. Rural and 
underserved areas don’t necessarily have 
the same intensity of need, especially if the 
services and access has remained an 
infrastructure and cost issue. When Covid 
changed the in-person nature of 
education to home-schooling, a lot of 
families were left behind if the tool and 
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access wasn’t available. Also, Covid 
education policy and response was patchy 
and inconsistent. Students/families who 
didn’t get support or continuity lost 
interest and felt “turned off” aby digital 
schooling. It will take time to collect and 
analyze data on how many students at 
what grade levels were irrevocably 
affected by and fell behind in school. 

• Device options: A lot of academic and 
workplace functions still rely on the bigger 
power, screens, and storage capacity of 
desktop and laptop computing. Tablets 
and smartphones tend to work on smaller, 
lighter apps, a lack of keyboard and large 
visually supportive monitors, and space for 
multiple productivity applications. Yet, 
when it comes to access and costs, 
smartphones are often the only option for 
rural and underserved populations due to 
lack of broadband and more affordability 
to getting one for a family. 

• Infrastructure: Large areas of the US 
haven’t invested in current and scalable 
broadband and infrastructure. Some is 
due to cost, some is due to State priorities 
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of how fiscal support should be used, and 
some seems to be due to a segment of 
underserved people not considering this 
infrastructure as a government 
responsibility. 

Results 

In the United States, the digital divide of 
broadband access has affected students’ ability 
to manage schoolwork and career training. 
While smartphones have made access to 
digital services and options more viable, the 
divide still affects the amount of time, quality 
of school and work output, and the adoption of 
more digital services in life. 

ACTION: Quick Task – Digital Divide 
and you 

• What is a primary digital divide challenge 
you face? 

• What affordability issues do you recognize 
in having personal access to the Internet 
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and its resources? 
• Where you live, what connection 

infrastructure challenges to Internet 
access do you face? 

U.S. Government and Digital 
Policy 

The United States has a patchwork of policy 
and law governing data privacy and digital 
access. There is has been no comprehensive 
federal policy, although several laws are on the 
books regarding privacy. Much of this was 
covered in Chapter 12. 

• Digital Government Strategy: Formed in 
2012 by the US Government, which aimed 
to develop common standards; ensure 
privacy and security, produce data in a 
device-agnostic way, and develop 
interoperable systems and security. It has 
been quietly managed by the U.S. General 
Services Administration. It is difficult to 
recognize what tangible impact this has 
had on U.S. policy, law, or funding of these 
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standards in government agencies. 
• Connected Government Act: In 2018, this 

was signed into law. It required that new 
and redesigned federal agency public 
websites to be mobile-friendly. It has also 
been managed by the U.S. General 
Services Administration. Its progress is also 
difficult to trace. 

• Ensuring Responsible Development of 
Digital Assets: Signed Executive Order in 
March 2022. The policy, which was 
informed by several U.S. government 
agencies, has a focus on protecting US 
citizens, financial system, and assets form 
digital threats. 

• Federal Communications Commission 
(FCC): The FCC does not currently regulate 
the Internet, or censor it. It does require 
broadband providers to have transparent 
about offered services and consumer 
choices for speed, price, and network 
administration standards. 
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ACTION: Quick Task – Government 
and Digital Policy 

• Does government (of any country for its 
own country) have a responsibility to 
legislate policy for digital privacy and 
security challenges? 

• Should the private sector have a role in 
creating policy for digital privacy and 
security challenges? 

• What are lines you think that a 
government should not cross in setting 
digital policy? 
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Chapter 15: 
Business 
Technology 
Advancements 

What We’ll Cover >>> 

• The Future in Business Technology 
• Home Automation 
• Workplace Automation 
• Artificial Intelligence 
• Hardware 
• Software 
• Access to Technology 

The Future in Business 
Technology 

This textbook has covered a lot about 
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computing, productivity, and the Internet. It 
might be hard to recognize what that all has to 
do with business technology, specifically. 

As covered at the beginning of this book, 
Business technology refers to the technologies 
and systems that help employees accomplish 
activities. It is related to use in school and the 
workplace, and includes computers and their 
peripherals, software and utility programs, and 
systems/use of the Internet. Business 
technology is about all the uses that make 
finding and getting a job, getting the work 
done, and providing results for stakeholders 
like customers, vendors, shippers, colleagues, 
and students. 

All that this book has covered has been 
supporting information and reference to issues 
and challenges that support business 
technology. Often the technology discussed 
wasn’t specific to the workplace (sometimes 
school, sometimes behavior, sometimes 
general technology). However, in one way or 
another the business/work market is impacted, 
because we as students, prospective 
employees, and actual workers are impacted. 
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Essentially, there are aspects of technology / 
the digital world that can’t really be separated 
from the core definition of “business 
technology”. It is all inter-related. 

This chapter will discuss current and possibly 
pending advancements in technology, which 
in one way or another is inter-related to the 
business world. 

Home Automation 

Home automation impacts the business world 
because it is a series of products and services, 
because information privacy and security are 
part of the equation, and because more people 
work in home offices that are affected. 
Employees in this business market are 
responsible for the development, assembly, 
and management of the products, as well as 
the technical and customer-service support. 
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MedAttrib: technofaq.org CC BY-NC-SA 4.0. 
Image of smarthome. 

Initially, most people’s home networks had just 
a few connected devices, like a computer and 
a printer. This has changed in recent years. An 
important need is to keep firmware updated, 
and consider a 2nd Wi-Fi network so that 
computers/work assets don’t mix with the 
smart home. 

Smart Devices 

Home automation allows many devices to 
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connect to our home network. Typically, these 
“smart” devices work just like their regular 
counterparts, like light switches, and they also 
have programmable smart features. They allow 
for tracking usage of power/energy, and by 
people who have access. They can help 
automate some chores. Programming can 
happen on the device, by smartphone, and by 
voice. 

• Smart Appliances. Get reminders if 
something is finished with a process, like 
the washing machine or oven. Set the 
coffee to brew before you wake up. A 
smart fridge can let you know food is 
spoiling, keep a shopping list and deliver it 
to your smartphone, and narrate recipes. 
Smart ovens can preheat and turn off with 
the recipe instructions. 

• Smart Lighting. Smart wall light switches 
work like a normal light switch, but can be 
turned on or off using your computing 
device. They can be programmed to 
activate the lights at certain times. Smart 
light bulbs are similar, but you leave the 
old light switch always turned on, and turn 
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the smart bulb on and off through the app 
or a secondary switch. 

• Smart Locks. A keypad can be 
programmed with a specific code, 
including ones for different people to track 
use. The door can also be locked and 
unlocked from a smartphone app. 

• Smart Smoke Alarms. A low battery can 
prompt a reminder message before the 
alarm goes off. 

• Smart Speakers (with microphones). Don’t 
want to use your phone or your watch to 
control your home automation, then give 
it a voice command instead. “Answer the 
phone” when it rings, or just to “Set the 
timer for 3 minutes” are just two of many 
possibilities. 

• Smart Thermostats. This can be 
programmed for temperature ranges at 
different times. 

• Smart TVs. Video streaming services such 
as Netflix provide on demand access to 
movies, documentaries, etc. A smart TV 
will have apps to access common 
streaming services, and also allow you to 
connect your phone or computer to the TV 
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so you can view your photos or computer 
screen on the larger TV screen. 

• Video Doorbells. The doorbell can notify 
your smartphone, and display the visitor. 
You can talk with them, and consider the 
tool as a security system that takes a 
picture of whoever comes in range of the 
doorbell’s camera. 

Workplace Automation 

Workplace automation uses technology 
systems to do repeatable / predictable 
workflows without requiring manual 
intervention. The technology systems are a 
blend of artificial intelligence (AI), machine 
learning algorithms, and robotics. 
Programmed effectively and correctly, 
automation can improve efficiency, reduce 
repetitive motion injuries, minimize human 
error, and support customer interactions that 
require standard information. 

We already experience many of these uses 
when visiting websites and needing customer 
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support. The key to making this workable is it 
put the customers first. The digital interfaces 
have to be well programmed to really be 
responsive and be able to resolve most 
problems, so that a customer can get rapid 
assistance and ask for a live person only when 
needed. 

Uses of workplace automation 

• Asset tracking: Digital tags can also be 
applied to warehoused products, to 
automate tracing, reporting, and ordering. 

• Automated Data Collection: This cab be 
configured to generate data entry input 
forms for a customer to use online, and/or 
for a phone customer’s call responses to 
be translated into a form and added to a 
database. Once in the database, the data 
can be sorted, analyzed, scheduled, and 
acted upon, with tracking and 
documentation. 

• Customer Relationship Management: 
Some or most of customer management – 
depending on the business – can benefit 
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from have automated problem-solving 
options. Customers can experience a CRM 
digital voice on the phone or a digital 
assistant on a website chat. They can 
receive bot-scheduled return calls to avoid 
waiting on hold. The live person can pull 
up database information to verify the 
customer’s identity and follow up on the 
problem resolution. 

• Digital tracking: Using digital tags and 
electronic shelf label can allow for the 
automatic syncing and updating of 
pricing, and update in-store inventory’s 
stocking needs. 

• Human resources: Recruiting can be done 
with attaching a database-reading 
application form onto job listings. 
Applicant data goes into the database and 
is there for tracking through the process: 
initial phone calls, comments, interview, 
and hiring process. Trainings can be 
assigned for onboarding, and some 
trainings can be automated digital 
scenario-based programs. Scoring, plus 
employee accomplishments and annual 
reviews go into the database. 
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• Industrial automation: Heavy, body-
stressing, small-space, and detail-oriented 
work on an assembly floor can be assisted 
by robotic counterparts. An example 
would be Boeing (because the author 
temped at the Everett plant and daily 
watched the assembly line). Boeing now 
uses an automated drilling system for 
plane exteriors, and a robotic painter for 
the 777 wings. Other examples in industry 
could be machining, welding, and other 
metal fabrication work. 

• In-person support: An office that has rare 
customer visits and does a lot of online 
work might not need a fully staffed front 
desk reception all day long, which can 
allow job sharing or only 3-4 hour in-
person reception. 

• Managing financials: A lot of a company’s 
financial work can be automated. Online 
forms can let employees input expenses 
that need to be reimbursed, timesheet 
info, vacation hours, etc. Payroll just needs 
access to timesheet data to auto-process 
salaries and deductions then and deposits. 

• Marketing automation: Much of the 
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acquisition of customer data is about 
being able to personalize marketing plans 
and advertising techniques. Bulk ads and 
print ad campaigns aren’t cost-effective 
and tend to be one-size fits all. For lower 
cost, through automation and digital 
delivery, prospective and repeat customers 
can be targeted with personalized ads, 
deals, discounts, and preferences. This is 
already common on Amazon and other 
sites. 

MedAttrib: technofaq.org CC BY-NC-SA 4.0. 
Relationships management. 
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Artificial Intelligence 

Artificial intelligence is a lot more routine than 
we may think it is. People have memories of 
the Terminator film regarding AI, robotics, and 
‘Skynet’. However, at this time most AI is about 
programming algorithms to apply to bots, 
computer systems, and some people-facing 
automation tasks. This book doesn’t have the 
bandwidth to devote sufficient time and space 
to what is happening even now, and other 
articles/books will be popping up all over that 
will cover every aspect of AI as it develops and 
moves forward. However, it is worth some 
coverage, given that in the past couple of years 
we have been learning more about, and been 
given access to, generative AI use. It is poised 
to affect and transform many of our basic 
computing, business technology, and 
information technology realities – as well as 
impact our sense of information integrity and 
personal privacy. 
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Basics of AI 

Artificial intelligence is the development of 
computer systems able to perform tasks that 
normally require human intelligence. It 
requires a computing device to be able to learn 
through experience to expand on basic 
programming. This is what ‘deep learning’ and 
‘machine learning’ refers to: a method of 
teaching computing devices to recognize 
complex patterns things like language, images, 
and other data to produce accurate insights 
and predictions. Software algorithms are able 
to learn and become better at carrying out 
specific tasks as they are exposed to more data 
that helps them refine and limit the need for 
repetitive input by the user because the AI 
adapts to the input and integrates it into future 
use. 

• Machine learning: AI programming that 
can automatically adapt with little human 
interaction. 

• Deep learning: Artificial neural networks 
mimic the learning process of the human 
brain. 
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• Foundation model: AI training on massive 
amounts of data with different sensor 
modalities to be able to perform a variety 
of tasks, rather than being designed for 
only one purpose. 

Applications are can include: 

• AI with language and pattern-recognition 
training will become better at detecting 
plagiarism, cheating, and other patterns in 
social and education output. 

• AI with sufficient exposure to big data and 
case studies can research and identify 
diseases more quickly and accurately, and 
streamline drug development. 

• Conversational search, which would allow 
a dynamic conversation with an AI to 
produce specific search results. 

• Decision-making, approving a job 
applicant for an interview, or determining 
qualifications for unemployment, etc. 

• Predictions (outcomes inferred by big data 
analysis). An example would be 
climatology. 

• Robotaxis may become a common 
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transport option given that driverless cars 
have moved so far in research and 
development. 

MedAttrib: L.J. Bothell image of “Artificial 
Intelligence in College” generated from DeepAI 
generator. (yes, I planned on the irony here, just 
to demonstrate. :0) ) 
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Issues in AI 

On September 26, 2023, your author (Mesozoic 
age), who uses MS Windows 11 on a laptop, 
received another Microsoft update. This update 
included a rollout of MS Copilot, (Preview) 
which one would like to think is a new version 
of what MS Cortana and the old MS Clippy 
paperclip bot used to be. However, it is 
expected to be much more, and is an “AI 
companion” that is fully integrated into 
Microsoft products/apps. 

Now, one doesn’t need to go look for and sign-
up to use ChatGPT, Dall-E 2, and a bunch of 
specific AI tools for specific uses like creating 
art, turning legalese into straightforward 
language, cleaning up audio, etc. One can just 
click the Copilot icon and a window pops up 
to allow you to choose a conversation style for 
your input, and ask it anything. Say I ask it “how 
long do Tabby cats live?”, I get a response that 
the AI draws from aggregated information on 
the Internet. Interestingly, the response added 
small footnote hyperlinks so I could click and 
see the source material, which is an approach 
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to offering information integrity and 
attribution. The same question posed to 
ChatGPT did not offer links or attribution 
information. Dall-E 2 requires one to purchase 
‘credits’ to use it, so I did not ask it. 

AI Accessibility 

This little exercise in just getting a Microsoft 
update reveals several things about AI in 
general: 

• A push for AI companion use tied to an OS 
(implying use of your whole computing 
experience and computer data to for the 
AI to access for workflows)? 

◦ The MS Copilot as a preview is free, but 
currently seems designed to be for 
Enterprise users (corporate paid 
account use, like at colleges, 
companies, etc.). It may also be 
available for consumers of MS Office 
365 for $30/month (as of 9/23). 

• Copilot does offer the approach to 
attributing source information for the user 
to see where the data is referenced. 

• Another approach (ChatGPT) requires you 

Chapter 15: Business Technology Advancements  |  677



to set up a currently free account to start 
using it (implying your consent and use of 
your information). It does not seem to 
attribute the generated information so it 
could come from anywhere, including 
inaccurate or wrong information. 

• Another approach – called an Open Source 
tool, seeks to monetize even before you 
can use it. 

Overall, whether paid or not, whether needing 
an account or not, the AI tools are being 
designed so you can input a question or ask 
for some kind of process/product, and get a 
varying degree of responses and results, 
depending on how the AI tool is designed and 
the algorithms it is programmed with. 

AI Uses of Concern 

Research starter: You can type in a question 
and the AI can generate a response. This is a 
step beyond just Googling something and 
getting a list of links to check out. The AI does 
the aggregation work and responds back. The 
issue can be if the user doesn’t really 
understand the information in depth, which 
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affects the information integrity, the 
attribution/citation of sources, and mostly 
copies/pastes the response in lieu of 
personalized learning in job and academic 
situations. 

Workflow integration: According to the goals 
of the Microsoft Copilot, you can also 
streamline your workflow across applications. 
It promises to (paraphrase here) “comb-sort 
across your ‘entire universe of data at work’ and 
the web, and have a ‘deep understanding’ of 
you and your job/priorities/organization to a 
head start on . . . complex or tedious tasks”. 
What will this mean? It may mean taking 
various notes you have kept on a work process 
or subject, and pulling it all together into a 
single document so you can decide what to 
use. It may mean the creating of AI-enhanced 
or designed images using MS design tools. It 
may mean personalizing information for you 
for shopping, planning an event, preparing a 
report, etc. It may help with predictive analytics 
from  your Excel workbooks and database 
information, and other programs you use. It 
also may mean that nothing on your computer 
that can be reached by the AI app is private 
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or fully secure, especially you don’t know if the 
information shared to the Cloud is truly yours, 
the employer’s, or somehow considered 
nobody’s because the AI generates from it. 

Automation of repetitive tasks: Sorting 
through surveys or data to summarize specific 
information will become easier and, as the AI 
learns, more accurate. It can check code, review 
resumes, check digital inventory information 
for needed ordering, etc. Depending on the 
algorithms used and the human oversight, this 
can be very useful or allow for information 
bubbles that leave out important 
considerations when decisions are made. 

People Management: AI is seen as a very useful 
way of assessing customer and employee 
information in order to personalize experience, 
market more efficiently to specific 
demographics, determine the viability of 
products, build contact lists, identify needs, 
and streamline workflow and costs. In the 
workplace managers can see who is thriving, 
who needs training, what the workplace needs 
are related to the number and type of 
employees, etc. However, people management 
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by algorithm alone is a risk, especially if it is 
part of one’s heathcare, one’s employment, 
ones banking/finances, and so on. 

• For instance, various Global 2000 
companies use ‘digital managers’ which 
allow workers to be be hired, have pay and 
benefit disparities, be compared 
statistically against other employees, and 
be fired by algorithms – without any 
human intervention or contact/follow-up 
with the employees. 

Data analysis: AI will be able to scan vast 
amounts of data for trends, incongruities, and 
specific criteria, faster and more accurately 
than humans in data analysis positions. AI 
might also, depending on the algorithms, be 
able to support or make decisions from the 
data analysis, such as for marketing, job 
candidates, and employee success/failure. 
Consumers will be able to refine and 
personalize their needs for information from a 
much larger bank of data with more accuracy 
and efficiency. Vast data analysis can be very 
useful; algorithm/AI-based decision-making 
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may be problematic if there isn’t sufficient 
human oversight and redundancy to get past 
the ‘process’. 

Product creation: Generative AI, in giving 
responses to questions and prompts, are being 
used to write actual research reports, executive 
summaries, articles, emails, essays, stories, and 
more. AI can also generate digital art, music, 
video, etc. Instructors are recognizing that 
students. The tool is “supposed to be” used 
responsibly, such as for idea prompts, research 
collation, creativity for fun, etc. It can be used 
for generating suggested outlines of content 
for a paper, find sources, help draft your own 
information into resume formats, and make an 
illustration example of an idea you are trying 
to communicate or a small soundbyte for a 
website you want to attach a personalized 
sound effect to. 

• In academics, teachers are seeing more 
situations of students relying on 
generative AI for composing the bulk or 
entirety of their assigned coursework. 
Teachers can expect students to use AI to 
generate essay and project ideas, help 
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them find sources for their research, 
generate a structural outline based on a 
project’s available information, and maybe 
even help refine out redundant content 
that would bloat an assignment. Teachers 
themselves may use AI tools for 
brainstorming and streamlining 
assignment ideas. 

• However, AI can be a problem when 
students cheat with it by using full content 
instead of doing their own work. Why? 
One, cheating/plagiarizing is unacceptable 
in any case, since the student clearly 
doesn’t learn the content and attempts to 
apply it to the real world and on a job – like 
as a nurse with medications, a mechanic 
with working trucks, a graphic artist with a 
cheat portfolio, a psychologist interfacing 
with people’s mental health – is a lie. 
However, with generative AI, it steps up to 
worse when AI content sourced from 
multiple creators has no attribution/
citation information, and when one can’t 
even trace where the information came 
from. Does it have currency, relevance, 
authority, accuracy, and a specific 
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purpose? Or is it hearsay, chatbot-based, 
social-media, slanted, or worse – using the 
copyrighted intellectual property of others 
without license or payment? 

• This problem persists when consumers 
use generative AI to create ‘stories’. 
“artwork’, ‘music’,, ‘news articles’ or other 
seemingly personal ‘intellectual property’, 
then pass it off as their own original work 
while trying to profit and create an artistic 
reputation. Does it copy the work-style of 
specific music artists, or slander a public 
figure, or ‘look’ like a Monet or H.R. Giger, 
or a Jane Austin story, or a James Cameron 
script? 

• This problem also allows publishers of 
various media (written, music, film, 
photography, visual) to try to replace 
human creatives with generative AI 
content in order to avoid giving credit, 
negotiating fair and appropriate use, and 
paying salaries, royalties, & licensing fees. 

As you can see, AI is a growing tool, benefit, 
workplace need, and issue full of unfolding 
problems, concerns, and ways to continue 
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evolving. Definitely for other books and articles 
to cover! 

Hardware 

How is computing hardware progressing? The 
discussion in Chapter 2 covered the basics of 
how things work; what’s coming up? 

We’ve been accustomed to the Moore’s Law 
that every 2 years the processing power we can 
pack into a square inch doubles. That is how 
we moved from room-sized supercomputers to 
small and slim smartphones that can do 
almost anything. 

Now, the research and development process 
is moving away from silicon-based transistors 
made from materials like graphene. Deep-
learning software is enhancing programming 
and responsiveness. Noises are being made 
about quantum computing: moving from 
standard bits to quantum bits (qubits) , which 
can surpass standard binary 0 and 1. My brain 
can’t handle it, but the results could allow a 
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quantum computer to find solutions in fewer 
steps than a standard computer, which would 
speed up processing. The quantum solution 
wouldn’t necessarily replace existing computer 
technology, but supplement is with an 
additional specialized chip. 

A survey of Google results for various “future 
computing” keyword phrases suggests: 

• Battery improvements: R&D is being done 
to create longer-lasting batteries that don’t 
need as much recharging, and using 
materials with lower environmental 
impact. 

• Chip advancements: To develop more 
efficient and cost-effective chips, the 
industry is working toward imprinting 
learning algorithms on chip architecture 
as another example of AI. 

• Computing input/Holographic tech: 
Touchscreen capacity is being researched 
to develop predictive touch, which would 
rely on machine learning to predict user 
actions. Holographic virtual tech is 
working to create line-of-sight 3D images 
the need for glasses / interfaces. This could 
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accelerate the possibility of holographic 
screens and allow for air-sweeping motion. 

• Distributed computing: Multiple 
computers work by sharing their 
computing power. A network would 
behave as a single computer that provides 
large-scale resources to deal with complex 
problem solving. 

• Energy costs: Technology – the 
development of computing devices, and 
the management/operating of vast server 
data centers (power, cooling), will have to 
be dealt with. Greening data centers to get 
to net zero emissions and 100% efficiency 
is underway; however, significant progress 
will need to be made to repurpose 
generated heat for the grid and for much 
more energy efficient equipment. 

• GPU dominance: Graphical Processing 
Units (GPU) co-work with the Central 
Processing Unit (CPU) on computers. The 
GPU’s purpose is to enhance computing 
with parallel processing to handle a lot of 
workloads at the same time. Big graphics, 
CAD, and gaming have been the 
beneficiaries; GPUs are also being tasked 
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with training artificial intelligence (AI) and 
deep learning models. GPU performance 
will have to evolve rapidly, and in time they 
may supplant the CPU. 

• Neuromorphic technology: Elements of a 
computer hardware and software 
elements are modeled after systems in the 
human brain & nervous system. This could 
allow devices to search for new info, learn, 
retain data, and make deductions. 

• Scalability: A goal of computing is to 
increase the scalability of processing, 
harness the resources of multiple 
machines, and make cloud environments 
“agnostic” – independent of being 
designed for specific computing 
architecture and instead being able to 
serve any device. This in turn may cause a 
shift in hardware acquisition itself. 
Currently we have software-as-a-service 
(SaaS) with subscription software like MS 
Office. Computing hardware may undergo 
a similar path, with organizations moving 
away from requiring large expenditures on 
equipment and instead leasing hardware-
as-a-service (HaaS). 
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Software 

How is computing software progressing? A 
survey of Google results for various “future 
computing software” keyword phrases 
suggests: 

• Application programming interfaces
(API): An API is a software interface that 
helps developers link cloud computing 
services which make data/computing 
multifunctional for numerous programs. 
This allows data from isolated locations to 
be pulled and harnessed. 

• Augmented reality: This will continue to 
be developed to reach personalized 
immersive experiences with tethered and 
standalone devices. Immersive 
experiences will need a huge push for 3D 
assets, and generative AI will be able to 
accelerate this. 

• Blockchain-oriented software: Through a 
blockchain database process, data in 
systems is replicated, closed in a set called 
a block, and decentralized. Blocks are lined 
in a chain (blockchain) which, with 
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transaction recording and public-key 
cryptography, ensures data security. Data 
can be viewed but not modified or hacked. 

• Continuously deployed software updates: 
Code changes to an application are 
automatically tested and released 
automatically into the production 
environment. Version control, code review, 
and configuration management helps 
bypass the need for quality-assurance 
testing and human approval. 

• Cybersecurity applications: With 
expectations of growth in cybercrime, like 
ransomware, AI /machine learning is being 
applied to security automation software. 
Software will have to become 
multifunctional to accommodate cloud 
security, IoT devices’ security, and the 
unique challenges of blockchain coding. 

• E-commerce platforms: A content 
management system (CMS) and 
commerce engine that webstores use to 
manage products, purchases and 
customer relationships. Future 
improvements will need to blend user-
friendly web presences with support for 
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IoT, voice, and augmented reality aspects 
of e-commerce stores. 

• Low code development: Low-code allows 
the creation of coded applications without 
needing developer skills, because a visual 
UI allows drag & drop pre-made code 
blocks. IT support will still need to 
supervise and test the results, concerns 
include security and ability for the apps to 
integrate with other business functions. 

• Microservices: The process of monolithic 
architecture, in which application 
processes are grouped and handled as a 
single service, is having to be updated 
because grouped code needing complete 
app changes is not agile. Microservices 
architecture modules are built as 
independent services that use API 
communication. Modules can be built, 
managed, and changed independently of 
the others, can be scaled easily, and be 
reused in other projects. 

• Multi-model databases: A database 
management system that organizes many 
NoSQL data models using a single 
backend, a unified query language, and 

Chapter 15: Business Technology Advancements  |  691



API. There is a growing trend toward 
databases offering many models and 
supporting several use cases. Different 
than relational databases because 
different data models from diverse 
databases can be queried and combined 
with a specific query language. 

• New computing languages: New 
programming languages are being 
developed to solve problems like speed 
optimization, scalability, and a need for 
user-friendly learning curves. Pluses in a 
language include being “memory safe,” or 
able to translate into and secure JavaScript 
syntax, or being hybrid like F#, or having 
early code-error detection. 

• Online marketing: Like other software 
development plans, online marketing 
platforms are increasing reliance on 
augmented reality, AI, chatbots, and other 
digital tech. Omni-channel experiences are 
being promoted in order to improve 
customer retention; a customer should be 
able to expect the same experience in a 
store, online marketplace, social media, or 
by phone. 

692  |  Chapter 15: Business Technology Advancements



• Progressive Web Applications (PWA): 
PWAs work are coded with HTML, CSS, and 
JS like websites without a browser 
interface or a need to download. They are 
platform agnostic for mobile, tablet, and 
desktop computing. Examples include 
retail storefronts, social magazines, game 
apps, etc. 

• Sharing Economy: Collaborative 
consumption platforms connect users 
with suppliers in real-time with GPS, data 
analytics, and AI. Focus is on personalized 
experiences, security, and the use – not 
ownership – of products and resources. 
Uses include crowdfunding, lodging, 
transportation, co-work spaces, and goods 
recirculation. 

Access to Technology 

A constant challenge is access to computing 
tools, the Internet, and efficient connections 
that provides security, speed, and no 
interruptions of service. 
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Part of the issue, as previously discussed, is a 
limitation of infrastructure in various regions 
in the U.S. and various countries around the 
world. Another issue is cost, for subscriptions 
to broadband service and for equipment that 
can do the work needed in education and 
workplace contexts. Another issue – which is 
outside the scope of this book – is 
standardization of services, as was recognized 
in education during Covid. Different 
workplaces – even branches of the same 
company, might have a lack of standardization 
of employee resources and management 
platforms. 

Connectivity 

5G: Now being rolled out and promoted is 5G, 
another generation of mobile networks. 5G is 
expected to have lower latency, which should 
effectively support AI, IoT, and augmented 
reality. It promises faster download speeds than 
the current 4G, which could improve video 
conferencing and automated tasks than at 
present. 
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Interconnectivity: Distributed IT infrastructure 
of many companies will be using hybrid-cloud 
or multi-cloud platform. Data and processing 
will be managed in the cloud although may 
be accessible to devices faster. More web 
platforms will be multifunctional and reliant on 
this interconnectivity so that companies can 
keep costs low, productivity high, transactions 
and data highly secure, and customer relations 
personalized. 

Digital accessibility: Everyone, including 
persons with divergent needs, needs full access 
to digital content. Accessibility standards 
processed by usability engineers need to be 
personalized and applied to computer 
interfaces. The goal needs to be Universal 
Design, which would remove most or all 
barriers altogether, rather than just behaving 
as assistive technology. This goal still seems 
distant, although AI and robotics in web 
platform usability could offer significant 
advancement, especially since the continuing 
increase in technical layers can be off-putting 
to users with divergent capabilities. 

Some emerging accessibility benefits include: 
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• Improved voice-to-text functions. 
• Connecting with a virtual assistant. 
• Smart home functionality. 
• Assistive technology tool Morphic that 

personalizes the computer to a user’s 
needs. 

• Possible public access bots/interface add-
on that could assist a variety of 
accessibilities. 
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Chapter 16: 
Workplace 
Readiness 

What We’ll Cover >>> 

• Life/Work Balance 
• Workplace Readiness 
• In-person Workplace 
• Hybridized Workplace 
• Mobile Workplace 
• At-home Workplace 
• Legal Rights with Technology 
• Tips and Techniques 
• Special Concerns 

This chapter will focus on the business 
technology workplace. The workplace – unlike 
when the author was a young ‘un slogging 
barefoot through miles of snow to a one-room 
office building – is rarely a single ‘workspace’ 
for people. It has completely blown apart and 
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come back as an assembly of workspaces 
connected by technology tools and resources. 
Certainly, many jobs remain tied to a physical 
workplace, like a mechanic’s workpit, an 
industrial plant’s assembly floor, a hospital 
setting, restaurant kitchens, etc. However, 
more support work and professional data/
product/services workplaces have become 
mobile, only tethered by equipment and 
access to company resources. 

Much high-value support has also been 
evolving to be primarily cognitive in nature. It 
requires constant data access, analysis, and 
manipulation to express and serve complex 
needs like customer management, financial 
administration, and education / skills-provision. 
Inventory, healthcare, manufacturing, travel, 
entertainment, transportation, energy & 
utilities, and most other industries have moved 
into a much more cloud-based and tech-reliant 
stage. The digital work market demands new 
ideas, information and business models that 
continually expand, combine and shift into 
more new ventures. Employees must 
consistently upskill so digital dexterity can 
meet ever-changing business needs. 
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Life/Work Balance 

Before delving more into this chapter, I am 
going to step out of ‘author’ identity and into 
‘colleague.’ I want to share some important 
things to consider. 

We are exposed to unending waves of advice, 
articles, tips, and training on how to find, get, 
keep, and live a job. The focus and priorities 
change from year to year, but they are all the 
same: you are your work, you are a ‘worker,’ 
your life is supposed to revolve around all 
things employment. Okay. . . no. 

This chapter will cover information that are 
based on general career intelligence and 
experiences of a lot of people. However, our 
priority in life should be our own sense of life 
/ work balance. Work is hopefully a personal 
‘drive’ and contribution, and certainly a way to 
earn income and tools for personal needs and 
security. It isn’t and shouldn’t be our full 
identity, a sole purpose of living, a soul-sucking 
trap, or something that isolates us from family, 
life experiences, hopes and goals, etc. We need 
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to keep all that in mind, and focus on balance, 
flexibility, and continuously growing so we can 
open more doors for ourselves. AND, think of 
yourself as “talent,” not ‘employee’ or ‘worker’ 
or ‘material.’ You’ll be able to thrive and be able 
to find diverse ways to employ your skills and 
abilities. 

Back to author mode. 

Workplace Readiness 

Workplace readiness includes personal 
qualities, people skills, and professional traits 
that are necessary to maintain employment. 
These skills are important because they are the 
most desirable skills employers are searching 
for in potential talent. They also give the best 
chance of career mobility. 

Work readiness skills include: 

• Communication: Communications is a 
range of verbal, written, body/face 
expression, and actions. It takes place in 
person, in video conferences, in chats, in 
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email, in documents, and in forms for 
customers, payroll, and regulatory needs. 
Clear language skills are necessary, and 
when one is working with (for instance) 
English as a second language, a priority 
has to be to keep learning ways to be clear, 
consistent, and easy for others to 
understand and work with. 
Communications also requires logic/
reasoning, respect for others, and an ability 
to follow-up to ‘resolve’ a subject. Finally, 
timing is important: communicating the 
right things at the right time, early and 
often in processes, when as soon as 
possible when there is a challenge to be 
handled, etc. 

• Digital: Includes computing skills like 
keyboarding, file organization and storage, 
basic computer care habits, and 
productivity tools. Digital/Internet skills like 
connecting, maintaining privacy and 
security, searching and accessing 
information, and practice of 
understanding of computer security 
fundamentals. Behaviors like ethics in 
using digital assets and professional 
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communication standards for social 
connections. 

• Interpersonal: People-facing skills like 
teamwork, conflict resolution, respect for 
diversity and equity, and inclusive win-win 
strategies. Be able to read and respond 
positively to body language; focus on 
people as individuals like yourself rather 
than material to get something out of. 
Avoid judgementalism, prejudice, and 
discrimination. 

• Job-specific: Core academic skills, job 
industry kills training, and in-the-job 
environment expertise. You need to bring 
skills and experience, and be able to learn 
employer-specific routines, practices, 
activities, and equipment. 

• Life management: Adulting skills like 
being able to prioritize, manage time, 
organize yourself, take responsibility, and 
use sound personal financial practices. 
Keeping personal stuff personal. A mobile 
and ever-changing work market also 
requires flexibility, reliability, and the ability 
to keep learning new skills. 

• Problem-solving: Ability to find and 
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recognize accurate information, perceive 
and minimize info bias, prioritize steps of 
action, use critical thinking practices, have 
creativity in seeking solutions, and focus 
on win-win results that support everyone 
involved. 

• Work ethic: Focus on adding value to the 
work and results – especially for those in 
customer positions (like you in other non-
work situations). Sense of responsibility to 
a safe and positive workplace. Doing work 
well because it should be. Willingness to 
keep upskilling. Separating personal 
things from the workplace. Recognizing a 
healthful balance between life and work 
demands. 

In-person Workplace 

An in-person workplace involves going to a 
work location every day. Considered desk-
bound, or workplace bound, in-person 
workplaces can be in office buildings, industrial 
factory locations, design and media workshops, 
restaurants, oil rigs, hotels, retail storefronts, 
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hospitals, law-enforcement, schools, etc. Some 
transit-related services are in-person 
workplaces, like work on buses, trains, planes, 
ships, filming locations, and other places in 
which colleagues and infrastructure of some 
kind present in person. It is characterized by: 

• Commuting to employer’s workplace. 
• Desk/cubicle assignment. 
• Dress code and behavior expectations. 
• Employer managed on-site computing, 

data, and tech support. 
• Employer-provided work resources, like 

infrastructure, computers, servers, desks, 
shared spaces, digital connections, 
machinery, and company knowledgebase. 

• Employer responsibility for workplace 
safety, security, ergonomics, monitoring, 
etc. 

• Hierarchy of prioritization of work and 
expectations. 

• In-person connections like visiting offices, 
hallway chats, etc. 

• On-site meetings and teamwork. 
• Shared spaces like kitchen, cafeteria, 

restrooms, lobby. 
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• Work product and services provided from 
employer-provided location. 

The Covid pandemic challenged this traditional 
work model in a lot of industries and support 
positions when a significant portion of the 
workforce needed to stay out of public areas 
like commuting transit, lobbies, elevators, 
shared workspaces, etc. There are pros and 
cons to the in-person workplace: 

Benefits 

• Assets and work product clearly belongs to 
employer. 

• Clear policies and regulatory expectations. 
• Equipment and resources are maintained 

by the employer. 
• Feeling more productive in the work space 

than at home. 
• No home-related interruptions from 

children or visitors. 
• Clear line between work and outside life. 
• In-person team building and interactions. 
• Face-to-face contact with customers, 
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colleagues, vendors, and supervisors. 
• Networking with colleagues, workshops, 

and conferences. 
• Professional appearance standards. 
• Sense of being recognized and accessible 

for promotion. 
• Working directly with vendors and 

providers. 
• Worker productivity high with employer-

supported resources. 

Concerns 

• Commuting time, costs, and 
inconvenience. 

• Expenses for dress code and for work time 
meals. 

• Impersonal or ‘canned’ environment. 
• Inflexibility of work hours and workflow. 
• Lack of privacy from monitoring. 
• Limited autonomy. 
• Sense of being judged for promotability. 
• Work and home life balance driven by the 

employer. 
• Workplace safety and security issues. 
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Hybridized Workplace 

A hybrid model involves employees going to a 
primary in-person workplace a percentage of 
the time and spending the rest of their time 
working from home, such as three days in and 
two days home. It is a flexible model that can 
translate to a fixed number of days per week 
or visiting the office on a required as-needed 
basis for important meetings and check-ins 
with the team. It requires employer support, 
access to employer infrastructure, and reliable 
from-home access to employer tools, 
connection, cloud space, etc. 

Benefits 

• Access to onsite equipment and resources 
some of the time. 

• Assets and work product clearly belongs to 
employer. 

• Balance of work and home life. 
• Daily autonomy balanced in favor of 

worker. 
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• Limited commuting. 
• Maintaining some professional presence 

and appearance. 
• Meetings can be attended in person or 

remotely. 
• Regular work resources connection 

through cloud resources. 
• Semi-regular in-person interactions with 

colleagues and teams. 
• Semi-regular visibility in the workplace. 
• Worker productivity high with employer-

supported resources. 

Concerns 

• Day-to-day challenges making hybrid 
model seamless. 

• Difficulty meeting and teamwork 
schedules. 

• Disconnect between in-office and remote 
employees. 

• Employer’s lack of a commitment to the 
remote model needs. 

• Lack of daily/assigned office work space. 
• Mismatch of equipment and resources 
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between workplace and home. 
• Perception of employees getting away 

with something. 
• Risk of being “on” more worktime – and 

overworked – because of lack of delineated 
‘work-away’ environment and excessive 
use of online communications. 

• Unclear policies, regulatory expectations, 
and safety support regarding home 
workplace. 

Mobile Workplace 

A mobile workforce doesn’t have employees 
bound by a specific workplace environment, 
even if they often work in-person. Workers 
function primarily between different work 
bases, in ‘the field,’ in vehicles (taxi/freelance 
drivers) and/or in shared coworking spaces 
designed for consulting/freelancing. Can 
include temp/project workers, freelancers and 
gig workers, traveling sales, inspectors, etc. 
Employees are connected by various types of 
mobile technology: computers, smartphones 
and other mobile devices. 
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Benefits 

• Assets and work product negotiable. 
• Balance of work-related and home work 

space. 
• Choices about commuting. 
• Control over most of work equipment and 

resources. 
• Flexible scheduling and location. 
• Home and work life balance driven by the 

worker. 
• Personalization in professional presence 

and appearance. 
• Work resources connected through cloud 

resources. 
• Regular interactions with colleagues in 

person and/or remotely. 
• Work-for-self autonomy. 

Concerns 

• Assets and work product can be controlled 
by work-for-hire agencies. 

• Challenges of stable, as needed, and 
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affordable cloud and resource access. 
• Disconnect from regular in-office 

workplace standards. 
• Gig and contract work ratings, invoicing, 

payment, and taxes. 
• Home life and work balance can be driven 

by clients/customers and/or employment 
agencies. 

• Irregular work schedule. 
• Juggling other workers’ schedules. 
• Lack of daily/assigned work location. 
• Lack of stable employment, salary and 

benefits. 
• Lack of policies, regulatory expectations, or 

safety support regarding mobile 
workplaces. 

• Primary/sole responsibility for work 
equipment and resources. 

• Perceptions that worker isn’t ‘working.’ 
• Risk of being overworked because of too-

flexible client needs and excessive use of 
online communications. 

• Stress of separating work from life. 
• Worker productivity depended on clients, 

agencies, and sometime uneven access to 
resources and connections. 
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At-home Workplace 

An at-home workplace involves the work 
location being solely/mostly a worker’s home 
location. It can be considered desk-bound, or 
workplace bound, but support and cognitive-
level work is be done away from a centralized 
employer workplace – with the right employer 
commitment and groundwork. It is 
characterized by: 

Benefits 

• Assets and work product clearly belongs to 
employer if on employer time and 
resources. 

• Access to employer equipment and 
resources at home. 

• Daily autonomy balanced in favor of 
worker. 

• Flexibility (some) in daily schedule. 
• Lower employer infrastructure needs and 

costs. 
• No commuting. 
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• Online meetings, conferences, and 
teamwork. 

• No workplace monitoring other than 
equipment/cloud hours. 

• Small budget needed for professional 
appearance or workplace lunches. 

• Worker productivity high with employer-
supported resources. 

Concerns 

• Can’t monitor employee daily activities 
other than by computer. 

• Challenges of accessing employer 
resources. 

• Complexity of tax preparation for home 
office status. 

• Disconnect between employees. 
• Employees may have limited at-home 

workspace. 
• Home interruptions to workflow and in 

tele-meetings. 
• No visibility in the employer’s workplace. 
• Risk of being “on” more worktime – and 

overworked – because of lack of delineated 
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‘work-away’ environment and excessive 
use of online communications. 

• Routine non-work interruptions. 
• Separation of work from home space and 

time. 
• Technical support of hardware. 
• Unclear policies, regulatory expectations, 

and safety support regarding home 
workplace. 

• Unclear ownership of assets and work 
product on employee resources and time. 

In any environment, the biggest worry for 
employers is productivity, given any limits of 
oversight of employees and variable access to 
and responsiveness of work equipment, 
resources, and connectivity. 

Workers may feel as productive in a home 
workspace, dependent on stable access to 
equipment/resources and minimal 
interruptions. 
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Legal Rights with technology 

Rights to work-related activity are in flux, 
especially with the nature of Internet and 
digital aspects of work. In-person workplace 
rights, policies, and regulations tend to be the 
most clearly delineated and able to be 
managed with human resources and legal 
systems. Rights of mobile work-related activity 
has different but still somewhat delineated 
rights, policies, and regulations related to self-
employment. The lines blur when dealing with 
hybridized and at-home workplaces, since 
employees may experience a mix of employer-
supported resources/services and 
responsibility for some of their own tools and 
environment. 

Employers can and do set policies, procedures, 
and actionable consequences for workplace-
related concerns. US labor law favors 
employers, and employment is usually 
considered to be ‘at will’ which means that 
employers can terminate employees at any 
time, for any reason, with little requirement to 
prove ‘just cause’. 
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It has to be up to every employee – of any kind 
– to find, access, and digest work-related 
regulatory information about: work product 
ownership, use of and responsibility for 
employment assets and connections, what 
time-keeping of work hours should account for, 
and what is supposed to be covered by privacy, 
safety, and security regulations. 

TIP: Employee Responsibility. It is also 
up to every employee to “adult” in the 
workplace. Whether you like an 
employer/job or not, you are agreeing to 
rules and accepting compensation for 
working on behalf of them, and others 
(like customers, patients, students, 
vendors) rely on you. That makes you 
responsible for your own work-related 
behavior. If you don’t want to be 
messed with, don’t mess with work. 

If you do mobile work and and/or any kind of 
self-employment, you also need to look into 
protections and policies for that, including 
taxes and deductions. In general, you need to 
make a point of knowing about: 
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• Access to legal clinics/assistance 
• Employment security 
• National labor practices policy 
• Occupational Safety and Health 

Administration (OSHA) 
• Privacy Rights laws as (discussed in 

Chapter 12, Special Issues). 
• State minimum wage laws 
• U.S. Department of Labor 
• Worker compensation 
• Your state’s worker rights 

Each state, and each type of work, has 
differences which realistically cannot be listed 
or linked in this textbook. However, here are a 
few considerations. 

Employee rights 

Employee privacy rights are rules that limit 
employer’s access to an employee’s 
possessions/person; limit monitoring employee 
actions and communications; and limit 
intruding on personal lives. The more 
technology you use in the workplace, the more 
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accurate and detailed a picture of you can 
build up about your personal life, habits and 
activities. Keep this in mind about all workplace 
activities. 

Rights to consider: 

• Freedom from discrimination. 
• Privacy in workplace areas like restrooms, 

and changing rooms, and some personal 
space in cubicles and offices. 

• Privacy in workspace communications like 
emails and phone calls; questionable if 
done on work equipment, connections, 
environment, and time. 

• Privacy of personal equipment and things 
brought to the workplace; questionable if 
personal equipment use is part of the 
workplace hiring agreement. 

• Right to fair compensation, including for 
overtime. 

• Privacy to personal communications and 
accounts handled outside the workplace, 
regarding personal social media, 
passwords, and communications. 

• Right to use break and lunch time as 
desired; questionable if workplace 

718  |  Chapter 16: Workplace Readiness



resources and location is being used. 

Employer Rights 

Federal workplace privacy / employee 
monitoring regulations come mainly from the 
Electronic Communications Privacy Act of 1986. 
Business owners are allowed to monitor all 
employee verbal and written communication 
with a legitimate business reason for doing it. 
More monitoring can happen employee’s give 
consent. 

• It is not supposed to allow monitoring of 
employees’ personal and business 
communications, although any use of 
employer workspace, tools, network 
connection, and worktime makes 
employers push against this. 

Employers expect discretion to dictate 
personal computer usage policies in the 
workplace when they own the computers, and 
workplace data accessible by and transmitted 
with them. Security reasons are another 
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employer concern, since systems can become 
vulnerable to malware when employees use 
the workplace Internet for personal downloads 
and connections. Security is also an issue when 
employees violate company confidentiality 
rules, even by chatting or complaining about 
work on social media. 

IT departments/employers can and do try to 
limit problems by: 

• Archiving email for later reference and 
review. 

• Blocking access to non-work related 
websites. 

• Installing biometric technology on 
machines and in the workplace. 

• Monitoring hard drives and computer 
terminals for use and timekeeping. 

• Monitoring use and sharing of licensed 
software packages. 

• Tagging inventory for data management 
and tracking. 

• Tracking and reviewing internet usage and 
email contents. 

• Use tracking software to alert about 
violations. 
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• Using cameras and recording for security 
monitoring in common and work spaces. 

• Using equipment and vehicle GPS systems 
for usage and timekeeping. 

Employees may have very few electronic 
privacy rights when working from home, since 
according to federal law, employers have a 
right to monitor use of employer-provided 
equipment and computer networks, including 
files, visited web pages, and work email. At-
home or hybridized work environments are not 
a situation for employees to relax workplace 
ethics and standards. 

As noted in Chapter 12, no matter what an 
employer’s policy is about privacy and 
company security, the employer has a 
responsibility to be transparent, current, and 
respectful about the policies and procedures 
with employees. As an employee, you have a 
responsibility to learn about what those are, 
document and keep that information, and be 
savvy in your workplace dealings. Learn what 
your employer’s policies are for: 

• Access to employee-owned material, 
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equipment, and accounts 
• Employee data collection, privacy, and 

security 
• Equipment and network/Internet use 
• Privacy 
• Time use 
• Workplace data protection/security 

Tips and Techniques 

Back in the day (the Stone Age), when I (the 
author) was young, I chose to become a 
professional temp. This was because 
permajobs seemed to rarely give raises or move 
you up in the company, and lay-off firings were 
becoming the norm. As a professional temp, I 
could control where I went, how long I stayed, 
travel light, play to my strengths, and keep 
learning & earning more. 

Back then, I got articles published about what 
I practiced – mobile workplace skills. I bought 
and brought my own few office supplies. I 
carried my own zip disk (later USB drive) with 
my own utilities and key tech needs. I created 
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my own workplace/timesheet form for my own 
reference. I learned how to take each new temp 
assignment by the horns from moment one by 
asking key questions. I was highly organized, 
communicated fairly well, and always focused 
on how I added value to the employer I was 
temping with. I worked to solve, mitigate, and 
prevent problems. I got asked back by a several 
employers, and hired longer term by a couple 
of them. 

That was in the 1990s and 2000s. I started 
teaching in 2009, but never totally lost touch 
with my temping/gig experiences. However, at 
the same time, technology has rushed up and 
bitten us all, and there are additional tips and 
tricks I would use now – in the spirit of what 
used to work but with an emphasis on how 
many more technological changes we face and 
now live with. I have come to realize that 
people come first, everyone matters, and we’re 
all in this digital world together (Digital 
Citizenship). Even the listed non-techy tips are 
useful in our techy world. This is that chapter 
for the “me” who would be in the workplace 
now if I stopped teaching and re-entered the 
workforce job search. 

Chapter 16: Workplace Readiness  |  723



• Always be aware of and prepared for a low-
privacy-protected environment, including 
the workplace. 

• Always be well stocked up on living basics 
(and fave items) and tech needs/fees, then 
set emergency money aside so you have 
flexibility and freedom in work-lean times. 

• Always keep your resume updated and 
accessible. Focus on skills, projects, and 
continued learning, and how you add 
value in situations. 

• Be a Positive Digital Citizen (Chapter 13). 
• Be a problem solver, minimizer, and 

preventer. 
• Be able to measure/record your own 

learning and productivity and report it to 
employers/job agencies. 

• Be clear to yourself about your needs, 
expectations, and personal “red line” of 
unacceptable conditions. 

• Build a few reliable and solid connections 
rather than multitudes of shallow social 
media contacts. 

• Clarify what is YOUR time and resources, 
and what is an employer’s. Don’t ever take 
risks with workplace assets and time. 
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• Create and maintain an e-profile, e-
portfolio, and professional network 
account, with regular updated 
accomplishment samples and certificates. 

• Create your own workplace reporting 
worksheet / timesheet and use for your 
personal records. 

• Hybridize your skills for mobility and 
flexibility, whether working at home, in a 
workplace, or in a blend. 

• Learn constantly: social skills, worldview, 
and upskilling. 

• Learn to separate yourself from your 
phone/email and an employer’s post-
worktime needs. 

• Learn to communicate minimalistically – 
no one needs to know all you are thinking, 
and less is more. Diplomacy, respect, and 
kindness will serve you well. 

• Secure your own devices with privacy and 
security tools/protections. 

• Time and skills management are yours to 
handle. 

• Win-win workplace and responsible social 
communication success: be aware of and 
part of Diversity, Equity, Inclusion and 
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Accessibility (DEIA); Justice, Equity, 
Diversity, Inclusion (JEDI) is also a valuable 
approach. 

726  |  Chapter 16: Workplace Readiness



In Conclusion 

Technology Essentials has offered a survey of 
computing and digital coverage and skills 
necessary to engage in school and the 
workplace. With a survey of practical 
computing skills, coverage about digital 
citizenship, application practices, and 
overviews on various business technology-
related issues, learners have been able to gain 
additional skills and knowledge. 

This book is definitely not an exhaustive 
reference, and much of the coverage was fairly 
generalized. Technology and digital citizenship 
changes so quickly that more specific 
information and resource links would be 
obsolete almost immediately. However, 
learners and instructors should be encouraged 
to research, explore, and learn more. The 
content can prompt discussions of main points 
as a starting point for debates, reviews of 
current needs and topics, and practices of 
workplace computing competencies. 
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